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Chapter 1. Overview

IBM® WebSphere® Portal provides a single access point to web content and
applications, while it delivers differentiated, personalized experiences for each user.

Multiple solutions are available to fit your needs.
WebSphere Portal Server

This foundation offering provides a single access point to web content and
applications and delivers socially infused, differentiated, personalized experiences
for each site visitor. WebSphere Portal Server supports workflows, limited content
management, simplified usability and administration, development tools and Web
2.0, open standards, security, and scalability. The result delivers exceptional web
experiences across multiple channels, in context with the correct business
applications and data, to engage and collaborate effectively, improve business
productivity, and deliver better business results.

WebSphere Portal Enable and Extend

These offerings add capability on to the foundation WebSphere Portal Server
offering. The Enable and Extend offerings add web content management
capabilities. The offerings deliver the correct information to the correct audience.
They include rich text editing tools, web content templates, workflow, advanced
enterprise search, and personalization services. Used together, these features help
you build rich websites that can deliver highly targeted and dynamic content to
customers, partners, and employees in more relevant ways.

IBM Web Content Manager and Standard EditionIBM Web
Content Manager

IBM Web Content Manager increases efficiency and accuracy of website
deployments. This is achieved by placing content creation in the hands of content
experts to create, maintain, and deliver online content while IT retains control.

For additional information about WebSphere Portal solutions visit:
[http:/ /www.ibm.com /software /websphere /portal /|

[“What's new” on page 2|

IBM WebSphere Portal provides new features for administrators, developers,
and content authors. Start with Version 8.5 to leverage these new features on
your site and then continue to get fixes, improvements, and new features with
the latest cumulative fix. Use this section to get the quick highlights on these
features and improvements.

[“Product capabilities” on page 20|
IBM WebSphere Portal capabilities let you quickly implement web experiences
that are engaging, flexible, and high performing.

[“Types of websites” on page 44|

Different types of websites require different solutions and use different
applications and features. These examples describe details of different websites
and the types of applications and features that are required to deliver them.



http://www.ibm.com/software/websphere/portal/

[“Accessibility features” on page 51
Accessibility features help users who have a physical disability, such as
restricted mobility or limited vision, to use software products successfully.

What's new

IBM WebSphere Portal provides new features for administrators, developers, and
content authors. Start with Version 8.5 to leverage these new features on your site
and then continue to get fixes, improvements, and new features with the latest
cumulative fix. Use this section to get the quick highlights on these features and
improvements.

[“What's new in the combined cumulative fixes”]

Learn what's new in the IBM WebSphere Portal Version 8.5 combined
cumulative fixes.

[“What's new in V8.5” on page 10|

Learn what's new in IBM WebSphere Portal Version 8.5 .

What's new in the combined cumulative fixes

2 WebSphere Portal v8.5

Learn what's new in the IBM WebSphere Portal Version 8.5 combined cumulative
fixes.

cro7 [“What's new with CF07”
This Combined Cumulative Fix includes new features and improvements.

cros [“What's new with CF06” on page 4|
This Combined Cumulative Fix includes new features and improvements.

cros [“What's new with CF05” on page 6]
This Combined Cumulative Fix includes new features and improvements.

CF04 [“What's new with CF04” on page 7|
This Combined Cumulative Fix includes new features and improvements.

CFO03 ["What's new with CF03” on page §|
This Combined Cumulative Fix includes new features and improvements.

What's new with CF07

This Combined Cumulative Fix includes new features and improvements.

Some features are ready for immediate use when you apply the latest combined
cumulative fix. Other features require extra configuration or a procedure to enable
the feature.

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Updates to Dojo 1.9 modules

Use new theme modules to write Dojo dijits. The Dojo 1.9 Claro Theme Artifacts
module, dijit_theme_basic_19, contains basic styles to render dijits. The Dojo 1.9
Basic Theme Artifacts module, dijit_theme_claro_19, contains the Claro theme
from Dojo.

Documentation resource: [“Modules that are provided with the modularized|
[theme” on page 2908|

Worklight is now IBM Worklight®

MobileFirst replaces Worklight to provide multi-channel support to your web
communities and is now supported by the v7.0 server.



Documentation resource: [“Integrating with IBM MobileFirst” on page 1280|

Improved manual syndication options

Manual syndication has been improved to give users more choice when updating a
syndication relationship to include a Rebuild with mirror option. If you select the
mirror option, all items on the subscriber are reset to mirror the syndicator. All
items that are newer on the syndicator are sent to the subscriber. Items that are
newer on the subscriber are overwritten with the older version from the
syndicator. Items that are created on the subscriber that do not exist on the
syndicator are removed from the subscriber. Version history is not syndicated.

Documentation resource: [Manually syndicating items|

Page template mappings

The selection of a presentation template is now optional when creating template
mappings for Page templates:

Documentation resource: [Defining page item properties|

The ML Translations text element is now hidden on forms

The ML Translations text element is displayed in the content item form only if the
Multilingual Solution is enabled. Otherwise, this element is hidden in the content
item form, but still visible in the Manage Elements dialog.

Documentation resource: [“Edit-time navigation creation extension” on page|

Text provider strings can now be stored in content items and site
areas

Previously, the strings used by the text provider plug-in had to be stored in a
custom plug-in. Now they can be stored in content items and site areas, allowing
users to create and maintain text provider strings from within Web Content
Manager.

Documentation resource: [“How to store translated text in a content item or site]
[area” on page 2142

Additional rendering modes for web content

Additional rendering modes for web content have been added to allow users to
define separate presentation templates for different media, such as JSON, XML,
HTML, plus a summary mode.

Documentation resource: [“Rendering modes for web content” on page 2387

Web content tag behavior and enhancements

Web content tag enhancements have been added to simplify and improve tag
creation and usage.

Documentation resource: [“Web content tag behavior and enhancements” on|
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Project template updates

You can now select a project template as the default project template. You can now
hide the Editors and viewers selection tool within the Publish Options, Approval
Settings, and Custom Action sections of the project form.

Documentation resource: |Creating project templates|

What's new with CF06

This Combined Cumulative Fix includes new features and improvements.

Some features are ready for immediate use when you apply the latest combined
cumulative fix. Other features require extra configuration or a procedure to enable
the feature.

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Configuration wizard supports database transfer to multiple databases
for Oracle

Use the Database Transfer configuration option using the configuration wizard to
transfer your Oracle database to multiple databases or schemas. The multiple
databases or schemas option can configure multiple databases with different data
sources and different users per schema. You can also use the multiple database
option to configure a single database with different data sources and different
users.

Documentation resource: [Database Management Systems} then go to Oracle:
Database transfer > Oracle: Oracle worksheet: Transfer to multiple databases.

Improving page loading performance with asynchronous web content
rendering

You can now increase page loading performance by separating portal page content
delivery from web content rendering.

Documentation resource: [“Improving page loading performance with|
[asynchronous web content rendering” on page 2359

Integrating remote JSON data by using the Digital Data Connector

Starting with CF06, the IBM Digital Data Connector (DDC) for WebSphere Portal
framework provides a generic JSON DDC plug-in that is ready to use for
integrating external JSON data of your choice. You can use this plug-in to render
external JSON data on your portal pages without having to write custom Java
code.

Documentation resource: [“Integrating remote JSON data” on page 3589

Web Application Bridge support for SAML

Starting with CF06, the Web Application Bridge now supports single sign-on using
Security Assertion Markup Language (SAML).

Documentation resource: [Content provider policy single sign-on|

WSRP

You can now configure the WSRP Consumer to invalidate the remote session when
a user explicitly logs out of the Consumer portal.


http://www-01.ibm.com/support/knowledgecenter/SSHRKX_8.5.0/help/panel_help/h_wab_auth.dita

Documentation resource: [“Configuring remote session invalidation” on page|

Updates to the Web Content Manager REST service

The Web Content Manager REST service now supports creating and updating
authoring templates.

Documentation resource: [“How to use REST with authoring templates” on page|

Updates to image and file elements

Image components and file components can now be selected when using image
elements in content items and site areas:

Documentation resource: [Adding a file resource element to an item|

Documentation resource: [Adding a file resource element to a template

Documentation resource: [Adding an image element to an item|

Documentation resource: [Adding an image element to a template

Updates to custom search box in the portal theme

You can now redirect search requests issued by a custom search form to the Search
Center.

Documentation resource: [“Redirecting search requests from a custom search|
[form to the Search Center” on page 793

OneUl is deprecated

OneUI styles were deprecated in the theme profiles of the default Portal 8.5 theme
in this combined cumulative fix. It simplifies theme development and CSS content
by excluding OneUI styles from the default theme. Core components that are
embedded in your customer theme, such as the Web Content Viewer or inline
editing, do not depend on OneUI styles any more. However, existing themes and
applications continue to work with the OneUI theme. Some static resources were
replaced with new .css and .js files. You might also need to remove old social
rendering libraries and deploy the new ones.

Documentation resource: [“Static resources” on page 2820|

Documentation resource: [“Removing the previous version of social rendering”]
on page 2430

Documentation resource: [“Enabling social rendering in a virtual portal” on page|

Document Services feeds for Federated Documents

Support for Document Service feeds for Federated Documents are now disabled by
default, but can be enabled using the
wp.federated.documents.document.services.enabled configuration setting.

Documentation resource: [“Configuring the federated documents feature” on|
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The textbox.io feature for Ephox is now supported

The textbox.io feature for Ephox is now supported. For further information, and to
obtain the application, visit the Ephox website.

What's new with CF05

This Combined Cumulative Fix includes new features and improvements.

Some features are ready for immediate use when you apply the latest combined
cumulative fix. Other features require extra configuration or a procedure to enable
the feature.

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Updating the content menu to open on click instead of on hover

This feature allows you to change the behavior of the content menu.

Documentation resource: [“Updating the content menu to open on click instead|
[of on hover” on page 3084

IBM UX Screen Flow Manager

Screen Flow Manager works like a wizard and uses screens to represent steps for a
task. Starting with CF05, Screen Flow Manager provides you with several options
to configure transitions between portlets, pages, and dialogs within a screen flow.
The Screen Flow Manager also provides the dialog chaining and nesting option.
You can configure another dialog to start after the current dialog ends or after the
current dialog pauses. For example, in a travel site, you can configure the Car
booking dialog to start after the Flight booking dialog ends or to start by pausing
the Flight booking dialog.

Documentation resource: [“Transitions” on page 3790|

Documentation resource: [“Dialog chaining and nesting” on page 3797

Project publish and validation updates

The process of publishing and validating projects is improved in CF05 to make it
easier to monitor and manage projects.

Documentation resource: [“Project Publishing” on page 2219|

Documentation resource: [“Project Validation” on page 2221|

Folder updates
Folders can now be workflowed, and added to projects.
Syndication modes

The syndication user interface has been updated to allow for the selection of
different modes of syndication.

Documentation resource: |Creating a syndication relationship|

SmartCloud for Social Business integration by using Active Directory
Federation Services (ADFS)

Integration between WebSphere Portal and IBM Connections in SmartCloud for
Social Business can now be completed by using Active Directory Federation



Services (ADFS), which supports single sign-on. Integration with Tivoli Federated
Identity Manager (TFIM) is still supported.

Documentation resource: [“Configuration settings for Active Directoryl
[Federation Services (ADFS)” on page 3351|

Searching in a multilingual environment

If your site is multilingual, you can now enable search for users in languages other
than their preferred language.

Documentation resource: [“Configuring search for multilingual sites” on page|
-833

Content as a Service pages

Use Content as a Service pages to render content that is managed by your IBM
Web Content Manager in different data formats such as JSON or XML. Content as
a Service pages allow the content that is centrally authored and maintained on
your website, to be accessed by the other data clients in raw data formats.

Documentation resource: [“Content as a Service pages” on page 2175|

WSRP

The WSRP Consumer markup caching feature now offers better performance. You
can now use WSRP markup caching without enabling the portlet container
fragment caching. With a new configuration parameter, you can enable and disable
markup caching specifically for selected remote portlets or for all remote portlets
of a Consumer portal.

The WSRP Consumer provides multiple new configuration parameters for defining
two-phase rendering behavior, WSRP response timeouts, and a limit for the size of
file uploads.

Documentation resource: [“WSRP Markup Caching” on page 1789

Updating the content menu to open on click instead of on hover

The content menu opens when a user hovers over a portlet containing IBM Web
Content Manager items. In Combined Cumulative Fix 05, you can set the content
menu to open when a user clicks an icon in the portlet skin instead.

Documentation resource: [Updating the content menu to open on click instead|

What's new with CF04

This Combined Cumulative Fix includes new features and improvements.

Some features are ready for immediate use when you apply the latest combined
cumulative fix. Other features require extra configuration or a procedure to enable
the feature.

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Validation improvements for the Configuration Wizard

Prevent a possible database transfer failure by validating your entries in the
wizard. When you chose to validate settings for the Database Transfer option, field
syntax and database connection validations are performed before you run the
configuration. Examples of fields that are validated can include (depending on
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your database type) host name and port number.
Renditions

Renditions are different versions of an image component or element. Renditions
can be thumbnails or smaller versions of an image formatted for mobile devices.

Documentation resource:
What's new with CF03

This Combined Cumulative Fix includes new features and improvements.

Some features are ready for immediate use when you apply the latest combined
cumulative fix. Other features require extra configuration or a procedure to enable
the feature.

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Theme analyzer for portlet modules

The Theme Optimization Analyzer now supports Resource Aggregation for
Portlets. You can view modules, contributions, and capabilities by page. You can
see what resources are coming from the theme and what resources are coming
from the portlets on the page. Support for pages was also extended to the export
theme data function, so your output includes page, theme, and profile information.

Resource Aggregation for portlets

The system resource aggregator automatically loads dependencies on capabilities
for portlets, if the theme metadata
resourceaggregation.autoLoadPortletCapabilities is set to true. These
capabilities and modules load automatically regardless of the profile on the page, if
the capabilities and modules are installed and active anywhere on the system. The
resource aggregator for portlets:

* Reduces the profile size
* Reduces the number of profiles that are required

* Reduces the need to modify the theme (a profile) or page (which profile
assigned) to use certain portlets on a page

* Makes the system overall simpler and easier to use.

Documentation resource: [Resource Ageregator overview]

Public ResourceCombinerService API

Use the ResourceCombinerService public API for portlets that must link multiple
resources on a page. The ResourceCombinerService public API links these
resources in a combined, optimized way to keep the number of requests to a
minimum.

Syndication extension points
The Web Content Manager API has been updated with new extension points for

syndication to give developers additional tools to control the syndication of items.
See the Web Content Manager Javadoc for details.
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Worklight 6.2 integration

Integration with IBM Worklight is upgraded to support version 6.2. Use the
features in Apache Cordova and the Worklight Client APIs to use local device
capabilities in your Portal solution. With this upgrade, you can use the improved
operational analytics, client-side log capture, rolling server upgrades, and more.

SmartCloud for Social Business Search (SAML)

You can now establish single sign-on between your portal installation and IBM
Connections in SmartCloud for Social Business which provides an integrated
digital experience for users. Integration between WebSphere Portal and IBM
Connections in SmartCloud for Social Business is completed by using Tivoli
Federated Identity Manager, which supports SAML-based single sign-on. For more
information on integrating IBM Connections in SmartCloud for Social Business
with WebSphere Portal, review the documentation resource.

Documentation resource: [“Configuring Portal to work with Connections in|
[SmartCloud for Social Business” on page 916|

Invalid friendly URLs

You can now validate friendly URLs for web content. Additionally, you can create
customized error messages that display when a user tries to access an invalid URL.

Documentation resource: [“How to validate friendly URLs for web content” on|

SmartCloud for Social Business HTTP Outbound

You can now activate outbound HTTP connections to remote resources with IBM
Connections in SmartCloud for Social Business by using SAML 2.0 tokens.

Documentation resource: [“Establishing SSO connections through SAML 2.0|
[tokens” on page 3340|

@mentions

Starting with IBM Connections 5.0 you can use the @mentions feature to mention
other IBM Connections users in your content or to notify them of the post. You can
insert the feature @username anywhere in the body of the post. The feature is
supported in the body and comment sections of the Wiki page, Blog post, Forum
topic, and file comments. A site visitor can get details about a user mentioned in
IBM Connections content that is rendered on WebSphere Portal pages. @mention
reference is displayed by using the portlet person card when you hover over the
link. If WebSphere Portal is configured to use IBM Connections business card, then
the business card is shown instead of portal person card.

SmartCloud for Social Business Connections integration

You can now use social rendering with content items from IBM Connections in
SmartCloud for Social Business. The IBM Connections integration assets that are
used to integrate IBM WebSphere Portal with IBM Connections can also be used to
integrate WebSphere Portal with IBM Connections in SmartCloud for Social
Business as well.
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Web Application Bridge Mobile support

Mobile support is provided for web applications that were developed and tested
for rendering inside mobile device browsers.

Windows Mobile Support

Device detection has been added for Windows Mobile devices. Windows smart
phones can render the mobile theme instead of the full desktop version of the
theme.

Web Content Manager Rest API

The Web Content Manager Rest API has been extended to include projects and
workflow item types.

Documentation resource: [“How to manage web content items by using REST”

Inplace editing for Web content

The default setting for inplace editing of Web content has been changed to "embed
mode" for text and rich text fields. See the section Default inplace editing mode in
the Web content authoring options topic.

Documentation resource: [“Web content authoring options” on page 538

What's new in V8.5
Learn what's new in IBM WebSphere Portal Version 8.5 .

[“What's new for administrators in V8.5”|
Version 8.5 includes new features and improvements for administrators, such as
syndication troubleshooting tools, staging-to-production tools and more.

[“What's new for developers in V8.5” on page 13|
Version 8.5 includes new features, such as theme optimization analyzer and
simple modules.

[“What's new for content authors in V8.5” on page 15|
Version 8.5 includes new capabilities for content authors to make content
creation easier.

[“What's changed” on page 16|
WebSphere Portal includes changes to existing features.

[“Unsupported and deprecated features for V8.5” on page 17|
Review the features that were available in previous versions of IBM WebSphere
Portal but are no longer available.

What's new for administrators in V8.5
Version 8.5 includes new features and improvements for administrators, such as
syndication troubleshooting tools, staging-to-production tools and more.

If you are migrating from version 7.0, review the What's new content for version 8.0
too. A link is provided at that end of the page.

Roadmaps

Roadmaps provide high-level steps that help you set up your environment. For
example, an environment might be a development environment or an authoring
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environment. The roadmaps are intended to help you simplify the complex tasks
and interfaces that are required to help you achieve your environment.

Document resource: [Chapter 3, “Roadmaps,” on page 69|

The roadmaps include links to essential supporting documentation resources. The
installation roadmaps include topology diagrams to help you visualize your
environment.

Installation

The installation and deployment is improved. Start with the appropriate roadmap
for your environment. Then, use the Installation Manager to install a working
portal with a Derby database. After a successful installation, go to the
Configuration Wizard to deploy your environment.

* |Chapter 4, “Installing,” on page 119

+ [“Configuration Wizard” on page 340|

These changes simplify the installation and configuration process.
Configuration Wizard

For new deployments, the configuration wizard provides you with a guided path
to apply a topology to your environment. The topologies guide you through the
steps that are required for your environment. You can transfer your database,
enable federated security, and create your cluster. For existing deployments, you
can also use it to add on features, migrate, or upgrade your existing product
offering.

Migration

Review the migration roadmaps to develop your migration plan. When you are
ready to migrate, start with the roadmap to prepare your source and target
environments. Then, use the Configuration Wizard to run the migration from your
previous version to Version 8.5. The Configuration Wizard automatically migrates
your data.

Security

Attribute based security for Web Content Manager content is a new access filter in
the product filter chain. You can extend the access control permission checks for
Web Content Manager content beyond the user or group-based decisions. You can
define your own criteria. The criteria might involve categories, keywords,
textComponents, htmlComponents, or shortTextComponents for an item. For more
information, read [“Enabling Attribute Based Security” on page 1864

Search

The remote search service installation requires fewer manual steps. Install the
remote search service with the Installation Manager.

The Did you mean? Search feature improves the search experience. It recommends
suggestions or corrections for keywords in a search query. The Did you mean?
Search feature is available for immediate use.

New search configuration parameters provide higher-quality search results for site
visitors. The boostingSettings parameter enables the allocation of extra weight to
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search terms in a query that are found in specific metadata fields of a document,
such as title or description. You can also change the default search operator from
Or to And. This change ensures that all terms listed in a search query are found in
all of the documents that are returned in the search results list.

Staging to production

Use a Portal Application Archive (PAA) file to package and deploy your initial
server. Export your initial server into the PAA file. Then, you can deploy the single
PAA file instead of importing multiple resources.

After you set up your initial server, you can create a PAA file for your differential
release. Then, you can deploy the single PAA file instead of deploying multiple
differential resources. You must create PAA files for all of your virtual portals.

Syndication

Additional tools have been added to the syndication and subscriber views to help
troubleshoot failed items during syndication.

Each failed item for a selected syndicator is displayed in the Failed Items view.
Information is displayed about each failed item, including information about what
the appropriate action is to fix the issue.

Root and Impact columns have been added. These new views are used to find the
root cause of a syndication failure, and what secondary items are impacted by the
root cause. By finding and fixing the root cause of the syndication failure, you also
potentially fix the syndication failures of the items that are impacted by the root
cause.

Web application bridge

Use the new web application bridge interface to create pre-configured web dock
applications for your content authors. Create content provider profiles that include
at least one policy. The policy provides directives and tuning parameters for a
specific context root or a regex to provision certain applications or resource paths.
Then, create web dock applications that are pre-configured with the correct
settings. The content author finds the appropriate web dock application and adds
it to their page.

Digital Data Connector

The IBM Digital Data Connector (DDC) for WebSphere Portal is a new feature to
integrate data from external data sources on portal pages by using IBM Web
Content Manager presentation components. Use the Digital Data Connector for
WebSphere Portal to create list-rendering profiles that define the set of attributes
available for your content authors to integrate external data sources.

Information mode and user assistance

Information mode displays more inline information, examples, and hovers help in
the user interface, such as the site toolbar. Information mode gives you more
assistance when you need it. After you are comfortable and understand the user
interface, you can turn off information mode. Information mode is a global setting.
Information mode is not implemented for the entire user interface. For example, it
is not available for the administration portlets. From the site toolbar, you can turn
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it on and off to suit your needs. The user assistance is now divided into two help
sections. One section is specific to the administrator and one is specific to the
content author.

Accessing administration options

You can now access Administration from the toolbar. Click - and select a
specific area of administration from the menu. You can access all the
Administration options in the navigation section after you open an administration
page from the menu.

IBM Knowledge Center

IBM Knowledge Center requires active scripting. If active scripting is disabled, IBM
Knowledge Center displays a gray page, and the content is not available.

Related information:

[ [WebSphere Portal V8.0: What's new for administrators|

[ [[BM Web Content Manager V8.0: IBM Web Content Manager new features and|

Iijrovementgl

What's new for developers in V8.5
Version 8.5 includes new features, such as theme optimization analyzer and simple
modules.

If you are migrating from version 7.0, review the What's new content for version 8.0.
A link is provided at that end of the page.

What's new for front-end developers

Configuring outbound HTTP connections
IBM WebSphere Portal now provides an easier way to configure outbound
HTTP connections. In WebSphere Portal Version 8.0 and earlier versions,
outbound HTTP connections were accessible through the Ajax Proxy
service. The Ajax Proxy service was configured by a configuration
document named proxy-config.xml. You find this document in the
/WEB-INF directory of the web module that uses the Ajax Proxy service.
Starting with WebSphere Portal Version 8.5 and the new outbound
connection service, the configuration of outbound HTTP connections is
now part of the standard datastore-based portal configuration.

Theme optimization analyzer
The theme optimization analyzer creates a validation report that analyzes
your theme and theme components for known issues and reports the
number of errors, warnings, and informational messages. It also includes a
detailed explanation about how to fix the errors that occur.

Simple modules
Simple modules for the resource aggregator framework are provided in the
WebDAV folder. You can define modules quickly with a limited set of
features with these simple modules.

Collaborating with Worklight
You can expand the capabilities available to your application when you
create a hybrid application that adds native device functions to your portal
with Worklight. When your hybrid application runs with your WebSphere
Portal pages rendered in a native application, WebSphere Portal loads the
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appropriate native resources for the device. These resources are loaded
automatically through modules that are provided in WebSphere Portal.

What's new for portlet and application developers
Attribute Based Security for Web Content Manager content

Attribute based security for Web Content Manager content is a new access
filter in the product filter chain. You can extend the access control
permission checks for Web Content Manager content beyond the user or
group-based decisions. You can define your own criteria. The criteria might
involve categories, keywords, textComponents, htmlComponents, or
shortTextComponents for an item. For more information, read
[Attribute Based Security” on page 1864

Dojo is no longer required for tagging and rating
The tag and rating widgets of earlier portal versions required Dojo to be
interactive. The new inline tag and rating widgets do not require Dojo to
be interactive.

Use the Configuration Wizard to deploy PAA files
You can now install and deploy Portal Application Archive (PAA) files
with the Configuration Wizard. Start the wizard and then go to Add On
New Capability > Install Add-ons.

Social Rendering List templates
WebSphere Portal page editors can use social rendering to feature social
data that is hosted on a remote IBM Connections server in the context of
portal pages.

IBM UX Screen Flow Manager
The new IBM UX Screen Flow Manager enables you to quickly build
wizard-like applications that guide users through sequences of screens. In
many cases such flows can be modeled declaratively, without any
programming efforts by interconnecting multiple portlets. Thus, IBM UX
Screen Flow Manager fosters reuse of portlets across multiple flows and
eases the maintainability of your applications.

What's new for web content developers

Custom HTML editor integration
Custom HTML fields are used to integrate third-party editors into the web
content authoring interface. You can use custom HTML editors in all
HTML fields of the web content authoring interface, or in single HTML
elements that are defined in an authoring template.

Default inplace editing mode
The default inplace editing mode can now be configured. Supported fields
can be pre-configured to either use inplace editing mode, embedded
editing mode, or dialog editing mode. The default inplace editing mode
can be overridden in EditableElement tags using the mode parameter, or in
the content template for content items.

Related information:

[ [WebSphere Portal V8.0: What's new for user interface developers|

[ [Theme Enhancements in WebSphere Portal 8.5|

[ [Theme Analyzer Enhancements in WebSphere Portal 8.5|
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What's new for content authors in V8.5
Version 8.5 includes new capabilities for content authors to make content creation
easier.

Enhanced authoring user interface

Use the new integrated site toolbar to quickly create and edit content. Within the
new site toolbar, you can drag content to the page you are editing.

You can associate vanity URLs with portal pages and labels. Vanity URLs are short
URLs that people can easily remember. They are shorter than full WebSphere
Portal URLs. They are sometimes also called marketing URLs. You can publish
vanity URLs for marketing campaigns through different channels, such as email or
print. This way, you can use vanity URLs to direct customers to a specific portal
page or content item. Interested site visitors who want to view your campaign can
then remember or copy the short vanity URL and type it into the browser address
field.

You can now add social content from external sources to your page.

You can integrate third-party content on your site with web dock application
portlets.

Page editors can integrate social content in the context of portal pages.

Learn more: [Site toolbar

Targeted content

Targeted content matches the content that displays in a spot to the site visitor that
views the spot. Content authors do not need IT experience to configure a spot on a
page to show targeted content. The administrator creates profiler rules for the
content authoring and marketing team in the personalization area of the site. The
profiles that are created in the profiler rules appear as segments when you
configure your spot. Specifically, the segment name that is displayed in the Ul
matches the label that is specified for the profiler rule. Then, the content author
uses the Targeted Content selection in the Configure Spot menu to map content to
segments.

Learn more: [Configure your content spot|

Digital Data Connector

Use the new IBM Digital Data Connector (DDC) for WebSphere Portal to integrate
data from external data sources on portal pages by using IBM Web Content
Manager presentation components. With Digital Data Connector, content authors
and designers can use Web Content Manager presentation components to generate
the web page markup for external data.

Syndication status
A new information window in the authoring portlet user interface that displays the
current syndication status for each item. Users can determine whether an item is

synchronized between the syndicator and subscriber, pending syndication, failed,
or configured to be syndicated.
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Information mode and user assistance

Information mode displays more inline information, examples, and hovers help in
the user interface, such as the site toolbar. Information mode gives you more
assistance when you need it. After you are comfortable and understand the user
interface, you can turn off information mode. Information mode is a global setting.
From the site toolbar, you can turn it on and off to suit your needs. You can now
view online help that is specific to content authors. Click Learn More links or the
question mark icon to find help that is specific to that topic.

What's changed

WebSphere Portal includes changes to existing features.

The following areas are changed in WebSphere Portal:

Installation Manager
The Installation Manager installs WebSphere Portal with an Apache Server
database and a default file repository. Then, you must use the
Configuration Wizard to set up a stand-alone or clustered environment.

Roadmaps
Go to [Chapter 3, “Roadmaps,” on page 69| to find information about
installation and deployment options, migration options, and integration
options.

Configuration Wizard
You can now use the Configuration Wizard to set up a stand-alone server
and set up a cluster. Use the wizard to transfer from the Apache Server
database to another supported database, enable federated security, migrate
your server, install add-ons, and more.

Site toolbar
The system administrator can use the site toolbar to create the projects and
templates for their websites. The content authors can use the site toolbar to
create pages and to add content and applications to their websites.

You can now access Administration from the toolbar. Click *- and select
a specific area of administration from the menu. You can access all the
Administration options in the navigation section after you open an
administration page from the menu.

Vanity URLs
Vanity URLs are a new feature within WebSphere Portal. You can use
vanity URLs instead of URL mappings. Go to[“Vanity URLs” on page 2388|
for information.

Sun Java" Directory Server
Sun Java Directory Server was rebranded to Oracle Directory Server.

Web application bridge
The system administrator can create and configure multiple web dock
applications. Then, the content author adds the application to their page
without having to configure the Web Dock portlet.

Remote search
You can install the remote search service with Installation Manager.

Online help
There is online help for system administrators and a separate online help
for content authors.
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IBM Web Content Manager

Dojo

The Web Content Manager documentation is merged with the WebSphere
Portal documentation.

Dojo is not required anymore in your custom theme even in edit mode.
You now can write a Dojo free theme, and still use Edit mode. However,
some components require Dojo. You must use Dojo to use
wcm_inplaceEdit, wp_federated_documents_picker,
wp_content_mapping_picker, and the Search and Tag Center Profile.

TopNav removal

The TopNav from earlier themes has been removed from desktop view.
The TopNav itself still exists, but it is hidden on desktops. If you want to
use the TopNav in the desktop view, you can update the dynamic content
spot definition in your theme's pTugin.xml.

Default theme profiles

The standard profiles are now Lightweight and Lightweight with Dojo,
Deferred and Deferred with Dojo, Basic Content and Basic Content with
Dojo. The Full profile has been removed. Profiles can now be hidden also.

Web Content Viewer (JSR 286) portlet

The display title of the JSR 286 Web Content Viewer portlet changed from
“Web Content Viewer (JSR 286)” to “Web Content Viewer.” The portal
shows the new display title in the toolbar and administration portlets.

The portlet application ID, ilwwcm-localrenderingportlet-jsr.war, and
the portlet name, Web Content Viewer (JSR 286), that are used with the
XML configuration interface and with the portal scripting interface did not
change.

Related information:

[ [WebSphere Portal V8.0: What's changed|

Unsupported and deprecated features for V8.5

Review the features that were available in previous versions of IBM WebSphere
Portal but are no longer available.

After a migration, features that are no longer supported or are deprecated can
result in unpredictable behavior. Remove unsupported and deprecated features
before you start your migration. As they become available, links to more
information are provided to help you move away from deprecated features.

If you are migrating from version 7.0, review the unsupported and deprecated
page for version 8.0 too. A link is provided at that end of the page.
Unsupported features and themes in Version 8.5

Web Clipper
The Web Clipper portlet is no longer supported. Use the Virtual Web
Application Manager portlet instead.

IBM themes from a previous version

The following themes are no longer supported: Portal, PortalWeb2, and Tab
Menu - Page Builder. These themes are migrated as is to WebSphere Portal
Version 8.5. However, they no longer work and are no longer supported.
You must manually update those themes. Merge their function into a clean
copy of a Portal 8.5 theme on the target server.
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The PageBuilder2 and 7.0.0.2 themes are supported if migrated to Version
8.5.

Documentation resource: [“Enabling new functionality in a migrated|
[portal” on page 1186|

Composite applications
Composite applications are no longer supported. If you have a composite
application in your system and you are migrating to Version 8.5, the
migration fails. Ensure that all composite applications are deleted before
you start the migration. When you delete a composite application, you
must also run the resource cleaner, otherwise pages can still exist in the
database.

Documentation resource: [“Removing unsupported composite]
lapplications” on page 1104]

CAI/TAI portlets
When you are migrating from one version to another, your script can
contain references to the CAI/TAI portlets. These portlets are no longer
available and any reference to these portlets cause your script to fail. For
more information, see |[“Virtual Portal tasks” on page 1152

IBM Portlet API
The IBM Portlet API is no longer supported. Go to|“Converting IBM|
[portlets (AIX IBM i Linux Solaris Windows)” on page 3414 to learn how to
convert your portlets that are based on IBM Portlet API to the Standard
Portlet APL

Deprecated features

Shared pages
Shared pages are deprecated.

Enabler, Builder, and Mashups components and API
The Enabler and the Builder components are deprecated. The Mashups
Enabler and the Builder API are deprecated.

Full and Base installation options
Before WebSphere Portal Version 8.5, a customer chose either a full
deployment with all the same pages and artifacts or a base deployment to
customize their portal. Starting with Version 8.5, the Configuration Wizard
installs the full deployment. Customers can then remove pages to
customize their portal. Then, they can package their customizations as a
Portal Application Archive (PAA) file. Finally, customers can install their
production server, run the empty-portal task, and install the customization
PAA file.

LikeMinds and Feedback
The LikeMinds and Feedback database domains are deprecated.

Stand-alone LDAP user registry
The stand-alone LDAP user registry configuration is deprecated. Instead,
configure the federated LDAP user registry. If you upgraded from
WebSphere Portal Version 7.0 or 8.0 with a stand-alone LDAP user registry,
you can continue to use your stand-alone LDAP user registry. However,
run the wp-modify-federated-security to change to a federated LDAP
user registry.

Documentation resource: [“Changing from a stand-alone repository to a|
[federated repository” on page 736|
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Active Credentials
Active credentials are deprecated from the Credential Vault portlet. Passive
credentials are still available.

Parallel Portlet rendering
The Parallel Portlet rendering feature is deprecated.

Adding a category from an outside component.
You can no longer add a category from an outside component. You must
use the site toolbar instead.

LTPA version 1 token support
The LTPA version 1 token is deprecated. WebSphere Application Server
Version 8.5.5. disables the LTPA version 1 token by default. If you are
integrating with third-party applications that rely on LTPA version 1,
update the application to support LTPA version 2. If you cannot update the
application, you must manually re-enable LTPA version 1 support after you
complete the migration. For information on updating your application to
support LTPA version 2, see the documentation for the application.

Tagging and rating dialog and inline widgets
In tagging and rating, the tag and rating widgets of previous portal
versions are deprecated. This affects both pairs of the old widgets, the
dialog widgets of the default user interface and the inline widgets of the
alternative user interface. They are replaced by a new pair of interactive
inline widgets. The new widgets combine the functions of the separate
widgets of earlier portal versions.

URL mappings
URL mappings are deprecated. If you upgrade from Version 8.0 to Version
8.5, you can continue to use your existing URL mappings, but creating new
URL mappings is no longer supported. Use vanity or friendly URLs.

Vanity URL documentation resource: [“Vanity URLs” on page 2388|

Friendly URL documentation resource: [“Using friendly URLs” on page|

1559

IBM Portlet API Web Content Viewer portlet
The Web Content Viewer portlet that is based on the IBM Portlet API has
been removed and is no longer supported. If you use the IBM Portlet API
Web Content Viewer, and you migrate to Version 8.5, then you must
replace the portlet and its clones with the JSR 286 Web Content Viewer
portlet as a post-migration step.

Documentation resource: [“Convert the IBM Portlet API Web Content|
[Viewer to the JSR 286 Web Content Viewer” on page 1146

Note: Note: In the version 8.5 user interface, the JSR 286 Web Content
Viewer portlet has been renamed to Web Content Viewer.

IBM Portlet API Remote Web Content Viewer portlet
The Remote Web Content Viewer portlet that is based on the IBM Portlet
API has been removed and is no longer supported. If you use the IBM
Portlet API Remote Web Content Viewer, and you migrate to Version 8.5,
then you must replace the portlet and its clones with the JSR 286 Web
Content Viewer portlet as a post-migration step.

Documentation resource: [“Convert the IBM Portlet API Remote Web)|
[Content Viewer to the JSR 286 Web Content Viewer” on page 1147]
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Note: Note: In the version 8.5 user interface, the JSR 286 Web Content
Viewer portlet has been renamed to Web Content Viewer.

Deprecated integration portlets

The following integration portlets were removed in WebSphere Portal Version 8.5:

IBM WebSphere Portal Integrator for SAP
The IBM WebSphere Portal Integrator for SAP portlet is now deprecated.
For SAP integration of single iViews or iPages, use the web application
bridge.

Documentation resource: [“Integrating with web applications” on page

1255

Deprecated Business portlets

The following Business portlets were removed in WebSphere Portal Version 8.5:

Remote Rendering Portlet
The remote rendering portlet is now deprecated. Use the Web Content
Viewer (JSR 286) portlet and Web Services for Remote Portlets (WSRP)
instead.

Web2Bookmarks portlet
The Web2Bookmarks portlet is no longer available for immediate use.
Instead, download the portlet from the IBM WebSphere Portal Business
Solutions Catalog.

Catalog;: [BM Collaboration Solutions Catalog|

Deprecated theme

The WebSphere Portal Page Builder 7.x theme was deprecated.

Related concepts:

[‘Configuring authentication filters” on page 385

The portal authentication filters are a set of plug-in points. You can use them to
intercept or extend the portal login, logout, session timeout, and request processing
by custom code, for example to redirect users to a specific URL.

Related tasks:
[“Federating the LDAP user registry” on page 1136|
The stand-alone LDAP user registry configuration is deprecated. Instead, configure

the federated LDAP user registry. Run the wp-modify-federated-security task to
change to a federated LDAP user registry.

[ [Solutions Catalog: WebSphere Portall
Related information:

[ [WebSphere Portal V8.0: Unsupported and deprecated features|

[ [WebSphere Application Server Network Deployment 8.5.5: Deprecated features|

Product capabilities

IBM WebSphere Portal capabilities let you quickly implement web experiences that
are engaging, flexible, and high performing.
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WebSphere platform

WebSphere is IBM's integration software platform. It includes the entire
middleware infrastructure - such as servers, services, and tools - needed to write,
run, and monitor 24x7 industrial-strength, on-demand Web applications and
cross-platform, cross-product solutions. WebSphere provides reliable, flexible, and
robust integration software.

WebSphere provides software for Service Oriented Architecture (SOA)
environments that enables dynamic, interconnected business processes, and
delivers highly effective application infrastructures for all business situations.

IBM WebSphere Application Server drives business agility by providing millions of
developers and IT Architects with an innovative, performance-based foundation to
build, reuse, run, integrate, and manage Service Oriented Architecture (SOA)
applications and services. From business critical and key enterprise-wide
applications to the smallest departmental level applications, WebSphere
Application Server offers the highest levels of reliability, availability, security, and
scalability.

Customization

You can customize WebSphere Portal to meet the needs of your organization, users,
and user groups. You can adapt the look and feel of the portal to fit the standards
of your organization and to customize page content for users and groups in
accordance with business rules and user profiles. Users, such as business partners,
customers, or employees, can further customize their own views of the portal.
Users can add portlets to pages and arrange them as they want and control portlet
color schemes. By aggregating portlets in one place and giving users the power to
customize their own desktops, WebSphere Portal gives users a means for doing
business efficiently and with high satisfaction.

Portlets

Portlets are central to WebSphere Portal. As special reusable Java servlet that
appear as defined regions on portal pages, portlets provide access to many
different applications, services, and web content. WebSphere Portal ships a rich set
of standard portlets, including portlets for displaying syndicated content,
transforming XML, and accessing search engines and web pages. More portlet
solutions are available on the IBM Lotus and WebSphere Portal Business Solutions
Catalog. These portlets are used to access Lotus Notes® iNotes, IBM Sametime®,
IBM Connections, and Microsoft Exchange. Several third-party portlets are also
available. Examples include Enterprise Resource Planning (ERP), Dashboards,
Business Intelligence, Process Management, and Customer Relationship
Management (CRM) portlets.

It is possible to develop custom portlets, too. WebSphere Portal supports the Java
Standard API (JSR 286) that portlet developers can use to create custom portlets.

Widgets

WebSphere Portal now includes widgets inside the portal. You can even create
mashups that consist of both portlets and widgets. Widgets are highly interactive
user interface components that are written in JavaScript. These widgets are
typically very narrow in scope and can easily be created using a script-based
language. Widgets can also be a solution for creating a mashup between different
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backend technologies like a Java EE-based portal server and a PHP-based server.

For additional information about new features, main components, and what each
component provides to the overall solution, explore the subtopics of this section.
[“Web analytics”|
WebSphere Portal includes a number of solutions to help you understand how
visitors use your site, including server-side analytics and client-side analytics.
Client-side analytics is also called active site analytics.

[“Web content” on page 23|
IBM WebSphere Portal and IBM Web Content Manager help you manage
content, share information, and communicate your message.

[“Social business” on page 30|

WebSphere Portal offers wikis, blogs, and tagging and rating capabilities. In
addition, you can integrate existing collaboration applications with your portal
site, such as Lotus Connections.

[“Integration” on page 35
WebSphere Portal integrates with many products.

[“Mobile” on page 3§|

A portal is a website that provides users with a single point of access to
Web-based resources by aggregating those resources in one place and by
requiring that users log in only to the portal itself, and not to each portlet they
use. WebSphere Portal can also deliver Web content to WAP-enabled devices,
i-Mode phones, Smart phones, and to various Web browsers. In addition, the
IBM Mobile Portal Accelerator multi-channel server and mobile device
repository extends portal content dynamically to over 7000 mobile devices, with
new updates and devices added as they reach the market.

[“Versatile framework” on page 40|

IBM WebSphere Portal provides users a consistent view of portal applications
and allows users to define specific sets of applications that are presented in a
single context. Depending on the requesting device, the rendering of this
application set must vary to fulfill the requirements of the device.

Web analytics

WebSphere Portal includes a number of solutions to help you understand how
visitors use your site, including server-side analytics and client-side analytics.
Client-side analytics is also called active site analytics.

With Portal analytics you can achieve the following goals:
Measure the success of your portal site.
Predict the demand to a portal in the future.
Plan for changing site visitor needs.

Active site analytics

Through active site analytics (client-side) WebSphere Portal makes it easier to
collect, process, and report on your site usage. Integration with leading web
analytics products is easy. For example, Coremetrics page view tags are
immediately available on pages in your site. In addition to integration with
Coremetrics, you can also integrate with other web analytics tools such as, Unica,
Omniture, and Webtrends.

Active site analytics:
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Captures visitor behavior data directly from the web browser to ensure that
every action is recorded.

Dynamically accommodates all content changes to the site so adding a page,
product, or category typically requires no tag maintenance.

Creates a comprehensive record of visitor interactions and clients also do not
have to pre-define segments, visitor events, campaigns, or categories for
analysis.

Active site analytics uses a flexible, backend business logic instead of hardcoding
the logic into the site instrumentation. As a result, you enjoy reduced IT
maintenance and maximum analytical flexibility.

You can analyze web analytics reports in context, without switching to an external
tool. This capability is called overlay reports. Overlay reports provide a quick look
at the success of a page, portlet, or web content. Overlay reports are immediately
available for Coremetrics, but you can extend that capability to other analytics
tools.

Server-side analytics

Using server-side analytics, you can gather information about page and site visitor
management activities, site visitor page and portlet requests, and session activities.
Page and visitor management activities include creating, reading, updating, and
deleting. Session activities include login, logout, timeouts, and login failures.

Related concepts:

[‘Logging and analyzing server side site data” on page 1982

IBM WebSphere Portal implements a logging function for your usage data. The
portal writes usage records to a dedicated log file if site analysis logging is
enabled. Multiple types of site analyzer loggers allow portal administrators to
collect statistical data in various areas. The portal server manages the collection of
data on its own, but from a business point of view you can also log custom details
of business events. You can configure the portal for site analysis logging for the
web content viewer.

[“Analyzing user behavior by Active Site Analytics” on page 1990

You can collect data about user behavior in your portal and send that data to a
service for analysis. For this purpose the portal provides Active Site Analytics
(ASA).

[“Collecting analytics data” on page 1992|

Before you can send data about user behavior in your portal to a service for
analysis, you need to collect that data. See the following topics for information
about how to do this.

[‘Displaying overlay analytics reports” on page 2008

You can use Active Site Analytics to show graphical statistics reports about
individual portal resources, such as pages or portlets. These reports are called
Active Site Analytics overlay reports.

[“Analytics tags and site promotions” on page 2018|
To obtain further analytics information from your portal, you can use analytics tags
for your portal resources. You can also use analytics tags for site promotions.

Web content

IBM WebSphere Portal and IBM Web Content Manager help you manage content,
share information, and communicate your message.
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[“IBM Web Content Manager”]|
IBM Web Content Manager accelerates the creation, maintenance, and delivery
of content across intranet, extranet, Internet, and portal sites.

[“Conceptual and functional divisions of a website” on page 25|
When you build a website by using Web Content Manager, you break up your
website into the following conceptual and functional divisions.

[‘Content Template Catalog” on page 27|

The content template catalog is a set of templates that you can use to accelerate
building a website. Using these templates you can build a basic site quickly
with little or no customization.

[‘Targeted content and Portal Personalization” on page 27

Targeted content provides you with a way to deliver multiple pieces of content
to different audiences. Targeted content matches the best content with the most
appropriate group by using segments. Segments help you split your audience
into meaningful groups with different interests or characteristics.

[“Portlets” on page 28|

Portlets are a central part of IBM WebSphere Portal. Portlets are small
applications that are independently developed, deployed, managed, and
displayed. Administrators and users compose personalized pages by choosing
and arranging portlets, resulting in customized Web pages.

Related information:

[ [[BM Web Content Manager Multilingual Solution|

IBM Web Content Manager

IBM Web Content Manager accelerates the creation, maintenance, and delivery of
content across intranet, extranet, Internet, and portal sites.

IBM Web Content Manager is a comprehensive solution for creating, managing,
and delivering content on your website.

Use Web Content Manager to publish your information and pull in content
from other sources, either RSS feeds or other content management systems. On
a single page, you can publish your corporate news and highlight news from
an external news source.

Authors can edit content inline on staging servers and editors can approve
content inline.

Using Personalization, you can target content based on the website users
authentication and preferences. Personalization rules let you control what
information specific users or user groups can see.

Workflows let you control how content is reviewed, approved, and published.
You can create custom workflows to reflect your existing business processes.

Use syndication to publish approved content to your live website.

Content

You can manage and store content in Web Content Manager, using an external
content management system, or both.
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Set up libraries to manage and store content in Web Content Manager.
Use IBM Web Content Integrator to import content in RSS feed format.

Integrate and link directly to external content management systems using CMIS
support included with Web Content Manager.

Use WebDAV to import content from a file system.
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Wikis and blogs are immediately available for you to add to pages in your site.
Management

Use projects to manage changes to a group of items. Projects can help you
coordinate approvals and publication.

Workflow is immediately available and you can develop custom workflows if
needed. Workflows help you control how content progresses from draft to
publication. Projects can have associated workflows too.

Authoring

Multiple authoring home pages are immediately available. You can also develop a
custom authoring environment if needed.

In addition to the authoring home pages, authors can edit content in context on the
staging servers. Using the edit mode, authors can select to edit content on a page.
Changes adhere to defined workflows and syndication publishes changes.

Multilingual websites

The IBM Web Content Manager Multilingual Solution download, available on the
solution catalog, provides a reference implementation for a multilingual website. It
includes a set of extension plugins that you can use to configure and deliver a
multilingual site.

Conceptual and functional divisions of a website
When you build a website by using Web Content Manager, you break up your
website into the following conceptual and functional divisions.

Table 1. Conceptual and functional divisions for layout

Content Layout

* Content items * Presentation templates

* Site areas * Component designs

* Components * Page layout and portlets
e Themes

Table 2. Conceptual and functional divisions for style

Context Style
* Site framework * CSs
* Page hierarchy * Themes

* Profiling
¢ Current user

¢ Personalization

When you are developing a website by using Web Content Manager and
WebSphere Portal, you are splitting the elements of your website between content,
context, layout, and style.

Content:
There are two types of content:
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Layout:

Dynamic
Dynamic content is generated dynamically based on a set of
preconfigured parameters, such as navigator or menu.

Static Static content is content where you store markup or files directly in
a component, content item, or site area. Where you store your
static content depends on how the content is used:

* Page-specific content is stored in content items.

* Content that is related to a section of your site can be stored in a
site area.

* Content that is reused in multiple sections of your site is stored
in components.

The layout and structure of each page in your website are defined by using
these features:

* The overall structure of each page is determined by the theme you are
using, the page layout you choose, and the web content viewer portlets
you add to the page layout.

* The layout of the content that is displayed within each web content
viewer is determined by markup that is used by the current presentation
template, and by the markup that is stored within the elements and
components that are referenced within the presentation template.

Context:

Style:
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The context of the content that is displayed is also important. The layout

and design of the page where a content item is displayed is different

depending on:

¢ The current portal page (Different pages can use different themes,
layouts, web content viewer portlets, and even different presentation
templates.)

* The current site area (Content that is linked to different site areas can
use different template maps that map to different site areas.)

* The current user (Different users can have different access to various
page elements, including individual pages, portlets, and web content
items.)

Each of these contextual variables can be used to display content or
components in different ways, depending on the current context.
Additionally, the profile of the current portlet, content item, or current user
can determine what is displayed on a page, as do any personalization
features used by your website.

While you can place stylistic elements directly within your HTML, it is
becoming increasingly common to use CSS to store and manage all the
stylistic elements of a website, including:

* Stored server-side and referenced within a WebSphere Portal theme
* Stored directly within a content item or component

One good practice is to store your CSS markup within an HTML field that
is stored in a content item. This provides quick access to the CSS if you
need to edit the CSS. In addition, you can use advanced features such as
workflows and inline editing to help you maintain your CSS. By storing all
your stylistic elements in CSS, you can quickly make stylistic changes to
your website by editing a CSS file instead of editing multiple items.



When a web page is rendered, Web Content Manager takes all these individual
item types and combines them to build a complete web page.

Content Template Catalog

The content template catalog is a set of templates that you can use to accelerate
building a website. Using these templates you can build a basic site quickly with
little or no customization.

The content template catalog is a comprehensive set of templates, pre-configured
portlets, content-oriented theme, and layouts. Use the palette of pre-configured
portlets to drop components on your pages for navigation, teasers, slide shows,
carousels, and more. The template pattern supports the creation of your own
templates. A page created from a template can be modified and then turned into a
new template. You could build up you own custom template library and provide a
self-service site development offering to your users.

You can download the content template catalog form the IBM Lotus and
WebSphere Portal Business Solution Catalog

Related information:

[ [[BM Web Content Manager Forum: Content Template Catalog Announcement|

Targeted content and Portal Personalization

Targeted content provides you with a way to deliver multiple pieces of content to
different audiences. Targeted content matches the best content with the most
appropriate group by using segments. Segments help you split your audience into
meaningful groups with different interests or characteristics.

A targeted spot displays different content to different segments. You can create a
target spot by defining content that is targeted to specific segments:

* Add content items to your content spot in a web content viewer.

* Add segments to each content item to display your content to the correct
audience. Segments help you define your target audience. For example, you can
define the audience by users, device class, or other attributes.

Personalization of content

Targeted content applies Personalization concepts to a new user interface where
you create Personalization rules as you work to target content to selected
segments. Personalization allows a portal or website to choose which content must
appear for a particular user. The WebSphere Portal Personalization component
selects content for users based on information in their profiles and on business
rules. Using Portal Personalization, business experts can classify site visitors into
segments and target relevant content to each segment. For example, a site that is
using Personalization might show different news articles to managers than to
regular employees or different information to valued customers. Personalization
offers analytic capabilities to record site usage patterns and includes the LikeMinds
recommendation engine, which provides collaborative filtering capabilities.
Collaborative filtering uses statistical techniques to identify groups of users with
similar interests or behaviors. Inferences can be made about what a particular user
might be interested in, based on the interests of the other members of the group.

You can define content through a number of applications, including IBM Web
Content Manager. Personalization automatically detects the content definition from
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these applications. Definitions of database or LDAP content types can also be made
through a Personalization wizard included with IBM Rational® Application
Developer.

After you define the content type, attributes of the content are shown to the rule
author. The rule author can use these attributes to make conditions that define if
and when certain content is displayed, or even if certain actions like database
updates and triggered emails occur. To create new Personalization rules, go to
Applications > Personalization > Business Rules.

Benefits of Personalization

* The Personalization component selects content for users that are based on
information in their profiles and on business logic. With Personalization
facilities, subject matter experts can select content that is suited to the needs and
interests of each site visitor. These web-based tools help companies quickly and
easily use content that is created by business and subject matter experts.

* Personalization classifies site visitors into segments and then targets relevant
content to each segment. Business experts create the rules for classifying users
and selecting content, by using web-based tools.

* Personalization has built-in capabilities for the IBM Java Content Repository.
This means that personalization rules can easily be used in your Web Content
Manager solutions.

* Personalization also includes a recommendation engine that provides
collaborative filtering capabilities. Collaborative filtering uses statistical
techniques to identify groups of users with similar interests or behaviors.
Inferences can be made about what a particular user might be interested in,
based on the interests of the other members of the group.

* Campaign management tools are also included with Personalization. Campaigns
are sets of business rules that work together to accomplish a business objective.
For example, a Human Resources manager might want to run a campaign to
encourage employees to enroll in a stock purchase plan or sign up for some
other new benefit that is now available to employees. The Human Resources
manager would define a set of rules that are shown to accomplish this business
objective. Campaigns have start and stop dates and times and can be email and
web-page based. Several campaigns can run simultaneously and can be
prioritized.

Related concepts:

[‘Developing a personalized portlet” on page 2679

This exercise demonstrates how to use Personalization features of WebSphere
Portal and Rational Application Developer to build your first personalized portlet.
Your final result is a working portlet that uses Personalization rules and content
spots to display personal news based on user attributes (or profiles).

Portlets

Portlets are a central part of IBM WebSphere Portal. Portlets are small applications
that are independently developed, deployed, managed, and displayed.
Administrators and users compose personalized pages by choosing and arranging
portlets, resulting in customized Web pages.

WebSphere Portal ships a rich set of standard portlets. For the most up-to-date
information about portlets, including the latest portlets that are available for
download, visit the IBM WebSphere Portal Business Solutions Catalog. Or, refer to
Developing portlets for information on creating custom portlets.
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Portlet applications

Portlets are more than simple views of existing Web content. A portlet is a
complete application, following a standard model-view-controller design. Portlets
have multiple states and view modes, plus event and messaging capabilities.

Portlets run inside the application server, similar to the way a servlet runs on an
application server, but are aggregated to a complete Web page by the WebSphere
Portal server. The portlet container provides a run-time environment where portlets
are instantiated, used, and finally destroyed. Portlets rely on the WebSphere Portal
infrastructure to access user profile information, participate in window and action
events, communicate with other portlets, access remote content, look up
credentials, and store persistent data.

Generally, portlets are administered more dynamically than servlets. For example,
portlet applications that consist of several portlets can be installed or removed
while the WebSphere Portal component is running. The settings and access rights
of a portlet can be changed by an administrator while WebSphere Portal is
running, even in a production environment.

Portlet modes allow a portlet to display a different user interface, depending on
the task that is required of the portlet. A portlet has several modes of display that
can be invoked by icons on the portlet title bar: View, Help, Edit, Configure, and
Edit Shared Settings.

A portlet is initially displayed in View mode. As the user interacts with the portlet,
the portlet can display a sequence of view states, such as forms and responses,
error messages, and other application-specific states. Help mode provides user
assistance. Edit mode lets the user change portlet settings. For example, a weather
portlet might provide an Edit page for users to specify location. Users must be
logged in to WebSphere Portal to access Edit mode. Configure mode changes the
default look of the portlet for all portlet instances and Edit Shared Settings changes
the look of the portlet on a specific page.

Each portlet mode can be displayed in normal, maximized, or minimized state.
When a portlet is maximized, it is displayed in the entire body of a page, replacing
the view of other portlets. When a portlet is minimized, by default, only the portlet
title bar is displayed on the page.

Portlet API

The Java Portlet Specification addresses the requirements of aggregation,
personalization, presentation, and security for portlets that run in a portal
environment. WebSphere Portal supports both portlet standards JSR 168 and JSR
286. For more information about the standard portlet API, go to the topic Standard
portlet APL.

Portlet communications

WebSphere Portal allows portlets to communicate with each other. Portlet
communication can be used to exchange data between portlets. This feature makes
the portal easier to use.

The portal supports events as defined in the JSR 286 specification. It allows

administrators to wire portlets by using the portal user interface.
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For example, one portlet can display information about accounts, and a second
portlet displays information about transactions that occurred for one of the
accounts over the last 30 days. To display this information, the transactions portlet
needs to obtain the appropriate account information when it displays the
transaction details. This exchange of information is accomplished by
communication between the two portlets, by using events as described in the JSR
286 specification. In this example, the account portlet defines a publishing event in
its portlet descriptor. The transaction portlet defines this event as a processing
event in its portlet descriptor. By using the portal user interface, you can now wire
those two portlets together. After you did this wiring, when the account portlet
throws an event, the transaction portlet receives this event and can show
information about the transactions of this account.

Portlet services

Portlet services are used to provide common functionality to portlets. Each portlet
service has its own service-specific interface for the functionality that it offers.
WebSphere Portal supports portlet services for standard portlets. Standard portlets
use a JNDI lookup to retrieve a PortletServiceHome object, which is used to
retrieve a portlet service implementation. A portlet service can be started only by
the code within a portlet. For more information about portlet services in the
portal,go to the topic Portlet services.

Creating and customizing portlet applications

Web Experience Factory is included with WebSphere Portal and provides a robust
selection of builders that supercharge the portlet development process without
writing code. Web Experience Factory's rapid application development technology
enables portlet creation 40 — 70 percent faster than using traditional J2EE
development methods. With Web Experience Factory, you can rapidly develop and
deploy custom service-oriented portlets and rich, interactive Web 2.0 style
applications with features like drag-and-drop, in-line editing, type-ahead search,
and intelligent page refresh functionality. Web Experience Factory transforms
operational data into high-value business information by integrating data from a
wide variety of packaged enterprise applications, repositories and data sources
including SAP, Siebel, PeopleSoft, Domino®, Web, and REST services and leading
relational databases through a rich, pre-built connector library.

Using Web Experience Factory's patented dynamic profiling functionality,
developers can easily empower business-user led portlet customization through
personalization and create dynamic, micro-targeted applications that vary portlet
content based on user role, geography, and more. Applications that are built with
Web Experience Factory can be deployed to multiple run-time environments to
provide the best user experience based on target audience, including WebSphere
Portal, Mashup Center, Lotus Notes, and Expeditor and WebSphere Application
Server.

Web Experience Factory applications are standards based and comply with portlet
standards including JSR 168 and JSR 286.

Social business

WebSphere Portal offers wikis, blogs, and tagging and rating capabilities. In
addition, you can integrate existing collaboration applications with your portal site,
such as Lotus Connections.
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[“IBM Connections”|

Integrate IBM Connections into your site by using community pages and
Connections Portlets.

[‘IBM Sametime” on page 32|
The IBM Sametime portlets are installed with WebSphere Portal and deployed
automatically.

[‘Blogs and wikis” on page 33

A set of preinstalled web content libraries are supplied. With these libraries,
you can add blog and wiki features to your websites. Use blogs, blog libraries,
and wikis to tap into the power of the community and to change the way you
work.

[‘Tagging and rating portal content” on page 33|

Users can tag or rate portal content and view the tags and ratings. Tagging and
rating allow users to better organize, categorize, and find portal content. This
task includes Web Content Manager, Connections, and custom content. For
example, users can tag or rate books in an online bookstore.

IBM Connections

Integrate IBM Connections into your site by using community pages and
Connections Portlets.

Connections Portlets

Connection portlets are not installed with the portal but you can easily download
them from IBM Lotus and WebSphere Portal Business Solutions Catalog.

The portlet includes activities, blogs, blog summary, bookmarks, bookmarks
summary, profiles, profiles summary, wikis, forums, forums summary, community
overview, and tags.

Community pages

Portlets on community pages are automatically scoped to the community
membership and display content from the community in the portlets. For example,
if your community contains a forum you can add the forum portlet to a
community page. The portal site visitors can view and interact with the forum
content from the portal site.

You can automatically create new communities for your pages during the page
template instantiation.

Search integration

Integrating Connections content into your portal search makes it easier for site
visitors to find community content. Visitors can search for a term and see results
from your portal site and Connections. Each Connections component has a unique
seedlist provider. To configure your portal search to include Connections content,
you must configure a content source for each seedlist. Instructions are provided in
the Connections product documentation.

Tag integration

You can configure you portal tag cloud to include tags from Connections. This
configuration makes it easier for your site users to find content in the communities.
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You can also add the Connections Tags Portlet to a page. Then, you can wire it to
other Connections portlets. Then, site visitors can use tags to find community
content faster in blogs, wikis, and more.

Profiles integration

You can configure your portal site to show Connections Business Card information.
Names that are associated with Connections profiles display as active links. Your
site visitors click the name to see the business card. From the business card visitors
can link to communities, blogs, and more for the selected user.

Files integration

Content authors can easily create links to files stored on Connections. From the
rich text editor, in IBM Web Content Manager, the author can browse Files.
Authors can also use Web Content Manager markup generation to render the
current contents of specific IBM Connections Folders.

Integration with Connections Files is based on the generic Content Management
Interoperability Services (CMIS).

Related concepts:

[“What's new for administrators in V8.5” on page 10|
Version 8.5 includes new features and improvements for administrators, such as
syndication troubleshooting tools, staging-to-production tools and more.

[“Roadmap: Integrating with IBM Connections” on page 115|

Related information:

[ [[BM WebSphere Portal Business Solutions Catalog]

[ [[BM Connections Portlets for WebSphere Portall

[ [How the Tags portlet interacts with the other IBM Connections portlets|

IBM Sametime
The IBM Sametime portlets are installed with WebSphere Portal and deployed
automatically.

The Sametime Web 2.0 Contact List portlet is available from the Applications >
Collaboration area of the portal site.

People awareness

Users can view contact and other typical business card information for a registered
user by displaying the Person card. The Person card is available through a wide
range of portal components including Domino and Sametime integration,
personalization, and Web content authoring. To view the Person card, move the
cursor over an active (underlined) person's name and then select Click for Person
Card.

When Sametime is enabled in your portal configuration, users can work with the
complete set of people awareness functionality, which includes instant messaging
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and application sharing through e-meetings. Person names appear aware - with a
dynamic online status indicator. Click Profile to display full information about the
person. Additional actions can include:

¢ Send Mail
¢ Chat
¢ Add as Sametime Contact

If you choose not to enable Sametime in your portal configuration, people
awareness functionality is more limited. People's names appear as hyperlinks, but
with no people awareness icon next to each name, and available actions on the
Person card are limited to those that are native to WebSphere Portal.

Related concepts:

[“Integrate with collaboration software ” on page 1203|

IBM WebSphere Portal integrates with collaboration software to provide you with
more effective and cost-efficient ways of accessing information, sharing ideas,
communicating and working together. Key software that WebSphere Portal
integrates with includes IBM Domino, IBM Sametime, and IBM Connections.

Blogs and wikis

A set of preinstalled web content libraries are supplied. With these libraries, you
can add blog and wiki features to your websites. Use blogs, blog libraries, and
wikis to tap into the power of the community and to change the way you work.

Blogs are a great tool to use when you want to generate ideas around a single
topic. You can use blogs for your own individual work or to gain feedback on a
single concept from the larger team. Blog libraries take blogs to the next level.
Rather than creating a blog per topic, you can use blog libraries to track multiple
topics in a centralized location. Wikis also provide you with another alternative for
authoring content. Simple inline editing, including the insertion of images and
links, makes authoring wikis quick and easy. You can also tag and rate blog and
wiki content.

Blogs, blog libraries, and wikis use the template libraries that are provided by IBM
Web Content Manager. Each blog, blog library, and wiki have its own library. The
page hierarchy that is provided for these components is the common one defined
by the Web Content Manager template libraries.

Tagging and rating portal content

Users can tag or rate portal content and view the tags and ratings. Tagging and
rating allow users to better organize, categorize, and find portal content. This task
includes Web Content Manager, Connections, and custom content. For example,
users can tag or rate books in an online bookstore.

Portal users can tag or rate portal content. This task includes the following types of
resources:

* Portal resources, such as pages and portlets
* Web Content Manager resources, such as articles or images

* Custom resources. For example, these resources can be items in an online store
or pictures in a portlet. Administrators can add these custom resources to the
portal so that users can tag or rate them.

In general, all content in a portal that can be uniquely identified can be tagged or
rated.
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Users can apply tags and ratings both publicly and privately for the following
purposes:

* Public tagging and rating helps users categorize, evaluate, and find portal
content that is based on tags and ratings by other users.

* Private tagging and rating can help users create their own personal way to
categorize, evaluate, and find portal content.

In detail, portal users can do the following tasks:
* Work with tags:

Tag portal content. Users can add tags to portal content. For example, the
user can apply the tag websphere to a page that provides information about
IBM WebSphere products. Users can remove tags that they applied
themselves.

View tags and related portal content: Users can view the tags that are applied
to individual portal resources, for example by starting the default tag and
rating widgets. Users can also work with aggregated sets of selected tags:

Users can view tags that are applied to a set of resources by using a tag
cloud. The tag cloud lists the tags in alphabetical order. Different font sizes
indicate how often the tags are applied. Depending on how the
administrator configures the tag cloud, the list can be portal wide or
limited to particular items. For example, portal pages, or books available on
the page where the user clicked the tag.

The tag cloud supports different views: users can switch between these
views. For example, they can view all tags, only tags that they themselves
applied, their own private tags, or the tags that were added most recently.

Users can switch between different display modes. For example, they can
have the tags to be displayed in a cloud as described earlier, or in a simple
list.

Users can use the tags that are displayed in the tag cloud to search for
content. When a user clicks a tag, the portal shows a list of resources that
have that tag that is applied. Clicking such a resource redirects the user to
that resource itself. Users can also click multiple tags; in this case the list
shows only resources that have all selected tags applied.

When users work with the list of resources, they can have the list that is
sorted by different criteria, for example, title, date, rating. The result list
portlet also supports two different view modes: a summary and a detail
view.

* Work with ratings:

— Rate portal content:

Users can apply ratings to individual resources to show how much they
"like" them. For example, a user can give a good book a rating of 4.

Users can change or remove ratings that they applied themselves. For
example, a user can update the previous rating 4 to a 5.

— View the ratings that they or other users apply to portal content.

Administrators can do the following tasks:

* All tasks that portal users can do as previously listed.

* Add content that users can tag or rate, for example, books in a bookstore.

* Assign users the access rights for tagging or rating content.

* Configure the tag clouds. By default, a tag cloud shows all tags that are applied
to portal-wide resources. Administrators can add tag clouds to portal pages or
themes and configure them as required. For example, they can limit a tag cloud
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to display only tags that is assigned to resources of a certain category, such as
portlets. When users click a tag from that tag cloud, the result list shows only
resources, in this case portlets.

* Move tags to a different portal system, for example, for staging or during
migration.

* Obtain basic statistics about tagging and rating. For example, you can obtain the
tags and tag counts for a specific portal page, or all tags that a specific user
applied. You can write queries for more detailed statistics, or create a user
interface to visualize them.

Developers can do the following tasks:

* Extend the tagging and rating capabilities of the portal by writing a custom user
interface that uses the Java Model API or the REST API.

» Write queries to obtain statistics about tagging and rating, and write a user
interface to visualize these statistics.

* Enable or disable filters, for example to prevent users from using unwanted
words as tags. By default the portal provides a blacklist and a whitelist filter.

Note: Depending on your portal and your user groups, administrators or
developers might consider creating user documentation for tagging and rating for
their portal users.

Related concepts:

[‘Tagging and rating” on page 1586
Get an overview of the administrative tasks related to tagging and rating.

Integration
WebSphere Portal integrates with many products.

[“Web application bridge integration”]
Use the Web Application Bridge to integrate with web applications, such as
Sharepoint.

[“Process integration” on page 36|

Use the Unified Task List portlet to integrate with business process solutions
such as IBM Process Server, WebSphere Lombardi Edition, and other enterprise
resource planning software.

[“IBM Industry Toolboxes for WebSphere Portal” on page 37]

Industry Toolboxes for WebSphere Portal provide a resource forum for
customers and partners. They pair technology expertise with industry thought
leadership to offer best-practice guidance optimized for the particular business
you are in.

[“Application integration” on page 37|

A portal provides access to content, data, and services that are located
throughout the enterprise. These services include predefined connectors and
portlets, and tools for creating additional connectors and portlets.

Web application bridge integration

Use the Web Application Bridge to integrate with web applications, such as
Sharepoint.

The web application bridge uses reverse proxy technology to integrate web-based
content providers, such as the Microsoft SharePoint server, with IBM WebSphere
Portal. Administrators must first define the virtual web applications or content
providers. A lightweight iFrame portlet displays the content from the backend
applications. Users can then access the iFrame on a page without requiring direct
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network access to the backend application. A special engine maps the Uniform
Resource Identifiers (URIs) on the iFrame portlet to real URIs from the content
providers.

Integrating the web application bridge with WebSphere Portal is a multistep
process. First, create the content provider profile. Second, create at least one policy
for each content provider profile. Then, create the web dock applications for the
content providers. Finally, add the web dock application portlets to a new or
existing page.

Related concepts:

[“Integrating with web applications” on page 1255|

The web application bridge uses reverse proxy technology to integrate web-based
content providers, such as the Microsoft SharePoint server, with IBM WebSphere
Portal. Administrators must first define the virtual web applications or content
providers. A lightweight iFrame portlet renders the content from the backend
applications. Users can then access the iFrame on a page without requiring direct
network access to the backend application. A special engine maps Uniform
Resource Identifier (URIs) on the iFrame portlet to real URIs from the content
providers.

Process integration

Use the Unified Task List portlet to integrate with business process solutions such
as IBM Process Server, WebSphere Lombardi Edition, and other enterprise resource
planning software.

Service-oriented architecture

For greater flexibility, the Unified Task List portlet retrieves data from the
configured enterprise resource planning software. Then, the retrieved data is
presented in the portal. The Unified Task List portlet can retrieve data from
multiple enterprise resource planning systems and render the result in a cohesive
user interface.

Developer resources

The Unified Task List portlet was developed by using Web Experience Factory. You
can use Web Experience Factory builders to develop actions, customize the Unified
Task List portlet, and develop custom forms.

You can download a Unified Task List Developer Pack from IBM Lotus and
WebSphere Portal Business Solutions Catalog. The developer pack includes
samples models and end-to-end business process transactions. Learn more about
the developer pack in the Web Experience Factory wiki.

Related concepts:

[‘Overview of the Unified Task List portlet” on page 1245
Review concepts about the Unified Task List portlet to understand the different
elements.

Related tasks:

[‘Configuring Unified Task List portlet at run time” on page 1248|

You can customize the Unified Task List portlet at run time as a WebSphere Portal
administrator. Customizing at run time involves accessing the deployed Unified
Task List to configure the portlet settings.
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[“Configuring Unified Task List portlet for single sign-on” on page 1247

Set up a single sign-on between IBM Process Server, IBM Forms Experience
Builder, WebSphere Lombardi Edition, IBM Business Process Manager and
WebSphere Portal. Single sign-on (SSO) provides a secure method of authenticating
a user within an environment and applies that authentication to access other
applications, systems, and networks for the duration of the session.

IBM Industry Toolboxes for WebSphere Portal

Industry Toolboxes for WebSphere Portal provide a resource forum for customers
and partners. They pair technology expertise with industry thought leadership to
offer best-practice guidance optimized for the particular business you are in.

Featured industries include:
* Government

* Healthcare

* Banking

* Insurance

* Retail

* Telecommunications

* Industrial

* Travel & Transportation

To learn more about IBM Industry Toolboxes and find available templates, visit
IBM.com.

Related information:

[ [[BM Industry Toolboxes for WebSphere Portal|

Application integration

A portal provides access to content, data, and services that are located throughout
the enterprise. These services include predefined connectors and portlets, and tools
for creating additional connectors and portlets.

Enterprise resource planning (ERP) and customer relationship management (CRM)
systems are excellent candidates for portlets because efficient, personalized access
to these functions provides measurable return on your portal investment. IBM
provides connectors to enterprise applications by using the Java Connector
Architecture (JCA).

Standard Java connectors

JCA is a standard architecture for integrating Java 2 Enterprise Edition (J2EE)
applications with enterprise information systems that are not relational databases.
Each of these systems provides native APIs for identifying a function to call,
specifying its input data, and processing its output data. The goal of the JCA is to
provide an independent API for coding these functions.

JCA also defines a standard Service Provider Interface (SPI) for integrating the
transaction, security, and connection management facilities of an application server
with those of a transactional resource manager. Thus, JCA is a standards-based
approach to managing connections, transactions, and secure access to enterprise
application systems. IBM JCA connectors provide access to systems such as SAP,
PeopleSoft, ].D. Edwards, Oracle Enterprise Edition, CICS, IMS, and
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Host-on-Demand. Leveraging its CrossWorlds acquisition, IBM plans to develop
and integrate JCA connectors to many other systems.

Rational Application Developer provides a complete development and unit test
environment for applications that use JCA connectors, Web services, and
microflows. Rational Application Developer tools include support for Web Service
Definition Language (WSDL), developer versions of the connectors, the Web
Services Invocation Framework (WSIF), and the microflow engine.

Mobile

A portal is a website that provides users with a single point of access to Web-based
resources by aggregating those resources in one place and by requiring that users
log in only to the portal itself, and not to each portlet they use. WebSphere Portal
can also deliver Web content to WAP-enabled devices, i-Mode phones, Smart
phones, and to various Web browsers. In addition, the IBM Mobile Portal
Accelerator multi-channel server and mobile device repository extends portal
content dynamically to over 7000 mobile devices, with new updates and devices
added as they reach the market.

[“WebSphere Portal Mobile Experience”]

Pages are optimized on smartphones, desktops, or almost any device. This
optimization is made possible with the WebSphere Portal Mobile Experience,
IBM Web Experience Factory smartphone builders, or the Mobile Portal
Accelerator.

[“Mobile Portal Accelerator” on page 39|

If your site needs to support a broad range of mobile devices, the Mobile Portal
Accelerator provides a mobile multi-channel server solution. Mobile Portal
Accelerator offers a multi-channel server and mobile device repository capable
of automating web page presentation to over 8,400 mobile devices. Each of
those devices can be optimized to the display and services capabilities that
include smartphones, tablets, handheld phones, and kiosk devices. Site
developers can write the content. Then, the multi-channel server solution
automates the presentation for optimized display on thousands of mobile
devices.

[“Development tools” on page 39|

Both IBM Web Experience Factory and IBM Rational Application Developer
include functionality to help you develop exceptional web experiences for your
mobile site visitors.

WebSphere Portal Mobile Experience

Pages are optimized on smartphones, desktops, or almost any device. This
optimization is made possible with the WebSphere Portal Mobile Experience, IBM
Web Experience Factory smartphone builders, or the Mobile Portal Accelerator.

The Mobile Experience demonstrated how to use a lightweight architecture that
provides exceptional performance on mobile devices. You can start with the
included sample code and then customize it to meet your specific business needs.

The Mobile Experience includes:

Sample mobile navigation widgets that follow common mobile application
navigation patterns

Sample mobile page layouts that demonstrate common content interaction
patterns

38 WebSphere Portal v8.5



The Mobile Experience is available on the IBM Lotus and WebSphere Portal
Business Solutions Catalog.

Related information:

[ [Mobile Solutions from the IBM Lotus and WebSphere Portal Business Solutions|

K;atalog]

Mobile Portal Accelerator

If your site needs to support a broad range of mobile devices, the Mobile Portal
Accelerator provides a mobile multi-channel server solution. Mobile Portal
Accelerator offers a multi-channel server and mobile device repository capable of
automating web page presentation to over 8,400 mobile devices. Each of those
devices can be optimized to the display and services capabilities that include
smartphones, tablets, handheld phones, and kiosk devices. Site developers can
write the content. Then, the multi-channel server solution automates the
presentation for optimized display on thousands of mobile devices.

Related information:

[ [[BM Mobile Portal Accelerator information center|

Development tools

Both IBM Web Experience Factory and IBM Rational Application Developer
include functionality to help you develop exceptional web experiences for your
mobile site visitors.

Web Experience Factory

Web Experience Factory includes new smartphone builders and samples to help
developers generate mobile portlets and pages faster. Automation components
include:

Native-looking navigation tabs, lists, buttons, and controls

Scrolling lists with display options, such as thumbnails and multiple line test
with multiple styles

Access to smartphone features, such as HTML 5, orientation, and geographical
location

Input UI patterns appropriate for smartphones, such as selectable lists and
check box lists

Rational Application Developer

Rational Application Developer includes tools designed to help you develop
portlet applications for WebSphere Portal. The portlet tools provide the following
capabilities:

* Portlet project support for the standard portlet APIL.

* Web perspective views and editors for developing portlets.

* Portlet project wizard to create basic portlets, Faces portlets, and Struts portlets.
+ Editing and validation of the portlet deployment descriptor (portlet.xml).

* Testing and debugging of portlets within the workbench using the WebSphere
Portal Test Environment.

* Testing and debugging of portlets on a remote machine using the WebSphere
Portal Server Attach.

* Visual tooling to insert portlet programming objects into JSP files, using Page
Designer.
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* Portlet sample applications, available in the Samples Gallery.
* Educational tutorials, available in the Tutorials Gallery.
Related information:

[ [Web Experience Factory 8 Documentation|

Versatile framework

IBM WebSphere Portal provides users a consistent view of portal applications and
allows users to define specific sets of applications that are presented in a single
context. Depending on the requesting device, the rendering of this application set
must vary to fulfill the requirements of the device.

The tasks of the aggregation, which are repeated with each request that comes
from the device, are:

* Gather information about the user, the device, and the selected language.

* Select the active portlets from the set of applications to which the user has
access.

+ Aggregate the output of the active portlets into a coherent, usable display.

WebSphere Portal also provides the ability to create a custom navigation model,
which includes such features as:

* Multilevel navigation

* Customized themes and skins

* Custom navigation - navigation tree can be contributed to by portlets themselves
* Custom arrangement of portlets (and thus content) on a page

Another aspect of the versatile framework is the ability to personalize a user's
portal experience, using "content spots" that render subscribed content based on
the user and user's role in the portal.

[“User experience”]

Customizing the user's experience is one of the main goals of IBM WebSphere
Portal. User and administrative portlets are provided for customizing content
and the look and layout of pages. In addition, tools are provided that allow
subject matter experts to personalize content to the needs and interests of each
site visitor.

User experience

Customizing the user's experience is one of the main goals of IBM WebSphere
Portal. User and administrative portlets are provided for customizing content and
the look and layout of pages. In addition, tools are provided that allow subject
matter experts to personalize content to the needs and interests of each site visitor.

Customizing pages

Users can have one or more custom pages and access each one through a different
page. A page can contain a group of pages that is organized for a specific purpose.
Each page can have a different set of portlets. Depending on authorizations, users

can change the look and feel of their pages by using skins and page layouts. Also,
page navigation hierarchy is tree-based, allowing any depth of nested pages.

The user or an administrator can set up the contents of each page. Administrators
can specify that certain portlets be required, so that users are unable to move them
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or to remove them from the pages. Each page can have its own color scheme and
column layout.

Cascading authorization

An administrator can grant or revoke access to customize a page or portion of a
page to other administrators or users. The administrator can determine user's
rights to modify a page. Administrators can control the edit authority that other
administrators have on a page and its contents. This is designed to help
organizations enforce policies and consistency, and create region-specific portals
with some centrally managed content. This control is best explained through an
example.

The first administrator can determine that a page will have three columns and not
allow the column layout to be modified by any other administrators. A second
administrator with lesser access cannot modify the column layout but can add
portlets to these columns. The following figure shows a page split into three
columns. Administrators can add portlets to these columns.
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The second administrator adds a stock portlet to column one and a company news
portlet to column two. This administrator wants these portlets to be available to
everyone and does not want them to be removed. However, the administrator can
add portlets to the columns. Therefore, the portlets are locked and cannot be
removed by other administrators with lesser access. The following figure shows an
example of how cascading authorization from one administrator to another would
look.
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Skins and themes

WebSphere Portal uses html, cascading style sheets, images, and other standard
web design artifacts to define the look of pages. Java Server Pages (JSP) and other
server-side dynamic techniques can also be used to help define the look of a site.
You can add or modify elements to control visual aspects of WebSphere Portal,
perhaps to add company-specific brand elements or to achieve a different color
scheme and visual style. The system for defining color themes and skins supports
multiple skins per theme, additional branding elements, navigation styles, and
dynamic, browser-independent cascading style sheets.

You can apply skins and themes to a page, not only to the overall product. You can
apply different skins individually to portlets as well, so that the appearance of a
portal can be fine-tuned to meet any user need. By using a different theme for each
page, a single installation can give the appearance of supporting many virtual
portals.
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Branding elements

You can change all visual elements of WebSphere Portal, including the masthead,
the navigation areas, graphics, portlet title areas, and style sheets, to give
WebSphere Portal a custom look. You can use standard file formats, such as JPEG,
GIF, CSS, and JSP files, to define the look and layout.

The structure of the component installation folder contains folders named "skin"
and "theme," with folders "html," "wml," and "chtml." These folders contain most
of the files that are used for defining the basic structure of the home page, its color
schemes, and portlet decorations. Portal designers can copy these folders and
modify their contents to create a custom look and feel. The theme administration
portlet registers the new files.

Changing portlet layout

You can change the placement of individual portlets on a page by using the
drag-and-drop feature. To rearrange a portlet on a page, click the title bar of the
portlet and then drag the portlet to a new location on the page. You can also add
portlets to the page for quick and easy page customization by dragging portlets
from the Portlet Palette to the page.

Personalization

The Personalization component selects content for users, based on information in
their profiles and on business logic. With Personalization facilities, subject matter
experts can select content that is suited to the needs and interests of each site
visitor. These web-based tools help companies quickly and easily use content that
is created by business and subject matter experts. Personalization involves three
basic personalization components:
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User Profile: information about users of the site, including user attributes

Content Model: defines attributes about content, such as product descriptions,
articles, and other information

Matching Technology: engines that match users to the correct content; includes
filtering, rules, recommendation engines, or combinations of all three.

The Personalization and WebSphere Portal components share a common user
profile and content model. The model is based on the WebSphere resource
framework interfaces classes. This means that personalization rules can easily be
added to portlets to select content and target it to WebSphere Portal registered
users.

Personalization classifies site visitors into segments and then targets relevant
content to each segment. Business experts create the rules for classifying users and
selecting content, using web-based tools.

Personalization also includes a recommendation engine that provides collaborative
filtering capabilities. Collaborative filtering uses statistical techniques to identify
groups of users with similar interests or behaviors. Inferences can be made about
what a particular user might be interested in, based on the interests of the other
members of the group.

New campaign management tools are also included with Personalization.
Campaigns are sets of business rules that work together to accomplish a business
objective. For example, an HR manager might want to run a campaign to
encourage employees to enroll in a stock purchase plan. The HR manager would
define a set of rules that are shown to accomplish this business objective.
Campaigns have start and stop dates and times and can be email- and web-page
based. Several campaigns can run simultaneously and can be prioritized.

Implicit profiling services can collect real-time information about site visitor actions
and then construct personalization business rules using this data. To analyze the
effectiveness of the site and its personalization strategies, the server provides
reports for the business owner of the site. This helps the company measure the
effectiveness of the business rules and campaigns in achieving its objectives.

Universal access

The system of page templates, themes, skins, and portlet rendering is fully enabled
for internationalization and accessibility by people with disabilities. For globally
accessible portals, WebSphere Portal searches for and selects the proper JSP pages,
based on the target browser and its settings for language and country.

Types of websites

44

Different types of websites require different solutions and use different applications
and features. These examples describe details of different websites and the types of
applications and features that are required to deliver them.

[“Intranet portal” on page 45|

An intranet portal site is designed to allow information to be quickly
disseminated to employees, to make common internal business processes more
efficient and to provide a sense of community within an organization.
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[“E-business site” on page 46|

An e-business site is an externally facing site that is designed to market a
company's products and services to consumers and allow them to purchase
these items online. The focus of the site is on helping consumers match their
needs to the appropriate product or service and maximizing their purchases.

[“Brochure-ware site” on page 48|

A brochure-ware site is an externally facing site that acts as an organization's
presence on the World Wide Web. The overriding focus is on representing the
organization's brand to its potential customers.

[“E-library site” on page 49|

An online library site is dedicated to providing access to a large amount of
content. The prime example is a news site, where new content is created
throughout the day, every day of the week and is published online and then
archived as it becomes out of date. Other examples include journals, analyst
reports, and software libraries.

[“Partner site” on page 50|

The audiences for a partner site are the partners of an organization. The site
provides information and applications that are not applicable to the broader
audience of consumers. A partner site would typically require a login but
would not use an automated registration system. The business partners would
be known to the company and given a login to access the partner site.

Intranet portal

An intranet portal site is designed to allow information to be quickly disseminated
to employees, to make common internal business processes more efficient and to
provide a sense of community within an organization.

The site provides access to:

News about what is happening within the organization.

Alerts that contain information that employees should be aware of and
potentially action.

Forms for working with various internal processes such as leave, purchases, and
travel.

A policies and procedures library with online versions of all policy and
procedure documentation.

Organizational communities with collaborative features like blogs and forums.
A search system to enable employees to find content.

The intranet portal also has a personalized home page that is dynamically built by
using a set of rules that retrieve content based on the current user's role,
department, and location. By tagging the content, and then matching this content
with the current user, only content that is appropriate for the current user is
displayed.

A number of components are used together to make this intranet portal work:

WebSphere Portal is used to provide a platform for the integration of content
and applications that form the intranet portal.

The overall theme and top-level navigation of the intranet is also managed by
using WebSphere Portal.

Web Content Manager provides the micro-level layout of the content within the
portal, and is also used to directly build the news, alerts, and communities
content.
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* The forms are online applications that are built by using the Forms/Lists system,
being pulled into the site by using Web Content Manager

* DPolicies and Procedures are document libraries managed using IBM FileNet
Content Manager.

* A custom feed producer would be written to allow the Web Content Integrator
to consume a feed from IBM FileNet Content Manager and Web Content
Manager would be used to present the documents in a website.

* Personalization is used to associate content with users, dynamically generating
the content that is displayed in the personalized home page

* A third-party discussion system is used to deliver collaborative forums in the
communities section of the site using a custom portlet.

* WebSphere Portal search is used with the Web Content Manager categorization
to provide both a simple text search and a more advanced category-based
search.

The size of an intranet portal tends to scale with the size of the organization. A
large organization has more information to disseminate, more business processes,
more communities of employees. This means that the content and the user
population tend to grow at the same rate.

Related concepts:

["Roadmap to building a web content system” on page 2075|

To build a web content system you need to deploy hardware, configure servers,
design an authoring system, configure a delivery environment and enable
syndication. Get an overview of the steps required to build your web content
system. Keep in mind the analysis and design documents developed during the
planning phase of a project as you review the roadmap.

[‘TBM Web Content Integrator” on page 2230

The Web Content Integrator is a solution for integrating externally managed web
content with WebSphere Portal. By using standard content syndication feed
technologies based on RSS 2.0, the Web Content Integrator provides a loosely
coupled mechanism for transferring published content and metadata to the portal
after they are approved in the source system. When the content and metadata are
transferred to the portal, it is possible to use the built-in content management
features of Web Content Manager to secure, personalize, and display the content to
users.

[‘Targeted content and Portal Personalization” on page 27

Targeted content provides you with a way to deliver multiple pieces of content to
different audiences. Targeted content matches the best content with the most
appropriate group by using segments. Segments help you split your audience into
meaningful groups with different interests or characteristics.

Related information:

[ [FileNet Content Manager]

E-business site

An e-business site is an externally facing site that is designed to market a
company's products and services to consumers and allow them to purchase these
items online. The focus of the site is on helping consumers match their needs to
the appropriate product or service and maximizing their purchases.

The site provides:
* Press releases about the latest news about the company's products and services.
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A promotions area with information about products and services that include
sales, special package deals, and discounts.

A products and services catalog area with the entire catalog displayed as a
searchable taxonomy:.

A shopping area where users can see:

— A searchable list of available products and services available for purchase
online.

— A summary of the items they are intending to purchase.
— An area to calculate tax, shipping, and other costs.

— An area to purchase these items online using mail order, or by using a
follow-up call from a salesperson.

— An area to track orders they initiated.

Articles where the organization can help customers by using articles that discuss
their products and services.

A support area with technical documentation, contact numbers, support request
forms, FAQs, and downloads.

A service for subscribing to a newsletter where the user is sent a regular update
that highlights new promotions, products, or articles.

The home page of the site is used to highlight the latest promotions, and to give a
strong sense of the brand of the organization. Throughout the site, collaborative
filtering is used to help suggest products and services to consumers based on their
purchasing and navigational activity. A discussion system can also be used to allow
users to build a community where they can comment on and rate various products
and services.

A number of components are used together to build the e-business site:

WebSphere Portal is used to provide a platform for the integration of content
and applications that form the e-business site.

The overall theme and top-level navigation of the intranet is also managed by
using WebSphere Portal.

Web Content Manager provides the micro-level layout of the content within the
site, and is also used to directly build the press releases, FAQs, articles, and
promotional content.

The catalog and shopping areas are being run by using WebSphere Commerce.

Personalization is used to suggest products to users based on collaborative
filtering, and to email the newsletter.

A third-party discussion system is used to deliver collaborative forums in the
communities section of the site by using a custom portlet.

An e-business site can generate a large amount of traffic with a relatively small
amount of content.

Related concepts:
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[Designing and setting up a portal site|

WebSphere Portal 7 provides improved page builder and improved client side
rendering and has a new default portal theme, the Page Builder theme. Themes
define how your portal site will look. After installation, a default theme is
deployed and you can either customize that theme or create your own. The new
themes approach introduced in 7 involves less editing of JSPs and allows you to
mix iWidgets and portlets on the same portal page and take advantage of both
client side and server side rendering mode. WebSphere Portal 7 continues to
support other themes, including your custom themes. If you have an existing
portal site you can continue to use your existing themes or you can migrate your
themes to the new standard.

[‘Roadmap to building a web content system” on page 2075|

To build a web content system you need to deploy hardware, configure servers,
design an authoring system, configure a delivery environment and enable
syndication. Get an overview of the steps required to build your web content
system. Keep in mind the analysis and design documents developed during the
planning phase of a project as you review the roadmap.

[“Targeted content and Portal Personalization” on page 27|

Targeted content provides you with a way to deliver multiple pieces of content to
different audiences. Targeted content matches the best content with the most
appropriate group by using segments. Segments help you split your audience into
meaningful groups with different interests or characteristics.

Related information:

[ [[BM WebSphere Commerce

Brochure-ware site

A brochure-ware site is an externally facing site that acts as an organization's
presence on the World Wide Web. The overriding focus is on representing the
organization's brand to its potential customers.

This type of site is relatively static and does not need the aggregation capabilities
of WebSphere Portal and is instead delivered by using both the servlet delivery
and pre-rendering features of Web Content Manager. The site is also designed to be
easily indexed by search engines like Google.

This site would include:

* Information about the organization that includes its ethics, goals, mission, and
history.

* A news area where the organization can talk about what they are doing now
and into the future.

* A contact area with lists of locations, phone numbers, and online contact forms
where users can submit queries, ask for follow-up calls.

* A job opportunities area where an organization can advertise positions

* A partners area where partners of the organization are listed with information
about them and their relationship with the organization, and links to partner
websites and partner contact details

* Information about the organization's products and services that includes case
studies and testimonials

The components in this site are limited with Web Content Manager providing all
the presentation, navigation, and content.
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A brochureware site can generate a large amount of traffic with a relatively small
amount of content.

Related concepts:

[“Roadmap to building a web content system” on page 2075|

To build a web content system you need to deploy hardware, configure servers,
design an authoring system, configure a delivery environment and enable
syndication. Get an overview of the steps required to build your web content
system. Keep in mind the analysis and design documents developed during the
planning phase of a project as you review the roadmap.

E-library site
An online library site is dedicated to providing access to a large amount of content.
The prime example is a news site, where new content is created throughout the
day, every day of the week and is published online and then archived as it
becomes out of date. Other examples include journals, analyst reports, and
software libraries.

Users would typically register for these sites, and might then be sent emails
regularly summarizing the latest content. On a news site, the latest news might be
free, but users might pay for access to archived content. On other types of "library"
sites, users might pay for access to any of the content.

A number of components are used together to deliver an e-library site:

* WebSphere Portal is used to provide a platform for the integration of content
and applications that form the e-business site.

* The overall theme and top-level navigation of the intranet is also managed by
using WebSphere Portal.

* Web Content Manager provides the micro-level layout of the content within the
site, and is also used to directly build content.

* For e-libraries where the content is presented as documents, then IBM FileNet
Content Manager would be used to store and manage the documents.

* A custom feed producer would be written to allow the Web Content Integrator
to consume a feed from IBM FileNet Content Manager and Web Content
Manager would be used to present the documents in a website.

An e-library site might have a large audience and a large amount of content.

Related concepts:

[Designing and setting up a portal site|

WebSphere Portal 7 provides improved page builder and improved client side
rendering and has a new default portal theme, the Page Builder theme. Themes
define how your portal site will look. After installation, a default theme is
deployed and you can either customize that theme or create your own. The new
themes approach introduced in 7 involves less editing of JSPs and allows you to
mix iWidgets and portlets on the same portal page and take advantage of both
client side and server side rendering mode. WebSphere Portal 7 continues to
support other themes, including your custom themes. If you have an existing
portal site you can continue to use your existing themes or you can migrate your
themes to the new standard.

[‘Roadmap to building a web content system” on page 2075|

To build a web content system you need to deploy hardware, configure servers,
design an authoring system, configure a delivery environment and enable
syndication. Get an overview of the steps required to build your web content
system. Keep in mind the analysis and design documents developed during the
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planning phase of a project as you review the roadmap.

['TBM Web Content Integrator” on page 2230

The Web Content Integrator is a solution for integrating externally managed web
content with WebSphere Portal. By using standard content syndication feed
technologies based on RSS 2.0, the Web Content Integrator provides a loosely
coupled mechanism for transferring published content and metadata to the portal
after they are approved in the source system. When the content and metadata are
transferred to the portal, it is possible to use the built-in content management
features of Web Content Manager to secure, personalize, and display the content to
users.

Related information:

[ [FileNet Content Manager]

Partner site

The audiences for a partner site are the partners of an organization. The site
provides information and applications that are not applicable to the broader
audience of consumers. A partner site would typically require a login but would
not use an automated registration system. The business partners would be known
to the company and given a login to access the partner site.

A partner site can include the following areas:

* A news area that is focused on partners. Larger organizations that work in
multiple areas of business might personalize the news area to suit each partner.

* A promotions area that details special deals for partners.

* Online services, providing useful tools and resources for partners to use, such as
calculators, forms, and catalogs.

* A billing area where partners can see the current bill status for services that are
contracted from the organization.

* A community area where partners might post information about themselves, and
also interact to help each other and receive help from the organization.

A number of components are used together to deliver a partner site:

* WebSphere Portal is used to provide a platform for the integration of content
and applications that form the intranet portal.

* The overall theme and top-level navigation of the intranet is also managed by
using WebSphere Portal.

* Web Content Manager provides the micro-level layout of the content within the
portal, and is also used to directly build the news and promotions content.

* Various IBM products plus third-party applications are used to build and deploy
the online services area.

* The catalog and billing services in the site is run by using WebSphere
Commerce.

* A third-party discussion system is used to deliver collaborative forums in the
communities section of the site by using a custom portlet.

* Personalization is being used to filter content throughout the site to ensure that
the appropriate content and inline services are reaching the appropriate partners.

A partner site is likely to have a limited audience but a large amount of content.
Related concepts:
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[Designing and setting up a portal site|

WebSphere Portal 7 provides improved page builder and improved client side
rendering and has a new default portal theme, the Page Builder theme. Themes
define how your portal site will look. After installation, a default theme is
deployed and you can either customize that theme or create your own. The new
themes approach introduced in 7 involves less editing of JSPs and allows you to
mix iWidgets and portlets on the same portal page and take advantage of both
client side and server side rendering mode. WebSphere Portal 7 continues to
support other themes, including your custom themes. If you have an existing
portal site you can continue to use your existing themes or you can migrate your
themes to the new standard.

[‘Roadmap to building a web content system” on page 2075|

To build a web content system you need to deploy hardware, configure servers,
design an authoring system, configure a delivery environment and enable
syndication. Get an overview of the steps required to build your web content
system. Keep in mind the analysis and design documents developed during the
planning phase of a project as you review the roadmap.

[“Targeted content and Portal Personalization” on page 27|

Targeted content provides you with a way to deliver multiple pieces of content to
different audiences. Targeted content matches the best content with the most
appropriate group by using segments. Segments help you split your audience into
meaningful groups with different interests or characteristics.

Related information:

[ [[BM WebSphere Commerce

Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use software products successfully.

Accessibility by people with disabilities A US Section 508 Voluntary Product
Accessibility Template (VPAT) can be requested with the [[BM accessibility websitel
IBM Digital Experience offerings use the newest W3C Standard, WAI-ARIA 1.0 to
ensure compliance to US Section 508 and Web Content Accessibility Guidelines
(WCAG) 2.0. The best accessibility experience is provided by using the newest
release of the browser and the newest release of the screen reader. For more
information, see the following URLs:

* |Accessible Rich Internet Applications (WAI-ARIA) 1.0|
* | Section 508 Standards for Electronic and Information Technologyl
+ | Web Content Accessibility Guidelines (WCAG) 2.0|

Updated IBM Digital Experience V8.5 offerings include the following products.
* IBM Customer Experience Suite V8.5

* IBM Customer Experience Suite Rich Media Edition V8.5

* IBM Employee Experience Suite V8.5

* IBM Portal Server V8.5

* IBM Portal Enable V8.5

 IBM Portal Express V8.5

* IBM Web Content Manager V8.5

* IBM Web Content Manager Rich Media Edition V8.5

* IBM Web Content Manager Standard Edition V8.5
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* IBM Content Accelerator V8.5
+ IBM Content Accelerator and WebSphere Portal V8.5

This version of IBM WebSphere Portal:
* Supports installation through a command-line interface known as console mode. It

is the accessible equivalent of installing by using the graphical user interface.

* Supports interfaces commonly used by screen readers and screen magnifiers

(Windows only)

* Supports use of screen-reader software and digital speech synthesizers to hear

what is displayed on the screen.

* Can be operated with only the keyboard

* Allows the user to request more time to complete timed responses

* Supports customization of display attributes such as color, contrast, and font size

* Communicates all information independently of color

* Supports the attachment of alternative input and output devices

* Supports alternatives to audio information

* Supports adjustable volume control

* Does not flash the screen at rates that can induce epileptic seizures

¢ Provides documentation in an accessible format

Supported browser: Firefox 25.

Recommended screen reader: JAWS 15.

The documentation includes the following features to aid accessibility:

* All documentation is available in HTML formats to give the maximum

opportunity for users to apply screen-reader software technology.

» All images in the documentation are provided with alternative text so that users

with vision impairments can understand the contents of the images.

When appropriate, the documentation for specific product features contains more
information about accessibility.

See the related links for information about IBM’s commitment to accessibility.

Related information:
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Chapter 2. Tutorials

Explore the following tutorials to learn more about using the IBM WebSphere
Portal features.

[“Tutorial: Creating and publishing content ”|

This tutorial demonstrates how you can use pages, projects, and workflow to
create and approve draft pages. After approval, changes are published to a
delivery server with syndication.

Related information:

[ [Getting Started with Your Digital Web Experience|

Tutorial: Creating and publishing content

This tutorial demonstrates how you can use pages, projects, and workflow to
create and approve draft pages. After approval, changes are published to a
delivery server with syndication.

During the tutorial, you will use different parts of the portal user interface. Most
actions originate for the site toolbar.

—~(&Y - ), ~ - -~ Published Site ~ ~—Edit Mode: OFF e
Q. b | A | e (a) @ O..
|Projects Create '"Page| s Menu =

Figure 1. Screen capture of the site toolbar with annotations.

1 Menu options
There are three menu options: Site, Application, and Administration.

Use the Site menu to switch between the sites that are hosted on a single
portal server.

Use the Application menu to access application such as Content,
Collaboration, Messaging, Personalization, and Unified Task List.

Use the Administration menu to access the administration portlets.

2 Toolbar
The toolbar provides access to authoring tools such as Projects, Create,
and Page.

From the Projects tab, the content authors can create new projects to
manage multiple changes. The tab displays the content that has been
created or changed in the website for that project. Each content item can be
managed individually. The content author can also create project templates.

From the Create tab, content authors can create pages, add applications to
a page, or add content to a page. The content shelf contains Web Content
Viewer portlets that are preconfigured with content associations. When the
content author drags content to the page, a copy of the associated content
is added to the page. Then the content author can customize the content.
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From the Page tab, content authors can view and modify page settings,
such as layout, vanity URLs, and more.

3 Project indicator
The project indicator provides access to the project menu and displays the
currently active project. If there is no active project, then the indicator
shows "Published Site" and you are viewing the currently published
website.

4 Edit Mode
Use the Edit Mode control to turn editing capability on and off.

5 Information Mode
Turns inline user assistance on and off. Inline assistance includes
descriptions and examples that appear in the user interface and hover help.

Currently this mode is only implemented in the site toolbar.

6 Menu
Provides access to additional page and preview actions.

Page actions include: View Page Properties, Show Hidden Pages, Show
Hidden Content, Move Page, and Delete Page.

Preview actions include: Preview as a specific user and preview as an

unauthenticated user.

Contents

[“Create users and groups” on page 55|

The tutorial uses multiple user roles to demonstrate how content is created and
flows through the system. To complete the steps in the tutorial as they are
documented, you must create the groups and user IDs.

[‘Step 1. Set up library access” on page 56|

Before the content authors, editors, and approvers can get started, the
SiteAdmin must grant library access to content authors and approvers.

[“Step 2. Set up syndication” on page 57|

Updates to pages and content are transferred from the authoring server to the
delivery server with syndication. When you publish a project, you can use
syndication to automatically publish new pages and content updates. To enable
this behavior, SiteAdmin sets up syndication between the required web content
libraries of the two servers.

[‘Step 3. Create workflow” on page 58|

Pages that are created in this tutorial are subject to custom workflow that is
attached to the page template. Before the SiteAdmin creates the page template
on the authoring server, the SiteAdmin creates the custom workflow to be used
with new pages.

[“Step 4. Create page template” on page 60|

SiteAdmin creates a page template that content authors can use to create pages.

[‘Step 5. Create page from template and submit changes for review” on page 63|

After SiteAdmin adds the Templatel page template, content authors can create
pages from the template.

[“Step 6. Approve and publish changes” on page 65|

After Authorl submits the changes in the News Section Updates project for
review, Reviewerl reviews the changes and submits the project for approval.
Approverl then accesses the project and approves the updates for publishing.
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When the project is submitted, SiteAdmin publishes the project, and the
changes are then available for all users on the authoring server.

[‘Step 7. Syndicate changes to delivery server” on page 66|

After SiteAdmin publishes the project, the updates are ready for syndication to
the delivery server. Although syndication runs at scheduled intervals,
SiteAdmin accesses the delivery server and manually starts the syndication
process.

Create users and groups

The tutorial uses multiple user roles to demonstrate how content is created and
flows through the system. To complete the steps in the tutorial as they are
documented, you must create the groups and user IDs.

About this task

This tutorial uses the following user roles, IDs, and group assignments.

Table 3. User roles in this tutorial and their related user IDs and group assignments

User Role

User ID Group

Site administrator

SiteAdmin wpsadmins

This group already exists and you do not need
to create it.

Content author Authorl ContentEditors
Content reviewer Reviewerl ContentReviewers
Content approver Approverl ContentApprovers

The tutorial highlights four user roles, the site administrator, content author,
content reviewer, and content approver. Each user role performs specific tasks in
the tutorial.

Site administrator (SiteAdmin)
The site administrator has administrator privileges in the portal and in
Web Content Manager. SiteAdmin is part of the user group wpsadmins,
and does these tasks:

* Sets up workflow stages and creates a custom workflow.
* Creates a page template that uses the custom workflow.
* Specifies access control settings where needed.

* Sets up a syndication relationship between the authoring server and the
delivery server.

 Publishes projects for syndication.

Content author (Authorl)
The content author is responsible for a certain portion of the site and can
create pages as needed. In addition the content author adds and edits
content on those pages. Authorl is part of the user group ContentEditors.

Content reviewer (Reviewer1)
Reviewerl reviews changes submitted by content authors and either
approves or rejects the individual changes. Upon approval, Reviewerl
submits the complete project for approval. Reviewerl is part of the group
ContentReviewers.

Content approver (Approverl)
Approverl oversees changes to the site and is responsible for approving
projects for publishing. Approverl is part of the group ContentApprovers.
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Procedure
1. Click the Administration menu icon. Then, click Access > Users and Groups.
2. Click All Portal User Groups.

3. Click New Group and type ContentEditor as the ID. Repeat this step to
create ContentReviewers and ContentApprovers.

4. Click ContentApprovers to open the group. Then click New User to create
Approverl.

5. Click All Portal User Groups in the breadcrumb.

6. Click ContentEditors to open the group. Then click New User to create
Authorl.

7. Click All Portal User Groups in the breadcrumb.

8. Click ContentReviewers to open the group. Then click New User to create
Reviewerl.

9. Click All Portal User Groups in the breadcrumb.

10. Click wpsadmins to open the group. Then click New User to create
SiteAdmin.

Step 1. Set up library access

Before the content authors, editors, and approvers can get started, the SiteAdmin
must grant library access to content authors and approvers.

About this task

In this step, access is defined for the following libraries:

Portal Site
Page objects and content for pages are stored in the Portal Site library.
Contributor access is required for the ContentEditors group.

Web Content
The custom workflow and workflow stages are stored in the Web Content
library. Contributor access is required for the ContentEditors,
ContentReviewers, and ContentApprovers groups.

Procedure
1. Log in as SiteAdmin.

2. Click the Administration menu icon. Then, click Portal Content > Web
Content Libraries.

3. Set permissions for the Portal Site library.
a. Click the Set permissions icon for the Portal Site library.
b. Click the Edit Role icon for the Editor role.
c. Click Add. Then, click Search to show all groups.
d. Select the ContentEditors group.
4. Click Portal Content > Web Content Libraries.
5. Set permissions for the Web Content library.
a. Click the Set permissions icon for the Web Content library.
b. Click the Edit Role icon for the Contributor role.
c. Click Add. Click Search to show all groups.
d. Select the ContentEditors, ContentReviewers, and ContentApprovers
group.
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What to do next

Remember: In addition to appropriate access to libraries, content authors require
Editor access to any pages and portlets that are involved. This access enables
authors to create pages and add portlets to pages. This tutorial relies on sample
content with predefined access. However, if you use your own content, ensure that
you specify sufficient access on these resources in the portal so authors can work
with them.

Step 2. Set up syndication

Updates to pages and content are transferred from the authoring server to the
delivery server with syndication. When you publish a project, you can use
syndication to automatically publish new pages and content updates. To enable
this behavior, SiteAdmin sets up syndication between the required web content
libraries of the two servers.

About this task

In this syndication relationship, the delivery server is the subscriber, and the
authoring server is the syndicator.

Procedure
1. Log in to the delivery server as an administrator.
2. Create a shared credential vault slot for accessing the syndicator.
a. Click the Administration menu icon. Then, click Access > Credential Vault.
b. Click Add a vault slot.
c. Enter a name for the vault slot. For example, syndication-slot.
d

Click new, and enter a vault resource to associate with the slot. For
example, syndication-resource

e. Click Vault slot is shared, and enter the user ID and password to access the
slot from the authoring server. This user ID and password must be defined
on the authoring server. This tutorial uses the credentials for SiteAdmin.

f. Click OK.
3. Then, click Portal Content > Subscribers.
4. Click Subscribe Now.
5. Specify the details for the syndicator and subscriber.
a. In the Syndicator URL field, enter the URL to access the authoring server.

This URL takes the form http://hostname:port_number/wcm_context_root.
The default context root for Web Content Manager is wps/wcm. For example:

http://www.example.com:10039/wps/wcm

b. In the Syndicator Name field, enter a name to identify the authoring server
in the syndication relationship. This name is used for the syndicator item
that is created on the authoring server.

C. In the Subscriber Name field, enter a name to identify the delivery server
in the syndication relationship. This name is used for the subscriber item
that is created on the delivery server.

d. In the Credential Vault Slot field, select the credential vault slot that you
created previously. For example, syndication-slot

e. Click Next, and select the libraries that you want to syndicate.
The following libraries are needed for this tutorial:
* Portal Site: Contains page artifacts and related content.

Chapter 2. Tutorials 57



f.

g.

* Web Content: Contains workflow items.

* Web Content Templates 3.0: Required for sample web content items.
* Template Page Content 3.0: Required for sample web content items.
For each library, select Live items in the Scope field.

Click Finish.

To verify the syndication connection, click the Test connection icon.

Step 3. Create workflow

Pages that are created in this tutorial are subject to custom workflow that is
attached to the page template. Before the SiteAdmin creates the page template on
the authoring server, the SiteAdmin creates the custom workflow to be used with
new pages.

About this task

The custom workflow is stored in the Web Content library and is a simple,
three-stage workflow that contains the following stages: Draft, Review, Publish. A
Draft and Publish stage is available for immediate use. Therefore you only need to
create the Review stage.

Table 4. Workflow stage access

Workflow stage

Access Group Description

Draft (already exists)

Grant Manager Access ContentEditors Enables authors to edit content that

is in the draft state.

Grant Reviewer Access ContentEditors Enables authors to move items to

the next stage in the workflow.

Publish (already exists)

Grant Draft Creator Access ContentEditors Enables authors to create drafts of

published content.

Review

Grant User Access ContentEditors Enables authors to view the status

of content in the review stage.

Grant Reviewer Access ContentReviewers Ensures that only reviewers can

submit draft content for approval.

Procedure

1.

Log in to the authoring server as SiteAdmin.

2. Create the Review workflow stage.
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a.

b
c.
d.
e
f.

Click the Applications menu and then click Content.
Click the Web Content Authoring tab.

Click Web Content > Workflow Items > Workflow Stages.
Click New > Workflow Stage.

Enter Review Stage for the workflow stage name.

Click Save and Close.

Edit the access for Draft workflow stage.

a.
b.

o

Sa "o o

Click the Draft workflow stage.

Click Edit.

Expand Workflow Defined Access section.

Click Grant Manager Access.

Type Co in the search field and click Search.

Select ContentEditors and click Add. Then click OK.
Click Grant Reviewer Access.

Type Co in the search field and click Search.




i. Select ContentReviewers and click Add. Then click OK.
j. Click Save and Close.
4. Edit the access for Publish workflow stage.
a. Click the Publish workflow stage.
b. Click Edit.
c. Expand Workflow Defined Access section.
d. Click Grant Draft Creator Access.
e. Type Co in the search field and click Search.
f. Select ContentEditors and click Add. Then click OK.
g. Click Save and Close.
5. Edit the access for Review workflow stage.
a. Click the Review workflow stage.
b. Click Edit.
c. Expand Workflow Defined Access section.
d. Click Grant User Access.
e. Type Co in the search field and click Search.
f. Select ContentEditors and click Add. Then click OK.
g. Click Grant Reviewer Access.
h. Type Co in the search field and click Search.
i. Select ContentReviewers and click Add. Then click OK.
j. Click Save and Close.
In the following example screen capture shows the access settings for Review

workflow stage. The ContentEditors group is listed with User access, and the
ContentReviewers group is listed with Approver access.

Workflow Defined Inheritance Propagation
User Grant User Access = [#] v
ContentEditors X
Contributor Grant Contributor Access [¥ |
Draft Creater Grant Draft Creator Access = [5] V|
Editor Grant Editor Access - | =]
Manager Grant Manager Access = 7 ¥
Reviewer Grant Reviewer Access » [¥]

ContentReviewers X

Figure 2. Screen capture of access settings for Review workflow stage.

6. Create the custom workflow named Workflow1.
a. Click Web Content in the breadcrumb.
b. Click Workflow Items > Workflows.
c. Click New > Workflow.
d. Enter Workflow1 for the workflow name.
e. In the Workflow Properties section, click Add Workflow Stages.
f. Add the following stages: Draft Stage, Review Stage, Publish Stage.
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g. Use the up and down arrows to order them accordingly: Draft Stage,
Review Stage, Publish Stage. The following example screen capture shows
the workflow of these stages.

&% Workflow Properties

*Workflow Stages:

Add Workflow Stages -

Web Content/ Draft Stage Aflw]|x
Web Content / Review Stage |&| | v/ (%
Web Content/ Publish Stage |&| |7 || %

Figure 3. Screen capture of workflow stages in the Workflow1 workflow.

h. Save your changes.

Step 4. Create page template

SiteAdmin creates a page template that content authors can use to create pages.

About this task

Because page changes need to be approved before they are published in this
tutorial, the SiteAdmin specifies a custom workflow (Workflow1) when they set
page properties for the template. When a content author creates a page from the
template, changes to the page are subject to the Workflow1 workflow.

Procedure

1. From the Site menu, click Home to go to the default site.
2. Click Projects.

Tip: You can set a workflow only on items that are in a draft state. Because of
this behavior, you must create the template as a draft in the context of a
project. By working in a project, you can also verify the workflow to make sure
that the stages behave as expected.

3. Type New Template and click Create.
The new project is shown as the active project.

Projects Create Page
A

Projects Overview

@ New Project Recent Projects

Create a project from:
Default Project Template ~

Mew Template|

Create

Figure 4. Screen capture of the open Projects tab.
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New Template ~ | EditMode:

Figure 5. Screen capture of the active project indicator.

4. Create the page template.
a. Turn on Edit Mode.

b. Click the Administration menu icon and then click Portal User Interface.

Projects Portal User Intertace |
Portlet Management
@ Projectn]  Access e

Itz prowg Portal Settings

Portal Content
Projects Overviq  search Administration

Portal Analysis

New
Virtual Portals

Active

Figure 6. Screen capture of the Administration menu.

c. Click Page Templates
From the toolbar click Create > Page.

Use the Basic template and type Templatel as the page title of the new page
template. You must be in Edit mode.

f. Click Create Page. Parentheses around the page name indicate that the page
is in a draft state. Close the toolbar in order to view the page.

e
Basic (Template1) Label Articles

(Templated)

Figure 7. Screen capture of the Template1 page.

5. Add the custom workflow to the page template.
a. From the toolbar click Page > General.
b. Click Edit Page Properties.
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D/: Template1 U:l Template1 Delete Publish

Status: Draft | Updated: today, 11:38

General AM - wpsadmin
Layout Basic  Details Drafis - 1 _6
Style

Location: Content Root > Hidden Pages > Page Templates

Vanity URLs Page URL: /wps/myportal/$project/New Template/lut/p/z0/04_Sj9CPykssy. .
Vanity URL: None
Associated content: None

Edit Page Properties &

Figure 8. Screen capture of General section of the Page tab.

c. Click the Security tab.

d. For the Workflow, click Select. Click the Web Content library and select
Workflowl and click OK.

As soon as you select the workflow, the page draft enters the selected
workflow. You can confirm the current workflow stage by examining the
workflow properties. In this case, the Draft stage is the current stage and
the Review stage is the next stage.

e. Close the Manage Page Properties dialog.

6. Complete the workflow for the draft template. Before you can publish the
project and make the new page template available to users, you must move the
template through the workflow.

a. On the General page, click Submit for Review.

Note: The Submit for Review button is only available to users that have
Approver access on the current workflow stage.

Menu =

D' Template1 Delete Submit for Review
| status: Draft | Workflow T ——
Stage: Draft
Stage | Updated: today, 1:30 PM - SiteAdmin

Details @

Location: Content Root > Hidden Pages > Page Templates

Figure 9. Screen capture of the Submit for Review button in the General view for the Page tab.

When you click Submit for Review, the draft item progresses to the next
stage in the current workflow. In this scenario, the template moves to the
Review Stage of the Workflow1l workflow. The General view displays the
current workflow stage.
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Menu =

-
‘ © Templatet’ submitted for review. ‘ i

D Delete Publish Withdraw from Review Reject

Status Draft | Worklow Stage: Review Stage | Updated: today, 135 | |
PM - siteAdmin

1

i Basic Details u

Location: Content Root = Hidden Pages > Page Templates
Figure 10. Screen capture of the General view of the Template1 page, showing the updated workflow stage.

b. Click Publish to move the template into the publish state.
7. Click Projects. With the New Template project as the current project, click

Publish.
Projects Create Page Menu =
A\
Projects Overview > Page Template
F @ Page Template - 1 Publish Manage Project Exit Project More =
Pending Created: SiteAdmin - foday
Y contentein Filter: All * | Sort: Title + ~ Q ::
41l Template? Publish Pending

Figure 11. Screen capture of the General view of the Template1 page, showing the updated workflow stage.

8.

After the project is published, you are taken out of the project context and
restored to the published site. Templatel is listed with the other page templates
on the Create Page tab.

What to do next

Important: Workflow changes are not dynamically applied to page templates that
use the workflow. If you change the workflow or its stages after you publish the
project that contains the template, repeat the steps to set the workflow:

1. Create a project.

2. Edit the page template, and specify the workflow again on the Security tab in
the page properties.
3. Move the template through the workflow, and publish the project.

Step 5. Create page from template and submit changes for
review

After SiteAdmin adds the Templatel page template, content authors can create
pages from the template.

About this task
In this scenario, Authorl is responsible for the section of the website that is
identified by a page called News. The News page itself was created by SiteAdmin

and was based on the Templatel page template.
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Procedure
1. Log in as Authorl.
2. Create a project to manage updates.
a. Open the toolbar and click Projects.
Enter News Section Update as the project name.
Click Create.
Click Manage Project.
Click Edit. Expand the Approval section and click Add.

Search for Approverl and add the user. When the project changes are
reviewed and submitted, Approverl can do the final approval of the
complete project.

-0 ao00C

Note on project approval: This review step is a separate review from the
review of individual items in the project. Even if item workflow is complete
for all items in the project, the updates cannot be published until the project
is approved.

g. On the Properties tab, expand the Access section.
h. For the Editor access level, click Grant Editor Access.

i. Search for the ContentReviewers group and add it. This access is needed to
enable the reviewer to view the items in the project and do the approval
steps.

j. Click Save and Close.
3. Create the News page.
a. Go to the Home page.
b. From the toolbar, click Create > Page.
C. Select the Templatel page template, and type News for the name of the
page.
d. Click Create Page.
Pages that you create in the portal are stored in the Portal Site library. For
example, in this tutorial, when Authorl creates the News page, a corresponding

site area is created in the Portal Site library. The path to the portal page site
area includes the entire page hierarchy up to the content root:

Content > Content Root > Home > News

4. Add the News page to the project. You can use access settings on the Publish
stage of your workflow to enable authors to create drafts of published content
by granting authors Approver access. This approach ensures that authors
cannot directly edit published content. In this scenario, the ContentEditors
group has Approver access on the Publish stage of the Workflow1 workflow. As
Authorl is a member of the ContentEditors group, Authorl can create a draft
of the News page.

a. From the open project, News Section Update, click More > Add to Project.
b. Click Portal SiteContentContent RootHome.
c. Check News and click Finish.
d. Close the Projects.
5. Create the Business page.
a. Go to the News page.
b. From the toolbar, click Create > Page.
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Note: As Authorl has access only to the News page, the Page tab only lets
you create a child page.

C. Select the Templatel page template, and type Business for the name of the
page.

d. Click Create Page.

Pages that you create in the portal are stored in the Portal Site library. For

example, in this tutorial, when Authorl creates the Business page, a

corresponding site area is created in the Portal Site library. The path to the
portal page site area includes the entire page hierarchy up to the content root:

Content > Content Root > Home > News > Business
6. Add content to the Business page.
a. Click Content.

b. Click Web Content from the list of categories. The site toolbar shows a list
of preconfigured Web Content Viewer portlets that you can add to the page.

€. Add Rich Text and an Image to the page. Close the toolbar to see the new
content on the page.

7. Click Projects. As you update the page and add content, the project
information reflects the changes.

Projects Create Page Menu =
A\

Projects Overview > News Section Updates

@ News Section Updates - 4 Submit For Review Manage Project Exit Project More =
Active = Created: Author One - today
Contents - 4 Filter All = | Sort: Title + = Q HH
44 Business Draft I Rich Text Drart
i Image Draft
!ﬁ News Draft

Figure 12. Screen capture of the project properties in the site toolbar, listing the recent items in the project that are
updated.

8.
9. When content changes are complete, submit each item in the project for review.

g Image Dratt

S

Edit properties

Edit

Delete ltem

Remove from Project

Submit for Review

Figure 13. Screen capture of content item menu option listing the Submit for Review option highlighted.

Step 6. Approve and publish changes

After Authorl submits the changes in the News Section Updates project for
review, Reviewerl reviews the changes and submits the project for approval.
Approverl then accesses the project and approves the updates for publishing.
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When the project is submitted, SiteAdmin publishes the project, and the changes
are then available for all users on the authoring server.

Procedure

1. Reviewerl opens the News Section Updates project in edit mode.
a. Open the site toolbar and click Projects.
b. Select News Section Updates from the list of projects.

Note: The list of projects includes only those projects to which you have
access.

c. For each item, click Publish.

{F8 Image Draft

p 31|

Edit properties

Edit

Delete ltem

Remove from Project

Publish

Figure 14. Screen capture of the content item menu with the Publish option highlighted.

2. Then Approverl, can open the News Section Updates project and approve the
project.

Projects Overview > News Section Updates

@ News Section Update... Reject Approve Manage Project Exit Project More =

Review Created: Author One - today

Figure 15. Screen capture of the buttons that are available in project overview to Approver1.

3. When the project changes are approved, SiteAdmin publishes the project by
making the News Update project the current project and clicking Publish from
the project menu.

Related tasks:

[“Previewing as another user” on page 2216|

You can preview changes to your website without logging out and logging on
again as another user. This preview capability is used to quickly verify that users
with different access levels see only content that they are authorized to see. You
can preview changes as a specific user or as an unauthenticated user.

Step 7. Syndicate changes to delivery server

After SiteAdmin publishes the project, the updates are ready for syndication to the
delivery server. Although syndication runs at scheduled intervals, SiteAdmin
accesses the delivery server and manually starts the syndication process.

Procedure
1. Log in to the delivery server as an administrator.
2. Click the Administration menu icon. Then, click Portal Content > Subscribers.

3. For the syndication relationship to the authoring server, click the Update
subscriber icon.
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Results

After syndication completes, the delivery server is automatically updated with the
Business page and its associated content.

Home  Applications Search Center  Tag Center

Welcome Getting Started User1  Actions  Log Out

Business

Mews = Business Q

Lorem ipsum dolor sit amet.

Consectetur adipiscing elit. Duis sagittis tempus m =
massa, eget tinecidunt eros varius sed. Ut placerat

pellentesque varius.

Cras nibh massa, blandit rutrum luctus bibendum, rutrum vitae risus. Duis porta

risus et felis tristique at pharetra elit malesuada. Integer ultricies fringilla odio, sed
consequat ligula tristique eu.

rtor. Proin accumsan diam etlectus b um vel rutrum
leo tortor. Praesent fermentum, ligula sit amet ultricies
semper, leo enim faucibus metus, non ornare magna mauris non magna. Sed
feugiat eleifend leo, sed pretium libero egestas ut

Nulla lacinia po
eros dapibus. Donec

Figure 16. Screen capture of the delivery server, with the new Business page shown.
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Chapter 3. Roadmaps

Review the roadmaps to understand the common deployment patterns that are
supported by the configuration wizard.

[“Roadmaps for installation and deployment”|

Installation and deployment roadmaps are designed for different environments,
such as a development or authoring environment. The environment reflects
how the server configuration is used. Under each environment is a topology.
The topology describes how the server and other elements are arranged. Each
roadmap includes a topology and high-level instructions for setting up the
selected environment.

[“Roadmap: Applying maintenance” on page 106|

Portal maintenance is delivered through two mechanisms: individual fixes
(iFixes) and combined cumulative fixes. iFixes are provided, when necessary,
for severe or security-related bugs. Combined cumulative fixes are delivered on
a regular schedule. They provide a mechanism to deliver fixes faster, improve
existing features, deliver new features, update documentation, and provide new
documentation on a frequent basis. To deliver continuous improvements for
your digital experience software, it is recommended that you apply the latest
combined cumulative fix to your environment.

["Roadmaps for migration” on page 110|
Choose the appropriate migration roadmap for your environment.

["Roadmaps for integration” on page 115|
Choose the appropriate integration roadmaps for your environment.

[“Roadmaps for web content” on page 117
Some roadmaps to help you create and integrate web content into your site.

Roadmaps for installation and deployment

Installation and deployment roadmaps are designed for different environments,
such as a development or authoring environment. The environment reflects how
the server configuration is used. Under each environment is a topology. The
topology describes how the server and other elements are arranged. Each roadmap
includes a topology and high-level instructions for setting up the selected
environment.

[“Roadmaps for stand-alone servers” on page 70|

A stand-alone server topology is useful for many environments. While the
underlying topology is similar for many environments, the configuration steps
to achieve a desired environment varies.

[“Roadmaps for clusters” on page 79|
Clusters topologies provide greater availability and capacity.

["Roadmaps for advanced configurations” on page 85|
Multiple clusters and portal farms are advanced configurations.

[“Roadmap: Web content servers” on page 102|

A web content server is ideal to create presentation templates, content
components, and other presentation elements of your website. In this roadmap,
the web server, database, and user registry software are distributed to different
physical servers.
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Roadmaps for stand-alone servers

A stand-alone server topology is useful for many environments. While the
underlying topology is similar for many environments, the configuration steps to
achieve a desired environment varies.

Roadmaps for WebSphere Portal Express are also available in IBM

Knowledge Center. For WebSphere Portal Express roadmaps, see [WebSphere Portall

[Express: Roadmaps for stand-alone servers|

[“Roadmap: Demonstration environment”|

This roadmap is ideal for running product, feature, and application
demonstrations. After the installation, you have an Apache Derby database and
a default file-based repository. You might not need to make any additional
changes to your demonstration environment. If you need to demonstrate a
specific database or user registry, use the Stand-alone server roadmap.

[“Roadmap: Portlet and theme development environment” on page 72|
A portlet and theme development server is ideal to develop and test portlets
and themes.

[“Roadmap: Test or small production environment” on page 75

A stand-alone server topology is ideal for a test or small production
environment. In this roadmap, the web server, database, and user registry
software are distributed to different physical servers.

Roadmap: Demonstration environment

This roadmap is ideal for running product, feature, and application
demonstrations. After the installation, you have an Apache Derby database and a
default file-based repository. You might not need to make any additional changes
to your demonstration environment. If you need to demonstrate a specific database
or user registry, use the Stand-alone server roadmap.

Who should use this roadmap
Use this roadmap if you are an organization with the following requirements:
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An organization that needs to explore new features or functions.

An organization that needs to demonstrate Version 8.5 to customers, clients, or
colleagues.

An organization that needs an environment to demonstrate applications and
designs.
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Topology diagram
A demonstration environment is a portal server with a local database. Since
Apache Derby is installed, configured, and ready for use, a database is not

i i . WebSphere Portal
included in the topology diagram. CIENPHIEE. Farta

Preparing for the installation process
Gather information and software before you install WebSphere Portal.

Procedure
1. Check requirements.

Documentation resource: [Detailed system requirements|
2. Get the software.
Documentation resource: [“Getting the software” on page 174

Installing the Exceptional Digital Experience
Installing WebSphere Portal involves preparing your operating system, installing or
upgrading the installation manager, and running the installation program.

About this task

Documentation resource: [“Installing the digital experience software” on page 223|

Applying the latest cumulative fix

Portal maintenance is delivered through two mechanisms: individual fixes (iFixes)
and combined cumulative fixes. iFixes are provided, when necessary, for severe or
security-related bugs. Combined cumulative fixes are delivered on a regular
schedule. They provide a mechanism to deliver fixes faster, improve existing
features, deliver new features, update documentation, and provide new
documentation on a frequent basis. To deliver continuous improvements for your
digital experience software, it is recommended that you apply the latest combined
cumulative fix to your environment.

About this task

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Tuning the servers in your environment
Tuning the servers is important to the performance of your portal environment.
WebSphere Portal is not tuned for a production environment after installation and
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deployment. Your database needs tuning for improved performance. You can
organize your database now or soon after you finish your configuration. You need
to tune and maintain your database on a regular basis.

Procedure

Run the performance tuning tool to complete an initial tuning of your servers.

Documentation resource: [“Portal server performance tuning tool” on page 361|

Roadmap: Portlet and theme development environment
A portlet and theme development server is ideal to develop and test portlets and
themes.

Who should use this roadmap

Use this roadmap if you are an organization that needs an environment to develop
and test your portlets and themes before you go live to the server. Do not use this
roadmap to develop web content. Go to ['Roadmap: Web content servers” on page|
to develop web content.

Topology diagram

The topology for a portlet and theme environment is the same as the
demonstration environment. It includes a portal server with a local database.
However, the software configuration is different. The topology diagram depicts a
portal server that is connected to a code repository for group development. While
the topology diagram depicts a server, the portlet and theme environment might
be configured on a notebook.

Code
Repository

WebSphere Portal

Preparing for the installation process
Gather information and software before you install WebSphere Portal.

Procedure
1. Check requirements.

Documentation resource: [Detailed system requirements|
2. Get the software.
Documentation resource: [“Getting the software” on page 174
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Installing prerequisites

Before you install WebSphere Portal, install any prerequisites that are necessary for
your environment. You can use existing prerequisite software installations. Verify
that your existing version is supported. If it does not, upgrade to the appropriate
version.

Procedure

1. Prepare a database server.

Documentation resource: [“Installing and preparing the database software”

2. Prepare a user registry.

Documentation resource: [“Preparing the user registry software” on page 214|

Installing the Exceptional Digital Experience
Installing WebSphere Portal involves preparing your operating system, installing or
upgrading the installation manager, and running the installation program.

About this task

Documentation resource: [“Installing the digital experience software” on page 223|

Applying the latest cumulative fix

Portal maintenance is delivered through two mechanisms: individual fixes (iFixes)
and combined cumulative fixes. iFixes are provided, when necessary, for severe or
security-related bugs. Combined cumulative fixes are delivered on a regular
schedule. They provide a mechanism to deliver fixes faster, improve existing
features, deliver new features, update documentation, and provide new
documentation on a frequent basis. To deliver continuous improvements for your
digital experience software, it is recommended that you apply the latest combined
cumulative fix to your environment.

About this task

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Transferring your database

After you install your web experience, Apache Server is your available database.
Depending on your requirements, you might need to transfer to a different
database. The Database Transfer configuration option in the Configuration Wizard
assigns users and permissions, creates databases, obtains support for database
collation, and transfers your database.

Before you begin

Log in to WebSphere Portal to verify that you have a working portal:

http://hostname.example.com:10039/wps/portal,

where hostname.example.com is the fully qualified

host name of the server where Portal is running and 10039 is

the default transport port that is created by WebSphere Application Server. The port
number might be different for your environment.
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Procedure

1. To get the latest updates for the wizard, apply the most recent combined
cumulative fix. For more information about applying the latest fix pack, see
WebSphere Portal and Web Content Manager V8.5.0.0 combined cumulative fix|

overviewl

Note: Skip this step, if you have the most recent fix pack applied.

2. Access the Configuration Wizard. Go to http://your_server:10200/ibm/wizard.

3. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924

Select Set Up a Stand-alone Server > Database Transfer.
Provide information about your environment.

Save your configuration settings.

N o oo~

Choose one of the following options:

* Click Download Files to run the steps remotely.

* Click Run All Steps to run the steps locally.

8. Log in to WebSphere Portal to verify that you have a working portal server.

Enabling federated security

After you install your web experience, a default file-based repository is your
available user registry. Depending on your requirements, you might need to enable
a federated LDAP user registry.

About this task

Note: If you set Use Administrator IDs stored in your LDAP user registry to yes,
the WebSphere Application Server and WebSphere Portal user IDs and passwords
are changed to the LDAP user ID and password. If you do not want to change
both user IDs and passwords to match the LDAP user ID and password, set this
value to no. After you configure your LDAP user registry, you can manually
change the user IDs and passwords.

Documentation resource: [“Updating user ID and passwords” on page 1963|

Procedure

1. To get the latest updates for the wizard, apply the most recent combined
cumulative fix. For more information about applying the latest fix pack, see
WebSphere Portal and Web Content Manager V8.5.0.0 combined cumulative fix|

overviewl

Note: Skip this step, if you have the most recent fix pack applied.

2. Access the Configuration Wizard. Go to http://your_server:10200/ibm/wizard.

3. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924
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4. Select Set Up a Stand-alone Server > Enable Federated Security.

Note: If you set Use Administrator IDs stored in your LDAP user registry to
yes, the WebSphere Application Server and WebSphere Portal user IDs and
passwords are changed to the LDAP user ID and password. If you do not want
to change both user IDs and passwords to match the LDAP user ID and
password, set this value to no. After you configure your LDAP user registry,
you can manually change the user IDs and passwords.

Documentation resource: [“Updating user ID and passwords” on page 1963|

5. Provide information about your environment.
6. Save your configuration settings.
7. Choose one of the following options:
* Click Download Files to run the steps remotely.
* Click Run All Steps to run the steps locally.
8. Log in to WebSphere Portal to verify that you have a working portal server.

Tuning the servers in your environment

Tuning the servers is important to the performance of your portal environment.
WebSphere Portal is not tuned for a production environment after installation and
deployment. Your database needs tuning for improved performance. You can
organize your database now or soon after you finish your configuration. You need
to tune and maintain your database on a regular basis.

Procedure

Run the performance tuning tool to complete an initial tuning of your servers.

Documentation resource: [“Portal server performance tuning tool” on page 361

Change to developer mode
Change your stand-alone server to developer mode to improve startup
performance.

About this task
Documentation resources: [“Changing to developer mode” on page 2805

Roadmap: Test or small production environment

A stand-alone server topology is ideal for a test or small production environment.
In this roadmap, the web server, database, and user registry software are
distributed to different physical servers.

Remember: Ensure that you configure the web server plug-in after you transfer
your database.

Who should use this roadmap
Use this roadmap if you are an organization with the following requirements:

* An organization that needs an environment to test their applications and designs
before they go live to the server.

* An organization that does not need a clustered environment for failover or high
availability.

* An organization with limited server resources that wants to set up a department
server or small website.

Chapter 3. Roadmaps 75



Topology diagram

A stand-alone server topology is versatile. It is the foundation for a portal farm,
authoring environment, test or rendering environment, small department-level
deployments, and more. A typical stand-alone portal server topology includes a
remote database and LDAP server. For many environments, it also includes a web
server to direct incoming traffic.

Database
Server

LDAP Server

Web Server WebSphere Portal

Preparing for the installation process
Gather information and software before you install WebSphere Portal.

Procedure
1. Check requirements.

Documentation resource: [Detailed system requirements|
2. Get the software.
Documentation resource: [“Getting the software” on page 174

Installing prerequisites

You can use existing prerequisite software installations. Verify that your existing
version is supported. If it is not, upgrade to the appropriate version. Otherwise,
install a web server, database server, and user registry server. Typically the
database and user registry servers are already installed and configured. However,
there might be specific configuration steps that are required to integrate them with
the portal server.

Procedure
1. Install web server.

Documentation resource: [“Preparing a remote web server” on page 222|

2. Prepare a database server.

Documentation resource: [“Installing and preparing the database software”

3. Prepare a user registry.

Documentation resource: [“Preparing the user registry software” on page 214|
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Installing the Exceptional Digital Experience
Installing WebSphere Portal involves preparing your operating system, installing or
upgrading the installation manager, and running the installation program.

About this task

Documentation resource: [“Installing the digital experience software” on page 223|

Applying the latest cumulative fix

Portal maintenance is delivered through two mechanisms: individual fixes (iFixes)
and combined cumulative fixes. iFixes are provided, when necessary, for severe or
security-related bugs. Combined cumulative fixes are delivered on a regular
schedule. They provide a mechanism to deliver fixes faster, improve existing
features, deliver new features, update documentation, and provide new
documentation on a frequent basis. To deliver continuous improvements for your
digital experience software, it is recommended that you apply the latest combined
cumulative fix to your environment.

About this task

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Setting up a stand-alone server

Start the configuration wizard to set up your stand-alone server. First, transfer
your database. The Database Transfer configuration option in the Configuration
Wizard assigns users and permissions, creates databases, obtains support for
database collation, and transfers your database. After you transfer your database,
enable your federated LDAP user registry.

Before you begin

Log in to WebSphere Portal to verify that you have a working portal:

http://hostname.example.com:10039/wps/portal,

where hostname.example.com is the fully qualified

host name of the server where Portal is running and 10039 is

the default transport port that is created by WebSphere Application Server. The port
number might be different for your environment.

Procedure

1. To get the latest updates for the wizard, apply the most recent combined
cumulative fix. For more information about applying the latest fix pack, see
WebSphere Portal and Web Content Manager V8.5.0.0 combined cumulative
fix overview

Note: Skip this step, if you have the most recent fix pack applied.

2. Access the Configuration Wizard. Go to http://your_server:10200/ibm/
wizard.

3. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924

4. Select Set Up a Stand-alone Server > Database Transfer.

Chapter 3. Roadmaps 77


http://www-10.lotus.com/ldd/portalwiki.nsf/dx/WebSphere_Portal_and_Web_Content_Manager_V8.5.0.0_combined_cumulative_fix_overview_cf8500
http://www-10.lotus.com/ldd/portalwiki.nsf/dx/WebSphere_Portal_and_Web_Content_Manager_V8.5.0.0_combined_cumulative_fix_overview_cf8500

5. Provide information about your environment.

6. Save your configuration settings.

7. Choose one of the following options:
* Click Download Files to run the steps remotely.
* Click Run All Steps to run the steps locally.

8. Optional: If you changed the context root during the installation or
configuration of IBM WebSphere Portal, then you must complete the optional
next step from the Configuration Wizard to update parameters with the new
context path after you complete the Create a Deployment Manager
configuration option. For more information about this configuration option
and completing the next steps, see [Create a deployment manager]

9. Log in to WebSphere Portal to verify that you have a working portal server.
10. Select Set Up a Stand-alone Server > Enable Federated Security.

Note: If you set Use Administrator IDs stored in your LDAP user registry to
yes, the WebSphere Application Server and WebSphere Portal user IDs and
passwords are changed to the LDAP user ID and password. If you do not
want to change both user IDs and passwords to match the LDAP user ID and
password, set this value to no. After you configure your LDAP user registry,
you can manually change the user IDs and passwords.

Documentation resource: [“Updating user ID and passwords” on page 1963|

11. Provide information about your environment.
12. Save your configuration settings.
13. Choose one of the following options:
* Click Download Files to run the steps remotely.
* Click Run All Steps to run the steps locally.
14. Log in to WebSphere Portal to verify that you have a working portal server.

Configuring the web server
Procedure

Move the web server plug-in from the WebSphere Application Server to the web
server.

Documentation resource: [“Web servers” on page 362

Tuning the servers in your environment

Tuning the servers is important to the performance of your portal environment.
WebSphere Portal is not tuned for a production environment after installation and
deployment. Your database needs tuning for improved performance. You can
organize your database now or soon after you finish your configuration. You need
to tune and maintain your database on a regular basis.

Procedure

1. Run the performance tuning tool to complete an initial tuning of your servers.

Documentation resource: [“Portal server performance tuning tool” on page]
2. Check the tuning guide for more instructions. Use the tuning guide for the
previous product version when the tuning guide for the current release is
unavailable.

Documentation resource: [Performance tuning guide|
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Next steps
Depending on the choices that you made during the installation and set up, there

are additional tasks to configure your environment.
The following options are available to continue configuring your environment:

Configure global settings
Documentation resource: [“Configuring portal behavior” on page 368|

Change the default portal Uniform Resource Identifier (URI)

If you changed the context root on the Configuration for IBM WebSphere
Portal: Profile configuration details: Advanced panel during installation:
“Completing the portal URI change started during installation” on page]
483

If you want to change the context root after installation: [“Changing the

fportal URI after an installation” on page 489|

Adapt the attribute configuration to match the LDAP server
Documentation resource: [“Adding more attributes to VMM” on page 715|

Configure syndication
Documentation resource: [“Syndication” on page 595|

Update your user registry
Documentation resource: [“User registry” on page 709|

Configure your search
Documentation resource:

1117

on page 816

Roadmaps for clusters

Clusters topologies provide greater availability and capacity.

Roadmaps for WebSphere Portal Express are also available in IBM
Knowledge Center. For the failover environment roadmap for WebSphere Express,
seqRoadmap: Failover environment]

["Roadmap: Production and delivery environment”]

The production environment represents the servers that incoming web traffic
accesses to experience your digital experience. It does not have to be a cluster.
This environment could multiple clusters, a portal farm, or a stand-alone server,
depending on your business needs. However, this roadmap is based on a
cluster topology. In a cluster, the portals share a common configuration and the
load is distributed evenly across all cluster instances.

Roadmap: Production and delivery environment

The production environment represents the servers that incoming web traffic
accesses to experience your digital experience. It does not have to be a cluster. This
environment could multiple clusters, a portal farm, or a stand-alone server,
depending on your business needs. However, this roadmap is based on a cluster
topology. In a cluster, the portals share a common configuration and the load is
distributed evenly across all cluster instances.

The Configuration Wizard prompts you to select the cluster type, static, or
dynamic. By default, the cluster type is static. A static cluster is a group of
application servers in a IBM WebSphere Application Server Network Deployment
environment that participates in workload management. A dynamic cluster
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monitors performance and load information and is able to dynamically create and
remove cluster members that are based on the workload. You can add extra nodes
to expand the capacity of the dynamic cluster.

Before version 8.5, you were required to install and configure IBM WebSphere
Virtual Enterprise to set up a dynamic cluster. In WebSphere Application Server
V8.5, the virtual enterprise component is integrated with the application server.
Therefore, you do not need to install and configure WebSphere Virtual Enterprise
before you set up a dynamic cluster.

Remember: Ensure that you configure the web server plug-in after you transfer
your database.

Who should use this roadmap

Use this roadmap if you are an organization with the following requirements:

* An organization whose production site requires improved availability and
failover

* An organization whose site experiences random high load situations that might
benefit from dynamic load balancing

* An organization whose website can benefit from other features such as
prioritization, health monitoring, and dynamic operations

* An organization that needs to manage deployments and synchronize various
cluster nodes with a single administrative interface, the deployment manager

Topology diagram

A cluster topology is versatile. You can use it to set up a production environment,
a test environment, and more. The clustered topology diagram includes two
horizontal nodes that are managed in the same cell. The nodes in the cluster use a
common LDAP and database server. A remote search server is depicted too. In a
cluster environment, you must use a remote search server.
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Preparing for the installation process
Gather information and software before you install WebSphere Portal.

Procedure
1. Check requirements.

Documentation resource: [Detailed system requirements|
2. Get the software.
Documentation resource: [“Getting the software” on page 174

Installing prerequisites

You can use existing prerequisite software installations. Verify that your existing
version is supported. If it is not, upgrade to the appropriate version. Otherwise,
install a web server, database server, and user registry server. Typically the
database and user registry servers are already installed and configured. However,
there might be specific configuration steps that are required to integrate them with
the portal server.

Procedure
1. Install web server.

Documentation resource: [“Preparing a remote web server” on page 222|

2. Prepare a database server.

Documentation resource: [“Installing and preparing the database software”

3. Prepare a user registry.
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Documentation resource: [“Preparing the user registry software” on page 214|

Installing the Exceptional Digital Experience
Installing WebSphere Portal involves preparing your operating system, installing or
upgrading the installation manager, and running the installation program.

About this task

Documentation resource: [“Installing the digital experience software” on page 223|

Applying the latest cumulative fix

Portal maintenance is delivered through two mechanisms: individual fixes (iFixes)
and combined cumulative fixes. iFixes are provided, when necessary, for severe or
security-related bugs. Combined cumulative fixes are delivered on a regular
schedule. They provide a mechanism to deliver fixes faster, improve existing
features, deliver new features, update documentation, and provide new
documentation on a frequent basis. To deliver continuous improvements for your
digital experience software, it is recommended that you apply the latest combined
cumulative fix to your environment.

About this task

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Setting up a cluster environment

Start the configuration wizard to set up your clustered environment. First, transfer
your database. Then, create the deployment manager and create a cluster node.
Then, enable your federated LDAP user registry. Finally, create your additional
horizontal cluster nodes using the Configuration Wizard. These instructions are for
a horizontal cluster only. For information on setting up a vertical cluster, see
Setting up a Cluster in the Configuring section of the documentation.

Before you begin

Log in to WebSphere Portal to verify that you have a working portal:

http://hostname.example.com:10039/wps/portal,

where hostname.example.com is the fully qualified

host name of the server where Portal is running and 10039 is

the default transport port that is created by WebSphere Application Server. The port
number might be different for your environment.

Procedure

1. To get the latest updates for the wizard, apply the most recent combined
cumulative fix. For more information about applying the latest fix pack, see
WebSphere Portal and Web Content Manager V8.5.0.0 combined cumulative|

fix overviewl

Note: Skip this step, if you have the most recent fix pack applied.

2. Access the Configuration Wizard. Go to http://your_server:10200/ibm/
wizard.

3. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For

details on the supported languages for all of the WebSphere Portal user
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interfaces, see [“Supported languages” on page 3924

Complete the following steps to transfer your database:

4.

8.

Select Set Up a Cluster > Database Transfer.

Note: The Database Transfer configuration option in the Configuration
Wizard assigns users and permissions, creates databases, obtains support for
database collation, and transfers your database.

Provide information about your environment.

Save your configuration settings.

Choose one of the following options:

* Click Download Files to run the steps remotely.

* Click Run All Steps to run the steps locally.

Log in to WebSphere Portal to verify that you have a working portal server.

Complete the following steps to create your deployment manager:

9.
10.
11.
12.

13.

14.

Select Set Up a Cluster > Create a Deployment Manager.
Provide information about your environment.

Save your configuration settings.

Choose one of the following options:

* Click Download Files to run the steps remotely.

* Click Run All Steps to run the steps locally.

Optional: If you changed the context root during the installation or
configuration of IBM WebSphere Portal, then you must complete the optional
next step from the Configuration Wizard to update parameters with the new
context path after you complete the Create a Deployment Manager
configuration option. For more information about this configuration option
and completing the next steps, see [Create a deployment manager|

Log in to WebSphere Portal to verify that you have a working portal server.

Complete the following steps to create a cluster node:

15.
16.
17.
18.

19.

Select Set Up a Cluster > Create a Cluster.

Provide information about your environment.

Save your configuration settings.

Choose one of the following options:

* Click Download Files to run the steps remotely.

* Click Run All Steps to run the steps locally.

Log in to WebSphere Portal to verify that you have a working portal server.

Complete the following steps to enable federated security:

20.

21.
22.
23.

Set Up a Cluster > Enable Federated Security.

Note: If you set Use Administrator IDs stored in your LDAP user registry to
yes, the WebSphere Application Server and WebSphere Portal user IDs and
passwords are changed to the LDAP user ID and password. If you do not
want to change both user IDs and passwords to match the LDAP user ID and
password, set this value to no. After you configure your LDAP user registry,
you can manually change the user IDs and passwords.

Documentation resource: [“Updating user ID and passwords” on page 1963|

Provide information about your environment.
Save your configuration settings.
Choose one of the following options:

* Click Download Files to run the steps remotely.
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* Click Run All Steps to run the steps locally.

24. Log in to WebSphere Portal to verify that you have a working portal server.
Complete the following steps to create extra cluster nodes:
25. Install WebSphere Portal on the additional node.

Documentation resource: [“Installing the digital experience software” on page|

Tip: For additional nodes, you only need to install the WebSphere Portal
product binary files. Therefore, on the Features screen of the IBM Installation
Manager, ensure that Portal Server Profile is not selected.

26. Set Up a Cluster > Create an Additional Cluster Node.

Note: If you are setting up a vertical cluster, manual instructions are available
for dynamic and static cluster configurations. For more information, see
“Adding vertical cluster members to a static cluster” on page 356| or [“Adding]|
vertical cluster members to a dynamic cluster” on page 358

27. Provide information about your environment.
28. Save your configuration settings.
29. Choose one of the following options:
* Click Download Files to run the steps remotely.
* Click Run All Steps to run the steps locally.
30. Log in to WebSphere Portal to verify that you have a working portal server.

Configuring the web server
Procedure

Move the web server plug-in from the WebSphere Application Server to the web
server.

Documentation resource: [“Web servers” on page 362|

Tuning the servers in your environment

Tuning the servers is important to the performance of your portal environment.
WebSphere Portal is not tuned for a production environment after installation and
deployment. Your database needs tuning for improved performance. You can
organize your database now or soon after you finish your configuration. You need
to tune and maintain your database on a regular basis.

Procedure

1. Run the performance tuning tool to complete an initial tuning of your servers.

Documentation resource: [“Portal server performance tuning tool” on page
-361

2. Check the tuning guide for more instructions. Use the tuning guide for the
previous product version when the tuning guide for the current release is
unavailable.

Documentation resource: [Performance tuning guidel

Configuring a remote search service
Configure the remote search service to offload and balance system load.

Procedure
1. Use the IBM Installation Manager to install the remote search service.
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Documentation resource: [“Installing remote search service by using IBM|
[[nstallation Manager” on page 795|

2. If you use single-sign on, prepare the security for the remote search service.

[Preparing security for remote search service in a single-sign on domain|

3. Configure the security between portal and the remote search server.

Documentation resource: [Configuring security between WebSphere Portall
[and remote search server|

4. Set the search user ID.

Documentation resource: [“Setting the search user ID” on page 803|

5. Configure the remote search service.

Documentation resource: [“Configuring a remote search service” on page 805

6. Configure the seedlist servlet.

Documentation resource: [“Configuring HTTP for the seedlist servlet” on|

Next steps
Depending on the choices that you made during the installation and set up, there
are additional tasks to configure your environment.

The following options are available to continue configuring your environment:

Configure global settings
Documentation resource: [“Configuring portal behavior” on page 368|

Change the default portal Uniform Resource Identifier (URI)

If you changed the context root on the Configuration for IBM WebSphere
Portal: Profile configuration details: Advanced panel during installation:
“Completing the portal URI change started during installation” on page]
483

If you want to change the context root after installation: [“Changing the

fportal URI after an installation” on page 489|

Adapt the attribute configuration to match the LDAP server
Documentation resource: [“Adding more attributes to VMM” on page 715|

Configure syndication
Documentation resource: [“Syndication” on page 595|

Add vertical cluster members
Documentation resource: [“Setting up a cluster” on page 348|

Configure search
Documentation resource: [“Configuring search in a cluster” on page 811]

Update your user registry
Documentation resource: [“User registry” on page 709|

Roadmaps for advanced configurations
Multiple clusters and portal farms are advanced configurations.

[“Roadmap: Multiple clusters” on page 86|
Add a IBM WebSphere Portal cluster to an existing cluster.

[“Roadmap: Portal farm” on page 97

The term "farm" refers to a series of identically configured, stand-alone server
instances. The stand-alone servers allow the farm to be increased or decreased
without having to worry about complex cluster configurations or inter-server
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awareness. Server farms offer a simple way to build and maintain a highly
scalable, highly available server environment.

Roadmap: Multiple clusters
Add a IBM WebSphere Portal cluster to an existing cluster.

Read [‘Planning for multiple clusters” on page 166 before you start to create your
multiple clusters.

Remember: Ensure that you configure the web server plug-in after you transfer
your database.

Who should use this roadmap
Use this roadmap if you are an organization with the following requirements:

* An organization that has an existing cluster and needs to add more clusters to
the existing one.

* An organization that wants to manage many application servers and clusters
within a single administrative domain or cell.

* An organization that wants to manage multiple portals and portal-based
products within the same managed cell.

Topology diagram

The multiple cluster topology depicts two portal clusters that share a cell. One
deployment manager manages the cell. Each cluster has an individual database for
the JCR and Release portal database domains. The clusters share a common
database server that has the Community, Customization, Likeminds, and Feedback
portal database domains. The clusters also share an LDAP server and a remote
search server. There is a search collection for each cluster, but the collections are
co-located on a single server.

Note: The release and JCR databases are separate. Therefore, apply maintenance
and application updates, including updates to portlet preferences, separately to
each cluster.

A network load balance directs incoming traffic between the two web servers. Each

cluster has a web server. However, a single on-demand router might be used
instead.
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Preparing for the installation process
Gather information and software before you install WebSphere Portal.

Procedure
1. Check requirements.

Documentation resource: [Detailed system requirements|
2. Get the software.
Documentation resource: [“Getting the software” on page 174

Installing prerequisites

You can use existing prerequisite software installations. Verify that your existing
version is supported. If it is not, upgrade to the appropriate version. Otherwise,
install a web server, database server, and user registry server. Typically the
database and user registry servers are already installed and configured. However,
there might be specific configuration steps that are required to integrate them with
the portal server.

Procedure
1. Install web server.

Documentation resource: [“Preparing a remote web server” on page 222|

2. Prepare a database server.

Documentation resource: [“Installing and preparing the database software”

3. Prepare a user registry.

Documentation resource: [“Preparing the user registry software” on page 214|

Installing the Exceptional Digital Experience
Installing WebSphere Portal involves preparing your operating system, installing or
upgrading the installation manager, and running the installation program.
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About this task

Documentation resource: [“Installing the digital experience software” on page 223|

Applying the latest cumulative fix

Portal maintenance is delivered through two mechanisms: individual fixes (iFixes)
and combined cumulative fixes. iFixes are provided, when necessary, for severe or
security-related bugs. Combined cumulative fixes are delivered on a regular
schedule. They provide a mechanism to deliver fixes faster, improve existing
features, deliver new features, update documentation, and provide new
documentation on a frequent basis. To deliver continuous improvements for your
digital experience software, it is recommended that you apply the latest combined
cumulative fix to your environment.

About this task

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Creating cluster A

Create your first cluster, including the database transfer, augmenting the
Deployment Manager, creating a cluster node, enabling security, and creating
additional horizontal cluster nodes. These instructions are for a horizontal cluster
only. For information on setting up a vertical cluster, see Setting up a Cluster in the
Configuring section of the documentation.

Before you begin

Log in to WebSphere Portal to verify that you have a working portal:

http://hostname.example.com:10039/wps/portal,

where hostname.example.com is the fully qualified

host name of the server where Portal is running and 10039 is

the default transport port that is created by WebSphere Application Server. The port
number might be different for your environment.

Procedure

1. To get the latest updates for the wizard, apply the most recent combined
cumulative fix. For more information about applying the latest fix pack, see
WebSphere Portal and Web Content Manager V8.5.0.0 combined cumulative|

fix overviewl

Note: Skip this step, if you have the most recent fix pack applied.

2. Access the Configuration Wizard. Go to http://your_server:10200/ibm/
wizard.

3. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924

4. Select Set Up a Cluster > Database Transfer.

Note: The Database Transfer configuration option in the Configuration
Wizard assigns users and permissions, creates databases, obtains support for
database collation, and transfers your database.
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5.

10.
11.
12.

13.

14.
15.
16.
17.
18.

19.
20.

Provide information about your environment.

Attention: Record your database settings so that you can use the same
information when you create Portal B. If cluster A exists, upgrade it to match
Portal B.

Important: Maintain the same number of data sources with identical names to
the Cluster A data sources. Then, the data source bindings in the applications
can be resolved on every cluster. If you share databases across the clusters,
this statement refers to both the shared and non-shared domains. All domains
must use the same names. For example, if Cluster A uses relDS comDS custDS
jerDS fbkDS 1mDS, then Cluster B must also use six data sources with the
same names. Cluster B cannot be configured to use a single data source. An
enterprise application that is shared between cluster contains only a single
binding to a single data source name. An application cannot contain a binding
to multiple data source names. If the data source names are the same and the
user ID and password are the same, then the extra aliases are not required.
The binding in the application resolves to the data source for both clusters
because the name is the same and the user ID and password is the same.

Save your configuration settings.

Choose one of the following options:

* Click Download Files to run the steps remotely.

* Click Run All Steps to run the steps locally.

Log in to WebSphere Portal to verify that you have a working portal server.
Select Set Up a Cluster > Create a Deployment Manager.
Provide information about your environment.

Save your configuration settings.

Choose one of the following options:

* Click Download Files to run the steps remotely.

* Click Run All Steps to run the steps locally.

Optional: If you changed the context root during the installation or
configuration of IBM WebSphere Portal, then you must complete the optional
next step from the Configuration Wizard to update parameters with the new
context path after you complete the Create a Deployment Manager
configuration option. For more information about this configuration option
and completing the next steps, see [Create a deployment manager]

Log in to WebSphere Portal to verify that you have a working portal server.
Select Set Up a Cluster > Create a Cluster.

Provide information about your environment.

Save your configuration settings.

Choose one of the following options:

* Click Download Files to run the steps remotely.

* Click Run All Steps to run the steps locally.

Log in to WebSphere Portal to verify that you have a working portal server.
Set Up a Cluster > Enable Federated Security.

Note: If you set Use Administrator IDs stored in your LDAP user registry to
yes, the WebSphere Application Server and WebSphere Portal user IDs and
passwords are changed to the LDAP user ID and password. If you do not
want to change both user IDs and passwords to match the LDAP user ID and
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password, set this value to no. After you configure your LDAP user registry,
you can manually change the user IDs and passwords.

Documentation resource: [“Updating user ID and passwords” on page 1963

21. Provide information about your environment.
22. Save your configuration settings.
23. Choose one of the following options:
* Click Download Files to run the steps remotely.
* Click Run All Steps to run the steps locally.
24. Log in to WebSphere Portal to verify that you have a working portal server.
25. Install WebSphere Portal on the additional node.

Documentation resource: [“Installing the digital experience software” on page

Tip: For additional nodes, you only need to install the WebSphere Portal
product binary files. Therefore, on the Features screen of the IBM Installation
Manager, ensure that Portal Server Profile is not selected.

26. Set Up a Cluster > Create an Additional Cluster Node.

Note: If you are setting up a vertical cluster, manual instructions are available
for dynamic and static cluster configurations. For more information, see

“ Adding vertical cluster members to a static cluster” on page 356| or [“Adding]
vertical cluster members to a dynamic cluster” on page 358

27. Provide information about your environment.
28. Save your configuration settings.
29. Choose one of the following options:
* Click Download Files to run the steps remotely.
* Click Run All Steps to run the steps locally.
30. Log in to WebSphere Portal to verify that you have a working portal server.

Configuring portal B
Install WebSphere Portal. Then, use the Configuration Wizard to deploy a
stand-alone portal.

Before you begin

Log in to WebSphere Portal to verify that you have a working portal:

http://hostname.example.com:10039/wps/portal,

where hostname.example.com is the fully qualified

host name of the server where Portal is running and 10039 is

the default transport port that is created by WebSphere Application Server. The port
number might be different for your environment.

Procedure
1. Access the Configuration Wizard. Go to http://your_server:10200/ibm/
wizard.

2. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924
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Select Set Up a Stand-alone Server > Database Transfer.
Provide information about your environment.

Important: Maintain the same number of data sources with identical names to
the Cluster A data sources. Therefore, the data source bindings in the
applications can be resolved on every cluster. If you share databases across the
clusters, this statement refers to both the shared and non-shared domains. All
domains must use the same names.

Save your configuration settings.

Choose one of the following options:

* Click Download Files to run the steps remotely.

* Click Run All Steps to run the steps locally.

Log in to WebSphere Portal to verify that you have a working portal server.
Select Set Up a Stand-alone Server > Enable Federated Security.

Note: If you set Use Administrator IDs stored in your LDAP user registry to
yes, the WebSphere Application Server and WebSphere Portal user IDs and
passwords are changed to the LDAP user ID and password. If you do not
want to change both user IDs and passwords to match the LDAP user ID and
password, set this value to no. After you configure your LDAP user registry,
you can manually change the user IDs and passwords.

Documentation resource: [“Updating user ID and passwords” on page 1963|

Provide information about your environment.

Save your configuration settings.

Choose one of the following options:

* Click Download Files to run the steps remotely.

* Click Run All Steps to run the steps locally.

Log in to WebSphere Portal to verify that you have a working portal server.

Configuring the multiple cluster
After you create cluster A and portal B, run the various tasks to create the multiple
cluster.

Procedure

1.

Optional: Complete the following steps on the primary node of Cluster A:

Use the same database user ID and password for each identically named
domain or data source. It allows the existing JAAS Authentication Aliases to
be functional. If a unique database user ID and password are required, more
manual configuration is required to create and map JAAS Authentication
Aliases for each data source.

a. Open a command prompt.
b. Change to the ConfigEngine directory.
C. Run the following task to create the JAAS Authentication Aliases:

+ AIX® HP-UX Linux Solaris: ./ConfigEngine.sh create-alias-multiple-
cluster -DauthDomainList=release,jcr -DWasPassword=dmgr_password

e IBM i: ConfigEngine.sh create-alias-multiple-cluster
-DauthDomainList=release,jcr -DWasPassword=dmgr password

* Windows: ConfigEngine.bat create-alias-multiple-cluster
-DauthDomainList=release,jcr -DWasPassword=dmgr password
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Where authDomainList is set to a list of domains that use unique database
user ID and passwords. The domain properties are set correctly in the
wkplc_dbdomain.properties file, including user ID and password.

2. Optional: If necessary, upgrade Portal B to the current fix pack.
3. Complete the following steps to create an inventory list of Portal B enterprise

applications and portlets:

a. Open a command prompt on Portal B.

b. Change to the ConﬁgEngine directory.
C. Run the following task to create the list:

* AIX HP-UX Linux Solaris: ./ConfigEngine.sh mapped-app-list-create
-DWasPassword=password

* IBM i: ConfigEngine.sh mapped-app-list-create
-DWasPassword=password

* Windows: ConfigEngine.bat mapped-app-Tist-create
-DWasPassword=password

. Run the following command from the b1' n directory to federate

Portal B:

./addNode.sh dmgr_hostname dmgr_port -includeapps
-username was_admin_user
-password was_admin_password

addNode.sh dmgr_hostname dmgr_port -includeapps
-username was_admin_user
-password was_admin_password

addNode.bat dmgr_hostname dmgr_port -includeapps
-username was_admin_user
-password was_admin_password

The variables are defined as:

* dmgr_hostname is the TCP/IP host name of the Deployment Manager server

* dmgr_port is the SOAP port number of the Deployment Manager server

* was_admin_user and was_admin_password are the user ID and password for
the Deployment Manager administrator

If the WebSphere Application Server administrator user ID and password are
different from the Deployment Manager values, add the following parameters
to the addNode task:

* -localusername local was_admin_user
* -localpassword local_was_admin_password

Tip: Read addNode command| for information about the addNode command
and other optional parameters.

Warning: If the addNode task fails for any reason, you must complete the
following steps before you rerun the task:

a. Remove the node if the AddNode task succeeded in creating the node.

b. If the items exist, log on to the deployment manager and complete the
following steps:

1) Remove the WebSphere_Portal server definition.
2) Remove the WebSphere Portal JDBC Provider.

. Stop the WebSphere_Portal server on the primary node of Cluster B and

ensure that the following parameters are set correctly in the wkplc.properties
file:


http://publib.boulder.ibm.com/infocenter/wasinfo/v8r0/index.jsp?topic=/com.ibm.websphere.nd.multiplatform.doc/info/ae/ae/rxml_addnode.html

Note: You can add these parameters (particularly passwords) directly to any
task. However, you might want to temporarily add them to the properties file.
You can then remove them when you are finished to keep your environment
secure.

a. Set WasSoapPort to the port used to connect remotely to the deployment
manager.

b. Set WasRemoteHostName to the full host name of the server that is used to
remotely connect to the deployment manager.

C. Verify that WasUserid is set to your Deployment Manager administrator
user ID.

d. Verify that WasPassword is set to your Deployment Manager administrator
password.

e. Verify that PortalAdminPwd is set to your WebSphere Portal administrator
password.

f. Verify that ClusterName is set.
g. Verify that PrimaryNode is set to true.

. Run the following task to determine which applications from the inventory
list are no longer mapped to Portal B. The task uses the application profiles in
the cell to restore the mappings. Wait 30 minutes after you run this task to
allow all EAR files to expand before you proceed to the next step.

* AIX HP-UX Linux Solaris: ./ConfigEngine.sh map-apps-to-server
-DWasPassword=password

* IBM i: ConfigEngine.sh map-apps-to-server -DWasPassword=password

* Windows: ConfigEngine.bat map-apps-to-server -DWasPassword=password

. Ensure that all database parameters are correctly set, including passwords, in

the wkplc_comp.properties and wkplc_dbtype.properties files on Portal B.

. Run the following task on Portal B:

* AIX HP-UX Linux Solaris: ./ConfigEngine.sh cluster-node-config-post-
federation -DWasPassword=password

e IBM i: ConfigEngine.sh cluster-node-config-post-federation
-DWasPassword=password

* Windows: ConfigEngine.bat cluster-node-config-post-federation
-DWasPassword=password

. The WebSphere Portal node is federated. It uses the Deployment Manager cell
and its user registry. If the administrative user ID and group name are
different between WebSphere Portal and Deployment Manager, choose one of
the following options:

* Add the existing administrative user ID and group to the Deployment
Manager security configuration

* Complete the following steps to change the values in the WebSphere Portal
configuration to match the Deployment Manager values:

a. If necessary, start the WebSphere_Portal server.

b. Verify that the required WebSphere Portal administrative user ID and
group ID are defined in the Deployment Manager user registry that
provides security.

c. Run the following task:

* AIX HP-UX Linux Solaris: ./ConfigEngine.sh wp-change-portal-admin-
user -DWasPassword=password -DnewAdminld=newadminid
-DnewAdminPw=newpassword -DnewAdminGroupld=newadmingroupid
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* IBM i: ConfigEngine.sh wp-change-portal-admin-user
-DWasPassword=password -DnewAdminld=newadminid
-DnewAdminPw=newpassword -DnewAdminGroupld=newadmingroupid

* Windows: ConfigEngine.bat wp-change-portal-admin-user
-DWasPassword=password -DnewAdminld=newadminid
-DnewAdminPw=newpassword -DnewAdminGroupld=newadmingroupid

Where:

* WasPassword is set to the administrative password for the Deployment
Manager cell

* newAdminId is set to the fully qualified distinguished name (DN) of the
WebSphere Portal administrative user ID in the cell

* newAdminGroupId is set to the fully qualified DN of the group for the
WebSphere Portal administrative user ID in the cell

Important: If the value for newAdminGroupId contains a space; for
example, Software Group, open the wkplc.properties file. Add the
values for newAdminId, newAdminPw, and newAdminGroupId. Save your
changes and then run the wp-change-portal-admin-user task.

d. After the task completes, stop the WebSphere_Portal server.

Complete the following steps from the WebSphere Integrated Solutions
Console on Portal B:

a. Log on to WebSphere Integrated Solutions Console.

b. Click System Administration > Node Agents.

C. Check the box next to the required node agent and then click Restart.
Stop and restart the deployment manager.

Stop and restart the WebSphere_Portal server on Portal B.

Restart the WebSphere_Portal server on Cluster A. Verify that Cluster A is
functionally intact; check pages and portlets. Verify that Portal B is
functionally intact; check the pages and portlets that you deployed into Portal
B before it was federated. Any discrepancies or errors must be corrected
before you continue.

Note: If Portal B has an administrative ID other than wpsadmin, the server is
not functional. It is functional after the cluster is complete and the
administrative ID is configured to match the security settings.

Choose one of the following options to define a cluster with Portal B as the
basis:

* Complete the following steps to define a static cluster:
— Run the following task:

- AIX HP-UX Linux Solaris: ./ConfigEngine.sh cluster-node-config-
cluster-setup -DWasPassword=dmgr_password

- IBM i: ConfigEngine.sh cluster-node-config-cluster-setup
-DWasPassword=dmgr_password

- Windows: ConfigEngine.bat cluster-node-config-cluster-setup
-DWasPassword=dmgr password

— Configure the cluster to use an external web server to take advantage of
features such as workload management. Go to [Configuring a web server]
land an application server on separate machines (remote)| for information.

Note: Start with the step about starting the plug-ins installation wizard.
* Complete the following steps to define a dynamic cluster:


http://www-01.ibm.com/support/knowledgecenter/SSEQTP_8.5.5/com.ibm.websphere.base.doc/ae/tins_webplugins_remotesa.html
http://www-01.ibm.com/support/knowledgecenter/SSEQTP_8.5.5/com.ibm.websphere.base.doc/ae/tins_webplugins_remotesa.html

Log on to the deployment manager WebSphere Integrated Solutions
Console.

Complete the following steps to create a node group:

Click System administration > Node groups.
Click New.
Type the node group Name.

Type any information about the node group in the Description text
box.

Click OK.
Click the Save link to save your changes to the master configuration.

Complete the following steps to add members to the node group:

Click System administration > >Node groups.

Click the name of the node group that you want to add members to.
Click Node group members under Additional Properties.

Click Add.

Select the primary node and then click Add.

Click the Save link to save your changes to the master configuration.

Complete the following steps to create a dynamic cluster in the node
group:

Click Servers > Clusters > Dynamic clusters.
Click New.

Select WebSphere Application Server from the Server Type menu and
then click Next.

Select Automatically define cluster members with rules.

Type the cluster name in the Dynamic cluster name text box. Then,
click Next. Type the same value that you provided for the ClusterName
parameter in the wkplc.properties file of your primary node.

Remove all default membership policies and then click Subexpression
builder.

Enter the following information in the Subexpression builder window:
* Select and from the Logical operator menu.

* Select Nodegroup from the Select operand menu.

* Select Equals (=) from the Operator menu.

* Type the node group name that you created in the previous step in
the Value text box.

* Click Generate subexpression.
* Click Append.

Click Preview membership to verify that all nodes included in the
node group display and then click Next.

Click Create the cluster member using an existing server as a
template and then select the primary node WebSphere_Portal server.

Click Next.

Specify the dynamic cluster properties for the minimum and
maximum number of server instances.

Review the summary page to verify your actions and then click
Finish.

Run the following task to create the dynamic cluster:
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* AIX HP-UX Linux Solaris: ./ConfigEngine.sh cluster-node-config-
dynamic-cluster-setup -DWasPassword=dmgr_password

* IBM i: ConfigEngine.sh cluster-node-config-dynamic-cluster-
setup -DWasPassword=dmgr password
* Windows: ConfigEngine.bat cluster-node-config-dynamic-
cluster-setup -DWasPassword=dmgr_password
15. Complete the following steps to access the Web Content Manager content
through an external web server:
a. Log on to the deployment manager WebSphere Integrated Solutions
Console.
b. Select Environment > WebSphere Variables.
c. From the Scope menu, select the Node=nodename, Server=servername

option to narrow the scope of the listed variables. Node=nodename is the
node that contains the WebSphere Portal application server.

d. Update the WCM_HOST variable with the fully qualified host name that is
used to access the WebSphere Portal server through the web server or On
Demand Router.

e. Update the WCM_PORT variable with the port number used to access the
WebSphere Portal server through the web server or On Demand Router.

f. Update the WCM_HOST and WCM_PORT variable for each additional WebSphere
Portal application server that exists in the cluster.

g. Synchronize the node with the deployment manager.

>

. Save your changes and then restart the deployment manager, the node
agents, and the WebSphere_Portal servers.

16. Install any additional nodes for Cluster B. Then, federate them as secondary
nodes and define them as cluster members on these nodes. You can add more
nodes to a static or dynamic cluster. You can also add more vertical cluster
members to an existing node in a static or dynamic cluster to provide vertical
scaling.

17. Restart the WebSphere_Portal server on Cluster A and Cluster B.

18. After you set up your multiple clusters, complete the extra tasks to ensure a
balanced workload and failover support.

* Update the web server configuration to enable user requests to be routed to
the new cluster. Refer to your web server documentation for information
about using a web server with multiple clusters in a cell.

* Update your database configuration to share database domains between
clusters. Refer to [“Database sharing between multiple clusters” on page 168|
for information about redundancy and failover support.

19. If you entered passwords in any of the properties files when you created your
cluster, remove them for security purposes. Refer to|‘Deleting passwords from|
[properties files” on page 1962 for information.

Results

Deployment of Cluster B is complete. It is now an independent cluster from
Cluster A, which means that Cluster B can have its own configuration, set of user
portlets, and target community. Any applications that are common between Cluster
A and Cluster B are most likely infrastructure or related to administration. Special
care must be taken to preserve their commonality between clusters and correct
maintenance levels.
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Configuring the web server
Procedure

Move the web server plug-in from the WebSphere Application Server to the web
server.

Documentation resource: [“Web servers” on page 362|

Tuning the servers in your environment

Tuning the servers is important to the performance of your portal environment.
WebSphere Portal is not tuned for a production environment after installation and
deployment. Your database needs tuning for improved performance. You can
organize your database now or soon after you finish your configuration. You need
to tune and maintain your database on a regular basis.

Procedure

1. Run the performance tuning tool to complete an initial tuning of your servers.

Documentation resource: [“Portal server performance tuning tool” on page]
2. Check the tuning guide for more instructions. Use the tuning guide for the
previous product version when the tuning guide for the current release is
unavailable.

Documentation resource: [Performance tuning guide]

Configuring a remote search service
Configure the remote search service to offload and balance system load.

Procedure
1. Use the IBM Installation Manager to install the remote search service.

Documentation resource: [“Installing remote search service by using IBM|
[nstallation Manager” on page 795|

2. If you use single-sign on, prepare the security for the remote search service.

[Preparing security for remote search service in a single-sign on domain|

3. Configure the security between portal and the remote search server.

Documentation resource: [Configuring security between WebSphere Portal|
land remote search server|

4. Set the search user ID.

Documentation resource: [“Setting the search user ID” on page 803|

5. Configure the remote search service.

Documentation resource: [“Configuring a remote search service” on page 805|

6. Configure the seedlist servlet.

Documentation resource: [“Configuring HTTP for the seedlist servlet” onl|

Roadmap: Portal farm

The term "farm" refers to a series of identically configured, stand-alone server
instances. The stand-alone servers allow the farm to be increased or decreased
without having to worry about complex cluster configurations or inter-server
awareness. Server farms offer a simple way to build and maintain a highly
scalable, highly available server environment.

Remember: Ensure that you configure the web server plug-in after you transfer
your database.
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Who should use this roadmap
Use this roadmap if you are an organization with the following requirements:

* An organization that requires a simple way to build and maintain a highly
scalable, highly available server environment

* An organization that requires an elastic environment where servers can be
added or removed dynamically without much effort

* An organization that does not want to depend on a Deployment Manager for
deployments

Topology diagram

The topology includes a network load balancer to direct incoming traffic to the
farm. Each stand-alone server has a database for JCR and Release domains. The
JCR and Release domain cannot be shared between portal servers in a farm.
However, the Community, Customization, Likeminds, and Feedback portal
database domains can be shared. The share portal database domains are depicted
on a common database server.

Network
Load
Balancer

WebSphere WebSphere WebSphere WebSphere
Portal Portal Portal Portal

Community, Customization,
Likeminds, and Feedback
Domains

Preparing for the installation process
Gather information and software before you install WebSphere Portal.

Procedure
1. Check requirements.

Documentation resource: [Detailed system requirements|
2. Get the software.

Documentation resource: [“Getting the software” on page 174
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Installing prerequisites

You can use existing prerequisite software installations. Verify that your existing
version is supported. If it is not, upgrade to the appropriate version. Otherwise,
install a web server, database server, and user registry server. Typically the
database and user registry servers are already installed and configured. However,
there might be specific configuration steps that are required to integrate them with
the portal server.

Procedure
1. Install web server.

Documentation resource: [“Preparing a remote web server” on page 222|

2. Prepare a database server.

Documentation resource: [“Installing and preparing the database software”

3. Prepare a user registry.

Documentation resource: [“Preparing the user registry software” on page 214|

Installing the Exceptional Digital Experience
Installing WebSphere Portal involves preparing your operating system, installing or
upgrading the installation manager, and running the installation program.

About this task

Documentation resource: [“Installing the digital experience software” on page 223|

Applying the latest cumulative fix

Portal maintenance is delivered through two mechanisms: individual fixes (iFixes)
and combined cumulative fixes. iFixes are provided, when necessary, for severe or
security-related bugs. Combined cumulative fixes are delivered on a regular
schedule. They provide a mechanism to deliver fixes faster, improve existing
features, deliver new features, update documentation, and provide new
documentation on a frequent basis. To deliver continuous improvements for your
digital experience software, it is recommended that you apply the latest combined
cumulative fix to your environment.

About this task

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Setting up a stand-alone server

Start the configuration wizard to set up your stand-alone server. First, transfer
your database. The Database Transfer configuration option in the Configuration
Wizard assigns users and permissions, creates databases, obtains support for
database collation, and transfers your database. After you transfer your database,
enable your federated LDAP user registry.

Before you begin

Log in to WebSphere Portal to verify that you have a working portal:

http://hostname.example.com:10039/wps/portal,

where hostname.example.com is the fully qualified

host name of the server where Portal is running and 10039 is

the default transport port that is created by WebSphere Application Server. The port
number might be different for your environment.
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Procedure

1. To get the latest updates for the wizard, apply the most recent combined
cumulative fix. For more information about applying the latest fix pack, see
WebSphere Portal and Web Content Manager V8.5.0.0 combined cumulative|
fix overview

Note: Skip this step, if you have the most recent fix pack applied.

2. Access the Configuration Wizard. Go to http://your_server:10200/ibm/
wizard.

3. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924

Select Set Up a Stand-alone Server > Database Transfer.
Provide information about your environment.
Save your configuration settings.

No o~

Choose one of the following options:
* Click Download Files to run the steps remotely.
* Click Run All Steps to run the steps locally.

8. Optional: If you changed the context root during the installation or
configuration of IBM WebSphere Portal, then you must complete the optional
next step from the Configuration Wizard to update parameters with the new
context path after you complete the Create a Deployment Manager
configuration option. For more information about this configuration option
and completing the next steps, see [Create a deployment manager|

9. Log in to WebSphere Portal to verify that you have a working portal server.
10. Select Set Up a Stand-alone Server > Enable Federated Security.

Note: If you set Use Administrator IDs stored in your LDAP user registry to
yes, the WebSphere Application Server and WebSphere Portal user IDs and
passwords are changed to the LDAP user ID and password. If you do not
want to change both user IDs and passwords to match the LDAP user ID and
password, set this value to no. After you configure your LDAP user registry,
you can manually change the user IDs and passwords.

Documentation resource: [“Updating user ID and passwords” on page 1963|

11. Provide information about your environment.
12. Save your configuration settings.
13. Choose one of the following options:
* Click Download Files to run the steps remotely.
* Click Run All Steps to run the steps locally.
14. Log in to WebSphere Portal to verify that you have a working portal server.

Configuring the web server
Procedure

Move the web server plug-in from the WebSphere Application Server to the web
server.

Documentation resource: [“Web servers” on page 362|
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Tuning the servers in your environment

Tuning the servers is important to the performance of your portal environment.
WebSphere Portal is not tuned for a production environment after installation and
deployment. Your database needs tuning for improved performance. You can
organize your database now or soon after you finish your configuration. You need
to tune and maintain your database on a regular basis.

Procedure

1. Run the performance tuning tool to complete an initial tuning of your servers.

Documentation resource: [“Portal server performance tuning tool” on page
2. Check the tuning guide for more instructions. Use the tuning guide for the
previous product version when the tuning guide for the current release is
unavailable.

Documentation resource: [Performance tuning guide|

Choosing the type of portal farm

You can choose from two supported portal farm configurations when you set up
your portal farm. You can set up a unique installation where each farm has a
unique installation or you can set up one instance that is shared between multiple
farm instances.

Procedure

* Configure a farm instance with unique installations.

Documentation resource: [“Setting up farm instances as unique installations”|
on page 523

* Configure a farm instance with a shared configuration.

Documentation resource: [“Setting up farm instances with a shared|
[configuration” on page 512

Configuring an HTTP server
Use a web server to handle load balancing across your portal farm.

Procedure

Set up the HTTP server plug-in on the portal farm.

Documentation resource: [“Setting up the HTTP server plug-in on a portal farm”|

Configuring remote and JCR search
WebSphere Portal provides two distinct search capabilities. You can use both types
of search capabilities in a portal farm environment.

Procedure

1. Configure a remote search.

Documentation resource: [“Configuring a remote Search in a portal farm” on|
page 813

2. Configure a JCR search.

Documentation resource: [“Configuring JCR search in a portal farm” on page]
-814
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Roadmap: Web content servers

A web content server is ideal to create presentation templates, content components,
and other presentation elements of your website. In this roadmap, the web server,
database, and user registry software are distributed to different physical servers.

Who should use this roadmap
Use this roadmap if you are an organization with the following requirements:
* An organization that needs an environment to create and test your web content
before they publish to other staging or production servers

* An organization that needs to create presentation templates (Authoring or
Presentation) for content authors and content rendering

* An organization that needs to create the site structure and entitlements

* An organization that needs to develop content with HTML, CSS, JavaScript, JSP,
or Java.

* An organization needs a staging server to perform final quality tests before
publishing.

* An organization needs a server to publish content to end users.

Important: Developing or publishing web content requires a supported database
other than Apache Server. An Apache Server database is available after installation.
Therefore, you must transfer to a supported database; for example DB2® or Oracle.

Topology diagram

The topology for a web content server includes a remote database and LDAP
server. The topology depicts an IBM Web Content Manager server, instead of a
portal server. When you install IBM WebSphere Portal, it includes Web Content
Manager. The configuration steps for the web content development server are
different from a basic stand-alone server. The web content server configuration
includes syndication with the rendering or test server.

Database
Server

LDAP Server

IEM Web
Content Manager

Preparing for the installation process

Gather information and software before you install WebSphere Portal.
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Procedure
1. Check requirements.

Documentation resource: [Detailed system requirements|
2. Get the software.
Documentation resource: [“Getting the software” on page 174

Installing prerequisites

Before you install WebSphere Portal, install any prerequisites that are necessary for
your environment. You can use existing prerequisite software installations. Verify
that your existing version is supported. If it does not, upgrade to the appropriate
version.

Procedure

1. Prepare a database server.

Documentation resource: [“Installing and preparing the database software”

2. Prepare a user registry.

Documentation resource: [“Preparing the user registry software” on page 214

Installing the Exceptional Digital Experience

Installing WebSphere Portal involves preparing your operating system, installing or
upgrading the installation manager, and running the installation program.

About this task

Documentation resource: [“Installing the digital experience software” on page 223|

Applying the latest cumulative fix

Portal maintenance is delivered through two mechanisms: individual fixes (iFixes)
and combined cumulative fixes. iFixes are provided, when necessary, for severe or
security-related bugs. Combined cumulative fixes are delivered on a regular
schedule. They provide a mechanism to deliver fixes faster, improve existing
features, deliver new features, update documentation, and provide new
documentation on a frequent basis. To deliver continuous improvements for your
digital experience software, it is recommended that you apply the latest combined
cumulative fix to your environment.

About this task

Documentation resource: [“Roadmap: Applying maintenance” on page 106|

Transferring your database

After you install your web experience, Apache Server is your available database.
Depending on your requirements, you might need to transfer to a different
database. The Database Transfer configuration option in the Configuration Wizard
assigns users and permissions, creates databases, obtains support for database
collation, and transfers your database.

Before you begin

Log in to WebSphere Portal to verify that you have a working portal:

Chapter 3. Roadmaps 103


http://www-01.ibm.com/support/docview.wss?uid=swg27007791

http://hostname.example.com:10039/wps/portal,

where hostname.example.com is the fully qualified

host name of the server where Portal is running and 10039 is

the default transport port that is created by WebSphere Application Server. The port
number might be different for your environment.

Procedure

1. To get the latest updates for the wizard, apply the most recent combined
cumulative fix. For more information about applying the latest fix pack, see
WebSphere Portal and Web Content Manager V8.5.0.0 combined cumulative fix|

overviewl

Note: Skip this step, if you have the most recent fix pack applied.

2. Access the Configuration Wizard. Go to http://your_server:10200/ibm/wizard.

3. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924

Select Set Up a Stand-alone Server > Database Transfer.
Provide information about your environment.

Save your configuration settings.

N o~

Choose one of the following options:

* Click Download Files to run the steps remotely.

* Click Run All Steps to run the steps locally.

8. Log in to WebSphere Portal to verify that you have a working portal server.

Enabling federated security

After you install your web experience, a default file-based repository is your
available user registry. Depending on your requirements, you might need to enable
a federated LDAP user registry.

About this task

Note: If you set Use Administrator IDs stored in your LDAP user registry to yes,
the WebSphere Application Server and WebSphere Portal user IDs and passwords
are changed to the LDAP user ID and password. If you do not want to change
both user IDs and passwords to match the LDAP user ID and password, set this
value to no. After you configure your LDAP user registry, you can manually
change the user IDs and passwords.

Documentation resource: [“Updating user ID and passwords” on page 1963

Procedure

1. To get the latest updates for the wizard, apply the most recent combined
cumulative fix. For more information about applying the latest fix pack, see
WebSphere Portal and Web Content Manager V8.5.0.0 combined cumulative fix|

overviewl

Note: Skip this step, if you have the most recent fix pack applied.
2. Access the Configuration Wizard. Go to http://your_server:10200/ibm/wizard.
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3. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924

4. Select Set Up a Stand-alone Server > Enable Federated Security.

Note: If you set Use Administrator IDs stored in your LDAP user registry to
yes, the WebSphere Application Server and WebSphere Portal user IDs and
passwords are changed to the LDAP user ID and password. If you do not want
to change both user IDs and passwords to match the LDAP user ID and
password, set this value to no. After you configure your LDAP user registry,
you can manually change the user IDs and passwords.

Documentation resource: [“Updating user ID and passwords” on page 1963

5. Provide information about your environment.
6. Save your configuration settings.
7. Choose one of the following options:
* Click Download Files to run the steps remotely.
* Click Run All Steps to run the steps locally.
8. Log in to WebSphere Portal to verify that you have a working portal server.

Tuning the servers in your environment

Tuning the servers is important to the performance of your portal environment.
WebSphere Portal is not tuned for a production environment after installation and
deployment. Your database needs tuning for improved performance. You can
organize your database now or soon after you finish your configuration. You need
to tune and maintain your database on a regular basis.

Procedure

Run the performance tuning tool to complete an initial tuning of your servers.

Documentation resource: [“Portal server performance tuning tool” on page 361

Configuring the Authoring portlet

Configure your Authoring portlet on your WebSphere Portal server.

Procedure
1. Configure extra Authoring portlet parameters.

Documentation resource: [“Further authoring portlet configuration options”)

2. Configure the workflow, profiling, and version control settings.

Documentation resource: [“Web content authoring options” on page 53§

3. Configure the Authoring portlet search.

Documentation resource: [“How to configure authoring portlet search” on|
page 545

4. Configure your server to import large files and images.

Documentation resource: [“Importing large files and images” on page 546

5. Configure your server to avoid time-out issues.
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Documentation resource: |”Ir1crease timeouts to prevent save errors” on page|

6. Configure remote server access so you can link to files and documents on
remote content management systems.

Documentation resource: [“Configuring remote server access for links” onl
page 549

7. Set up support for federated documents.

Documentation resource: [“Setting up support for federated documents” on|

Syndication

Use syndication to synchronize content between authoring, staging, and publishing
environments.

Procedure

1. Plan your syndication strategies.

Documentation resource: [“Syndication relationships” on page 595|

2. Define syndication properties.

Documentation resource: [“Syndication properties” on page 601

3. Tune your syndication strategy to improve performance.

Documentation resource: [“Syndication tuning” on page 603|

4. Create your syndication relationships.

Documentation resource: |Creating a syndication relationship by using the
[Administration Portlet|

Roadmap: Applying maintenance

Portal maintenance is delivered through two mechanisms: individual fixes (iFixes)
and combined cumulative fixes. iFixes are provided, when necessary, for severe or
security-related bugs. Combined cumulative fixes are delivered on a regular
schedule. They provide a mechanism to deliver fixes faster, improve existing
features, deliver new features, update documentation, and provide new
documentation on a frequent basis. To deliver continuous improvements for your
digital experience software, it is recommended that you apply the latest combined
cumulative fix to your environment.

Use this roadmap to learn more about the following information:
* What the latest combined cumulative fix contains
* How to apply the latest combined cumulative fix

* How to configure and enable new combined cumulative fix features

Who should use this roadmap

Use this roadmap if you:

* Installed WebSphere Portal V8.5 for the first time and want to apply an iFix or
the latest combined cumulative fix.

* Need a high-level view of which features or improvements are ready to use by
default after you apply the latest combined cumulative fix and which features
need additional configuration.
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What is continuous delivery

Continuous delivery is short development cycles with continuous integration and
automated tests. The result is a releasable product at any time. Continuous
delivery has the following benefits:

* Accelerated time to market

* Building the right product

* Improved productivity and efficiency
* Reliable releases

* Improved product quality

* Improved customer satisfaction

The continuous delivery features are delivered with the combined cumulative fixes.

Learning about this combined cumulative fix

Some combined cumulative fixes focus on fixing known issues that are identified
by APARs. Other cumulative fixes are focused on new features.

Procedure
1. View a list of APAR fixes delivered a combined cumulative fix.

Documentation resource: [Fixes integrated in WebSphere Portal 8.5.0.0|
[Combined Cumulative Fixes|

2. Get an overview of the features and improvements delivered in the latest
combined cumulative fix.

Documentation resource: [“What's new with CF07” on page 2|

Applying a combined cumulative fix

To apply a combined cumulative fix, you must update the product files with IBM
Installation Manager. You must also update properties files, download the
cumulative fix, and run ConfigEngine tasks to apply the changes to each profile in
your system. The IBM WebSphere Portal V8.5.0.0 combined cumulative fix readme
file provides detailed instructions on how to apply a fix and planning information.

Before you begin

CFO3 Use the Health Checker tool to identify issues with your installation. You
should use the Health Checker tool on your target system before you apply a
combined cumulative fix. You can learn more about how to apply the Health
Checker tool in the readme instructions.

Individual fixes: Individual fixes (iFixes) are included in the combined cumulative
fix. However, if you need a fix before the combined cumulative fix is available, you
can install the iFix. iFixes are found on IBM Fix Central (http:/ /www.ibm.com /|
lsupport/fixcentral /). To install an iFix, download it from Fix Central and use the
IBM Installation Manager to update the portal server. An iFix can be installed with
the Installation Manager GUI or command line interface. It can also be automated
with a response file. Most iFixes also require a command to update your profile.
This requirement differs with each fix. Refer to the readme file that comes with the
iFix for details.
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Procedure

To apply this cumulative fix, follow the readme instructions that apply to your
environment. You can find separate instructions for stand-alone, cluster, farm, and
remote search environments from the overview topic.

Documentation resource: [I[BM WebSphere Portal V.8.5.0 combined cumulative|
[fix instructions: stand-alone

Documentation resource: [I[BM WebSphere Portal V.8.5.0 combined cumulative|
[fix instructions: cluster|

Documentation resource: [IBM WebSphere Portal V.8.5.0 combined cumulative|
[fix instructions: farm|

Documentation resource: [I[BM WebSphere Portal V.8.5.0 combined cumulative|
[fix instructions: remote search|

Configuring features in CF06

Some features are configured by default after you apply your cumulative fix. Other
features require additional configuration tasks or enablement steps before you can
use them. This section provides documentation resources for features and
improvements that require additional configuration.

Updates to custom search box in the portal theme
This feature requires additional configuration to redirect search requests
issued by a custom search form to the Search Center.

Documentation resource: [“Redirecting search requests from a custom|
[search form to the Search Center” on page 793

Using remote session invalidation with WSRP
This feature requires additional configuration to enable remote session
invalidation.

Documentation resource: [“Configuring remote session invalidation” on|

page 1784

Configuring features from previous cumulative fixes

After you install the current combined cumulative fix, you might decide that you
want to use a feature from a previous fix. This section provides documentation
resources for those features and improvements that require additional
configuration.

CFOs
Features from CF05

The following features, included with the fifth combined cumulative fix, requires
additional configuration:

SmartCloud for Social Business Search (SAML)
This feature requires configuration to integrate WebSphere Portal and IBM
Connections in SmartCloud for Social Business. As of CF05, you can

integrate by using either Active Directory Federation Services (ADFS) or
Tivoli Federated Identity Manager (TFIM).

Documentation resource: [“Establishing single sign-on (SSO) between the|
portal installation and IBM Connections in SmartCloud for Social|
Business” on page 917
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Searching in a multilingual environment
This feature requires configuration. By default, the Search Center uses the
preferred language of the user to analyze search terms and refine search
results. To enable searching in other languages, configure the Search Center
portlet.

Documentation resource: [“Configuring search for multilingual sites” on|

Content as a Service pages
This feature requires configuration. Content as a Service pages require the
new functions of WebSphere Portal and IBM Web Content Manager version
8.5 CF05 to be enabled. Run the configuration task install-caas to enable
the Content as a Service pages.

Documentation resource: [“Setting up Content as a Service” on page]

CFO04
Features from CF04

The following feature, included with the fourth combined cumulative fix, requires
additional configurations:

Renditions
This feature requires configuration. Renditions are disabled by default. You
must run a ConfigEngine task to enable them.

Documentation resource: [“Enabling renditions” on page 2308|

CF03
Features from CF03

The following feature, included with the third combined cumulative fix, requires
additional configurations:

Resource aggregation for portlets
This feature requires configuration if your custom theme was created from
the Portal 8.5 theme on a system before CF03. Connect to your WebDAV
and edit the local copy of your metadata.properties file. Set the theme
metadata resourceaggregation.autoLoadPortletCapabilities to true.

Documentation resource: [“Change the auto-loading of portlet]
[capabilities” on page 2837

Blogs and wikis
This feature requires enablement. You must run a configuration task to
update the content that is used by Blogs and Wikis to apply the newest
updates.

If you customized your Blogs and Wikis, you lose your customizations and
you must reapply those customizations after you run the task. Enablement
is manual and optional.

Documentation resource: [“Blogs and wikis” on page 1163

SmartCloud for Social Business HTTP Outbound
This feature requires configuration to use social rendering with a
Connections server that runs in the Smart Cloud for Social Business.
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To configure the Connections server type, set the custom property
server.type in the WP Connections Integration Service resource
environment provider to SC4SB in the WebSphere Integrated Solutions
Console.

Documentation resource: [“Configuring the Connections server type” on|
|o; e 2417,

Invalid friendly URLs
This feature requires enablement and configuration. Set the
friendly.pathinfo.validation.enabled property to true in the WebSphere
Portal Configuration Service Resource Environment Provider.

Documentation resource: [“How to enable the validation of friendly|
[URLs for web content” on page 2340

Documentation resource: [“Configuring the validation of friendly URLs|
[for web content” on page 2340

Roadmaps for migration

Choose the appropriate migration roadmap for your environment.

[“Roadmap: Migrating a stand-alone server environment”|
Roadmaps provide a high-level overview of complex tasks such as migrating a
stand-alone server environment to a new version of IBM WebSphere Portal.

[“Roadmap: Migrating a clustered environment” on page 112
Roadmaps provide a high-level overview of complex tasks such as migrating a
clustered environment to a new version of IBM WebSphere Portal.

Roadmap: Migrating a stand-alone server environment

Roadmaps provide a high-level overview of complex tasks such as migrating a
stand-alone server environment to a new version of IBM WebSphere Portal.

Who should use this roadmap?

Use this roadmap if you are:
* Migrating a stand-alone server environment from Version 7.0.0.x to Version 8.5.

* Migrating a stand-alone server environment from Version 8.0.0.x to Version 8.5.

Note: If you are migrating from IBM WebSphere Portal Version 8.0.0.1 on
WebSphere Application Server Version 8.5.5.2 to WebSphere Portal Version 8.5, you
must follow a different migration process. For more information, see |”Migratiné
[from Portal 8.0.0.1 on WebSphere Application Server 8.5.5.2” on page 1075

You must apply the latest cumulative fix and one of the two most recent fix packs
to your source environment, and the latest cumulative fix and the most recent fix
pack to your target environment before you can migrate to WebSphere Portal
Version 8.5. For more information, see [Supported migration paths}

Planning for migration
Gather information and create a plan for migration.

Check the requirements and considerations for migration:

+ Documentation resources: [Planning for migration|

— Backup and recovery of data files and databases is an essential operation for
any business system, particularly for data and applications that are running in
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production environments. Create and follow a plan for backing up and
recovering data on all tiers of your WebSphere Portal deployment. For more
information, see [Backup and recovery]

— Remove unsupported or deprecated features before you start migration. For
more information, see [Deprecated features}

— If you need to migrate multiple environments, such as a production
environment or development environment, you can use staging to production
techniques. For more information, see [Migrate multiple tier environments

Plan a local migration if your source and target environments are on the same
system, and plan for a remote migration if your source and target environments
are on separate systems. For more information about local and remote migrations,
see [Local versus remote]

Preparing your source environment

Prepare the source portal that you want to use for migration.

 Documentation resources: [Preparing your source environment|

— To keep the earlier portal environment in production and reduce the amount
of downtime during migration copy the earlier portal server JCR and Release
domains. For more information, see [“Using copies of source database|
[domains to minimize downtime” on page 1110

Setting up your target environment

Set up your target environment for migrating to Version 8.5.

+ Documentation resource: [Setting up your target environment]

— The portal migration attempts to install custom applications in the target
environment, but it does not automatically copy the files that are required for
those applications. If the files are not copied over, it is possible that the
applications will fail to install or not work properly. For more information
about copying these files, see [“Copying files for third party and custom|
lapplications” on page 1110,

— To effectively set up your target environment, install the Portal and
WebSphere binary files on all target systems. For more information, see
[“Installing Portal and WebSphere binary files” on page 1109.|

Migrating to WebSphere Portal Version 8.5

Start the Configuration Wizard to migrate data, applications, databases, property
files, security settings, and more.

1. To get the latest updates for the wizard, apply the most recent cumulative fix.
For more information about applying the latest fix pack, see [WebSphere Portall
land Web Content Manager V8.5.0.0 combined cumulative fix overviewl

Note: Skip this step, if you have the most recent fix pack applied.

2. Access the Configuration Wizard using your target environment and system
host name. Go to: http://your_server:10200/ibm/wizard.

3. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

4. Select Migrate to a New Version > Migrate a Stand-alone Server.

o

Provide information about your environment.
6. Save your wizard selections.
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7. Choose one of the following options:
* Click Download Configuration Scripts to run the steps remotely.

* Click Start Configuration to run the steps locally. This option starts to run
the automated steps until a manual step is encountered.

Migration is partially complete after you do the tasks in the configuration wizard.
You must return to the product documentation to complete the final steps of the
migration process.

Next steps

Migration is not complete until you review the Next steps section in the product
documentation. Complete the post-migration activities and enabling new
functionality tasks that are applicable to your environment. Do not complete any of
the enabling new functionality tasks until all post-migration activities tasks are
finished.

* Documentation resources:
— Then, you must run the PRE-APPLY-FIX and APPLY-FIX tasks to ensure that

your migrated system is up-to-date. This step is required. For more
information, see [“Applying the latest combined cumulative fix updates” on|

IEage 1133.|

— More tasks must be completed depending on how you customized the source
portal environment and which components you used. For example, if you use
a virtual portal, then complete the virtual portal post-migration activities. For
more information, see [Post-migration activities|

— New functionality that was not available in the earlier portal version requires
extra attention after migration is complete. For more information, see
[Enabling new functionality]

After you complete the tasks in the Next steps section of the product
documentation, migration is complete.

Roadmap: Migrating a clustered environment

Roadmaps provide a high-level overview of complex tasks such as migrating a
clustered environment to a new version of IBM WebSphere Portal.

Who should use this roadmap?

Use this roadmap if you are:
* Migrating a clustered environment from Version 7.0.0.x to Version 8.5.
* Migrating a clustered environment from Version 8.0.0.x to Version 8.5.

Note: If you are migrating from IBM WebSphere Portal Version 8.0.0.1 on
WebSphere Application Server Version 8.5.5.2 to WebSphere Portal Version 8.5, you
must follow a different migration process. For more information, see |”Migratiné
[from Portal 8.0.0.1 on WebSphere Application Server 8.5.5.2” on page 1075]

You must apply the latest cumulative fix and one of the two most recent fix packs
to your source environment, and the latest cumulative fix and the most recent fix
pack to your target environment before you can migrate to WebSphere Portal
Version 8.5. For more information, see [Supported migration paths}
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Planning for migration
Gather information and create a plan for migration.

Check the requirements and considerations for migration:

+ Documentation resources: [Planning for migration|

— Backup and recovery of data files and databases is an essential operation for
any business system, particularly for data and applications that are running in
production environments. Create and follow a plan for backing up and
recovering data on all tiers of your WebSphere Portal deployment. For more
information, see [Backup and recovery]

— Remove unsupported or deprecated features before you start migration. For
more information, see [Deprecated features]

— If you need to migrate multiple environments, such as a production
environment or development environment, you can use staging to production
techniques. For more information, see [Migrate multiple tier environments|

Plan a local migration if your source and target environments are on the same
system, and plan for a remote migration if your source and target environments
are on separate systems. For more information about local and remote migrations,
see [Local versus remote]

Preparing your source environment

Prepare the source portal that you want to use for migration.

 Documentation resources: [Preparing your source environment|

— Review the considerations for a multiple cluster environment for information
on supporting multiple clusters that use different database credentials. For
more information, see [“Multiple cluster environments” on page 1074

— To keep the earlier portal environment in production and reduce the amount
of downtime during migration copy the earlier portal server JCR and Release
domains. For more information, see |“Using copies of source database|
[domains to minimize downtime” on page 1110

— The target environment initially uses the same ports as the source
environment. There are three important steps you must complete to ensure
that the source and target environments do not become corrupted. For more
information, see |“Disabling automatic synchronization to protect your
[clustered source environment” on page 1092

Setting up your target environment

Set up your target environment for migrating to Version 8.5.

+ Documentation resource: [Setting up your target environment|

— The portal migration attempts to install custom applications in the target
environment, but it does not automatically copy the files that are required for
those applications. If the files are not copied over, it is possible that the
applications will fail to install or not work properly. For more information
about copying these files, see [“Copying files for third party and custom|
lapplications” on page 1110.)

— To effectively set up your target environment, install the Portal and
WebSphere binary files on all target systems. For more information, see
[“Installing Portal and WebSphere binary files” on page 1109
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Migrating to WebSphere Portal Version 8.5

Start the Configuration Wizard to migrate data, applications, databases, property
files, security settings, and more.

1. During a cluster migration, you might need to enter information into the
Configuration Wizard more than once. Use the following worksheet to
identify the information that is entered multiple times, and use these values
during the migration process.

Table 5. Worksheet: Migration information for the Configuration Wizard

Field description: Value:

Deployment manager host name

Deployment manager cell name

Deployment manager node name

Administrator user name

Administrator password

Soap port

2. To get the latest updates for the wizard, apply the most recent cumulative fix.
For more information about applying the latest fix pack, see [WebSphere Portall
[and Web Content Manager V8.5.0.0 combined cumulative fix overview]

Note: Skip this step, if you have the most recent fix pack applied.

3. Access the Configuration Wizard using your target environment and system
host name. Go to: http://your_server:10200/ibm/wizard.

4. Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

5. Select Migrate to a New Version > Migrate a Cluster Step 1: Migrate the
Deployment Manager Profile.

6. Provide information about your environment.
7. Save your wizard settings.

8. Click Download Configuration Scripts to run the steps on the deployment
manager.

9. After you complete the steps from Step 1, select Migrate to a New Version >
Migrate a Cluster Step 2: Migrate Node Profiles.

10. Provide information about your environment.
11. Save your wizard settings.
12. Choose one of the following options:
* Click Download Configuration Scripts to run the steps remotely.

* Click Start Configuration to run the steps locally. This option starts to run
the automated steps until a manual step is encountered.

13. Complete these steps on all nodes.

14. After you complete the steps for Step 2, select Migrate to a New Version >
Migrate a Cluster Step 3: Upgrade Node Profiles.

15. Provide information about your environment.
16. Save your wizard settings.
17. Choose one of the following options:
* Click Download Configuration Scripts to run the steps remotely.
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* Click Start Configuration to run the steps locally. This option starts to run
the automated steps until a manual step is encountered.

18. Complete these steps on all nodes
Next steps

Migration is not complete until you review the Next steps section in the product
documentation. Complete the post-migration activities and enabling new
functionality tasks that are applicable to your environment. Do not complete any of
the enabling new functionality tasks until all post-migration activities tasks are
finished.

* Documentation resources: [Next steps|

— Then, you must run the PRE-APPLY-FIX and APPLY-FIX tasks to ensure that
your migrated system is up-to-date. This step is required. For more
information, see [“Applying the latest combined cumulative fix updates” on|

lpage 1133]

— More tasks must be completed depending on how you customized the source
portal environment and which components you used. For example, if you use
a virtual portal, then complete the virtual portal post-migration activities. For
more information, see [Post-migration activities|

— New functionality that was not available in the earlier portal version requires
extra attention after migration is complete. For more information, see
[Enabling new functionality]

After you complete the tasks in the Next steps section of the product
documentation, migration is complete.

Roadmaps for integration

Choose the appropriate integration roadmaps for your environment.

["Roadmap: Integrating with IBM Connections”|

Roadmap: Integrating with IBM Connections

Integrating your portal site with IBM Connections is a multiple step process. Some
steps are required and others are optional. Optional steps depend on the level of
integration that you need. This roadmap is intended to provide an overview of the
process. Links to detailed instructions are provided from the roadmap.

Installing Connections and WebSphere Portal

Before you begin, the following programs must be installed and configured.

Install Connections

Documentation resource: [Installing IBM Connections|

Install IBM WebSphere Portal.
Documentation resource: [Installing WebSphere Portal|

Configure portal to use a federated LDAP server.

Documentation resource depends on your WebSphere Portal installation
scenario, stand-alone server, or cluster.

Note: Do not remove the file system user repository after you federate your LDAP
server.
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Configuring your portal to work with IBM Connections

Procedure
1. Import the SSL certificate from Connections to your portal server.
Documentation resource: [[mporting a certificate to support SSL}

2. Configure the portal Ajax proxy. The Ajax proxy is updated for the base
Connections URLS during the IBM Connections Portlets installation. If FileNet
is used, you must still configure the Ajax proxy manually to update for FileNet.
Configure the Ajax proxy so that direct requests that the CCM portlet makes to
the FileNet server are allowed to pass through the proxy Server.

Documentation resource: [Configuring the Ajax proxy to allow FileNet]

3. Configure single sign-on.

Documentation resource: [“Set up single sign-on” on page 902|
Documentation resource for portlets: [Configuring authentication for the|
4. Install and Deploy the Portlets
Note: Before you install the portlets, steps 1 - 3 must be completed.
a. Download the Connections portlets for WebSphere Portal.
[[BM Connections Portlets for WebSphere Portal|
b. Install the portlets.
Documentation resource: [Installing the IBM Connections Portlets for]
[WebSphere Portal|
C. Add modules that are needed by the Connections portlets to the portal
theme default profile.
Documentation resource: [Updating the portlet theme]

5. Configure a common directory service for the portlets.

Documentation resource: [Configuring common Directory Services for your|
[security configuration|

6. Integrate community membership to allow access control administration that is
based on community membership.

a. Documentation resource: [Integrating community membership with Portall
b. Documentation resource: |[Automatically grant page access to community]

7. Enhance the deployment of Connections portlets for WebSphere Portal with
optional configuration steps.

Documentation resource{Optional and Recommended Configurations|
Documentation resource: [Social rendering|
Documentation resource: [Social Media Publisher|
Documentation resource: [[BM Social Rendering Templates for Digital Datal
[Connector

8. Configure search with the Remote Content Server Search Service Type (RCSS),
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[Search Service Type (RCSS)|
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Roadmaps for web content

Some roadmaps to help you create and integrate web content into your site.

['Roadmap: Importing web content”]
When you set up a new site, you might have content in an existing system that
you need to migrate or import into your site.

Roadmap: Importing web content

When you set up a new site, you might have content in an existing system that
you need to migrate or import into your site.

Using REST to import web content into Web Content Manager

Application developers can use Representational State Transfer (REST) services to
work with Web Content Manager. The REST service for Web Content Manager
provides authoring access to content items and elements. The service follows the
Atom Publication Protocol, and atom feeds, and entries are accessible in XML
(application/atom+xml) and JSON (application/json) format.

This is useful when you need to perform a once-off migration of Web content from
an external system into an Web Content Manager authoring environment.

See |"REST service for Web Content Manager” on page 3609| for further
information.

Using WCI to import web content managed in an external system

The Web Content Integrator is a solution for integrating externally managed Web
content with WebSphere Portal. Through the use of standard content syndication
feed technologies based on RSS 2.0, the Web Content Integrator provides a
loosely-coupled mechanism for transferring published content and metadata to the
portal after they have been approved in the source system. When the content and
metadata have been transferred to the portal, it is possible to use the built-in
content management features of WebSphere Portal to secure, personalize, and
display the content to users.

This is useful when you need to continue to use externally managed Web content
in a site delivered using Web Content Manager.

See [“IBM Web Content Integrator” on page 2230| for further information.
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Chapter 4. Installing

IBM WebSphere Portal provides flexible deployment options that range from
proof-of-concept where you can examine and test functionality to a highly
available and scalable production environment. Review the planning information
to learn more about hardware and software requirements, high availability,
scalability, supported topologies, and much more. Select your operating system
and then select the installation pattern that most reflects your business needs.

1.

[“Planning to install WebSphere Portal”

Before you install IBM WebSphere Portal in a production environment, you
need to assess your hardware and software needs, possible database
configurations, security options, and LDAP server options. Skipping this
important step can lead to unexpected results and costly delays.

[“Getting the software” on page 174|
There are different ways for you to get WebSphere Portal and Web Content
Manager Version 8.5 software.

[“Installing and preparing the prerequisite software” on page 204|

Before you install the digital experience software, make sure that the
prerequisite software is installed and configured. Depending on your
environment, you might already have the prerequisites, such as a database
server and user registry. Verify that the prerequisite software is the correct
version, has the required fix packs applied, and is configured to work with the
digital experience software.

. |“Installing the digital experience software” on page 223|

IBM's Exceptional Digital Experience is designed to help create, manage,
simplify, and integrate your processes into an engaging online experience. IBM
WebSphere Portal and IBM Web Content Manager are a part of the Exceptional
Digital Experience. The product documentation uses digital experience software
as a shorthand for IBM WebSphere Portal and IBM Web Content Manager.

. ["Installing add-ons” on page 307

You can use the Solution Installer through the Configuration Wizard to install
and uninstall add-ons to an IBM WebSphere Portal server instance. The
Solution Installer uses the Portal Application Archive (PAA) format as the
standard format for application distribution. Portal Application Archive (PAA)
updates are not supported in the configuration wizard currently. For more
information about updating add-ons using a command prompt, see the
Managing your existing PAA file section.

[“Uninstalling the digital experience software” on page 315

Uninstalling the digital experience software is a multiple step process and the
method you use is dependent upon your configuration. Removing WebSphere
Portal in a single-server configuration is different from removing WebSphere
Portal from a cluster. Manual uninstallation instructions are provided for a
single-server configuration in case of an error situation.

Planning to install WebSphere Portal

Before you install IBM WebSphere Portal in a production environment, you need to
assess your hardware and software needs, possible database configurations,
security options, and LDAP server options. Skipping this important step can lead
to unexpected results and costly delays.
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About this task

Restriction: The serverName is hardcoded to WebSphere Portal. The serverName
cannot be changed in a stand-alone environment. If you do change it, the
ConfigEngine scripts do not work. For a clustered environment, see

370392| for options on replacing the WebSphere Portal JVM.
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[‘System requirements” on page 121

Before you install IBM WebSphere Portal, review the hardware and software
requirements to ensure that you have the supported versions of prerequisite
and corequisite software and the required hardware.

[“Release notes” on page 121

Known issues and problems are centrally available on the support page. Links
into the support knowledge base are integrated throughout the documentation
to make sure that you have the most current information. Before you start the
installation process, check the IBM Support site for the most current
information about known limitations or issues. Use the following dynamic
queries to find late breaking information about this release.

[“WebSphere Portal Support Statement” on page 121

This support statement proposes a revision to the definition of “supported” and
“unsupported” about the various products of which IBM WebSphere Portal
depends on for proper operation.

[“User IDs and passwords” on page 125

Understanding character limitations for user IDs and passwords is important
because they are used throughout the system to provide access and secure
content. The character limitations provided here apply to the IBM WebSphere
Portal administrator, IBM WebSphere Application Server administrator,
database administrator, LDAP server administrator, and user IDs. Database and
LDAP servers can have more restrictive limitations than provided here.
Therefore, check the database and LDAP server product documentation for
restrictions. Failure to correctly define user IDs and passwords during the
installation process can result in installation failure. In addition, your company
might have more restrictive user ID and password requirements that you must
also follow.

[“Web Content Manager environments” on page 128|

To use a Web Content Manager system, you need to deploy a set of Web
Content Manager environments within your overall WebSphere Portal system.
Reviewing the Web Content Manager environments help you understand what
happens in each environment and how you might want to set up your physical
severs. Web Content Manager is installed by using the WebSphere Portal
installation user interface.

[‘Database” on page 138

IBM WebSphere Portal includes an Apache Derby database that is configured
and ready for immediate use. As a result, you have a running portal that is
ready for exploration or portlet and theme development. But for a production
environment or any environment for Web Content Manager, you must use one
of the other supported database management systems.

[“User registry considerations” on page 149|

A user registry or repository authenticates a user and retrieves information
about users and groups to do security-related functions, including
authentication and authorization.

[“Cluster considerations” on page 155|
To increase capacity and availability, multiple portal servers can be clustered
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with IBM WebSphere Application Server Network Deployment. In a cluster, the
portals share a common configuration and the load is distributed evenly across
all cluster instances.

[“Virtual environment overview” on page 171|

You can use virtualized environments, for example VMWare ESX, to meet your
business needs such as production server consolidation, centralized
management, or dynamic test environments. The virtual environment provides
transparency to the operating systems, applications, and middleware that it
uses.

[“Multiple profile support” on page 172|

IBM WebSphere Portal creates an application server configuration profile to
represent its application server configuration, such as data source definitions,
web application and portlet deployments, and Java virtual machine
configuration. A configuration profile represents the full configuration of a
single portal instance. Multiple profiles give you the ability to have multiple,
independently configured portal instances that run from the same installation.
Before WebSphere Portal Version 7, there was only one configuration profile per
installation, which was typically named wp_profile.

System requirements

Before you install IBM WebSphere Portal, review the hardware and software
requirements to ensure that you have the supported versions of prerequisite and
corequisite software and the required hardware.

See the detailed system requirements document at the following URL: [WebSphere
[Portal detailed system requirements|

Release notes

Known issues and problems are centrally available on the support page. Links into
the support knowledge base are integrated throughout the documentation to make
sure that you have the most current information. Before you start the installation
process, check the IBM Support site for the most current information about known
limitations or issues. Use the following dynamic queries to find late breaking
information about this release.

Related information:

[ [Technotes for installation and configuration issues|

[ [Technotes for migration issues|

[ [Technotes for database connectivity issues|

[ [All technotes for this release]

WebSphere Portal Support Statement

This support statement proposes a revision to the definition of “supported” and
“unsupported” about the various products of which IBM WebSphere Portal
depends on for proper operation.
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Introduction

WebSphere Portal requires the use of several collateral products for its normal
operations. In particular, it requires WebSphere Application Server, a database, a
repository for user information (typically an LDAP), and other products depending
on specific customer requirements.

During the testing of a new release, Development generally tests WebSphere Portal
with a prescribed list of these collateral products. These products are designated as
“Supported Products” in the documented hardware and software requirements for
that release.

Because the list of “Supported Products” cannot reasonably describe all possible
configurations that a customer might need to use, some customers voiced concerns
about the level of support that is provided for configurations that are not
designated as “Supported”. This document is intended to provide clarification of
the level of support that can be expected for the current release with various
combinations of dependent products.

Note: Although the statements in this document reflect the general level of
support that can be expected for WebSphere Portal, the terms and conditions of
any specific support offering, license or other Agreement you might have with IBM
will determine the actual delivered support for the product. Nothing herein shall
be construed as supplementing, modifying or superseding the terms of your IBM
license agreement for WebSphere Portal or any other agreement you might have
with IBM, nor shall it create any obligation for IBM to deliver a level of support
other than might be set forth in such Agreements.

Categories of Support

There are three categories of support for collateral products to WebSphere Portal.
They are “Supported Products”, “Newer Versions, and Releases of Supported
Products” and “Unsupported Products”. The definition and support statement for

each category follows:

Supported Product
A “Supported Product” is a product (at a specified version, release and fix
level) that was tested by Development and is known to work with
WebSphere Portal.

Products in this category are supported according to the terms of your
WebSphere Portal License Agreement. PMRs (Problem Management
Records) are accepted by IBM Support in accordance with the conditions of
the WebSphere Portal License Agreement.

Newer Versions and Releases of Supported Products
Many products outside the specific version(s), release(s), or fix pack(s) of
the “Supported” version (referenced in the documented hardware and
software requirements) might not be explicitly tested by IBM WebSphere
Development, yet can reasonably be expected to perform within the
accepted bounds of reliability, function, and performance by a customer.

Products that fall into this category are typically newer releases or fix
levels of a product already in the “Supported Product” category or a
product that adheres to a standard API that WebSphere Portal supports
(such as an LDAP server). Some specific examples might include a newer
operating system fix level, a WebSphere Application Server (WAS) fix pack

122 WebSphere Portal v8.5



newer than the original “Supported” fix pack level, an IBM Java (JVM) fix
pack, a new fix pack, or release of DB2 or an updated LDAP server.

For products that fall into this category, support is as follows:

For IBM products, such as IBM Directory Server or Domino LDAP, IBM
DB2, IBM JDKs (JVMs) and WebSphere Application Server, WebSphere
Portal will fully support fix-pack, release and version updates that do not
significantly change interfaces or other underlying support that WebSphere
Portal depends on for its functionality. If and when a newer release of one
of these products is shipped that WebSphere Portal cannot accommodate,
that fact will be noted as described in the next section entitled
“Unsupported Products”. Note that in order for WebSphere Portal to
support an update to a database or LDAP product, WebSphere Application
Server must support that update as well.

For non-IBM products, the Support team makes a commercially reasonable
effort to support products in this category. Support accepts problem reports
(PMRs) for the appropriate releases that use these untested products. If
Support is able to re-create the reported problem with a “Supported”
version of the product, we will attempt to fix the problem.

If Support is not able to re-create the problem with a “Supported” version
of the product in question and is not able to resolve the problem on the
untested version of the product in question, Support will look to the
support organization for the product in question to provide resolution.
Please note that varying degrees of customer involvement may be
necessary to handle this process for non-IBM products.

If the support organization for the untested product in question is unable
to resolve the problem, Support will deem that version, release or fix pack
level of the untested product in question to now be an “Unsupported
Product”.

Unsupported Products
An “Unsupported Product” is a product (at a specified version, release and
fix level) that is known to not work with WebSphere Portal and is therefore
not supported. A product can be included in this category as a result of an
explicit test effort by Development or as a result of discovery from a prior
customer problem. The WebSphere Portal Support team maintains a list, by
release, of all known “Unsupported Products”. The list is published as a
techdoc and is available to all customers.

WebSphere Application Server has a similar support statement, which can
be found on the web.

Note: WebSphere Application Server uses specially customized builds of
the IBM Java SDKs on certain platforms. Updates to these builds must be
obtained from WebSphere Application Server support.

WebSphere Portal can be sensitive to changes in the underlying WebSphere
Application Server. Upgrading to a new fix pack level of the application
server is well tolerated and encouraged (such as from WebSphere
Application Server version 8.0 to 8.0.x) as long as all required fixes for
WebSphere Application Server are available as integrated into that fix pack
or by applying an interim fix specifically for that maintenance level.
However, upgrading from one version of WebSphere Application Server to
the next (such as from 7.0 to 8.0) is problematic if not done within the
context of a migration of versions and must never be attempted with an
“in-place” system.
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For example, an existing instance of WebSphere Portal version 8.0 that is
installed and functioning on WebSphere Application Server version 8.0
cannot be successfully migrated to WebSphere Application Server version
8.x by using the WebSphere Application Server Migration Tools. Such
attempts might result in a non-functional system. For more information on
such scenarios, consult IBM WebSphere Portal support.

Support for LDAP Servers

LDAP support spans two categories:

Fully tested and supported LDAP servers:

The list of fully tested LDAP servers for each release of WebSphere Portal
is documented in the detailed system requirements for each release.
WebSphere Portal support accepts problem reports for the appropriate
WebSphere Portal releases using the tested directory servers. These
problem reports receive high-priority attention. Features that are tested
with these directories include relatively simple search and retrieval
functions for user and group objects. Functions outside this scope, such as
the Active Directory Global Catalog feature, are considered advanced
features and have not been tested with WebSphere Portal. WebSphere
Portal support encourages customers to work with their LDAP provider
for additional support on these advanced features.

Untested and partially supported LDAP servers:

In general, WebSphere Portal support makes a best effort to support
directory servers that have not been tested with WebSphere Portal.
WebSphere Portal support accepts problem reports for the appropriate
WebSphere Portal releases using untested directory servers. If WebSphere
Portal support can re-create the reported problem using a tested LDAP
server, staff will attempt to fix the problem. If the support team is not able
to re-create the problem on a tested LDAP server, customers are referred to
the LDAP provider for further assistance.

Support for External Security Managers (ESM)

ESM support spans two (2) categories:

Fully tested and supported ESM software:

The list of fully tested ESM software versions for each release of
WebSphere Portal is documented in the detailed system requirements for
each release. WebSphere Portal support accepts problem reports for the
appropriate WebSphere Portal releases using the tested ESM servers. These
problem reports receive high-priority attention. Features that are tested
with these software products include authentication and authorization.
Functions outside this scope, such as login customizations, referrals,
impersonation, and step up authentication are considered advanced
features and have not been tested with WebSphere Portal. WebSphere
Portal support encourages customers to work with their ESM provider for
additional support on these advanced features.

Untested and partially supported ESM servers:
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In general, WebSphere Portal support makes a best effort to support ESM
servers that have not been tested with WebSphere Portal when relying on
the ESM for authentication only. WebSphere Portal support accepts
problem reports for the appropriate WebSphere Portal releases using
untested ESM Trust Association Interceptor (TAI) implementations. If
WebSphere Portal support can re-create the reported problem using a



tested ESM, staff will attempt to fix the problem. If the support team is not
able to re-create the problem on a tested ESM, customers are referred to
the ESM provider for further assistance.

Related information:

[ |System requirements|

User IDs and passwords

Understanding character limitations for user IDs and passwords is important
because they are used throughout the system to provide access and secure content.
The character limitations provided here apply to the IBM WebSphere Portal
administrator, IBM WebSphere Application Server administrator, database
administrator, LDAP server administrator, and user IDs. Database and LDAP
servers can have more restrictive limitations than provided here. Therefore, check
the database and LDAP server product documentation for restrictions. Failure to
correctly define user IDs and passwords during the installation process can result
in installation failure. In addition, your company might have more restrictive user
ID and password requirements that you must also follow.

When a person signs up as a user or when an administrator enrolls a user, they
must complete the user information form. On this form, do not enter characters
that might not be supported. Regardless of what characters you are able to enter
on the user information form, user ID and passwords are limited to the valid
characters described here. You can specify other characters in the given name and
surname fields. If your company policy is more restrictive, you can provide that
information to your users in the enrollment form help or as inline help directly on
the form.

Important: WebSphere Portal cannot create user IDs or passwords that contain
spaces, although it fully supports any existing user IDs and passwords or those
IDs created in the user repository that contain spaces.

Under normal circumstances a valid user ID and password can contain the
following characters:

Note: The only supported characters in IBM i are lowercase characters, uppercase
characters, numbers, and the underscore.

Lowercase characters {a-z}
Uppercase characters {A-Z}
Numbers {0-9}
Exclamation point {!}

Open parenthesis {(}

Close parenthesis {)}

Dash {-}; this character is not supported as the first character in the user ID or
password

Period {.}; this character is not supported as the first character in the user ID or
password

Underscore {_}; this character is the only supported special character in IBM i
Grave accent {*}
Tilde {~}
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Commercial at {@}, this character is not supported when you create the
WebSphere Portal and WebSphere Application Server administrator during
installation.

Important: These characters are all ASCII characters. Non-ASCII characters are not
allowed for user name or password.

Note: If you plan on using a non-ASCII-based encoding, ensure your Java virtual
machine has the correct generic arguments specific for the non-ASCII-based
encoding. For example, for UTF-8 encoding, add the following two parameters to
the Java virtual machine generic arguments for WebSphere Portal:
-Dfile.encoding=UTF-8 and -Dclient.encoding.override=UTF-8

Note: (Linux only) Some tasks might require you to enter the fully qualified user
ID. If your fully qualified user ID contains a space; for example:
cn=wpsadmin,cn=users,1=SharedLDAP,c=US,ou=Lotus,o0=Software
Group,dc=ibm,dc=com, you must place the fully qualified user ID in the properties
file or into a parent properties file instead of as a flag on the command line. For
example, create a parent properties file called mysecurity.properties, enter the
fully qualified user ID, and then run the task: ./ConfigEngine.sh task_name
-DparentProperties=/opt/mysecurity.properties.

Note: (Windows only) Some tasks might require you to enter the fully qualified
user ID. If your fully qualified user ID contains a space; for example:
cn=wpsadmin,cn=users,1=SharedLDAP,c=US,ou=Lotus,o0=Software
Group,dc=ibm,dc=com, you must place quotations around the fully qualified user ID
before you run the task; for example,
"cn=wpsadmin,cn=users,1=SharedLDAP,c=US,ou=Lotus,o=Software
Group,dc=ibm,dc=com".

The following table contains a list of the required fields on the user information
form and the supported characters.
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Table 6. Valid characters and unsupported characters for user information

User information

Valid characters

Unsupported characters

User ID

Note: The only supported characters
in IBM i are lowercase characters,
uppercase characters, numbers, and
the underscore.
Lowercase characters {a-z}
Uppercase characters {A-Z}
Numbers {0-9}
Exclamation point {!}
Open parenthesis {(}
Close parenthesis {)}
Dash {-}; this character is not
supported as the first character in
the user ID or password
Period {.}; this character is not
supported as the first character in
the user ID or password
Underscore {_}; this character is
the only supported special
character in IBM i
Grave accent {°}
Tilde {~}
Commercial at {@}, this character
is not supported when you create
the WebSphere Portal and
WebSphere Application Server
administrator during installation.

Only ASCII characters are allowed.
Other restrictions: The user ID
cannot contain spaces; for example,
user name.

Note: User IDs cannot be longer than
200 characters.

If you enter any unsupported
characters during the installation, you
receive an error message that states
which character is invalid. For
example, "The special character [@]
was found in the administrative user
ID field. Enter the administrative
user ID again."

Important: You receive a different
error message if you enter any
unsupported characters when you
create users through the Manage
users and groups portlet.
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Table 6. Valid characters and unsupported characters for user information (continued)

User information

Valid characters

Unsupported characters

Password / Confirm password

Note: The only supported characters
in IBM i are lowercase characters,
uppercase characters, numbers, and
the underscore.
Lowercase characters {a-z}
Uppercase characters {A-Z}
Numbers {0-9}
Exclamation point {!}
Open parenthesis {(}
Close parenthesis {)}
Dash {-}; this character is not
supported as the first character in
the user ID or password
Period {.}; this character is not
supported as the first character in
the user ID or password
Underscore {_}; this character is
the only supported special
character in IBM i
Grave accent {°}
Tilde {~}
Commercial at {@}, this character
is not supported when you create
the WebSphere Portal and

WebSphere Application Server
administrator during installation.

Diacritics, such as the umlaut, and
DBCS characters are not allowed.
Other restrictions: The password
cannot contain spaces; for example,
pass word.

Note: Passwords cannot be longer
than 128 characters.

Attention: Login or ConfigEngine
tasks might fail if the password
contains any unsupported characters,
including DBCS characters. This
action happens even if a user is
successfully enrolled with a password
that contains DBCS characters.

If you enter any unsupported
characters during the installation, you
receive an error message that states
which character is invalid. For
example, "The special character [@]
was found in the password field.
Enter the password again."

Given name

All characters

n/a

Surname

All characters

n/a

Note: The previous characters are true if the user.UNIQUEID.charset parameter is
set to ascii. If set to unicode, the standard Java Letter definition is used and all
characters that are recognized as letter or digit by Java are allowed by default. See
the Puma Validation Service section in the "Portal configuration services" link for
information about further parameters that can be modified to affect the behavior of
Portal's validation of users, groups, and passwords.

Web Content Manager environments

To use a Web Content Manager system, you need to deploy a set of Web Content
Manager environments within your overall WebSphere Portal system. Reviewing
the Web Content Manager environments help you understand what happens in
each environment and how you might want to set up your physical severs. Web
Content Manager is installed by using the WebSphere Portal installation user

interface.

Each server or cluster in your web content system requires a separate data
repository, but they would usually share LDAP. A Web Content Manager system
can be deployed in isolation or in parallel with a WebSphere Portal system.
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[“Web content system overview”|

The type of web content system you deploy is determined by the size of your
web content system, the type of website, and the number of users that create
content, or view your web content.

[“Web content authoring environments” on page 130|
An authoring environment is used to create and manage web content and is
used by your content authors and website designers.

[“Web content testing environments” on page 133

Testing environments can be simple or complex. A simple example is a
stand-alone server where content and non-content items are tested before they
are sent to the live site. A complex environment is a complete replica of your
delivery environment. A more complex environment is used to test content,
theme, and application changes and the performance of your delivery
environment.

[“Web content delivery environments” on page 135|

A production delivery environment is the environment that hosts your website.
If you have a IBM Web Content Manager only license, you can deliver your
website without using WebSphere Portal features.

Web content system overview

The type of web content system you deploy is determined by the size of your web
content system, the type of website, and the number of users that create content, or
view your web content.

Web content system types

There are three main types of web content systems:

Single environment systems
This environment is where authoring and delivery occur within a single
environment. This type of environment would be deployed by a small
organization with a small website, such as an intranet. Authoring and
delivering content within the same environment can be resource-intensive,
so the type of environment you deploy needs to be robust enough to allow
authoring and delivery to occur at the same time. For example, running
clustered servers is a common solution for a single instance system.

Dual environment systems
This environment is where authoring and delivery are split into different
environments. This model reduces the load on both authoring and delivery
servers and also allows the authoring environment to be located behind a
firewall. This type of system would be used with externally facing
websites, or where you have many users authoring content or many users
viewing a website.

Staged systems
This environment is where a staging environment is added between the
authoring and delivery environments. The staging environment can be
used for user acceptance testing (UAT) or to accumulate changes from your
authoring environment before changes are syndicated to your delivery
environment in a single batch. This system would be deployed to deliver
large, complex sites with many content creators and you need to ensure
that the website content is accurate, error-free and can run under load.
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Environment types

Authoring environment
An authoring environment is used to create and manage web content. This
environment is used by your content creators and website designers. An
authoring system can consist of:

* An authoring server or cluster.

* Individual UAT servers where site and content updates can be tested
before the content is syndicated to the delivery environment.

Staging environment
A staging environment can consist of:

¢ Individual holding servers where changes from your authoring
environment can be accumulated before your changes are syndicated to
your delivery environment in a single batch. Pairs of holding servers can
be used to provide you with built-in redundancy.

* A complete replica of your delivery environment where UAT can occur
to both review site and content updates, and to test the performance of
your delivery environment.

Delivery environment
This environment is used by your website viewers. A delivery environment
can consist of:

* Pre-rendered sites where a web content site is pre-rendered as a set of
HTML files that are then used to deliver a static website.

* a WebSphere Portal server or cluster where content is delivered by a
servlet. Servlet delivery is used to deliver websites that contain dynamic
content, but do not include any WebSphere Portal content or
applications.

* a WebSphere Portal server or cluster where content is delivered by either
a local or remote web content viewer portlet. Web content viewer
portlets are used to deliver websites that contain dynamic web content
alongside other portlets or applications.

* A combination of the previous three.

Web content authoring environments
An authoring environment is used to create and manage web content and is used
by your content authors and website designers.

Most Web Content Manager sites need to support many content authors. A
clustered server solution is the best solution for this scenario.

Standard authoring environment

A standard authoring environment consists of a single authoring cluster that
syndicates directly to either a staging or delivery environment. The following
topology depicts an authoring environment that is configured to syndicate live
items to the live production environment. The production server hosts the live site
that visitors browse. Live items include published and expired items. The
authoring environment is depicted as a stand-alone server, however it might be
clustered.
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The following activities occur in the authoring environment:
* Create drafts

* Approve drafts

* Test changes

* Publish changes

Authoring environment with testing

Add a test environment to run user acceptance testing on your content
management system and website. The test environment provides an extra layer of
validation before content and design changes are pushed to the live website.

In the following topology, all items are syndicated from the authoring environment
to the testing environment. After the content is tested, only live items are
syndicated back to the authoring environment. Then, live items are syndicated to
the production server.

In the diagram, the following activities happen on each server.

Authoring environment
* Create drafts
* Approve drafts
* Test changes
* Syndicate all items to test environment
* Syndicate live items to live site

Testing environment
 Publish changes
* Test changes
* Syndicate live items to authoring environment

In addition, theme changes might be pushed to testing environment to validate

that the content elements and design elements integrate as expected. Design
integration elements are not included in the topology diagram.
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Decentralized authoring environments

If your content authors are at different locations, or you have different groups of
content authors, consider deploying a set of decentralized authoring clusters. This
scenario works best if the decentralized content authors work with separate
content stored in different content libraries.

For example, if you have users that are in different locations, it might be more
efficient to set up a local authoring environment at each location. Two-way
syndication is used between all authoring environments with a centralized
authoring environment. The centralized authoring environment provides an
integrated view of all changes from the different authoring environments.

In the diagram, the following activities happen on each server.

Authoring environments 1, 2, and 3

e Create drafts

* Approve drafts

* Test changes

* Syndicate all items to central authoring environment

Centralized authoring environment

* Receive all items from authoring environments

* Syndicate all items to authoring environment

* Syndicate live items to testing environment (not shown)

* Syndicate live items to the live website
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Decentralized authoring creates the risk of conflicting updates between authoring
environments. To reduce the risk of conflicts, you can allocate different sites, or
different sections of a site, to each authoring environment. You can also use
different authoring environments for different user roles. For example, content
authors might use a different authoring environment than presentation template

designers.

Access to each decentralized authoring environment is controlled with a
combination of authoring portlet access controls and item security settings. For
example, only users that require access to the local authoring environment would
be granted access to the local authoring portlet. Users would be given "Read"
access to all items, but only "Edit" access to items they are required to update.

Web content testing environments
Testing environments can be simple or complex. A simple example is a stand-alone
server where content and non-content items are tested before they are sent to the
live site. A complex environment is a complete replica of your delivery
environment. A more complex environment is used to test content, theme, and
application changes and the performance of your delivery environment.

A single website might have multiple testing environments. Some testing
environments focus on content and design integration, application and data
integration, performance, and more. A web content test environment is a layer of
validation before changes are sent to the live website. The test environment might
be used to accumulate changes from your authoring environments before the
changes are syndicated to the production delivery environment.
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Site testing within an authoring environment

When testing within an authoring environment a testing server is paired with an
authoring server. The testing server simulates the delivery environment and is
used to test major changes to a website.

Syndication Syndication
of of
All ltems Live Items

Testing
Environment

Syndication
of
Live Items

Authoring Live Web
Environment Content

System testing within a staging environment

When testing within a staging environment, data from the authoring environment
is syndicated to a staging environment. User acceptance testing happens in the
staging environment. If all tests are passed, data is syndicated from staging to the
delivery production environment.
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Specific activities take place in each environment.

Authoring environment
* Create drafts
* Approve drafts
* Test changes
* Publish changes
* Syndicate live items to the staging environment

Testing environment
Test changes.

Syndicate live items to production environment.

Production environment
Deliver live website.

Web content delivery environments

A production delivery environment is the environment that hosts your website. If
you have a IBM Web Content Manager only license, you can deliver your website
without using WebSphere Portal features.

Pre-rendered delivery

Deploy a pre-rendered site when you are not using any WebSphere Portal features,
such as portlets, and your content is static and is only updated periodically. When
you set up a pre-render delivery environment, your complete website is converted
to static HTML files.

In a pre-rendered delivery environment, live items are syndicated from the

authoring environment to the delivery environment. The content is converted into
a set of static HTML files, which are then displayed to users through a web server.
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Servlet delivery

A servlet delivered website is used when you do not need to use any portlet-based
features such as authoring tools. In a servlet delivery environment, content is
syndicated from the authoring server to the delivery server. The Web Content
Manager servlet displays the content. Site visitors access the site through a web

server.
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Portlet delivery

Web content viewers are portlets that display content from a web content library as
part of a portal page. If your presentation is simple, a single web content viewer
can be sufficient. However, you can also use multiple web content viewers to
aggregate content from different libraries and provide a richer experience for site
visitors. A local web content view portlet is used to display content within your
web content delivery environment.

In a portlet delivery environment, content is syndicated from the authoring server
to the delivery server. It is displayed to users through a web content viewer portlet
that is deployed on a portal server. When a local web content viewer is used, the
web content viewer portlet is deployed on the same server as Web Content
Manager.

Delivery Environment

Syndication
of
Live Items
Authoring Web Content Web Server
Environment Viewer Portlet

Remote portlet delivery

WSRP support in the web content viewer is used to display content on a remote
WebSphere Portal server or cluster.

In a remote portlet delivery environment, content is syndicated from the authoring
server to a Web Content Manager server in the delivery environment. The web
content viewer portlet is deployed on the Web Content Manager server. It is
configured to communicate with the WSRP proxy portlet that is installed on a
portal server in the delivery environment. Users view web content by accessing the
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proxy portlet on the remote portal server, typically through a web server.

Delivery Environment
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Authoring Web Content WSRP Proxy Web Server
Environment Viewer Portlet Portlet
on on
IBEM Web IBM WebSphere
Content Manager Portal

Database

IBM WebSphere Portal includes an Apache Derby database that is configured and
ready for immediate use. As a result, you have a running portal that is ready for
exploration or portlet and theme development. But for a production environment
or any environment for Web Content Manager, you must use one of the other
supported database management systems.

Apache Derby

Derby is a built-in Java database that provides a small footprint, is self-tuning, and
is ideal for solutions where the database must be hidden. Derby works in a
non-clustered environment with a few users, such as a portlet or theme
development environments.

Derby does not support clustered environments, enabling security in a
database-only mode, or vertical cloned environments in which multiple application
servers are configured on a single server.

The Derby database that is installed by default is not supported for use in a
production environment.

Apache Derby and Web Content Manager

Use one of the other supported databases in a production environment or when
you are developing presentation templates or authoring web content. The Derby
database can be sufficient for non-production installations of WebSphere Portal, the
performance of Derby with Web Content Manager is poor. A typical cause of
performance issues is transaction timeouts. Although you can increase these
timeouts, the resulting performance is prohibitively slow. You must use one of the
other supported database management systems. They are better able to handle
large amounts of data and can be tuned for performance.

CFo7

Apache Derby and Site Builder

The use of Apache Derby with Site Builder is not supported on development or
production environments.
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Database transfer

Transfer data to another supported database before you use the portal extensively.
Large amounts of data in the databases can cause the database transfer to fail if
your Java heap size is not large enough. Do not postpone transferring data to
another database management system. Waiting to transfer the database can cause
errors to occur during the transfer process, such as not having adequate Java heap
size.

Configuration Wizard

Use the wizard to either create scripts that you or your database administrator can
use to create databases, create database user IDs, and configure database user ID
privileges. The wizard collects information about your database management
system, the database topology you want, the user IDs you require, and more. Then,
it generated custom scripts and instructions.

[“Database users”]

There are two types of database users: database configuration users and
database runtime users. Become familiar with the privileges required for each
user type to work with the database domains of IBM WebSphere Portal and the
commands for creating database configuration users and granting privileges.

[“Database topologies” on page 142|

Consider the database configuration options in relation to your IBM WebSphere
Portal deployment scenario. The complexity of the network topology increases
as you scale from a proof-of-concept environment using Derby to systems using
vertical and horizontal clustering techniques.

[“Portal database domains” on page 144]

Sets of databases tables and schemas for portal resources are called database
domains. Database domains classify and help you determine how to distribute
portal data. There are six database domains: release, customization, community,
JCR, feedback, and likeminds.

[‘TDBC type 2 and type 4 drivers” on page 146|
The Configuration Wizard uses JDBC type 4 drivers by default. You can change
the default selection in the Configuration Wizard.

[“Shared database domains” on page 146|

To maximize data availability, you can distribute portal data across multiple
databases and, for some domains, share data between multiple lines of
production. You can choose to transfer a single database domain or multiple
domains.

Database users

There are two types of database users: database configuration users and database
runtime users. Become familiar with the privileges required for each user type to

work with the database domains of IBM WebSphere Portal and the commands for
creating database configuration users and granting privileges.

Database configuration user

The database administration user that is typically created when a database
management system (DBMS) is installed is the database installation user or the
database configuration user. The database configuration user is not necessarily the
user that is created by default when the database management system is installed.
The default user might be used as the database configuration user. The database
configuration user is used by WebSphere Portal for configuration tasks and creates
the database structure that is needed by WebSphere Portal. For example, the
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database configuration user can create database tables and indexes, do database
transfer, and often times has operating system privileges, depending on the
database management system.

Database runtime user

The database runtime user has fewer privileges than the database configuration user.
The runtime user has runtime access to the data source of a database and can do
basic read and write operations on the data. Consider creating a dedicated runtime
user for each database domain of WebSphere Portal. If you do not create runtime
users, then WebSphere Portal uses the configuration user to connect to the
databases at run time.

Privileges of database users

The following table identifies the minimum privileges that are needed to correct
function by the two types of database users: configuration users and runtime users.
The privileges that are listed pertain to all WebSphere Portal database domains.

Table 7. List of minimum privileges held by database runtime users for all database
domains.

Permission
within the
database

domain Release Community| CustomizatipfCR Feedback |Likeminds

Access to Yes Yes Yes Yes Yes Yes
the
database

Read on all | Yes Yes Yes Yes Yes Yes
tables

Write on all | Yes Yes Yes Yes Yes Yes
tables

Update on | Yes Yes Yes Yes Yes Yes
all tables

Delete on Yes Yes Yes Yes Yes Yes
all tables

Create No No No No No No
tables

Create No No No No No No
indexes

Use of No No No No Yes No
sequences

Table 8. List of privileges held by database configuration users for all database domains.

Permission
within the
database

domain Release Community| CustomizatipfCR Feedback |Likeminds

Access to Yes Yes Yes Yes Yes Yes
the
database

Read on all | Yes Yes Yes Yes Yes Yes
tables
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Table 8. List of privileges held by database configuration users for all database
domains. (continued)

Permission

within the

database

domain Release Community | CustomizatipfCR Feedback |Likeminds
Write on all | Yes Yes Yes Yes Yes Yes
tables

Update on | Yes Yes Yes Yes Yes Yes
all tables

Delete on | Yes Yes Yes Yes Yes Yes
all tables

Quota on Yes Yes Yes Yes Yes Yes
disk to

create new

objects

Create Yes Yes Yes Yes Yes Yes
table

spaces

Drop table | Yes Yes Yes Yes Yes Yes
spaces

Create Yes Yes Yes Yes Yes Yes
tables

Alter tables | Yes Yes Yes Yes Yes Yes
Drop tables | Yes Yes Yes Yes Yes Yes
Create Yes Yes Yes Yes Yes Yes
indexes

Drop Yes Yes Yes Yes Yes Yes
indexes

Create Yes Yes Yes No Yes Yes
triggers

Drop Yes Yes Yes Yes Yes Yes
triggers

Create No No No Yes Yes No
sequences

Use of No No No Yes Yes No
sequences

Create No No No Yes No No
types

Drop types |No No No Yes No No
Create No No No No No No
views

Drop views | No No No Yes No No

Related information:

“Database Transfer: Granting privileges to database users for DB2 for i” on page|
661

Configuration and runtime database users are granted a different set of privileges,
depending on whether these users are schema owners or not. You can create a
copy of the SQL scripts and edit this copy to manually grant permissions to
configuration and runtime database users.
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Database topologies

Consider the database configuration options in relation to your IBM WebSphere
Portal deployment scenario. The complexity of the network topology increases as
you scale from a proof-of-concept environment using Derby to systems using
vertical and horizontal clustering techniques.

WebSphere Portal data is separated into six portal database domains: release,
customization, community, JCR, feedback, and likeminds. The portal database
domains facilitate the flexibility that is required to meet different availability
requirements. The database topology varies depending on the deployment
scenario. A proof-of-concept or development environment has different database
topology requirements than a production environment. Review the topologies to
determine your portal deployment requirement.

Local database

For proof-of-concept, demonstrations, and development environments, you can use
a local database. You can install the database management software on the same
server as WebSphere Portal. When the database is on the same server as the portal,
it is referred to as a local database. Using a local database can make administering
your environment easier. However, this setup is best used for proof-of-concept
deployments only. A local database competes for server resources with your portal.

In the topology diagram, all of the portal database domains are stored in one
database, wpsdb.

Release
"'\-u..___‘_._,_.-ﬂ'
Customization
—
Community
"-u..__‘_'__.-ﬂ'

JCR
PE—

Feedback
o ——— |

Likeminds

——

Detail View
WebSphere of wpsdb
Portal ——

Remote database

For normal load balancing, you can use one or more remote databases. You can
install the database management software on a different server from WebSphere
Portal. When the database is on a different physical server than the portal, it is
referred to as a remote database. Using a remote database can provide performance
benefits, depending on the speed of the network.

When multiple lines of production are involved and each line of production is
implemented as a cluster of servers, share portal database domains. Each database
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domain can be placed on a separate database for efficient maintenance. The release
and JCR portal database domains cannot be shared.

The topology diagram is similar to the local database topology. The main
difference is that the database is on a different server than the portal.

Likeminds
WebSphere Database Detail View
Portal Server of wpsdb

High capacity and availability

For high capacity load balancing, use one or multiple remote databases. When you
deploy the portal in a large-scale, high-demand environment, you can dedicate a
server specifically for database transactions. As more users access the portal, the
portal application becomes database intensive. Database activity can take up
processor resources and disk I/O time. Separating the database from the server
that the portal is running on increases its capacity.

In the topology diagram, there is a remote database server with four databases.
The JCR and release portal database domains have unique databases. They cannot
be shared. Also, the release portal database domain cannot be taken offline.
Another database contains the customization and community portal database
domains. Finally, there is another database to contain the feedback and likeminds
portal database domains.
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WebSphere Database Server
Portal with Multiple Likeminds
Databases

Portal database domains
Sets of databases tables and schemas for portal resources are called database
domains. Database domains classify and help you determine how to distribute

portal data. There are six database domains: release, customization, community,
JCR, feedback, and likeminds.

The database domains categorize portal data into the following categories and
subcategories to help you decide how to distribute portal data into different
databases:

Release data (release and JCR)
Includes all portal content definitions, rules, and rights that are designed
externally then brought into the portal by a staging process, such as page
hierarchy, available portlets and themes, templates, credential slots,
Personalization rules, and policies. These resources are typically not
modified during production and need administrative rights to do so.
Administrators typically create release data on an integration server and
stage it to the production system. Release data is protected by access
control and contains only data, not code. Release data includes two
separate portal database domains: release and JCR.

The release portal database domain contains portal static site configuration,
including access control, pages, and portlets.

The JCR portal database domain contains authored content, Personalization
rules, and theme policy definitions.

Customization data (customization)
This data is associated with a particular user only and cannot be shared
across users or user groups. Typical examples are portlet data or
customized pages (implicitly derived pages). Because this data is scoped to
a single user only, access control protection is simplified.

Community data (community)
This data includes all resources that are modified during production.
Typically, users and groups are allowed to modify or delete shared
resources. Community resources are protected by access control.
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Configuration data
Configuration data is not store in a portal database domain. It is typically
kept in property files. The property files are either protected by file system
security or application server administration rights. This data defines the
portal server setup, such as database connection, object factories, and
deployment descriptors. This type of data typically is constant during the
time a server node is running.

Feedback and likeminds portal database domains store data exclusively for the
Feedback and LikeMinds applications.

Database schema names
The table includes the default names that are used in the Configuration Wizard.
Replace these values with the values in your environment; schema names must be

different when the database is shared.

All table spaces are approximately 2.8 GB by default. The size increases with the
use of the Java Content Repository function.

For some database software, such as DB2, the database name cannot exceed 8
characters and can contain letters and numbers only.

Table 9. Space required for various databases

Application

Database name | Space required

WebSphere Portal

Used for the portal (at a minimum) or to
hold all data. Stores information about user custdb
customization, such as pages, and user
profile and login information.

reldb Depends on the number of users and portal objects,

commdb such as pages and portlets.

Personalization,Web Content Manager jerdb Depends on the number and size of Personalization
rules and campaigns, and the number and size of

Contains documents, personalization rules, items and elements that are created in.Web Content

personalization campaigns, and document Manager

library configuration information.

Feedback fdbkdb Depends on the amount of traffic to the site. The
amount of data that is logged per login-enabled page

Contains the information that is logged by can vary.

your website for analysis of site activity

and generating reports.

LikeMinds

Contains the recommendations that are
displayed to users. The LikeMinds
application analyzes the visitor's
interactions with your website are and

generates predictions.

Imdb Depends on the amount of traffic to the site.

Database users

The table indicates types of objects that are owned by each user. The architecture
allows each of the following users to exist in the same database. All table spaces
are approximately 2.8 GB by default. The size increases with the use of Java
Content Repository.
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Application Database user Function

WebSphere Portal releaseusr Core user who owns
approximately 230 tables,
which are used for
customizationusr WebSphere Portal core
objects, which include tables
that store the user
customizations that are made
to pages.

communityusr

Java Content Repository jer Java Content Repository user
who owns approximately 100
tables. The number might be
higher depending on usage.

Feedback feedback Feedback user who owns
approximately 50 tables that
are used for logging site and
personalization usage.

LikeMinds likeminds LikeMinds user who owns
approximately 15 tables that
are used to hold the website
usage analysis routines and
recommendation text.

JDBC type 2 and type 4 drivers
The Configuration Wizard uses JDBC type 4 drivers by default. You can change the
default selection in the Configuration Wizard.

During step 2, Customize Values, click Advanced to change the driver type.

When you use a JDBC type 2 connection, WebSphere Portal and DB2 Connect are
installed on one system (the local system). The DB2 server is installed on a
different system (the remote system).

When you use a JDBC type 4 connection, you do not need DB2 Connect. Instead,
the DB2 Universal JDBC driver that is supplied with DB2 is copied to portal server.
It is used within the Java virtual machine (JVM) of WebSphere Portal and connects
directly to the remote DB2 server.

Depending on your database software, there might be more required configuration
steps for using type 2 drivers. Review the installing database software topics.

Related tasks:

[“Installing and preparing Oracle or Oracle RAC” on page 207|
You can use Oracle or Oracle RAC as the database software.

[“Installing and preparing DB2 for z/OS” on page 210

Use this information to install DB2 for z/OS® for use with IBM WebSphere Portal.
[“Installing and preparing DB2” on page 205

Use this information to install DB2 or DB2 pureScale for use with IBM WebSphere
Portal.

Shared database domains

To maximize data availability, you can distribute portal data across multiple
databases and, for some domains, share data between multiple lines of production.
You can choose to transfer a single database domain or multiple domains.
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Separation of WebSphere Portal data allows you to store each category of data in
its own set of database tables or the file system. Database domains support the
storage and transfer of data by category, for example, Configuration, Release,
Customization, Community, and IBM Java Content Repository (JCR). Separating
your data allows you to share domains across multiple portals. You can also
spread the different domains across different database types. For example, you can
choose to leave LikeMinds data on your default database and move all other data
to another database. The separation of the domains can be used to support
production environments, where the production nodes are split into separate
clusters. Each cluster can run independently, but share the Community and
Customization database domains, for example. Each of these clusters is called a line
of production.

Preferences are kept in layers that are modifiable based on portlet modes. For
example, there is one layer of default preferences that are defined by the portlet
deployment descriptor. This layer is modifiable within the CONFIG mode that is
supported by WebSphere Portal. In WebSphere Application Server, the values of
the portlet deployment descriptor are read-only. WebSphere Portal provides one
additional preference layer that enables portal administrators to specify different
default values per portlet window. This capability is supported through the portlet
mode EDIT_DEFAULTS, and applies to all who use the same portlet window.
There is no such preference layer in WebSphere Application Server. Both products
support the standard modes: VIEW, EDIT, and HELP. When a user customizes a
portlet on a page in any standard mode, the user can change their personal portlet
preferences. Default preferences on a per page or per portlet base cannot be set in
any standard mode; you need to use custom portlet modes instead. Portlet
preferences are stored in the customization domain when stored by users (typically
in edit mode) on the entity level whereas when you use configure mode, you're
working on the portlet definition level and those are stored on the release level.

The following table lists the supported database domains, whether a domain is
sharable, and notes.

Table 10. Supported database domains

Database domain Sharable Notes

Release no In an environment that
consists of multiple lines of
production, one copy of the
release data exists per cluster.

Considered the domain as
release data and promote to
production lines individually.

Customization yes In an environment that
consists of multiple lines of
production, customization
data is kept in a database
that is shared across the lines
of production. Therefore, the
data is automatically in
synchronization across the
lines of production.

Community yes

JCR no Considered the domain as
release data and promote to
production lines individually.
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Table 10. Supported database domains (continued)

Database domain Sharable Notes
Feedback yes
LikeMinds yes

The following table summarizes the portlet modes, the database that data is in,
and whether that database is sharable:

Table 11. Portlet modes and where the data is stored

Shareable between
multiple lines of
Type Portlet mode Domain production
Administrator config release no
preferences
Shared preferences edit_defaults release no
Personalized edit customization yes
preferences

For maintenance and staging purposes, you can take a single line of production
out of service while another line is still serving requests with the old data. After
the first production line is updated and back in service again, the second line is
updated by using the same approach. Updates of data in the shared domain are
critical because they influence the other production line.

The capacity of the entire environment must be greater than the intended use so
that individual servers can be taken out of production without affecting application
availability. To ensure that all of the system resources are available for the portal,
production systems must be dedicated to the portal and must not run any other
server software that is not related to the portal.

For maintenance purposes, the following database domains can be taken offline:
* Community

e Customization

* Feedback

* LikeMinds

The following databases must not be taken offline at anytime when WebSphere
Portal is started:

* Release

* JCR

While a database domain is offline, WebSphere Portal cannot access the
corresponding data and thus error messages might be displayed. WebSphere Portal
itself remains responsive. When a database domain becomes available again,
WebSphere Portal detects this availability, reconnect, and continue working with
the corresponding data. Regular maintenance must not affect the shared database

domains because it is imperative that these datadata remains available to all lines
of production currently in use.
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Sharing of VMM databases

The VMM database feature makes it much simpler to use multiple repositories,
since this capability is achieved through configuration, rather than development,
with the use of the new VMM. In essence, this feature provides the ability to map
entries from multiple individual user repositories into a single virtual repository.
The federated repository consists of a single named realm, which is a set of
independent user repositories. Each repository might be an entire external
repository or, in the case of LDAP, a subtree within that repository. The root of
each repository is mapped to a base entry within the federated repository, which is
a starting point within the hierarchical namespace of the virtual realm. The Virtual
Member Manager (VMM) databases for a full repository and for the property
extension can be shared between lines of production. If the VMM databases are out
of service, WebSphere Portal does not function.

User registry considerations

A user registry or repository authenticates a user and retrieves information about
users and groups to do security-related functions, including authentication and
authorization.

User registries store user account information, such as user ID and password, that
can be accessed during authentication. User repositories store user profiles and
preference information. A user registry or repository is used to:

* Authenticate a user by using basic authentication, identity assertion, or client
certificates

* Retrieve user and group information to do security-related administrative
functions such as mapping users and groups to security roles

By default, IBM WebSphere Portal is installed with a federated repository with a
built-in file repository. The federated repository allows you to add various user
registries, realm support for Virtual Portals, and/or property extensions to create a
single, working unit. The available user registries that you can add to the federated
repository are LDAP user registries, database user registries, and custom user
registries.

Remember: Using the built-in file repository is not recommended in a production
environment. After you add another repository and choose the administrative
users from that repository, you must remove the file repository.

Based on the federated repository, WebSphere Portal allows you to create a user
base that can be federated over multiple repositories: LDAP, DB, and/or custom
user registry. It also allows you to define additional attributes in a separate store if
your corporate LDAP directory is read-only.

If you are using a federated repository, you must plan on where you want to store
new users and groups. By default, new users and groups are stored in the default
file repository. If you use use multiple LDAP user registries and database user
registries, you must figure out which user registry you want to define as your
default user registry where new users and groups are stored. After you add all
user registries to your federated repository, you can run the wp-set-entitytypes
task to set a specific user registry as the default location.

Remember: Before you combine multiple user registries, review the registries for
the following limitations and correct any issues:
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Distinguished names must be unique for a realm over all registries. For example,
if uid=wpsadmin,o=yourco exists in LDAP1, it must not exist in LDAP2, LDAP3,
or DBI.

The short name, for example wpsadmin, should be unique for a realm over all
registries.

The base distinguished names for all registries that are used within a realm must
not overlap; for example, if LDAP1 is c=us,o=yourco, LDAP2 must not be
o=yourco.

Do not leave the base entry blank for any of the registries used within a realm.

If IBM Domino is one of your user registries in a multiple registry configuration
and shares a realm with another user registry, ensure that the groups are stored
in a hierarchical format in the Domino Directory as opposed to the default
flat-naming structure. For example, the flat-naming convention is cn=groupName
and the hierarchical format is cn=groupName ,o0=root.

The user must exist in a user registry and not within the property extension
configuration; otherwise, the user cannot be a member of the realm.

[“User registry options”]

IBM WebSphere Portal provides various security configuration tasks. In the
past, there was one task and you might not recover from errors. Also, you
might not expand your user registry to meet your growing business needs.
Now there are multiple tasks and you can fine-tune your system to meet your
business needs.

[“Virtual Member Manager integration” on page 153

IBM WebSphere Application Server includes the Virtual Member Manager
(VMM), which IBM WebSphere Portal uses to access user and group
information. VMM provides an interface that enables communication between
WebSphere Portal and any repository, whether federated repositories or your
own custom user registry.

[“Realm support” on page 154

A realm is a collection of users or groups from one or more branches of your
repository tree. Those branches can be part of a single repository, for example
an LDAP user registry, or it can be a combination of multiple user registries. A
realm is then mapped to a Virtual Portal to allow the realm's user population to
log in to the Virtual Portal. This functionality allows you to define areas within
WebSphere Portal that only a limited set of users can access.

[“Property extension” on page 155|

Use the property extension, formerly known as the lookaside database, to store
extra user attributes into a database store without touching your backend user
registry. You can use the property extension if your LDAP is read-only but you
want users to specify an extra attribute such as Timezone. You can store this
extra attribute in the database store. You can also add extra attributes for an
application if you cannot change your repository schema. Property extension
can be used with a federated repository or a custom user registry.

Related reference:

[‘Directory Search” on page 1215|

The Directory Search or "People Picker" portlet is a common embedded component
that allows users to search for and select names of people (individual users) and
groups for which the portal is configured.

User registry options
IBM WebSphere Portal provides various security configuration tasks. In the past,
there was one task and you might not recover from errors. Also, you might not
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expand your user registry to meet your growing business needs. Now there are
multiple tasks and you can fine-tune your system to meet your business needs.

You have the following general security options to choose from:

Table 12. Security options with explanation

Security option

Explanation

Federated security

With this option, you can create Virtual
Portals with multiple realms. You can also
use multiple repositories (LDAP, database,
custom), and you can add Application
Groups to your system. This option is good
if you must merge multiple LDAP servers
into one cohesive structure.

Attention: If you plan to enable the
transient user feature, you must choose the
federated user registry configuration.
Important: You must take special care that
there are no duplicate names between the
various repositories. For example, if you
installed the product with a Portal
Administrator of adminl, then adminl must
not exist in the corporate LDAP server.

Custom security

This option provides you with the ability to
write a fully controlled WebSphere Security
environment. There is a custom user registry
and a custom member adapter for Virtual
Member Manager (VMM). The abilities of
this option depend on your implementation.

Federated security

WebSphere Portal is configured with a default federated repository with a built-in
file repository. The federated repository offers you the richest number of options to
meet your business needs. You can easily expand your business as your needs
grow. For example, your company acquires a new business that has an existing
LDAP user registry. You can add that LDAP server to your federated repository.
Choose one of the following tasks to enable a production repository:

Table 13. Tasks to enable a production repository

Task

Description

Add a federated LDAP repository to the
VMM configuration

Select this option to add an LDAP server to
the federated repository. This task does not
change the current security assignment.
Therefore, the administrative user that is
defined during installation is still active.

Add a federated database repository to the
VMM configuration

Select this option to add a database to the
federated repository. This task does not
change the current security assignment.
Therefore, the administrative user that is
defined during installation is still active.
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Table 13. Tasks to enable a production repository (continued)

Task Description

Add a federated custom user registry Select this option to add a custom user
registry that your company created to the
federated repository. This task does not
change the current security assignment.
Therefore, the administrative user that is
defined during installation is still active.

After you add your initial user registry, you can add more user registries to the
repository to create a multiple user registry configuration. After you configure your
repository, you must remove the default file-based repository. You do not have to
remove the file-based repository in a development environment or if you are using
IBM Connections. The following tasks are required to remove the default file-based
repository:

Table 14. Tasks required to remove the default file-based repository

Task Description

Change the user registry where users and This task changes the default repository

groups are stored where new users and groups are stored.

Change WebSphere Application Server This task changes the WebSphere

administrator Application Server administrator user ID
and password.

Change WebSphere Portal Server This task changes the WebSphere Portal

administrator administrator user ID and password.

Delete a federated repository from the VMM | This task deleted the default file-based
configuration repository from your configuration.

After you use your federated repository, you might need to manage your user
registry. You can run any of the following optional tasks to fine-tune your
federated repository:

Table 15. Optional tasks to manage the federated repository

Task Description

Updating the federated LDAP user registry | Choose this option to update certain
parameters such as your bind ID and
password to fix issues with your LDAP user

registry.
Updating the federated database user Choose this option to update certain
registry parameters such as the data source name,

database URL, and database type to fix
issues with your database user registry.

Create a realm Choose this option to create a realm, which
is a group of users from one or more user
registries that form a coherent group within
WebSphere Portal. Realms allow flexible
user management with various configuration
options. A realm must be mapped to a
Virtual Portal to allow the defined users to
log in to the Virtual Portal. In a federated
repository, you can create multiple realms.
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Virtual Member Manager integration

IBM WebSphere Application Server includes the Virtual Member Manager (VMM),
which IBM WebSphere Portal uses to access user and group information. VMM
provides an interface that enables communication between WebSphere Portal and
any repository, whether federated repositories or your own custom user registry.

The Virtual Member Manager (VMM) is an abstract component within the
WebSphere Application Server infrastructure. As the following diagram illustrates,
WebSphere Portal uses the Portal User Management Architecture (PUMA) System
Programming Interface (SPI) to retrieve and set attributes on user objects. PUMA
passes these requests to VMM, which then passes the requests on to a
corresponding registry adapter that connects VMM to the repository.

WebSphere Application Server

WebhSphere Application Server Security

YIMM LDAP
Database

Custom Implementation
{includes custom user repository database)

The preceding diagram includes the following components:
Federated repositories

An out-of-box implementation of the UserRegistry interface that supports
multiple repositories. To communicate with the federated repositories, both
WebSphere Application Server and WebSphere Portal dispatch all
operations to VMM.

VMM SPI

VMM offers a Service Provider Interface (SPI), wim.Repository, that enables
communication with repositories. WebSphere Application Server uses this
SPI to connect to federated repositories. WebSphere Portal uses this SPI to
connect to all repositories.

User registry adapter

Chapter 4. Installing 153



An implementation of the VMM SPI that enables VMM to connect to a
specific repository, whether an LDAP directory, database, files, or other
repository. Registry adapters enable communication between WebSphere
Portal and any repository.

Important: You must create a user registry adapter if you plan to use a
custom user registry or repository that WebSphere Portal does not support
out-of-box. To create a user registry adapter, implement the wim.Repository
interface. Refer to the following topics in the WebSphere Application
Server Information Center for information and instructions:

Repository SPI (System programming interfaces for virtual member manager
adapters)

Sample custom adapters for federated repositories examples
Related tasks:

[‘Setting up custom user repositories” on page 1907

A custom user repository is any repository that WebSphere Portal does not support
out-of-box. However, you can configure WebSphere Portal to support any type of
repository in a federated or stand-alone user registry, whether an LDAP directory,
database, file system, and so on. Setting up custom user repositories involves tasks
such as defining additional repositories to the default federated user registry,
creating a custom stand-alone user repository, and updating your user repository
to reflect changes in your environment. Learn what steps are required to create and
update custom user repositories and what specific interfaces you must implement
to enable communication between WebSphere Portal and a repository.

Related information:

[ [Webcast replay of WebSphere Portal WMM to VMM comparison|

[ [Setting up a custom user repository with Virtual Member Manager for IBM|
[WebSphere Application Server and IBM WebSphere Portall

[ [[BM WebSphere Developer Technical Journal: Expand your user registry|
options with a federated repository in WebSphere Application Server, Using the|
Virtual Member Manager|

[ [Virtual member manager APIs|

[ [Sample custom adapters for federated repositories examples|

[

Realm support

A realm is a collection of users or groups from one or more branches of your
repository tree. Those branches can be part of a single repository, for example an
LDAP user registry, or it can be a combination of multiple user registries. A realm
is then mapped to a Virtual Portal to allow the realm's user population to log in to
the Virtual Portal. This functionality allows you to define areas within WebSphere
Portal that only a limited set of users can access.

For example, if you are an international company with employees in Asia, Europe,
USA, and Canada, you might have an application or information that applies only
to a subset of these employees. You can create a subset of employees and create a
Virtual Portal that contains the application or information for that realm. Users
from one realm cannot access another realm unless they are also members of that
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realm. For example, the wpsadmin user cannot log in to a Virtual Portal unless the
wpsadmin user is a member of the corresponding realm.

You can create a realm that combines users from your various user registries; for
example, your realm can span three LDAP user registries and a database user
registry: LDAP1, LDAP2, LDAP3, and DB1.

Remember: Before you combine multiple user registries, review the registries for
the following limitations and correct any issues:

* Distinguished names must be unique for a realm over all registries. For example,
if uid=wpsadmin,o=yourco exists in LDAP1, it must not exist in LDAP2, LDAPS3,
or DB1.

* The short name, for example wpsadmin, should be unique for a realm over all
registries.

* The base distinguished names for all registries that are used within a realm must
not overlap; for example, if LDAP1 is c=us,o0=yourco, LDAP2 must not be
o=yourco.

* Do not leave the base entry blank for any of the registries used within a realm.

* If IBM Domino is one of your user registries in a multiple registry configuration
and shares a realm with another user registry, ensure that the groups are stored
in a hierarchical format in the Domino Directory as opposed to the default
flat-naming structure. For example, the flat-naming convention is cn=groupName
and the hierarchical format is cn=groupName ,0=root.

* The user must exist in a user registry and not within the property extension
configuration; otherwise, the user cannot be a member of the realm.

Property extension

Use the property extension, formerly known as the lookaside database, to store
extra user attributes into a database store without touching your backend user
registry. You can use the property extension if your LDAP is read-only but you
want users to specify an extra attribute such as Timezone. You can store this extra
attribute in the database store. You can also add extra attributes for an application
if you cannot change your repository schema. Property extension can be used with
a federated repository or a custom user registry.

IBM Web Content Manager stores extra information for the following features:
* Web content user profiling
* Category selection trees

If this information cannot be stored in the main repository, for example the main
repository is read-only, a property extension configuration is required.

Cluster considerations

To increase capacity and availability, multiple portal servers can be clustered with
IBM WebSphere Application Server Network Deployment. In a cluster, the portals
share a common configuration and the load is distributed evenly across all cluster
instances.

IBM WebSphere Portal comes standard with WebSphere Application Server
Network Deployment, a distribution of IBM WebSphere Application Server that
provides a Deployment Manager server type for centrally managing and clustering
a series of servers. To cluster a series of portal servers means that all portal
instances share configuration, including database, applications, and portlets, and
site design. The cluster provides a domain against which most administrative
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actions are done once and synchronized with each server in the cluster. This action
both simplify administration and ensure that all cluster members are configured
and behave identically.

A server cluster also provides a shared domain in which session and cache data
can be replicated and kept consistent across all members of the cluster. The cluster
also provides an application synchronization mechanism that ensures consistent
application management (start, stop, updates, and so on) across the cluster.

WebSphere Application Server provides an HTTP Server plug-in that can balance
user traffic across all members of the cluster. And through a feature called "session
affinity"”, ensure that a user remains bound to a specific cluster instance during
their session to improve efficiency and performance. Additionally, in the event a
cluster member is down the workload management features of the plug-in
recognizes that the instance is no longer available and route traffic around it.

There are two types of clusters: vertical and horizontal clusters. Most large-scale
deployments are mixtures of both cluster types.

It is also possible to deploy multiple portal clusters to improve availability, failover,
and disaster recovery.

It is recommended that you review the cluster guidelines and limitations topics for
more information about what is involved in setting up a cluster.

Restriction: The serverName is hardcoded to WebSphere Portal. The serverName
cannot be changed in a stand-alone environment. If you do change it, the
ConfigEngine scripts do not work. For a clustered environment, see
for options on replacing the WebSphere Portal JVM.
[Guidelines for setting up a cluster” on page 157
When you set up a WebSphere Portal cluster, you must take into account any
cluster planning that is required for the WebSphere Application Server nodes. If
you are not familiar with WebSphere Application Server clustering, find
resources here to help you get started.

[“Limitations for setting up a cluster” on page 15§
Certain limitations apply when you set up a WebSphere Portal cluster.

[“HTTP session failover” on page 159

In a clustered environment, all requests for a particular session are directed to
the same server instance in the cluster. In other words, after a user establishes a
session (for example, by logging in), the user is served by the same server
instance during the session. To verify which server is handling user requests for
a session, you can view the global settings portlet. This portlet displays the
node name of the server handling requests. If one of the servers in the cluster
fails, the request is rerouted to another server in the cluster. If distributed
sessions support is enabled, the new server can access session data from the
database or another server instance.

[“Setting up an IBM i database in a cluster” on page 160|

To communicate with a database, servers that run IBM i can use either of two
JDBC drivers: the IBM Toolbox for Java JDBC driver or the IBM Developer Kit
for Java JDBC driver (also referred to as the native JDBC driver). Which JDBC
driver you must use depends on how you are setting up your clustered
environment.

[“Security options” on page 163)|
The security model in IBM WebSphere Application Server and IBM WebSphere
Portal affects the planning and implementation of security in a cluster. Security
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is enabled by default for the WebSphere Application Server deployment
manager. WebSphere Portal does not attempt to change the security settings in
the deployment manager cell whenever a node is federated. Therefore, any
existing security configuration of a stand-alone WebSphere Portal is replaced
with the security settings of the deployment manager cell when it joins that
cell. If you remove the node from the deployment manager cell, the original
security settings are reinstated.

[“Security Scenarios” on page 163)|

Setting up a clustered environment requires that you consider two security
scenarios. The first scenario is out-of-box security that is used when you first
set up the cluster environment where the deployment manager is not
configured for security. The second scenario is when an existing deployment
manager is already configured for security before a node joins the cell.

[“Using external security managers in a cluster” on page 164|

If you are configuring security for IBM WebSphere Portal with an external
security manager, review some additional considerations, depending on the
external security manager that you are using. Complete any configuration for
an external security manager after you have completed all other setup,
including ensuring that the WebSphere Portal cluster is functional. In addition,
review the "Systems requirement" file to ensure you are using a supported level
of the external security manager software.

[“Planning for multiple clusters” on page 166|

Get an overview of the concepts associated with setting up multiple clusters.
Multiple clusters are sets of servers that are managed together within a single
administrative domain that is known as a cell, and participate in workload
management.

[“Dynamic clusters” on page 169
You can create a dynamic cluster to run IBM WebSphere Portal.

[“Cluster maintenance” on page 170|

Maintaining IBM WebSphere Portal in a cluster typically means applying
corrective services (fix packs and interim fixes) or updating the software release
level on each node in the cluster. Instructions for applying corrective service to
a WebSphere Portal cluster are provided with the corrective service package.
Before you apply any maintenance, analyze any user impact. Ensure that you
are able to provide uninterrupted service (also referred to as 24x7 availability),
even during the maintenance phase.

Guidelines for setting up a cluster

When you set up a WebSphere Portal cluster, you must take into account any
cluster planning that is required for the WebSphere Application Server nodes. If
you are not familiar with WebSphere Application Server clustering, find resources
here to help you get started.

Prerequisites

In WebSphere Application Server, a cluster is composed of multiple identical copies
of an application server. A cluster member is a single application server in the
cluster. WebSphere Portal is installed as an enterprise application server within the
WebSphere Application Server infrastructure. All of the clustering features
available within the WebSphere Application Server infrastructure are also available
and apply to WebSphere Portal. Thus, a WebSphere Portal cluster is a collection of
multiple WebSphere Portal servers that are identically configured.

For more planning information, refer to the appropriate IBM WebSphere
Application Server Network Deployment version at Ihttp:/ /www.ibm.com/ |
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Guidelines for implementing cluster environments

Implement cluster environments according to the following guidelines:

The WebSphere Portal databases must be transferred to a supported external
database, for example: DB2, Oracle, or SQL Server .

You can use several approaches to configure an external web server in a
clustered environment. The instructions for installing a WebSphere Portal follow
WebSphere Application Server, which involves the plug-ins installation wizard to
install the binary plug-in module after the cell is set up. For a complete
description of the procedure for configuring an external web server in a
clustered environment, refer to the following information:

— AIX HP-UX Linux Solaris Windows: [Selecting a Web server topology diagram|

— IBM i: [Selecting a Web server topology diagram and road map|

The deployment manager node must be installed separately before the cells and
clusters can be configured.

WebSphere Application Server provides database session persistence and
memory-to-memory replication as techniques for HTTP session failover in a
clustered environment. Review the following information to determine whether
you want to use one of these techniques in your cluster:

— AIX HP-UX Linux Solaris Windows: [Task overview: Managing HTTP sessions|
— IBM i: [Task overview: Managing HTTP sessions]

You can create a dynamic cluster to run WebSphere Portal.

The WasRemoteHostName and WasSoapPort properties, which are in the
wkplc.properties file, must always be accurate because many ConfigEngine
scripts depend on them. If you are in a stand-alone environment, these
parameters point to the host name and soap port for the WebSphere_Portal
application server. If you are in a clustered environment, these parameters point
to the Deployment manager host name and soap port. Modify these properties
when instructed to during the installation instructions.

If you add a node to a cell or change a node's configuration after it is federated
to the deployment manager, synchronize the node's configuration.

If you are planning to configure an external security manager for authentication
or authorization, install and configure the WebSphere Portal cluster first. Verify
that the cluster is working properly before you configure the external security
manager.

IBM i: Set up a recycling procedure WebSphere Portal database with the
following command; this procedure automatically removes the unused journal
files:

CHGJRN JRN(Your DB2 DB Name/QSQJRN) DLTRCV(*YES)

Where Your DB2 DB Name is the value of the release.DbName property, which is
in the wkplc_dbdomain.properties file.

Limitations for setting up a cluster
Certain limitations apply when you set up a WebSphere Portal cluster.
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You must install WebSphere Portal as a stand-alone node before you create a
cluster. You cannot install WebSphere Portal into a managed node.

AIX IBM i Linux Solaris Windows: Except for the initial setup of the cluster,
WebSphere Portal is not supported on a managed node that is not part of a
cluster.


http://www.ibm.com/software/webservers/appserv/was/library/
http://www-01.ibm.com/support/knowledgecenter/SSAW57_8.5.5/com.ibm.websphere.nd.doc/ae/tins_road_plugins.html
http://www-01.ibm.com/support/knowledgecenter/SSAW57_8.5.5/com.ibm.websphere.nd.doc/ae/tins_road_plugins.html
http://www-01.ibm.com/support/knowledgecenter/SSAW57_8.5.5/com.ibm.websphere.nd.iseries.doc/ae/tins_road_plugins.html?lang=en
http://www-01.ibm.com/support/knowledgecenter/SSAW57_8.5.5/com.ibm.websphere.nd.doc/ae/tprs_sep1.html
http://www-01.ibm.com/support/knowledgecenter/SSAW57_8.5.5/com.ibm.websphere.nd.iseries.doc/ae/tprs_sep1.html

Note: A cluster can be created which contains only one WebSphere Portal server,
enabling a single WebSphere Portal server to be operational in a managed cell.

* You cannot use the Derby database. The WebSphere Portal databases must be
transferred to a supported external database, for example: DB2, Oracle, or SQL
Server .

* In a clustered environment, it is not possible to change settings through the
Global Settings portlet or the XML configuration interface. These changes must
be made by modifying the respective properties in the WebSphere Integrated
Solutions Console.

* To support search, you must install and configure a remote search service on an
application server node that is not part of the cluster.

* Administrative actions for WebSphere Portal are immediately visible for the user
who completes them. However, another user can be assured of seeing the
changes only if the user logs out of WebSphere Portal and then logs back in.
This limitation applies to both cluster and non-cluster environments.

* When you create a cluster or a cluster member, do not use spaces in the cluster
name or the cluster member name.

* IBM i limitations: Installation in a mixed node environment is not supported in
an IBM i environment.

* For the deployment manager and each WebSphere Portal node to be in the
cluster, verify that each system clock is set to within 5 minutes of the others or
the addNode command fails.

Restriction: The serverName is hardcoded to WebSphere Portal. The serverName
cannot be changed in a stand-alone environment. If you do change it, the

ConfigEngine scripts do not work. For a clustered environment, see
1370392] for options on replacing the WebSphere Portal JVM.

HTTP session failover

In a clustered environment, all requests for a particular session are directed to the
same server instance in the cluster. In other words, after a user establishes a
session (for example, by logging in), the user is served by the same server instance
during the session. To verify which server is handling user requests for a session,
you can view the global settings portlet. This portlet displays the node name of the
server handling requests. If one of the servers in the cluster fails, the request is
rerouted to another server in the cluster. If distributed sessions support is enabled,
the new server can access session data from the database or another server
instance.

Distributed session support must be configured separately in WebSphere
Application Server. Refer to the WebSphere Application Server documentation for
information:

+ Windows and UNIX: |Distributed sessions|

+ IBM i: [Distributed session support]

By default, failover support is available for WebSphere Portal and any portlets that
are installed with the product. To take advantage of failover support with your
own developed portlets, you must ensure that your portlets are properly
implemented.

Failover and lost data

Data that is stored within the JVM memory. It is not managed by the application
server or the WebSphere Portal server because replication might be lost in the case
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of failover. Even with the distributed session support, users cannot recover any
uncommitted information that is not stored in sessions or other replicated data
areas. In such cases, users might restart a transaction after a failover occurs. For
example, if you are working with a portlet and moved between several screens
when a failover occurs, you return to the initial screen. If you are attempting to
deploy a portlet when a failover occurs, the deployment might not be successful.
Therefore, you must redeploy the portlet. The validity of user login sessions is
maintained despite node failures with distributed session support enabled.

In cases where a portlet does not support failover, a "Portlet unavailable" message
is displayed for the portlet after a failover occurs. If a portlet supports partial or
incomplete failover, some data that is displayed before the failover might
disappear after the failover occurs. The portlet might not work as expected. In such
extreme cases, the user must log out and in to resume normal operation.

After a failover occurs, the request is redirected to another cluster member by the
web server plug-in. Most browsers issue a GET request as a response to a redirect
after you submit a POST request. It ensures that the browser does not send the
same data multiple times without the user's knowledge. However, after the
failover, users must refresh the page or resubmit the form to recover the POST
data.

Note: Any portlets or applications that use POST data are affected by this
behavior.

Failover for the Authoring Portlet

You can configure distributed session support in WebSphere Application Server,
either for persistent sessions or memory-to-memory session replication. Configure
the Custom tuning parameters setting to determine what session attributes are
replicated and how often the replication takes place. You can select a tuning level
from "Very high" to optimize for performance to "Low" to optimize for failover. In
order for session information to be preserved after failover, set the custom-tuning
level so that all session attributes are written.

If the write frequency is set as "Time-based" with a frequency of 10 seconds,
changes within 10 seconds of the failover are lost. If the write frequency is set as
"End of the servlet service", the Authoring portlet session remains intact after
failover.

During a failover condition or session timeout, a Web Content Manager user might
return to the initial screen of the Authoring portlet. Uncommitted data is lost,
including values for new content items or edits to an existing item. There is,
however, no loss of service and the user can continue to work.

Setting up an IBM i database in a cluster

To communicate with a database, servers that run IBM i can use either of two
JDBC drivers: the IBM Toolbox for Java JDBC driver or the IBM Developer Kit for
Java JDBC driver (also referred to as the native JDBC driver). Which JDBC driver
you must use depends on how you are setting up your clustered environment.

The JDBC driver is specified by the db2_iseries.DbDriver property in the
wkplc_dbtype.properties file, which is in thConfigEngine/
properties directory. You can specify the value by editing the file manually or by
selecting the appropriate value by using the configuration wizard.

* Native JDBC driver: com.ibm.db2. jdbc.app.DB2Driver

160 WebSphere Portal v8.5



* IBM Toolbox for Java JDBC driver: com.ibm.as400.access.AS400JDBCDriver
Scaling topology considerations

Vertical and horizontal scaling topologies in an IBM i environment require different
JDBC driver configurations, according to how you deploy your database.

Scaling topology JDBC driver considerations

Vertical scaling When you sett up a vertical cluster, you can
install the database locally on the same
machine as your portal or remotely on a
separate machine. Use the appropriate JDBC
driver, depending on where the database is
installed.

* Local database: Either the native JDBC
driver or the IBM Toolbox for Java JDBC
driver can be used.

* Remote database: The IBM Toolbox for
Java JDBC driver must be used for
connections to a remote database.

Horizontal scaling When you set up a horizontal cluster, you
must use the IBM Toolbox for Java JDBC
driver. The typical configuration is to use a
remote database for primary and secondary
nodes in the cluster. If you choose, you can
use a local database for the primary node
and configure the secondary nodes to use
that database, just as you would any other
remote database. However, regardless of
whether you choose to include a local
database in your environment, you must use
the IBM Toolbox for Java JDBC driver with
your horizontal cluster.

Using a local database in an IBM i horizontal cluster

Although the instructions for setting up a horizontal cluster describe how to use a
remote database for both primary and secondary nodes, you can choose to
configure your IBM i horizontal cluster to use a local database for the primary
node instead. In this example, a database and Web Server are locally installed on
the system (System 1) where IBM® WebSphere® Portal and IBM WebSphere
Application Server are installed. System 1 is the primary node. System 2 is the
secondary node.
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Note: Although it is possible to use a local database on a secondary node instead
of the primary node, this configuration is not tested and is not documented here.

Important: Even though you are using a local database for the primary node in
this scenario, all database connections are configured as if the database were
remote. Specifically, you must use the IBM Toolbox for Java JDBC driver
(com.ibm.as400.access.AS400JDBCDriver) when you configure the database for
both primary and secondary nodes.

To use a local database with your primary node, do the database configuration,
with the following variations when you update the properties files in

thCon figEngine directory.
wkplc_dbtype.properties
* Specify the JDBC driver in the db2_iseries.DbDriver property. For
example:
db2_iseries.DbDriver=com.ibm.as400.access.AS400JDBCDriver

* Specify the database location as remote in the db2_iseries.DbDriverType
property. For example:

db2_iseries.DbDriverType=4

wkplc_dbdomain.properties

* Specify the primary node's host name for the domain.DbName properties.
For example: release.DbName=primary_host_name/wpsdb

* Specify the primary node's host name in the domain.DbUr1 properties.
For example: release.DbUr1=jdbc:as400:primary_host_name/wpsdb

Note: If you use the configuration wizard for database transfer, update the values
in the wizard panels rather than in the properties files.

Complete all other configuration as described. When you configure secondary

nodes in this scenario, do your database configuration as you would for any
remote database, by using the primary node's host name for the database transfer.
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Security options

The security model in IBM WebSphere Application Server and IBM WebSphere
Portal affects the planning and implementation of security in a cluster. Security is
enabled by default for the WebSphere Application Server deployment manager.
WebSphere Portal does not attempt to change the security settings in the
deployment manager cell whenever a node is federated. Therefore, any existing
security configuration of a stand-alone WebSphere Portal is replaced with the
security settings of the deployment manager cell when it joins that cell. If you
remove the node from the deployment manager cell, the original security settings
are reinstated.

Default security settings

The default security that is enabled on the deployment manager profiles and
WebSphere Portal profiles installation is the Virtual Member Manager (VMM)
federated security with a single file-based repository configured. If you plan to add
the stand-alone node into a deployment manager cell, there is no need to modify
this default security setting on a WebSphere Portal node. During federation, the
stand-alone environment security settings are replaced with the deployment
manager security settings. The original stand-alone environment security settings
are preserved and revert to the original settings if you remove the node from the
cluster.

Note: If administrative security is disabled on the deployment manager, it must be
enabled before you run the security configuration tasks on the WebSphere Portal
cluster members.

Security options for a cluster

All of the VMM federated security options, including multiple LDAP repositories,
database repositories, and the default file-based repository can be used.

WebSphere Portal provides a number of security tasks, which can be used to
modify the WebSphere Application Server security settings and make the required
updates to the WebSphere Portal configuration in a single step. As soon as a
WebSphere Portal node is federated into a deployment manager cell, all run
WebSphere Portal security tasks update the security configuration on the
deployment manager cell. Run security tasks after you federate the WebSphere
Portal node because the Deployment Manager cell does not contain the
configuration resources that are required to run the security tasks.

Note: Do not use the file-based repository as your only repository in a production
environment. The reason is that updates are only possible through the WebSphere
Integrated Solutions Console, not through portal user management. These updates
are sent to each node in the cell with deployment manager file synchronization.
This process can be time-consuming for large volumes of users and groups. Also,
synchronization does not occur at the same time for all nodes in a cell, so there are
times when the nodes in the cell have differing security definitions. Also, the Users
and Groups portlet is not available with the file-based repository. You must replace
the file-based repository with a federated LDAP user registry to have access to the
Users and Groups portlet.

Security Scenarios

Setting up a clustered environment requires that you consider two security
scenarios. The first scenario is out-of-box security that is used when you first set
up the cluster environment where the deployment manager is not configured for

Chapter 4. Installing 163



security. The second scenario is when an existing deployment manager is already
configured for security before a node joins the cell.

Out-of-box security

The first scenario is when the default Virtual Member Manager (VMM) file-based
repository security is used on both the WebSphere Portal nodes and the
deployment manager. When the WebSphere Portal node is federated into the
deployment manager cell, the node's security settings are replaced with the
deployment manager security settings. Before you federate the first node into the
cell, the required administrative group and administrative user (wpsadmins and
wpsadmin) must be defined in the deployment manager's security repository.
Otherwise, the WebSphere Portal administrators group and administrative user are
lost when you federate the node into the deployment manager.

After you set up the cluster, you can modify the security settings of the cell. You
can use WebSphere Integrated Solutions Console to modify security in the cell.
However, use the WebSphere Portal security tasks to change cell security to ensure
that the security configuration settings for WebSphere Application Server and
WebSphere Portal are identical.

Note: Using the WebSphere Integrated Solutions Console to configure or update
the out-of-box security is NOT supported in a stand-alone environment. This
option is only supported in a clustered environment that uses the Deployment
Manager WebSphere Integrated Solutions Console.

Modified security with Virtual Member Manager (VMM) federated

The second scenario is when the existing deployment manager default security was
modified before the first WebSphere Portal node joined the cell. WebSphere Portal
supports the capability of using two different sets of administrative user ID and
password credentials when you federate a WebSphere Portal node into a cell. One
set is for the WebSphere Portal node authentication and one set is for deployment
manager authentication. It is not necessary to define a common administrative user
ID before WebSphere Portal joins the cell. If the deployment manager cell is using
federated VMM with extra repositories, the security settings on the portal node are
replaced with the modified deployment manager VMM federated security settings.
The original stand-alone environment security settings are preserved and revert to
the original settings if you remove the node from the cluster.

Using external security managers in a cluster

If you are configuring security for IBM WebSphere Portal with an external security
manager, review some additional considerations, depending on the external
security manager that you are using. Complete any configuration for an external
security manager after you have completed all other setup, including ensuring that
the WebSphere Portal cluster is functional. In addition, review the "Systems
requirement” file to ensure you are using a supported level of the external security
manager software.

General considerations

The following considerations apply to all external security managers:

* When setting up security in a cluster to use an external security manager, ensure
that you review and, if required, perform the security configuration on each
node in the cluster, as described in the following topics:

— IBM Security Access Manager: [“Security Access Manager” on page 1918
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— Computer Associates eTrust SiteMinder: [“Configuring eTrust SiteMinder for|
lauthentication and authorization” on page 1952|

* If you make any changes to the external security manager configuration after
initially setting it up, first make the changes in the wkplc_comp.propreties on
the primary node of the cluster. If additional nodes exist in the cluster, ensure
that any changes you make to the wkplc_comp.properties file on the primary
node are propagated to the wkplc_comp.properties file on other nodes in the
cluster.

Security Access Manager cluster considerations

* Ensure that you run the validate-pdadmin-connection task on each node in the
cluster.

» If the validate-pdadmin-connection task fails, run the run-svrssl-config task
before attempting to run validate-pdadmin-connection again. Note that the
wp.acc.impl.PDServerName parameter in the wkplc_comp.properties file
represents an individually configured AMJRTE connection to Security Access
Manager, and each node in the cluster must have a unique value for
wp.acc.impl.PDServerName before running the run-svrssi-config task.

* If you are using an external Web server, additional configuration is required
before running any task to configure an external security manager with a
WebSphere Portal cluster. Edit the wkplc_comp.properties file on each node, and
ensure that the values for the wp.ac.impl.JunctionHost and
wp.ac.impl.JunctionPort properties are set to the backend server host name and
port number you are using for your Web server.

* Ensure that the WebSEAL Trust Association Interceptor (TAI) parameters, found
in the wkpTc_comp.properties file, are the same on each node in the cluster. If
you run a configuration task that overwrites the WebSEAL junction, the
WebSphere Application Server TAI properties are not automatically updated.
Therefore, you must manually ensure that all nodes are using the same
parameters. To manually ensure the nodes are the same, use the Deployment
Manager WebSphere Integrated Solutions Console and go to Security > Global
security > Web and SIP Security > Trust Association > Interceptors >
com.ibm.sec.authn.tai. TAMETai > Custom properties.

Note: If you are still using the deprecated Trust Association Interceptors (TAls)
implementation, go to Security > Global security > Web and SIP Security >
Trust Association > Interceptors >
com.ibm.ws.security.web.TAMTrustAssociationInterceptorPlus > Custom
properties.

* Enter the file location specified by the wp.ac.impl.PDPermPath parameter in the
wkplc_comp.properties file. This property indicates the location of the Security
Access Manager AMJRTE properties file (PdPerm.properties). In a cluster
composed of nodes with different operating systems, the location of the
PdPerm.properties file might differ, depending on the node.

The value for wp.ac.imp1.PDPermpath can be set globally for all cluster members.
Use the com.ibm.websphere.security.webseal.configURL property, accessed in
the Deployment Manager WebSphere Application Server. Go to Security >
Global security > Web and SIP Security > Trust Association > Interceptors >
com.ibm.ws.security.web.TAMTrustAssociationInterceptorPlus > Custom
properties. Because the Deployment Manager security configuration is not
sensitive to each node's filesystem type, the value for the configURL property
must be resolved on each node.

To ensure that the location of the PdPerm.properties file is properly specified,
use one of the following approaches:
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— If your nodes are all on UNIX platforms, use the UNIX link command (1n) to
ensure the value for 0.om.ibm.websphere.security.webseal.configURL
resolves on each node.

— If the PdPerm.properties file location differs on each node and your cluster
consists of different platforms, this property can accept a WebSphere
Application Server variable to establish a location on each node's filesystem to
correctly reference the file.

eTrust SiteMinder cluster considerations

Ensure that you have installed and validated the eTrust SiteMinder binaries on
each node in the cluster.

If you are only using eTrust SiteMinder for authentication, install and validate the
Application Server Agent.

If you are using eTrust SiteMinder for authentication and authorization, both the
Application Server Agent and the SDK must be installed and validated.

Related information:

[‘System requirements” on page 121]

Before you install IBM WebSphere Portal, review the hardware and software
requirements to ensure that you have the supported versions of prerequisite and
corequisite software and the required hardware.

Planning for multiple clusters

Get an overview of the concepts associated with setting up multiple clusters.
Multiple clusters are sets of servers that are managed together within a single
administrative domain that is known as a cell, and participate in workload
management.

IBM WebSphere Application Server Network Deployment can manage many
application servers and application server clusters within a single administrative
domain, or cell. The single cell has the following advantages:

* A single administration user interface (WebSphere Integrated Solutions Console)
* A single administrative scripting client (wsadmin)

 Shared resources at the cell, node, or server scope

* Replication domains for sharing application data, state information, and caches

* Workload management at the web server level provides a single-server identity
for all applications hosted across the cell. It enables ease of collaboration
between applications while it builds a rich user application experience

An administrator's goal is to manage as many WebSphere Portal and portal-based
products within the same managed cell as possible. It takes advantage of the
administrative and runtime features.

WebSphere Portal can federate multiple, independently configured portals into the
same cell. While there are limitations to this support, it allows multiple clusters to
be managed together. One portal might be providing different applications or
services than another portal. With a common server identity, these services and
applications can integrate seamlessly at the browser through the latest in web 2.0
technology. For example, it uses Ajax and REST services.
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How multiple clusters work in a single cell

It is important to understand that a cell’s configuration has the notion of scope.
The scope controls the visibility of that resource to other resources and application
server instances. An example of a resource might be a data source definition, or a
WebSphere variable definition. Scopes are typically defined as being one of the
following options:

Cell  All resources that are defined in this scope are visible to all other resources
defined in the cell. Therefore, they are configured as globally available.

Node A cell has one or more nodes, and each node is named and matches with
some WebSphere Application Server profile on some physical server. All
resources that are defined at this scope are visible only to other resources
defined in this same node, including any server definitions.

Server A node has one or more server definitions. All resources that are defined at
this scope are visible only to that server. No other server or node can use
these resources.

Cluster
A resource that is defined at a cluster scope is visible to all cluster
members, or server instances, in this cluster. However, it is not visible to
any other servers in the same nodes.

Note: Resources that are defined within a circle, can be seen by all other resources
and scopes that are defined within that circle.

Within this concept of scope, an important point is that all enterprise applications
are cell-scoped. In other words, there can be only one enterprise application with a
given name in the cell. If multiple servers and clusters, or multiple clusters require
the use of that enterprise application, they must share it.

Typically, when you install an enterprise application that is shared across multiple
clusters, the administrator installs the enterprise application archive into the cell’s
Deployment Manager. Then, it maps the application to the target clusters where it
runs. WebSphere Portal installs several enterprise applications as part of its basic
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configuration and before any cluster is defined. Special steps must be followed to
ensure that these infrastructure applications are appropriately shared when
multiple clusters are defined within the same cell. And by extension, since they are
infrastructure applications, all WebSphere Portal clusters must be at the same
version.

Since portlets are enterprise applications of a special type, it is possible, but not
always appropriate, to share portlets across multiple clusters. Many portlets (for
example WebSphere Portal administration) are considered part of the
infrastructure, and as a result can be shared across multiple clusters. Most user
application portlets are specific to certain clusters and are installed as such.

Also, the Java Platform, Enterprise Edition security configuration for the cell is
shared by all servers and clusters that are managed in the cell. Therefore, each
server and cluster must share an underlying user repository.

To summarize at a high level, supporting multiple clusters in the same cell
involves:

* A common security model, including user repositories, for every cluster

* Some number of common enterprise applications and portlets that must be
made common as part of the federation and clustering process

* Installing portlets into certain clusters, or across clusters, as appropriate

* Understanding how to tell if enterprise applications are shared between clusters

* Defining other resources at the appropriate scope, depending on the usage goals

Limitations

All portal clusters must be at the same maintenance levels
WebSphere Portal is made up of several enterprise applications. These
applications are tightly coupled to the underlying services and
infrastructure. All portal-based clusters in the same cell must be at the
same service level.

IBM Process Server considerations
When multiple clusters need access to a common Process Server, centralize
the server within its own cluster. Use WebSphere Portal with the client
installation of the Process Server to allow remote access to the central
process server cluster.

[“Database sharing between multiple clusters”]

Multiple database domains are used in a typical IBM WebSphere Portal
environment, such as the release domain, customization domain, and
community domain. In most cases, the relevance of data within these domains
is WebSphere Portal specific. In other words, different database domains are
used for different configurations because the application mix and user
community is likely different. You might want to support multiple identically
configured WebSphere Portal installations in the same cell. Many of the
database domains might be shared, for ease of maintenance or failover.

Database sharing between multiple clusters:

Multiple database domains are used in a typical IBM WebSphere Portal
environment, such as the release domain, customization domain, and community
domain. In most cases, the relevance of data within these domains is WebSphere
Portal specific. In other words, different database domains are used for different
configurations because the application mix and user community is likely different.
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You might want to support multiple identically configured WebSphere Portal
installations in the same cell. Many of the database domains might be shared, for
ease of maintenance or failover.

If two independently configured clusters exist within the same cell, each cluster
must have its own set of database domains. If two clusters that are identically
configured exist within the same cell, all database instances must be shared except
the release and JCR database domain. All user-specific and community data is
shared between clusters, while each cluster’s static configuration can be
independently updated.

Database settings

When you configure multiple clusters in the same IBM WebSphere Application

Server cell, special attention must be given to the database settings.

* Based on your configuration case, determine which database domains you want
to share with other clusters in the same cell (multiple cluster environment).

Important: JCR domains and release domains cannot be shared between
different clusters or servers. Each distinct cluster or server in your environment
must use a separate JCR domain and a separate release domain. For example:

Table 16. Examples of separate JCR or Release domains between all clusters or servers
when you use Web Content Manager.

Development Server

Authoring Cluster

Staging Server

Delivery Cluster

JCR Domain 1

JCR Domain 2

JCR Domain 3

JCR Domain 4

Release Domain 1

Release Domain 2

Release Domain 3

Release Domain 4

* Assign the data source names according to what databases are shared between
the clusters and what are unique per cluster. A single data source cannot be used
for multiple domains if the domains are a mixture of shared and non-shared.

* Maintain the same number of data sources with identical names when enterprise
applications are shared across all clusters in the same cell. The data source
bindings in the applications can be resolved on every cluster.

* When you install the primary node of the next cluster (Cluster B), the node can
be configured to use the shared database domains. Set the appropriate property
values in the wkplc_dbdomain.properties and wkplc_dbtype.properties files.

Dynamic clusters
You can create a dynamic cluster to run IBM WebSphere Portal.

Important for IBM i only: Dynamic clusters are not supported.

Install WebSphere Portal. Then, start the Configuration Wizard. Select Set Up a
Cluster. Then, run the tasks associated with that option. Choose dynamic as the
type of cluster to create.

The OnDemand Router (ODR) component provides capabilities such as workload
balancing, prioritization, health monitoring, and dynamic operations for dynamic
clusters. An ODR can be configured to provide multi-cluster routing, including
dynamic clusters that are in remote cells, and routing to other servers. The ODR
can serve as a replacement for the HTTP server plug-in, but in many
configurations both components are used. The HTTP server might be in the DMZ
to serve static content and to provide an entry point to the private network where
the ODR is.
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Review the following considerations before you configure the OnDemand Router
(ODR) to route traffic to WebSphere Portal clusters:

* Internal users can send requests directly to the ODR instead of through a
front-end web server. When you send direct requests, you must configure the
ODR to append a via header to the HTTP requests. Set the value of the ODR
custom property http.compliance.via to true; see the "On-demand router
settings" link in the Related section for information.

Note: This step is not required when you send user traffic through the web
server to the ODR. The web server appends the via header to the HTTP request.

* The ODR can selectively route traffic to clusters based on the incoming URL.
You can configure IP alias values for the ODR. Then, define routing rules to
associate user traffic for each IP alias to the appropriate WebSphere Portal
cluster.

* You can use the ODR to load balance traffic among identical portal clusters. You
can configure a Multicluster Routing Policy (MCRP) for the ODR to identify the
destination clusters and the type of load balancing. Read the "Configuring the
on-demand router for multi-cluster failover and load balancing routing" link in
the Related section.

Note: If you route traffic to remote static clusters with Generic Server Cluster
definitions, the cel1_name value must be the local cell name where the ODR is.

* You can also use the ODR to route traffic to remote clusters, both static and
dynamic. Define a generic server cluster for each target portal cluster. Read the
"Defining generic server clusters for remote ODR cells" link in the Related
section.

Note: If you are routing to remote static clusters that use vertical cluster
members, you must complete the optional step at the end. This step defines a
server custom property for each port in the generic server cluster.

Important: When you apply maintenance, it is important that the deployment
manager is inactive until both upgrades are complete. If the deployment manager
is active before both upgrades are complete, it might detect an incompatible
version and remove some required resources from the dynamic cluster.

Cluster maintenance

Maintaining IBM WebSphere Portal in a cluster typically means applying corrective
services (fix packs and interim fixes) or updating the software release level on each
node in the cluster. Instructions for applying corrective service to a WebSphere
Portal cluster are provided with the corrective service package. Before you apply
any maintenance, analyze any user impact. Ensure that you are able to provide
uninterrupted service (also referred to as 24x7 availability), even during the
maintenance phase.

Fixes are classified as "minor" if they do not update the underlying WebSphere
Portal databases or require version upgrades to other supporting software such as
databases servers or IBM WebSphere Application Server. Most of the WebSphere
Portal service packs are not considered minor and might require the use of a
separate installation procedure to ensure 24x7 availability.

Note: If you are not using horizontal scaling in your environment, any fix that

requires a restart results in temporary outage for your users. Existing 24x7
installation procedures do not apply to these environments.
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Warning: You do not need to remove the node from the cluster when you apply
fixes; doing so might result in the inability to add the node back to the cluster.

Minor fixes

Apply all minor fixes on each cluster node. Use the installation instructions that
are supplied with the fix. When you apply minor fixes that might update
previously deployed enterprise applications, first turn off the auto-synchronization
feature of the deployment manager. After the fix is deployed on all cluster nodes,
you can force a manual synchronization with the deployment manager to ensure
that all updates are synchronized on the nodes. You can then enable the
auto-synchronization feature again.

If the documentation associated with the minor fix requires that you restart
WebSphere Portal or WebSphere Application Server, apply the minor fix one node
at a time. This process enables other nodes to continue to provide service to your
users. However, if the fix requires an update to the WebSphere Portal databases,
you might be required to stop the cluster before you apply the fix. If so, use a
procedure that ensures 24x7 availability.

Fixes and service packs

There are multiple approaches to installing service packs into a WebSphere Portal
clustered environment. Installing a service pack involves modifying the IP sprayer
to remove a cluster from receiving user requests. This process allows time to finish
handling existing user sessions and to upgrading that cluster on all nodes. After
verification testing assures that the upgraded cluster is operational, it can start
receiving production traffic while the next cluster is taken offline and goes through
the upgrade process. This approach preserves complete 24x7 availability during the
upgrade process.

A separate document is available that describes the process of installing WebSphere
Portal service packs (fix packs) into an existing cluster while you maintain 24x7
availability. To briefly summarize this procedure, you remove a node or set of
nodes from the flow of user traffic by configuring the IP sprayer and web server.
You then upgrade the node with the service packs. After the upgrade is complete,
return the node or set of nodes to the flow of user traffic. Repeat the procedure
with the next node or set of nodes. This process continues until all nodes in the
cluster are upgraded.

Important: While the upgrade process is taking place, some portlets might become
temporarily unavailable because of updates to the shared database, which are
incompatible with the previous version of the portlet. This process can introduce
functional limitations to the 24x7 availability.

Virtual environment overview

You can use virtualized environments, for example VMWare ESX, to meet your
business needs such as production server consolidation, centralized management,
or dynamic test environments. The virtual environment provides transparency to
the operating systems, applications, and middleware that it uses.

There are special considerations to be made when running IBM WebSphere Portal
in a virtual environment. Virtual machines work best when used to consolidate test
and development servers, where multiple virtual machines can share physical
machine resources, and even "over commit" those resources, under the assumption
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that at any given time not all of the system's resources are needed. This does not
mean that virtual machines cannot be used for production delivery, except that
special care must be taken to not overcommit vital resources. Also, because of the
extra processing layer, the physical system's memory and CPU that handles the
context switching and memory management for the virtual machines, performance
can start to degrade under heavy use as compared to native installations. Careful
testing needs to be done to understand WebSphere Portal's performance in your
virtualized environment and to know how far to scale WebSphere Portal to
compensate for any degradations.

For virtualized test and development environments, you can overcommit the
physical resources of the machine. For production environments, ensure that there
is sufficient physical CPU and memory to service each virtual machine. A good
rule for memory requirement is to double the WebSphere Portal instance's
maximum heap size and use that as the virtual machine memory configuration.
Memory paging, both within the virtual machine and in the hypervisor should be
strictly avoided as that can lead to performance degradation.

Multiple profile support

IBM WebSphere Portal creates an application server configuration profile to
represent its application server configuration, such as data source definitions, web
application and portlet deployments, and Java virtual machine configuration. A
configuration profile represents the full configuration of a single portal instance.
Multiple profiles give you the ability to have multiple, independently configured
portal instances that run from the same installation. Before WebSphere Portal
Version 7, there was only one configuration profile per installation, which was
typically named wp_profile.

Note: For more information about application server profiles, go to
[profiles on non-z/OS operating systems]

Starting with WebSphere Portal Version 7, it is possible to create extra profiles in
addition to the default profile, which is useful in the following scenarios:

* Reuse a single installation for multiple independent portal instances, such as for
various test or development efforts.

* Recover from a configuration problem by deleting the current profile and
re-creating it without having to reinstall the product.

* Update a Deployment Manager profile to handle portal servers and thus avoid
all the manual preparation steps.

The following profile types can be generated:

portal.default
This profile holds a stand-alone portal server in the captured configuration.
It might be used as a stand-alone server or after the federation as a base
for a portal cluster.

managed.portal
This profile is enhanced with the portal run time environment but does not
contain any servers. The main purpose of this profile is to use it as a run
time environment for extra cluster members. After the federation of this
profile, the standard portal tasks can be used to create a portal server
cluster member from an existing cluster template.

management.portal.augment
This profile is created by augmenting a standard Deployment Manager
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profile. The resulting profile holds a deployment manager that is prepared
for use with portal. It can be used to federate the other portal profiles
immediately without the need for the additional manual steps. Because the
deployment manager is often on different hardware, there is the possibility
to move this augmentation template to another installation and run it
there.

Search Collection and Multiple Profiles

When you run the enable-profiles or replace-profiles tasks, all existing Search
collections are captured in the profile template. The Search function does not
support sharing Search collections between multiple profiles. Before you run the
enable-profiles or replace-profiles tasks, either delete all search collections,
including the default Search collections to avoid search errors when you create the
additional profiles. You can use the backup and restore procedures to preserve the
search collections on the original profile or you can use the following export and
import steps:

1. Export the existing search collections.

2. Remove the existing search collections.

3. If you installed WebSphere Portal as a non-root user, run the chmod -R g+rwx
/portal_server_root task to modify permissions for the Portal Server directory.

4. Run the enable-profiles or replace-profiles configuration task to capture the
Portal configuration in the profile template.

5. Import the saved search collections on the original profile.

6. Create new profiles with the profile templates; default search collections are
automatically created in the new profile.

7. Run the chmod -R g+rx /portal_server_root task to restore permissions to the
Portal Server directory.

If you want to share search collections between multiple server instances, then you
must configure a remote search server that supports search collections sharing.

Important information for cluster configurations

Manage all maintenance at the cluster level. During maintenance, take the entire
cluster out of service. Then, the cluster-wide changes can take effect without
affecting user traffic or potentially causing synchronization conflicts. In a
continuous availability environment, multiple clusters might be necessary to allow
traffic to continue to one cluster while another is being serviced.

Maintaining a WebSphere Portal installation with multiple profiles involves
applying maintenance to the product binary files and applying maintenance to
each profile instance. All profile instances and the WebSphere Portal product
binary files are updated at the same time to avoid conflicts. If a profile belongs to a
cluster and the cluster is updated, the shared WebSphere Portal product binary
files and all other profiles must be updated to maintain synchronization.

If multiple portal profiles with a set of product binary files are part of a cluster, all

profiles that share the binary files must belong to the cluster. This approach
provides consistency when you apply maintenance at the cluster boundary.
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Getting the software

There are different ways for you to get WebSphere Portal and Web Content
Manager Version 8.5 software.

[“Physical media”|
WebSphere Portal is available on DVD. Installing from physical media is
practical when installing on a limited number of servers.

[“Live repository”]

You can download and install WebSphere Portal directly from a live repository.
All that you need is IBM Installation Manager and you can select the portal
repository from the list.

[“Electronic images” on page 176

Use Passport Advantage for downloading the electronic images of WebSphere
Portal. Installing is simpler than ever before. IBM Installation Manager makes it
easy. The following sections, formerly referred to as download documents,
provide download information for the different WebSphere Portal and Web
Content Manager offerings.

Physical media

WebSphere Portal is available on DVD. Installing from physical media is practical
when installing on a limited number of servers.

Benefits:

This option has the following benefits and is best if performing a limited
number of installations:

* No prerequisite steps required before installation

* Provides a seamless way to install IBM Installation Manager if it is not
currently installed

* Provides an installation path if a file server is not available or is slower
than the DVD

Limitations:

¢ Installing from the DVD on IBM i is not supported
¢ Silently installing from the DVD is not supported

Linux note: For security reasons, some Linux versions, such as Red Hat
Enterprise Linux, prevent programs from running from automounted

DVDs. Thus, not allowing to run the installer from the DVD. To fix this
issue, add the /dev/hdc /media/ auto
pamconsole,fscontext=system u:object r:removable t,exec,noauto,managed
0 0 line to the end of the /etc/fstab file to update file system table.

Live repository

You can download and install WebSphere Portal directly from a live repository. All
that you need is IBM Installation Manager and you can select the portal repository
from the list.

About this task

After you enter your credentials in IBM Installation Manager, you can see the
software repositories that you are entitled to download and install. This option is
ideal when you perform installations at a large scale.
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Depending on your operating system, choose one of the following paths to install
directly from a live repository:

* From the IBM Installation Manager graphical user interface, complete the
following steps:

1.
2. S
Click Apply.
Click OK.

On the main Installation Manager panel, select Install.

© N o o~ W

Click File > Preferences > Passport Advantage.

elect the Connect to Passport Advantage check box.

In the Password Required dialog box, enter your credentials.
Click OK.

S

elect the package that you want to download and install.

If you are installing Portal to an existing copy of WebSphere Application
Server, then select only IBM WebSphere Portal Server. To complete this
installation option, your existing copy of WebSphere Application Server

must meet the following requirements:

- WebSphere Application Server Version 8.5.5.2 or later
- Java Version 7
- No existing Portal profile

If you are not installing Portal to an existing copy of WebSphere
Application Server, then select the following packages:

- IBM WebSphere Application Server Network Deployment
- IBM WebSphere Portal Server
- IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional."

If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable
packages.

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable
packages.

* From the IBM Installation Manager console user interface, complete the
following steps:

1.

Enter P to go to the Preferences menu.

2. Enter 6 to go to the Passport Advantage menu.

© N oA

Enter 1 to connect to Passport Advantage.

Enter P to enter your user name and password.

Enter 0 for OK.

Enter A to apply your changes and return to the Preferences menu.
Enter R to return to the Main menu.

Enter 1 to see all of the repositories that you are entitled to download and
install.

Enter the number of the package that you want to download and install.
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— If you are installing Portal to an existing copy of WebSphere Application
Server, then select only IBM WebSphere Portal Server. To complete this
installation option, your existing copy of WebSphere Application Server
must meet the following requirements:

- WebSphere Application Server Version 8.5.5.2 or later
- Java Version 7
- No existing Portal profile

— If you are not installing Portal to an existing copy of WebSphere
Application Server, then select the following packages:

- IBM WebSphere Application Server Network Deployment
- IBM WebSphere Portal Server
- IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional."

If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable
packages.
10. Enter 1 to install the package that you selected.

Related tasks:

[Running the installation program|

Use the IBM Installation Manager program to install the software. IBM Installation

Manager provides multiple user interfaces. Select the one that you are more

comfortable with. You can use the graphical user interface or the console to create

a response file for automated installations.

Electronic images

Use Passport Advantage for downloading the electronic images of WebSphere
Portal. Installing is simpler than ever before. IBM Installation Manager makes it
easy. The following sections, formerly referred to as download documents, provide
download information for the different WebSphere Portal and Web Content
Manager offerings.

[“Getting WebSphere Portal Server software” on page 177
This section describes how to download and assemble IBM WebSphere Portal
Version 8.5 components by using the Passport Advantage Online website.

[“Getting WebSphere Portal Enable software” on page 181|

This section describes how to download and assemble IBM WebSphere Portal
Version 8.5 components by using the Passport Advantage Online website.
[“Getting WebSphere Portal Extend software” on page 187

This section describes how to download and assemble IBM WebSphere Portal
Version 8.5 components using the Passport Advantage Online website.

[“Getting Web Content Manager software” on page 196|
This section describes how to download and assemble IBM WebSphere Portal
Version 8.5 components by using the Passport Advantage Online website.

[“Getting Web Content Manager Standard Edition software” on page 200|
This section describes how to download and assemble IBM WebSphere Portal
Version 8.5 components by using the Passport Advantage Online website.
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Getting WebSphere Portal Server software
This section describes how to download and assemble IBM WebSphere Portal
Version 8.5 components by using the Passport Advantage Online website.

Downloadable eAssembly images

The IBM WebSphere Portal Version 8.5 product consists of multiple offerings and
each offering includes multiple downloadable electronic images that are packaged
by platform. Each platform package is called an eAssembly and each eAssembly
contains all of the electronic images that are required for that offering to run on
that platform. The following table shows the eAssembly numbers for each of the
IBM WebSphere Portal Version 8.5 offerings.

Important: When you expand the eAssembly files, ensure that you expand the
files into the same parent directory to create a complete installable image. For
example, if you expand into a parent directory that is called download_directory, the
following directory structure results:

download directory/Setup
download _directory/IBMJAVA7
download directory/WAS8552
download_directory/WP85_Server

Failure to expand all files in the same parent directory results in an installation
failure.

The following directories might also exist but are not required to be expanded in
the same parent directory:

download_directory/qsg_850_portal_wcm
download_directory/WP85_RemoteSearch

IBM Web Content Manager support

The WebSphere Portal Server offering does not provide all features of Web Content
Manager. To get complete web content management capabilities, install either
WebSphere Portal Enable or WebSphere Portal Extend.

Required software

Table 17. List of eAssembly images for IBM WebSphere Portal and Web Content Manager
V8.5 Multiplatform Multilingual Quick Start Guide
Part number | Description

CIYE7ML IBM WebSphere Portal and Web Content Manager V8.5 Multiplatform Multilingual Quick Start Guide

Table 18. List of eAssembly images for IBM WebSphere Portal Server V8.5 and IBM
WebSphere Application Server Setup V 8.5.5.2

Part number | Description

CIYVS8ML IBM WebSphere Portal Server Setup V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CIYVOML IBM WebSphere Portal Server Install V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CIYWOML IBM WebSphere Application Server Network Deployment V8.5.5.2 Multiplatform Multilingual
IMPORTANT: All parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same
directory to create an installable image.
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Table 18. List of eAssembly images for IBM WebSphere Portal Server V8.5 and IBM
WebSphere Application Server Setup V 8.5.5.2 (continued)

Part number

Description

CIYWIML

IBM WebSphere SDK Java Technology Edition V7.0.6.1 Multiplatform Multilingual IMPORTANT: All
parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create
an installable image.

CIYW2ML

IBM WebSphere Portal V8.5 Remote Search and Document Conversion Services Multiplatform
Multilingual

Optional software

Table 19. List of eAssembly images for IBM WebSphere Application Server Network
Deployment V8.5.5 Supplements and Edge Components

Part number

Description

CIK1VML

IBM WebSphere Application Server V8.5.5 Supplements (1 of 3) for Multiplatform Multilingual

CIKIWML

IBM WebSphere Application Server V8.5.5 Supplements (2 of 3) for Multiplatform Multilingual

CIK1XML

IBM WebSphere Application Server V8.5.5 Supplements (3 of 3) for Multiplatform Multilingual

CIK2NML

IBM WebSphere Edge Components: Load Balancer for IPv4 and IPv6 (for WebSphere Application
Server Network Deployment V8.5.5) Multiplatform Multilingual

CIL5DML

IBM WebSphere Edge Components: Load Balancer for IPv4 (for WebSphere Application Server
Network Deployment V8.5.5) Multiplatform, Multilingual

CIL5EML

IBM WebSphere Edge Components: Caching Proxy (for WebSphere Application Server Network
Deployment V8.5.5)Multiplatform, Multilingual

Table 20. List of eAssembly images for IBM DB2 Workgroup Server Edition 10.5

Part number

Description

CIXUIML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on AMD64 and Intel® EM64T
systems (x64)

CIWN3ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on POWER® (System i® and
System p®) systems

CIWN4ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on z Systems®

CIWN5ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for AIX®

CIWN6ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for HP-UX on HP Integrity Itanium-based
systems

CIWN7ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Solaris on UltraSPARC systems

CIWNSML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Solaris on x64 systems

CIWNOML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Windows® on AMD64 and Intel®
EM64T systems (x64)

CIWM5ML

IBM® DB2® National Language Pack 10.5 for Linux® on AMD64 and Intel® EM6AT systems (x64)

CIWM6ML

IBM® DB2® National Language Pack 10.5 for Linux® on POWER® (System i® and System p®) systems

CIWM7ML

IBM® DB2® National Language Pack 10.5 for Linux® on z Systems®

CIWMSML

IBM® DB2® National Language Pack 10.5 for ATX®

CIWM9ML

IBM® DB2® National Language Pack 10.5 for HP-UX on HP Integrity Itanium-based systems

CIWNOML

IBM® DB2® National Language Pack 10.5 for Solaris on UltraSPARC systems

CIWNIML

IBM® DB2® National Language Pack 10.5 for Solaris on x64 systems

Table 21. List of eAssembly images for IBM Tivoli Directory Integrator V7.1.1

Part number

Description

CZUE5SML

IBM Tivoli Directory Integrator V7.1.1 Quick Start Guide

CZUFOML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Windows - x86

CZUF7ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Windows - x86-64

CZUFIML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for AIX

CI772ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for AIX - PPCé64

CZUF2ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux Linux - x86

CZUF3ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux Linux - x86-64
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Table 21. List of eAssembly images for IBM Tivoli Directory Integrator V7.1.1 (continued)

Part number | Description

CZUE9ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux - zSeries & s/390
CZUFSML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux - POWER (i/p Series)
CZUF4ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Solaris - SPARC

CZUE6ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Solaris -Opteron

CZUE7ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for HP-UX - Integrity

Table 22. List of eAssembly images for IBM Security Directory Server V6.3.1

Part number

Description

CISOHML IBM Security Directory Server V6.3.1 win-base.zip (with ENT, Only IM based Installer, supports
32/64 bit)

CISOJML IBM Security Directory Server V6.3.1 win-IM.zip (contains ibm_IM_32bit, ibm_IM_64bit)

CISOKML IBM Security Directory Server V6.3.1 win-jdk.zip (contains ibm_jdk_32bit, ibm_jdk_64bit)

CISOLML IBM Security Directory Server V6.3.1 win-db2.zip (contains ibm_db2_32bit, ibm_db2_64bit)

CISOMML IBM Security Directory Server V6.3.1 win-ewas.zip (contains ibm_ewas_32bit, ibm_ewas_64bit)

CISONML IBM Security Directory Server V6.3.1 win-gskit.zip (contains ibm_gskit_32bit, ibm_gskit_64bit)

CISOPML IBM Security Directory Server V6.3.1 win.iso (with ENT, IM based Installer, pre-req installables)

CISORML IBM Security Directory Server V6.3.1 aix-ppc64-base.tar (with ENT, IM based Installer)

CISOTML IBM Security Directory Server V6.3.1 aix-ppc64-IM.tar

CISOUML IBM Security Directory Server V6.3.1 aix-ppc64-jdk.tar

CISOVML IBM Security Directory Server V6.3.1 aix-ppc64-db2.tar

CISOWML IBM Security Directory Server V6.3.1 aix-ppc64-ewas.tar

CISOXML IBM Security Directory Server V6.3.1 aix-ppc64-gskit.tar

CISOYML IBM Security Directory Server V6.3.1 aix-ppc64.iso (with ENT, IM based Installer, pre-req installables)

CIS10ML IBM Security Directory Server V6.3.1 linux-x86-64-base.tar (with ENT, IM based Installer)

CIS12ML IBM Security Directory Server V6.3.1 linux-x86-64-IM.tar

CIS13ML IBM Security Directory Server V6.3.1 linux-x86-64-jdk.tar

CIS14ML IBM Security Directory Server V6.3.1 linux-x86-64-db2.tar

CIS15ML IBM Security Directory Server V6.3.1 linux-x86-64-ewas.tar

CIS16ML IBM Security Directory Server V6.3.1 linux-x86-64-gskit.tar

CIS17ML IBM Security Directory Server V6.3.1 linux-x86-64.iso (with ENT, IM based Installer, pre-req
installables)

CISTHML IBM Security Directory Server V6.3.1 linux-x86-base.tar (with ENT, Native Installer)

CIS1JML IBM Security Directory Server V6.3.1 linux-x86-jdk.tar

CIS1IKML IBM Security Directory Server V6.3.1 linux-x86-db2.tar

CISILML IBM Security Directory Server V6.3.1 linux-x86-ewas.tar

CISIMML IBM Security Directory Server V6.3.1 linux-x86-gskit.tar

CISINML IBM Security Directory Server V6.3.1 linux-x86.iso (with ENT, native installer, pre-req installables)

CIS1I9ML IBM Security Directory Server V6.3.1 solaris-x86-64-base.tar (with ENT, Native Installer)

CIS1IBML IBM Security Directory Server V6.3.1 solaris-x86-64-jdk.tar

CIS1ICML IBM Security Directory Server V6.3.1 solaris-x86-64-db2.tar

CISIDML IBM Security Directory Server V6.3.1 solaris-x86-64-ewas.tar

CISIEML IBM Security Directory Server V6.3.1 solaris-x86-64-gskit.tar

CIS1IFML IBM Security Directory Server V6.3.1solaris-x86-64.iso (with ENT, native installer, pre-req installables)

CIS1QML IBM Security Directory Server V6.3.1 solaris-sparc-base.tar (with ENT, Native Installer)

CIS1ISML IBM Security Directory Server V6.3.1 solaris-sparc-jdk.tar

CIS1ITML IBM Security Directory Server V6.3.1 solaris-sparc-db2.tar

CISTUML IBM Security Directory Server V6.3.1 solaris-sparc-ewas.tar

CISIVML IBM Security Directory Server V6.3.1 solaris-sparc-gskit.tar

CISIWML IBM Security Directory Server V6.3.1 solaris-sparc.iso (with ENT, native installer, pre-req installables)

CIS1ZML IBM Security Directory Server V6.3.1 linux-ppc64-base.tar (with ENT, Native Installer)

CIS21IML IBM Security Directory Server V6.3.1 linux-ppc64-jdk.tar
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Table 22. List of eAssembly images for IBM Security Directory Server V6.3.1 (continued)

Part number

Description

CIS22ML

IBM Security Directory Server V6.3.1 linux-ppc64-db2.tar

CIS23ML

IBM Security Directory Server V6.3.1 linux-ppc64-ewas.tar

CIS24ML

IBM Security Directory Server V6.3.1 linux-ppc64-gskit.tar

CIS26ML

IBM Security Directory Server V6.3.1 linux-ppc64.iso (with ENT, native installer, pre-req installables)

CIS28ML

IBM Security Directory Server V6.3.1 linux-s390x-base.tar (with ENT, Native Installer)

CIS2AML

IBM Security Directory Server V6.3.1 linux-s390x-jdk.tar

CIS2BML

IBM Security Directory Server V6.3.1 linux-s390x-db2.tar

CIS2CML

IBM Security Directory Server V6.3.1 linux-s390x-ewas.tar

CIS2DML

IBM Security Directory Server V6.3.1 linux-s390x-gskit.tar

CIS2EML

IBM Security Directory Server V6.3.1 linux-s390x.iso (with ENT, native installer, pre-req installables)

Table 23. List of eAssembly images for IBM Web Experience Factory V8.5

Part number

Description

CIYW5ML

IBM Web Experience Factory V8.5 Multiplatform Multilingual QuickStart

CIYW6ML

IBM Web Experience Factory V8.5 Multiplatform Multilingual

Table 24. List of eAssembly images for IBM Connections V4.5

Part number

Description

CIHC4ML

IBM Connections V4.5 Quick Start Guide for AIX, Windows, Linux, IBMi Multilingual

CIHC5ML

IBM Connections V4.5 for Windows Multilingual

CIISMML

IBM Connections V4.5 for AIX Multilingual

CIHC6ML

IBM Connections V4.5 for Linux Multilingual

CIHC7ML

IBM Connections V4.5 Linux for z Systems Multilingual

CIHC8ML

IBM Connections V4.5 Wizard for Windows Multilingual

CIHCOML

IBM Connections V4.5 Wizard for Linux, AIX Multilingual

Table 25. List of eAssembly images for IBM Worklight Consumer Edition V6.1

Part number

Description

CIQT7ML

Quick Start Guide for Worklight Consumer Edition V6.1 for Multiplatforms Multiplatforms

CIQ5JEN

IBM Worklight Consumer Edition V6.1 zip of Installation Manager Repository for IBM Worklight
Server Multiplatforms English

CIQ5KEN

IBM Worklight Consumer Edition V6.1 zip of Eclipse update for IBM Worklight Studio Multiplatform
English

CIQ5LEN

IBM Worklight Consumer Edition V6.1 zip of Eclipse Update Site for Mobile Test Workbench
Worklight Multiplatforms English

CILD7ML

IBM Rational Enterprise Deployment V1.6.3 Windows Multilingual

CILDSML

IBM Rational Enterprise Deployment V1.6.3 Linux x86 Multilingual

CILEOML

IBM Rational Enterprise Deployment V1.6.3 Linux x86-64 Multilingual

CILEIML

IBM Rational Enterprise Deployment V1.6.3 Linux PPC Multilingual

CILE2ML

IBM Rational Enterprise Deployment V1.6.3 Linux s390 Multilingual

CILE3ML

IBM Rational Enterprise Deployment V1.6.3 AIX Multilingual

CILE5SML

IBM Rational Enterprise Deployment V 1.6.3 for Solaris 10 SPARC

CILE6ML

IBM Rational Enterprise Deployment V 1.6.3 for X86-64

CIK2UML

Quick Start for IBM WebSphere Application Server - Liberty Core V8.5.5 for Multiplatform
Multilingual

CIK2VML

IBM WebSphere Application Server - Liberty Core V8.5.5 for Multiplatform Multilingual

CIK2YML

IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (1 of 3) for Multiplatform
Multilingual

CIK2ZML

IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (2 of 3) for Multiplatform
Multilingual

CIK30ML

IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (3 of 3) for Multiplatform
Multilingual
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Table 25. List of eAssembly images for IBM Worklight Consumer Edition V6.1 (continued)
Part number | Description

CI6TQML IBM® DB2® 10.1 - Limited Use for Linux® on AMD64 and Intel® EM64T

CI6TSML IBM® DB2® 10.1 - Limited Use for Linux® on POWER® (System i® and System p®) systems
CI6TRML IBM® DB2® 10.1 - Limited Use for Linux® on z Systems®

CI6TTML IBM® DB2® 10.1 - Limited Use for 64-bit AIX®

CI6TVML IBM® DB2® 10.1 - Limited Use for Solaris on UltraSPARC systems

CI6TWML IBM® DB2® 10.1 - Limited Use for Solaris on x64 systems

CI6TYML IBM® DB2® 10.1 - Limited Use for Windows® on AMD64 and Intel® EM64T systems (x64)
CI71IVML IBM® DB2® 10.1, National Language Pack for Linux® on AMD64 and Intel® EM64T systems (x64)

CI7IWML IBM® DB2® 10.1, National Language Pack for Linux® on POWER® (System i® and System p®) systems

CI7IXML IBM® DB2® 10.1, National Language Pack for Linux® on z Systems®
CI71QML IBM® DB2® 10.1, National Language Pack for AIX®

CI71SML IBM® DB2® 10.1, National Language Pack for Solaris on UltraSPARC systems
CI7Z1TML IBM® DB2® 10.1, National Language Pack for Solaris on x64 systems

Related information:

[ [WebSphere Portal detailed system requirements|

[ [[BM Passport Advantage|

Getting WebSphere Portal Enable software
This section describes how to download and assemble IBM WebSphere Portal
Version 8.5 components by using the Passport Advantage Online website.

Downloadable eAssembly images

The IBM WebSphere Portal Version 8.5 product consists of multiple offerings and
each offering includes multiple downloadable electronic images that are packaged
by platform. Each platform package is called an eAssembly and each eAssembly
contains all of the electronic images that are required for that offering to run on
that platform. The following table shows the eAssembly numbers for each of the
IBM WebSphere Portal Version 8.5 offerings.

Important: When you expand the eAssembly files, ensure that you expand the
files into the same parent directory to create a complete installable image. For
example, if you expand into a parent directory that is called download_directory, the
following directory structure results:

download directory/Setup
download directory/IBMJAVA7
download directory/WAS8552
download _directory/WP85_Server
download _directory/WP85_Enable

Failure to expand all files in the same parent directory results in an installation
failure.

The following directories might also exist but are not required to be expanded in
the same parent directory:

download directory/qsg_850 portal wcm
download _directory/WP85_RemoteSearch
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Required software

Table 26. List of eAssembly images for IBM WebSphere Portal and Web Content Manager
V8.5 Multiplatform Multilingual Quick Start Guide

Part number

Description

CIYE7ML

IBM WebSphere Portal and Web Content Manager V8.5 Multiplatform Multilingual Quick Start Guide

Table 27. List of eAssembly images for IBM WebSphere Portal Enable V8.5 and IBM
WebSphere Application Server Setup V8.5.5.2

Part number

Description

CIYW3ML

IBM WebSphere Portal Enable Setup V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CIYVOML

IBM WebSphere Portal Server Install V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CIYW4ML

IBM WebSphere Portal Enable Install V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CIYWOML

IBM WebSphere Application Server Network Deployment V8.5.5.2 Multiplatform Multilingual
IMPORTANT: All parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same
directory to create an installable image.

CIYWIML

IBM WebSphere SDK Java Technology Edition V7.0.6.1 Multiplatform Multilingual IMPORTANT: All
parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create
an installable image.

CIYW2ML

IBM WebSphere Portal V8.5 Remote Search and Document Conversion Services Multiplatform
Multilingual

Optional software

Table 28. List of eAssembly images for IBM WebSphere Application Server Network
Deployment V8.5.5 Supplements and Edge Components

Part number

Description

CIK1VML

IBM WebSphere Application Server V8.5.5 Supplements (1 of 3) for Multiplatform Multilingual

CIK1IWML

IBM WebSphere Application Server V8.5.5 Supplements (2 of 3) for Multiplatform Multilingual

CIK1XML

IBM WebSphere Application Server V8.5.5 Supplements (3 of 3) for Multiplatform Multilingual

CIK2NML

IBM WebSphere Edge Components: Load Balancer for IPv4 and IPv6 (for WebSphere Application
Server Network Deployment V8.5.5) Multiplatform Multilingual

CIL5DML

IBM WebSphere Edge Components: Load Balancer for IPv4 (for WebSphere Application Server
Network Deployment V8.5.5) Multiplatform, Multilingual

CIL5EML

IBM WebSphere Edge Components: Caching Proxy (for WebSphere Application Server Network
Deployment V8.5.5)Multiplatform, Multilingual

Table 29. List of eAssembly images for IBM DB2 Workgroup Server Edition 10.5

Part number

Description

CIXU9ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on AMD64 and Intel® EM64T
systems (x64)

CIWN3ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on POWER® (System i® and
System p®) systems

CIWN4ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on z Systems®

CIWN5ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for AIX®

CIWN6ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for HP-UX on HP Integrity Itanium-based
systems

CIWN7ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Solaris on UltraSPARC systems

CIWNSML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Solaris on x64 systems

CIWN9ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Windows® on AMD64 and Intel®
EM64T systems (x64)

CIWM5ML

IBM® DB2® National Language Pack 10.5 for Linux® on AMD64 and Intel® EM6AT systems (x64)

CIWM6ML

IBM® DB2® National Language Pack 10.5 for Linux® on POWER® (System i® and System p®) systems
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Table 29. List of eAssembly images for IBM DB2 Workgroup Server Edition
10.5 (continued)

Part number

Description

CIWM7ML | IBM® DB2® National Language Pack 10.5 for Linux® on z Systems®

CIWMSML | IBM® DB2® National Language Pack 10.5 for AIX®

CIWM9ML IBM® DB2® National Language Pack 10.5 for HP-UX on HP Integrity Itanium-based systems
CIWNOML IBM® DB2® National Language Pack 10.5 for Solaris on UltraSPARC systems

CIWNIML IBM® DB2® National Language Pack 10.5 for Solaris on x64 systems

Table 30. List of eAssembly images for IBM Tivoli Directory Integrator V7.1.1

Part number

Description

CZUE5ML IBM Tivoli Directory Integrator V7.1.1 Quick Start Guide

CZUFOML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Windows - x86
CZUF7ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Windows - x86-64
CZUFIML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for AIX

CI772ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for AIX - PPC64
CZUF2ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux Linux - x86
CZUF3ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux Linux - x86-64
CZUESML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux - zSeries & s/390
CZUFSML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux - POWER (i/p Series)
CZUF4ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Solaris - SPARC
CZUE6ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Solaris -Opteron
CZUE7ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for HP-UX - Integrity

Table 31. List of eAssembly images for IBM Security Directory Server V6.3.1

Part number

Description

CISOHML IBM Security Directory Server V6.3.1 win-base.zip (with ENT, Only IM based Installer, supports
32/64 bit)

CISOJML IBM Security Directory Server V6.3.1 win-IM.zip (contains ibm_IM_32bit, ibm_IM_64bit)

CISOKML IBM Security Directory Server V6.3.1 win-jdk.zip (contains ibm_jdk_32bit, ibm_jdk_64bit)

CISOLML IBM Security Directory Server V6.3.1 win-db2.zip (contains ibm_db2_32bit, ibm_db2_64bit)

CISOMML IBM Security Directory Server V6.3.1 win-ewas.zip (contains ibm_ewas_32bit, ibm_ewas_64bit)

CISONML IBM Security Directory Server V6.3.1 win-gskit.zip (contains ibm_gskit_32bit, ibm_gskit_64bit)

CISOPML IBM Security Directory Server V6.3.1 win.iso (with ENT, IM based Installer, pre-req installables)

CISORML IBM Security Directory Server V6.3.1 aix-ppc64-base.tar (with ENT, IM based Installer)

CISOTML IBM Security Directory Server V6.3.1 aix-ppc64-IM.tar

CISOUML IBM Security Directory Server V6.3.1 aix-ppc64-jdk.tar

CISOVML IBM Security Directory Server V6.3.1 aix-ppc64-db2.tar

CISOWML IBM Security Directory Server V6.3.1 aix-ppc64-ewas.tar

CISOXML IBM Security Directory Server V6.3.1 aix-ppc64-gskit.tar

CISOYML IBM Security Directory Server V6.3.1 aix-ppc64.iso (with ENT, IM based Installer, pre-req installables)

CIS10ML IBM Security Directory Server V6.3.1 linux-x86-64-base.tar (with ENT, IM based Installer)

CIS12ML IBM Security Directory Server V6.3.1 linux-x86-64-IM.tar

CIS13ML IBM Security Directory Server V6.3.1 linux-x86-64-jdk.tar

CIS14ML IBM Security Directory Server V6.3.1 linux-x86-64-db2.tar

CIS15ML IBM Security Directory Server V6.3.1 linux-x86-64-ewas.tar

CIS16ML IBM Security Directory Server V6.3.1 linux-x86-64-gskit.tar

CIS17ML IBM Security Directory Server V6.3.1 linux-x86-64.iso (with ENT, IM based Installer, pre-req
installables)

CISTHML IBM Security Directory Server V6.3.1 linux-x86-base.tar (with ENT, Native Installer)

CIS1JML IBM Security Directory Server V6.3.1 linux-x86-jdk.tar

CISIKML IBM Security Directory Server V6.3.1 linux-x86-db2.tar

CISILML IBM Security Directory Server V6.3.1 linux-x86-ewas.tar
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Table 31. List of eAssembly images for IBM Security Directory Server V6.3.1 (continued)

Part number

Description

CISIMML

IBM Security Directory Server V6.3.1 linux-x86-gskit.tar

CISINML

IBM Security Directory Server V6.3.1 linux-x86.iso (with ENT, native installer, pre-req installables)

CIS19ML

IBM Security Directory Server V6.3.1 solaris-x86-64-base.tar (with ENT, Native Installer)

CIS1BML

IBM Security Directory Server V6.3.1 solaris-x86-64-jdk.tar

CISICML

IBM Security Directory Server V6.3.1 solaris-x86-64-db2.tar

CISIDML

IBM Security Directory Server V6.3.1 solaris-x86-64-ewas.tar

CISIEML

IBM Security Directory Server V6.3.1 solaris-x86-64-gskit.tar

CIS1IFML

IBM Security Directory Server V6.3.1solaris-x86-64.iso (with ENT, native installer, pre-req installables)

CISIQML

IBM Security Directory Server V6.3.1 solaris-sparc-base.tar (with ENT, Native Installer)

CIS1ISML

IBM Security Directory Server V6.3.1 solaris-sparc-jdk.tar

CISITML

IBM Security Directory Server V6.3.1 solaris-sparc-db2.tar

CISTUML

IBM Security Directory Server V6.3.1 solaris-sparc-ewas.tar

CISIVML

IBM Security Directory Server V6.3.1 solaris-sparc-gskit.tar

CISTWML

IBM Security Directory Server V6.3.1 solaris-sparc.iso (with ENT, native installer, pre-req installables)

CIS1ZML

IBM Security Directory Server V6.3.1 linux-ppc64-base.tar (with ENT, Native Installer)

CIS21IML

IBM Security Directory Server V6.3.1 linux-ppc64-jdk.tar

CIS22ML

IBM Security Directory Server V6.3.1 linux-ppc64-db2.tar

CIS23ML

IBM Security Directory Server V6.3.1 linux-ppc64-ewas.tar

CIS24ML

IBM Security Directory Server V6.3.1 linux-ppc64-gskit.tar

CIS26ML

IBM Security Directory Server V6.3.1 linux-ppc64.iso (with ENT, native installer, pre-req installables)

CIS28ML

IBM Security Directory Server V6.3.1 linux-s390x-base.tar (with ENT, Native Installer)

CIS2AML

IBM Security Directory Server V6.3.1 linux-s390x-jdk.tar

CIS2BML

IBM Security Directory Server V6.3.1 linux-s390x-db2.tar

CIs2CML

IBM Security Directory Server V6.3.1 linux-s390x-ewas.tar

CISs2DML

IBM Security Directory Server V6.3.1 linux-s390x-gskit.tar

CIS2EML

IBM Security Directory Server V6.3.1 linux-s390x.iso (with ENT, native installer, pre-req installables)

Table 32. List of eAssembly images for IBM Web Experience Factory V8.5

Part number

Description

CIYW5ML

IBM Web Experience Factory V8.5 Multiplatform Multilingual QuickStart

CIYW6ML

IBM Web Experience Factory V8.5 Multiplatform Multilingual

Table 33. List of eAssembly images for IBM Connections V4.5

Part number

Description

CIHC4ML

IBM Connections V4.5 Quick Start Guide for AIX, Windows, Linux, IBMi Multilingual

CIHC5ML

IBM Connections V4.5 for Windows Multilingual

CIISMML

IBM Connections V4.5 for AIX Multilingual

CIHC6ML

IBM Connections V4.5 for Linux Multilingual

CIHC7ML

IBM Connections V4.5 Linux for z Systems Multilingual

CIHC8ML

IBM Connections V4.5 Wizard for Windows Multilingual

CIHCOML

IBM Connections V4.5 Wizard for Linux, AIX Multilingual

Table 34. List of eAssembly images for IBM Worklight Consumer Edition V6.1

Part number

Description

CIQT7ML

Quick Start Guide for Worklight Consumer Edition V6.1 for Multiplatforms Multiplatforms

CIQ5JEN

IBM Worklight Consumer Edition V6.1 zip of Installation Manager Repository for IBM Worklight
Server Multiplatforms English

CIQ5KEN

IBM Worklight Consumer Edition V6.1 zip of Eclipse update for IBM Worklight Studio Multiplatform
English

CIQ5LEN

IBM Worklight Consumer Edition V6.1 zip of Eclipse Update Site for Mobile Test Workbench
Worklight Multiplatforms English
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Table 34. List of eAssembly images for IBM Worklight Consumer Edition V6.1 (continued)

Part number | Description

CILD7ML IBM Rational Enterprise Deployment V1.6.3 Windows Multilingual

CILD9ML IBM Rational Enterprise Deployment V1.6.3 Linux x86 Multilingual

CILEOML IBM Rational Enterprise Deployment V1.6.3 Linux x86-64 Multilingual

CILEIML IBM Rational Enterprise Deployment V1.6.3 Linux PPC Multilingual

CILE2ML IBM Rational Enterprise Deployment V1.6.3 Linux s390 Multilingual

CILE3ML IBM Rational Enterprise Deployment V1.6.3 AIX Multilingual

CILESML IBM Rational Enterprise Deployment V 1.6.3 for Solaris 10 SPARC

CILE6ML IBM Rational Enterprise Deployment V 1.6.3 for X86-64

CIK2UML Quick Start for IBM WebSphere Application Server - Liberty Core V8.5.5 for Multiplatform
Multilingual

CIK2VML IBM WebSphere Application Server - Liberty Core V8.5.5 for Multiplatform Multilingual

CIK2YML IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (1 of 3) for Multiplatform
Multilingual

CIK2ZML IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (2 of 3) for Multiplatform
Multilingual

CIK30ML IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (3 of 3) for Multiplatform
Multilingual

CI6TQML IBM® DB2® 10.1 - Limited Use for Linux® on AMD64 and Intel® EM64T

CI6TSML IBM® DB2® 10.1 - Limited Use for Linux® on POWER® (System i® and System p®) systems

CI6TRML IBM® DB2® 10.1 - Limited Use for Linux® on z Systems®

CI6TTML IBM® DB2® 10.1 - Limited Use for 64-bit ATX®

CI6TVML IBM® DB2® 10.1 - Limited Use for Solaris on UltraSPARC systems

CI6TWML IBM® DB2® 10.1 - Limited Use for Solaris on x64 systems

CI6TYML IBM® DB2® 10.1 - Limited Use for Windows® on AMD64 and Intel® EM64T systems (x64)

CI71IVML IBM® DB2® 10.1, National Language Pack for Linux® on AMD64 and Intel® EM6AT systems (x64)

CI7ZIWML IBM® DB2® 10.1, National Language Pack for Linux® on POWER® (System i® and System p®) systems

CI71IXML IBM® DB2® 10.1, National Language Pack for Linux® on z Systems®

CI71QML IBM® DB2® 10.1, National Language Pack for AIX®

CI71SML IBM® DB2® 10.1, National Language Pack for Solaris on UltraSPARC systems

CI7ITML IBM® DB2® 10.1, National Language Pack for Solaris on x64 systems

Table 35. List of eAssembly images for IBM Connections Content Manager 4.5

Part number

Description

CIHC4ML IBM Connections V4.5 Quick Start Guide for AIX, Windows, Linux, IBMi Multilingual
CIQ52ML IBM FileNet Content Engine V5.2 AIX Multilingual

CIQ55ML IBM FileNet Content Engine V5.2 Linux Multilingual

CIQ57ML IBM FileNet Content Engine V5.2 Windows Multilingual

CIQ58ML IBM FileNet Content Engine V5.2 Linux on z Systems Multilingual
CIQ5DEN IBM FileNet Content Engine Client V5.2 Linux English

CIQ5FEN IBM FileNet Content Engine Client V5.2 Windows English
CIQ5GEN IBM FileNet Content Engine Client V5.2 Linux on z Systems English
CIQ5AEN IBM FileNet Collaboration Services V2.0 Win

CIG7ZML IBM FileNet Collaboration Services V2.0 Win

CIG80ML IBM FileNet Collaboration Services V2.0 AIX

CIG84ML IBM FileNet Collaboration Services V2.0 Linux

CIG8CML IBM FileNet Collaboration Services V2.0 Linux on z Systems

Table 36. List of eAssembly images for IBM Business Process Manager Express V 8.5

Part number

Description

CIL9EML

IBM Business Process Manager Express Version 8.5 Multiplatform Multilingual Quick Start Guide

CIL9BML

IBM Business Process Manager Express Version 8.5 For Windows 32/64Bit (1 of 3) Multilingual
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Table 36. List of eAssembly images for IBM Business Process Manager Express V
8.5 (continued)

Part number

Description

CIL9CML

IBM Business Process Manager Express Version 8.5 For Windows 32/64Bit (2 of 3) Multilingual

CIL9DML

IBM Business Process Manager Express Version 8.5 For Windows 32/64Bit (3 of 3) Multilingual

CIL9FML

IBM Business Process Manager Express Version 8.5 For Linux X86 32/64Bit (1 of 3) Multilingual

CIL9GML

IBM Business Process Manager Express Version 8.5 For Linux X86 32/64Bit (2 of 3) Multilingual

CILO9HML

IBM Business Process Manager Express Version 8.5 For Linux X86 32/64Bit (3 of 3) Multilingual

CZKC3ML

IBM Tivoli Directory Server 6.3 Client-Server with entitlement (zip file) for Windows 32 bit
Multilingual

CZKG4ML

IBM Tivoli Directory Server 6.3 Client-Server with entitlement (zip file) for win-x86-64 Multilingual

CZK9IML

IBM Tivoli Directory Server 6.3 Client-Server with entitlement (tar file) for Linux x86-64 Multilingual

CZZ89ML

Tivoli Access Manager for e-business V6.1.1 for Linux on x86 Multilingual

CZZ8EML

Tivoli Access Manager for e-business V6.1.1 for Windows Multilingual

Table 37. List of eAssembly images for IBM Content Analytics with Enterprise Search V3.0

Part
number

Description

CI73LML

IBM Content Analytics with Enterprise Search V3.0 Multiplatform Quick Start
Guide

CI73MML

IBM Content Analytics with Enterprise Search V3.0 Windows Multilingual

CI73NML

IBM Content Analytics with Enterprise Search V3.0 Agent for Windows File
System Crawler Multilingual

CI774ML

IBM Content Analytics with Enterprise Search V3.0 Linux Multilingual

CI775ML

IBM Content Analytics with Enterprise Search 3.0 AIX Multilingual

CI776ML

IBM Content Analytics with Enterprise Search V3.0 Linux on Sys z Multilingual

CZYIOML

Content Intgrtr 8.6 Quick Start Guide

CZYIIML

Content Intgrtr 8.6 Windows ML elmage

CZYI3ML

Content Intgrtr 8.6 Documentation MP ML elmage

CZYI2ML

Content Intgrtr 8.6 AIX, HP-UX, Linux, Solaris ML elmage

CZT7]ML

Quick Start for IBM WebSphere Application Server V8.0 for Multiplatform
Multilingual

CZM9HMI

L IBM WebSphere Application Server V8.0 (1 of 4) for Multiplatform Multilingual

CZM9IIML

IBM WebSphere Application Server V8.0 (2 of 4) for Multiplatform Multilingual

CZMI9JML

IBM WebSphere Application Server V8.0 (3 of 4) for Multiplatform Multilingual

CZVG3ML

IBM WebSphere Application Server V8.0 (4 of 4) for Multiplatform Multilingual

CZM91IML,

IBM WebSphere Application Server V8.0 Supplements (1 of 4) for Multiplatform
Multilingual

CZM94ML|

IBM WebSphere Application Server V8.0 Supplements (2 of 4) for Multiplatform
Multilingual

CZM95ML

IBM WebSphere Application Server V8.0 Supplements (3 of 4) for Multiplatform
Multilingual

CZXROML

IBM WebSphere Application Server V8.0 Supplements (4 of 4) for Multiplatform
Multilingual

CZM9OML,

IBM Installation Manager V1.4.3.1 for Windows x86 Multilingual (required
Install WebSphere Application Server V8.0)

Related information:
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[ [WebSphere Portal detailed system requirements|

[ [[BM Passport Advantage|

Getting WebSphere Portal Extend software
This section describes how to download and assemble IBM WebSphere Portal
Version 8.5 components using the Passport Advantage Online website.

Downloadable eAssembly images

The IBM WebSphere Portal Version 8.5 product consists of multiple offerings and
each offering includes multiple downloadable electronic images that are packaged
by platform. Each platform package is called an eAssembly and each eAssembly
contains all of the electronic images that are required for that offering to run on
that platform. The following table shows the eAssembly numbers for each of the
IBM WebSphere Portal Version 8.5 offerings.

Important: When you expand the eAssembly files, ensure that you expand the
files into the same parent directory to create a complete installable image. For
example, if you expand into a parent directory that is called download_directory, the
following directory structure results:

download directory/Setup
download _directory/IBMJAVA7
download directory/WAS8552
download _directory/WP85_Server
download_directory/WP85_Extend

Failure to expand all files in the same parent directory results in an installation
failure.

The following directories might also exist but are not required to be expanded in
the same parent directory:

download_directory/qsg_850_portal_wcm
download _directory/WP85_RemoteSearch

Required software

Table 38. List of eAssembly images for IBM WebSphere Portal and Web Content Manager
V8.5 Multiplatform Multilingual Quick Start Guide
Part number | Description

CIYE7ML IBM WebSphere Portal and Web Content Manager V8.5 Multiplatform Multilingual Quick Start Guide

Table 39. List of eAssembly images for IBM WebSphere Portal Extend V8.5 and IBM
WebSphere Application Server Setup V8.5.5.2
Part number | Description

CIZ5TML IBM WebSphere Portal Extend Setup V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CIYVOML IBM WebSphere Portal Server Install V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CIZ5UML IBM WebSphere Portal Extend Install V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.
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Table 39. List of eAssembly images for IBM WebSphere Portal Extend V8.5 and IBM
WebSphere Application Server Setup V8.5.5.2 (continued)

Part number

Description

CIYWOML

IBM WebSphere Application Server Network Deployment V8.5.5.2 Multiplatform Multilingual
IMPORTANT: All parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same
directory to create an installable image.

CIYWIML

IBM WebSphere SDK Java Technology Edition V7.0.6.1 Multiplatform Multilingual IMPORTANT: All
parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create
an installable image.

CIYW2ML

IBM WebSphere Portal V8.5 Remote Search and Document Conversion Services Multiplatform
Multilingual

Optional software

Table 40. List of eAssembly images for IBM WebSphere Application Server Network
Deployment V8.5.5 Supplements and Edge Components

Part number

Description

CIK1VML

IBM WebSphere Application Server V8.5.5 Supplements (1 of 3) for Multiplatform Multilingual

CIKIWML

IBM WebSphere Application Server V8.5.5 Supplements (2 of 3) for Multiplatform Multilingual

CIK1IXML

IBM WebSphere Application Server V8.5.5 Supplements (3 of 3) for Multiplatform Multilingual

CIK2NML

IBM WebSphere Edge Components: Load Balancer for IPv4 and IPv6 (for WebSphere Application
Server Network Deployment V8.5.5) Multiplatform Multilingual

CIL5DML

IBM WebSphere Edge Components: Load Balancer for IPv4 (for WebSphere Application Server
Network Deployment V8.5.5) Multiplatform, Multilingual

CIL5EML

IBM WebSphere Edge Components: Caching Proxy (for WebSphere Application Server Network
Deployment V8.5.5)Multiplatform, Multilingual

Table 41. List of eAssembly images for IBM DB2 Workgroup Server Edition 10.5

Part number

Description

CIXU9ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on AMD64 and Intel® EM64T
systems (x64)

CIWN3ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on POWER® (System i® and
System p®) systems

CIWN4ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on z Systems®

CIWN5ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for AIX®

CIWN6ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for HP-UX on HP Integrity Itanium-based
systems

CIWN7ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Solaris on UltraSPARC systems

CIWNSML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Solaris on x64 systems

CIWNO9ML

IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Windows® on AMD64 and Intel®
EMG64T systems (x64)

CIWM5ML

IBM® DB2® National Language Pack 10.5 for Linux® on AMD64 and Intel® EM6AT systems (x64)

CIWM6ML

IBM® DB2® National Language Pack 10.5 for Linux® on POWER® (System i® and System p®) systems

CIWM7ML

IBM® DB2® National Language Pack 10.5 for Linux® on z Systems®

CIWMSML

IBM® DB2® National Language Pack 10.5 for AIX®

CIWM9ML

IBM® DB2® National Language Pack 10.5 for HP-UX on HP Integrity Itanium-based systems

CIWNOML

IBM® DB2® National Language Pack 10.5 for Solaris on UltraSPARC systems

CIWN1ML

IBM® DB2® National Language Pack 10.5 for Solaris on x64 systems

Table 42. List of eAssembly images for IBM Tivoli Directory Integrator V7.1.1

Part number

Description

CZUE5SML

IBM Tivoli Directory Integrator V7.1.1 Quick Start Guide

CZUFOML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Windows - x86

CZUF7ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Windows - x86-64

CZUFIML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for AIX

CI772ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for AIX - PPCé64
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Table 42. List of eAssembly images for IBM Tivoli Directory Integrator V7.1.1 (continued)

Part number | Description

CZUF2ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux Linux - x86
CZUF3ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux Linux - x86-64
CZUE9ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux - zSeries & s/390
CZUFSML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux - POWER (i/p Series)
CZUF4ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Solaris - SPARC

CZUE6ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Solaris -Opteron

CZUE7ML IBM Tivoli Directory Integrator Identity Edition V7.1.1 for HP-UX - Integrity

Table 43. List of eAssembly images for IBM Security Directory Server V6.3.1

Part number

Description

CISOHML IBM Security Directory Server V6.3.1 win-base.zip (with ENT, Only IM based Installer, supports
32/64 bit)

CISOJML IBM Security Directory Server V6.3.1 win-IM.zip (contains ibm_IM_32bit, ibm_IM_64bit)

CISOKML IBM Security Directory Server V6.3.1 win-jdk.zip (contains ibm_jdk_32bit, ibm_jdk_64bit)

CISOLML IBM Security Directory Server V6.3.1 win-db2.zip (contains ibm_db2_32bit, ibm_db2_64bit)

CISOMML IBM Security Directory Server V6.3.1 win-ewas.zip (contains ibm_ewas_32bit, ibm_ewas_64bit)

CISONML IBM Security Directory Server V6.3.1 win-gskit.zip (contains ibm_gskit_32bit, ibm_gskit_64bit)

CISOPML IBM Security Directory Server V6.3.1 win.iso (with ENT, IM based Installer, pre-req installables)

CISORML IBM Security Directory Server V6.3.1 aix-ppc64-base.tar (with ENT, IM based Installer)

CISOTML IBM Security Directory Server V6.3.1 aix-ppc64-IM.tar

CISOUML IBM Security Directory Server V6.3.1 aix-ppc64-jdk.tar

CISOVML IBM Security Directory Server V6.3.1 aix-ppc64-db2.tar

CISOWML IBM Security Directory Server V6.3.1 aix-ppc64-ewas.tar

CISOXML IBM Security Directory Server V6.3.1 aix-ppc64-gskit.tar

CISOYML IBM Security Directory Server V6.3.1 aix-ppc64.iso (with ENT, IM based Installer, pre-req installables)

CIS10ML IBM Security Directory Server V6.3.1 linux-x86-64-base.tar (with ENT, IM based Installer)

CIS12ML IBM Security Directory Server V6.3.1 linux-x86-64-IM.tar

CIS13ML IBM Security Directory Server V6.3.1 linux-x86-64-jdk.tar

CIS14ML IBM Security Directory Server V6.3.1 linux-x86-64-db2.tar

CIS15ML IBM Security Directory Server V6.3.1 linux-x86-64-ewas.tar

CIS16ML IBM Security Directory Server V6.3.1 linux-x86-64-gskit.tar

CIS17ML IBM Security Directory Server V6.3.1 linux-x86-64.iso (with ENT, IM based Installer, pre-req
installables)

CISTHML IBM Security Directory Server V6.3.1 linux-x86-base.tar (with ENT, Native Installer)

CIS1JML IBM Security Directory Server V6.3.1 linux-x86-jdk.tar

CIS1IKML IBM Security Directory Server V6.3.1 linux-x86-db2.tar

CISILML IBM Security Directory Server V6.3.1 linux-x86-ewas.tar

CISIMML IBM Security Directory Server V6.3.1 linux-x86-gskit.tar

CISINML IBM Security Directory Server V6.3.1 linux-x86.iso (with ENT, native installer, pre-req installables)

CIS1I9ML IBM Security Directory Server V6.3.1 solaris-x86-64-base.tar (with ENT, Native Installer)

CIS1IBML IBM Security Directory Server V6.3.1 solaris-x86-64-jdk.tar

CIS1ICML IBM Security Directory Server V6.3.1 solaris-x86-64-db2.tar

CISIDML IBM Security Directory Server V6.3.1 solaris-x86-64-ewas.tar

CISIEML IBM Security Directory Server V6.3.1 solaris-x86-64-gskit.tar

CIS1IFML IBM Security Directory Server V6.3.1solaris-x86-64.iso (with ENT, native installer, pre-req installables)

CIS1IQML IBM Security Directory Server V6.3.1 solaris-sparc-base.tar (with ENT, Native Installer)

CIS1ISML IBM Security Directory Server V6.3.1 solaris-sparc-jdk.tar

CIS1ITML IBM Security Directory Server V6.3.1 solaris-sparc-db2.tar

CISTUML IBM Security Directory Server V6.3.1 solaris-sparc-ewas.tar

CISIVML IBM Security Directory Server V6.3.1 solaris-sparc-gskit.tar

CISIWML IBM Security Directory Server V6.3.1 solaris-sparc.iso (with ENT, native installer, pre-req installables)
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Table 43. List of eAssembly images for IBM Security Directory Server V6.3.1 (continued)

Part number

Description

CIS1ZML

IBM Security Directory Server V6.3.1 linux-ppc64-base.tar (with ENT, Native Installer)

CIS21IML

IBM Security Directory Server V6.3.1 linux-ppc64-jdk.tar

CIS22ML

IBM Security Directory Server V6.3.1 linux-ppc64-db2.tar

CIS23ML

IBM Security Directory Server V6.3.1 linux-ppc64-ewas.tar

CIS24ML

IBM Security Directory Server V6.3.1 linux-ppc64-gskit.tar

CIS26ML

IBM Security Directory Server V6.3.1 linux-ppc64.iso (with ENT, native installer, pre-req installables)

CIS28ML

IBM Security Directory Server V6.3.1 linux-s390x-base.tar (with ENT, Native Installer)

CIS2AML

IBM Security Directory Server V6.3.1 linux-s390x-jdk.tar

CIS2BML

IBM Security Directory Server V6.3.1 linux-s390x-db2.tar

CIS2CML

IBM Security Directory Server V6.3.1 linux-s390x-ewas.tar

CIS2DML

IBM Security Directory Server V6.3.1 linux-s390x-gskit.tar

CIS2EML

IBM Security Directory Server V6.3.1 linux-s390x.iso (with ENT, native installer, pre-req installables)

Table 44. List of eAssembly images for IBM Web Experience Factory V8.5

Part number

Description

CIYW5ML

IBM Web Experience Factory V8.5 Multiplatform Multilingual QuickStart

CIYW6ML

IBM Web Experience Factory V8.5 Multiplatform Multilingual

Table 45. List of eAssembly images for IBM Connections V4.5

Part number

Description

CIHC4ML

IBM Connections V4.5 Quick Start Guide for AIX, Windows, Linux, IBMi Multilingual

CIHC5ML

IBM Connections V4.5 for Windows Multilingual

CIISMML

IBM Connections V4.5 for AIX Multilingual

CIHC6ML

IBM Connections V4.5 for Linux Multilingual

CIHC7ML

IBM Connections V4.5 Linux for z Systems Multilingual

CIHC8ML

IBM Connections V4.5 Wizard for Windows Multilingual

CIHCOML

IBM Connections V4.5 Wizard for Linux, AIX Multilingual

Table 46. List of eAssembly images for IBM Worklight Consumer Edition V6.1

Part number

Description

CIQT7ML

Quick Start Guide for Worklight Consumer Edition V6.1 for Multiplatforms Multiplatforms

CIQ5JEN

IBM Worklight Consumer Edition V6.1 zip of Installation Manager Repository for IBM Worklight
Server Multiplatforms English

CIQ5KEN

IBM Worklight Consumer Edition V6.1 zip of Eclipse update for IBM Worklight Studio Multiplatform
English

CIQ5LEN

IBM Worklight Consumer Edition V6.1 zip of Eclipse Update Site for Mobile Test Workbench
Worklight Multiplatforms English

CILD7ML

IBM Rational Enterprise Deployment V1.6.3 Windows Multilingual

CILDSML

IBM Rational Enterprise Deployment V1.6.3 Linux x86 Multilingual

CILEOML

IBM Rational Enterprise Deployment V1.6.3 Linux x86-64 Multilingual

CILEIML

IBM Rational Enterprise Deployment V1.6.3 Linux PPC Multilingual

CILE2ML

IBM Rational Enterprise Deployment V1.6.3 Linux s390 Multilingual

CILE3ML

IBM Rational Enterprise Deployment V1.6.3 AIX Multilingual

CILE5SML

IBM Rational Enterprise Deployment V 1.6.3 for Solaris 10 SPARC

CILE6ML

IBM Rational Enterprise Deployment V 1.6.3 for X86-64

CIK2UML

Quick Start for IBM WebSphere Application Server - Liberty Core V8.5.5 for Multiplatform
Multilingual

CIK2VML

IBM WebSphere Application Server - Liberty Core V8.5.5 for Multiplatform Multilingual

CIK2YML

IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (1 of 3) for Multiplatform
Multilingual

CIK2ZML

IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (2 of 3) for Multiplatform
Multilingual
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Table 46. List of eAssembly images for IBM Worklight Consumer Edition V6.1 (continued)

Part number | Description

CIK30ML IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (3 of 3) for Multiplatform
Multilingual

CI6TQML IBM® DB2® 10.1 - Limited Use for Linux® on AMD64 and Intel® EM64T

CI6TSML IBM® DB2® 10.1 - Limited Use for Linux® on POWER® (System i® and System p®) systems

CI6TRML IBM® DB2® 10.1 - Limited Use for Linux® on z Systems®

CI6TTML IBM® DB2® 10.1 - Limited Use for 64-bit ATX®

CI6TVML IBM® DB2® 10.1 - Limited Use for Solaris on UltraSPARC systems

CI6TWML IBM® DB2® 10.1 - Limited Use for Solaris on x64 systems

CI6TYML IBM® DB2® 10.1 - Limited Use for Windows® on AMD64 and Intel® EM64T systems (x64)

CI71IVML IBM® DB2® 10.1, National Language Pack for Linux® on AMD64 and Intel® EM6AT systems (x64)

CI7IWML IBM® DB2® 10.1, National Language Pack for Linux® on POWER® (System i® and System p®) systems

CI71IXML IBM® DB2® 10.1, National Language Pack for Linux® on z Systems®

CI71QML IBM® DB2® 10.1, National Language Pack for AIX®

CI71SML IBM® DB2® 10.1, National Language Pack for Solaris on UltraSPARC systems

CI7ITML IBM® DB2® 10.1, National Language Pack for Solaris on x64 systems

Table 47. List of eAssembly images for IBM Connections Content Manager 4.5

Part number

Description

CIHC4ML IBM Connections V4.5 Quick Start Guide for AIX, Windows, Linux, IBMi Multilingual
CIQ52ML IBM FileNet Content Engine V5.2 AIX Multilingual

CIQ55ML IBM FileNet Content Engine V5.2 Linux Multilingual

CIQ57ML IBM FileNet Content Engine V5.2 Windows Multilingual

CIQ58ML IBM FileNet Content Engine V5.2 Linux on z Systems Multilingual
CIQ5DEN IBM FileNet Content Engine Client V5.2 Linux English

CIQ5FEN IBM FileNet Content Engine Client V5.2 Windows English
CIQ5GEN IBM FileNet Content Engine Client V5.2 Linux on z Systems English
CIQ5AEN IBM FileNet Collaboration Services V2.0 Win

CIG7ZML IBM FileNet Collaboration Services V2.0 Win

CIG8OML IBM FileNet Collaboration Services V2.0 AIX

CIG84ML IBM FileNet Collaboration Services V2.0 Linux

CIG8CML IBM FileNet Collaboration Services V2.0 Linux on z Systems

Table 48. List of eAssembly images for IBM Business Process Manager Express V 8.5

Part number | Description
CIL9EML IBM Business Process Manager Express Version 8.5 Multiplatform Multilingual Quick Start Guide
CIL9BML IBM Business Process Manager Express Version 8.5 For Windows 32/64Bit (1 of 3) Multilingual
CIL9ICML IBM Business Process Manager Express Version 8.5 For Windows 32/64Bit (2 of 3) Multilingual
CIL9DML IBM Business Process Manager Express Version 8.5 For Windows 32/64Bit (3 of 3) Multilingual
CIL9FML IBM Business Process Manager Express Version 8.5 For Linux X86 32/64Bit (1 of 3) Multilingual
CIL9GML IBM Business Process Manager Express Version 8.5 For Linux X86 32/64Bit (2 of 3) Multilingual
CIL9HML IBM Business Process Manager Express Version 8.5 For Linux X86 32/64Bit (3 of 3) Multilingual
CZKC3ML IBM Tivoli Directory Server 6.3 Client-Server with entitlement (zip file) for Windows 32 bit
Multilingual
CZKG4ML IBM Tivoli Directory Server 6.3 Client-Server with entitlement (zip file) for win-x86-64 Multilingual
CZK9IML IBM Tivoli Directory Server 6.3 Client-Server with entitlement (tar file) for Linux x86-64 Multilingual
CZZ89ML Tivoli Access Manager for e-business V6.1.1 for Linux on x86 Multilingual
CZZ8EML Tivoli Access Manager for e-business V6.1.1 for Windows Multilingual
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Table 49. List of eAssembly images for IBM Content Analytics with Enterprise Search V3.0

Part
number

Description

CI73LML

IBM Content Analytics with Enterprise Search V3.0 Multiplatform Quick Start
Guide

CI73MML

IBM Content Analytics with Enterprise Search V3.0 Windows Multilingual

CI73NML

IBM Content Analytics with Enterprise Search V3.0 Agent for Windows File
System Crawler Multilingual

CI774ML

IBM Content Analytics with Enterprise Search V3.0 Linux Multilingual

CI775ML

IBM Content Analytics with Enterprise Search 3.0 AIX Multilingual

CI776ML

IBM Content Analytics with Enterprise Search V3.0 Linux on Sys z Multilingual

CZYIOML

Content Intgrtr 8.6 Quick Start Guide

CZYIIML

Content Intgrtr 8.6 Windows ML elmage

CZYI3ML

Content Intgrtr 8.6 Documentation MP ML elmage

CZYI2ZML

Content Intgrtr 8.6 AIX, HP-UX, Linux, Solaris ML elmage

CZT7]ML

Quick Start for IBM WebSphere Application Server V8.0 for Multiplatform
Multilingual

CZM9HMI

L IBM WebSphere Application Server V8.0 (1 of 4) for Multiplatform Multilingual

CZM9IML

IBM WebSphere Application Server V8.0 (2 of 4) for Multiplatform Multilingual

CZMI9JML

IBM WebSphere Application Server V8.0 (3 of 4) for Multiplatform Multilingual

CZVG3ML

IBM WebSphere Application Server V8.0 (4 of 4) for Multiplatform Multilingual

CZM91IML,

IBM WebSphere Application Server V8.0 Supplements (1 of 4) for Multiplatform
Multilingual

CZM94ML|

IBM WebSphere Application Server V8.0 Supplements (2 of 4) for Multiplatform
Multilingual

CZM95ML

IBM WebSphere Application Server V8.0 Supplements (3 of 4) for Multiplatform
Multilingual

CZXROML

IBM WebSphere Application Server V8.0 Supplements (4 of 4) for Multiplatform
Multilingual

CZM9OML,

IBM Installation Manager V1.4.3.1 for Windows x86 Multilingual (required

Install WebSphere Application Server V8.0)

Table 50. List of eAssembly images for IBM Forms Server, IBM Forms Designer, and IBM
Forms Viewer V 8.0.1 and IBM Forms Experience Builder V8.5

Part number

Description

CIN78ML

IBM Forms Server V8.0.1 Multiplatform Multilingual Quick Start Guide

CIN79ML

IBM Forms Server V8.0.1 Win 64-bit Multilingual

CIN7AML

IBM Forms Server V8.0.1 Win 32-bit Multilingual

CIN7BML

IBM Forms Server V8.0.1 Linux 64-bit Multilingual

CIN7CML

IBM Forms Server V8.0.1 Linux 32-bit Multilingual

CIN7DML

IBM Forms Server V8.0.1 IBMi 64-bit Multilingual

CIN7EML

IBM Forms Server V8.0.1 IBMi 32-bit Multilingual

CIN7EML

IBM Forms Server V8.0.1 AIX 64-bit Multilingual

CIN7GML

IBM Forms Server V8.0.1 AIX 32-bit Multilingual

CIN7HML

IBM Forms Server V8.0.1 Solaris 64-bit Multilingual

CIN7IML

IBM Forms Server V8.0.1 zLinux 64-bit Multilingual

CIN7JML

IBM Forms Server V8.0.1 zLinux 64-bit Multilingual

CIN7KML

IBM Forms Server V8.0.1 zLinux 31-bit Multilingual
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Table 50. List of eAssembly images for IBM Forms Server, IBM Forms Designer, and IBM
Forms Viewer V 8.0.1 and IBM Forms Experience Builder V8.5 (continued)

Part number

Description

CINEIML IBM Forms Viewer V8.0.1 Windows Multilingual Quick Start Guide

CINE2ML IBM Forms Viewer V8.0.1 Windows Multilingual

CINE3ML IBM Forms Designer V8.0.1 Windows Multilingual Quick Start Guide

CINE4ML IBM Forms Designer V8.0.1 Windows Multilingual

CIM5PML IBM Forms Experience Builder v8.5 Multiplatform Multilingual Quick Start Guide
CIJM3ML IBM Forms Experience Builder v8.5 for Windows

CIJM4ML IBM Forms Experience Builder v8.5 for Linux x86

CIJM5ML IBM Forms Experience Builder v8.5 for AIX

CIJM6ML IBM Forms Experience Builder v8.5 for Linux on z Systems

Table 51. List of eAssembly images for IBM Sametime Limited Use 9.0

Part number

Description

CIQ43ML IBM Sametime V9.0 Multiplatform Multilingual Quickstart Guide

CITN1IML IBM Sametime Connect Client Limited Use V9.0 Windows, x86 Linux, Mac Multilingual

CITN2ML IBM Sametime Community Server Limited Use V9.0 Windows Multilingual

CITN3ML IBM Sametime Community Server Limited Use V9.0 AIX, Linux Multilingual

CITN4ML IBM Sametime Community Server Limited Use V9.0 IBM i Multilingual

CIQ48ML IBM Sametime Proxy Server V9.0 Windows, x86 Linux, AIX, IBMi Multilingual

CIQ4CML IBM Sametime System Console Server V9.0 Windows, x86 Linux, AIX, IBMi Multilingual

CIQ6JML IBM WebSphere V8.5.5.0 iFixes for IBM Sametime V9.0 Windows, x86 Linux, AIX, IBMi Multilingual

CIB8QML Quick Start Guide - IBM Notes and Domino V9.0 Multilingual

CIBSREN IBM Notes and Domino V9.0 Release Notes English

CIB9AEN IBM Notes, Domino Designer and Admin V9.0 for Windows XP,Vista and Windows 7 32 Bit English

CIBMOEN IBM Domino Server V9.0 32 Bit for Windows English

CIBM3EN IBM Domino Server V9.0 32 bit for AIX English

CIBM4EN IBM Domino Server V9.0 32 bit for Linux for xSeries English

CIBM7EN IBM Domino Server V9.0 for IBM i English

CINK4CS IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Czech

CINKSHU IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Hungarian

CINK6RU IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Russian

CINK7EL IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Greek

CINKS8TR IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Turkish

CINK9AR IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Arabic

CINLOPT IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Portuguese

CINLIPL IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Polish

CINL2TH IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Thai

CINL3SI IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Slovenian

CINL4SK IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Slovakian

CILI1FI IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Finnish

CILI2NO IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Norwegian

CILI3SV IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Swedish

CILI4DA IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Danish

CILISNL IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Dutch

CIJ7CCA IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Catalan

CIJ7DDE IBM Notes, Domino Designer and Admin 9.0 for Windows XP, Windows 7 and Windows 8 German

CIJ7ZEKO IBM Notes, Domino Designer and Admin 9.0 for Windows XP, Windows 7 and Windows 8 Korean

CIJ7FSC IBM Notes, Domino Designer and Admin 9.0 for Windows XP, Windows 7 and Windows 8 Simplified
Chinese

CIJ7GES IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Spanish
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Table 51. List of eAssembly images for IBM Sametime Limited Use 9.0 (continued)

Part number

Description

CIJ7HFR

IBM Notes, Domino Designer and Admin 9.0 for Windows XP, Windows 7 and Windows 8 French

CIJ71TC

IBM Notes, Domino Designer and Admin 9.0 for Windows XP, Windows 7 and Windows 8 Traditional
Chinese

Chj7]JA

IBM Notes, Domino Designer and Admin 9.0 for Windows XP, Windows 7 and Windows 8 Japanese

CIJ7KIT

IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Italian

CIJ7LBP

IBM Notes and Domino Designer 9.0 for Windows XP, Windows 7 and Windows 8 Brazilian
Portuguese

CILS9FI

IBM Domino 9.0 Language Pack for Windows 2008/2012 and IBM Power Systems (Multi O/S
Install)Finnish

CILT4FI

IBM Domino Server V9.0 Language Pack for AIX, Linux on XxSeries and Linux on zSeries Multi O/S
Install Finnish

CILTONO

IBM Domino 9.0 Language Pack for Windows 2008/2012 and IBM Power Systems (Multi O/S
Install)Norwegian

CILT5SNO

IBM Domino Server V9.0 Language Pack for AIX, Linux on XxSeries and Linux on zSeries Multi O/S
Install Norwegian

CILT1SV

IBM Domino 9.0 Language Pack for Windows 2008/2012 and IBM Power Systems (Multi O/S
Install)Swedish

CILT6SV

IBM Domino Server V9.0 Language Pack for AIX, Linux on XSeries and Linux on zSeries Multi O/S
Install Swedish

CILT2DA

IBM Domino 9.0 Language Pack for Windows 2008/2012 and IBM Power Systems (Multi O/S
Install)Danish

CILT7DA

IBM Domino Server V9.0 Language Pack for AIX, Linux on XSeries and Linux on zSeries Multi O/S
Install Danish

CILT3NL

IBM Domino 9.0 Language Pack for Windows 2008/2012 and IBM Power Systems (Multi O/S
Install)Dutch

CIJ9RJA

IBM Domino Server V9.0 Language Pack for Windows 2008, Windows 2012 and IBM Power Systems
Multi O/S Install Japanese

CIJA9JA

IBM Domino Server V9.0 Language Pack for AIX, Linux on XxSeries and Linux on zSeries Multi O/S
Install Japanese

CIJ9TEN

IBM Domino Server V9.0 Language Pack for Windows 2008, Windows 2012 and IBM Power Systems
Multi O/S Install English

CIBIEN

IBM Domino Server V9.0 Language Pack for AIX, Linux on XSeries and Linux on zSeries Multi O/S
Install English

CIJ9LKO

IBM Domino Server V9.0 Language Pack for Windows 2008, Windows 2012 and IBM Power Systems
Multi O/S Install Korean

CIJA4KO

IBM Domino Server V9.0 Language Pack for AIX, Linux on XxSeries and Linux on zSeries Multi O/S
Install Korean

CINQICS

IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Czech

CINS0CS

IBM Domino Server V9.0 Language Pack for Linux on xSeries Czech

CINS7TH

IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install Thai

CINS9TH

IBM Domino Server V9.0 Language Pack for AIX Thai

CIJ9MSC

IBM Domino Server V9.0 Language Pack for Windows 2008, Windows 2012 and IBM Power Systems
Multi O/S Install Simplified Chinese

CIJA5SC

IBM Domino Server V9.0 Language Pack for AIX, Linux on XxSeries and Linux on zSeries Multi O/S
Install Simplified Chinese

CIJ9QTC

IBM Domino Server V9.0 Language Pack for Windows 2008, Windows 2012 and IBM Power Systems
Multi O/S Install Traditional Chinese

CIJASTC

IBM Domino Server V9.0 Language Pack for AIX, Linux on XxSeries and Linux on zSeries Multi O/S
Install Traditional Chinese

CIJ9JCA

IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Catalan

CIJ9KDE

IBM Domino Server V9.0 Language Pack for Windows 2008, Windows 2012 and IBM Power Systems
Multi O/S Install German

CIJA3DE

IBM Domino Server V9.0 Language Pack for AIX, Linux on XxSeries and Linux on zSeries Multi O/S
Install German

CIJ9SIT

IBM Domino Server V9.0 Language Pack for Windows 2008, Windows 2012 and IBM Power Systems
Multi O/S Install Italian
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Table 51. List of eAssembly images for IBM Sametime Limited Use 9.0 (continued)

Part number | Description

CIJBOIT IBM Domino Server V9.0 Language Pack for AIX, Linux on XSeries and Linux on zSeries Multi O/S
Install Italian
CIJ9PFR IBM Domino Server V9.0 Language Pack for Windows 2008, Windows 2012 and IBM Power Systems

Multi O/S Install French

CIJA7FR IBM Domino Server V9.0 Language Pack for AIX, Linux on XSeries and Linux on zSeries Multi O/S
Install French

CIJ9NES IBM Domino Server V9.0 Language Pack for Windows 2008, Windows 2012 and IBM Power Systems
Multi O/S Install Spanish

CIJAGES IBM Domino Server V9.0 Language Pack for AIX, Linux on xSeries and Linux on zSeries Multi O/S
Install Spanish

CIJ9UBP IBM Domino Server V9.0 Language Pack for Windows 2008, Windows 2012 and IBM Power Systems
Multi O/S Install Brazilian Portuguese

CIJB2BP IBM Domino Server V9.0 Language Pack for AIX, Linux on xSeries and Linux on zSeries Multi O/S
Install Brazilian Portuguese

CINQSAR IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Arabic

CINR9AR IBM Domino Server V9.0 Language Pack for Linux on xSeries Arabic

CINROEL IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Greek

CINSIEL IBM Domino Server V9.0 Language Pack for Linux on xSeries Greek

CINR1IW IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Hebrew

CINS2IW IBM Domino Server V9.0 Language Pack for Linux on xSeries Hebrew

CINR2HU IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Hungarian

CINTOHU IBM Domino Server V9.0 Language Pack for AIX and Linux on xSeries Hungarian

CINR7SK IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Slovakian

CINRSSI IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Slovenian

CINS8KZ IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Kazakh

CINR3PT IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Portuguese

CINR4PL IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Polish

CINT1PL IBM Domino Server V9.0 Language Pack for AIX and Linux on xSeries Polish

CINR5RU IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Russian

CINS4RU IBM Domino Server V9.0 Language Pack for Linux on xSeries Russian

CINR6TR IBM Domino Server V9.0 Language Pack for Windows 2008 and Windows 2012 Multi O/S Install
Turkish

CINS5TR IBM Domino Server V9.0 Language Pack for Linux on xSeries Turkish

CINS3PT IBM Domino Server V9.0 Language Pack for Linux on xSeries Portuguese

CIK2NML IBM WebSphere Edge Components: Load Balancer for IPv4 and IPv6 (for WebSphere Application
Server Network Deployment V8.5.5) Multiplatform Multilingual

CIL5DML IBM WebSphere Edge Components: Load Balancer for IPv4 (for WebSphere Application Server
Network Deployment V8.5.5) Multiplatform, Multilingual

CIL5EML IBM WebSphere Edge Components: Caching Proxy (for WebSphere Application Server Network
Deployment V8.5.5)Multiplatform, Multilingual

CIK2HML | IBM WebSphere Application Server Network Deployment V8.5.5 (1 of 3) for Multiplatform
Multilingual

CIK2IML IBM WebSphere Application Server Network Deployment V8.5.5 (2 of 3) for Multiplatform
Multilingual

CIK2JML IBM WebSphere Application Server Network Deployment V8.5.5 (3 of 3) for Multiplatform
Multilingual

CIK2GML IBM Installation Manager V1.6.2 for Linux x86_64 (required to install WebSphere Application Server
V8.5.5), Multilingual
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Table 51. List of eAssembly images for IBM Sametime Limited Use 9.0 (continued)

Part number | Description

CILODML IBM Installation Manager V1.6.2 for Windows x86_64 (required to install WebSphere Application
Server V8.5.5), Multilingual

CIKTYML IBM Installation Manager V1.6.2 (required Install WebSphere Application Server V8.5.5) for AIX
PowerPC Multilingual

CIK23ML IBM Installation Manager V1.6.2 (required Install WebSphere Application Server V8.5.5) for IBM i
Multilingual

CIK2LML IBM DMZ Secure Proxy Server (1 of 2) (WebSphere Application Server Network Deployment V8.5.5)
Multiplatform Multilingual

CIK2MML | IBM DMZ Secure Proxy Server (2 of 2) (WebSphere Application Server Network Deployment V8.5.5)
Multiplatform Multilingual

CI6TQML IBM® DB2® 10.1 - Limited Use for Linux® on AMD64 and Intel® EM64T
CI6TTML IBM® DB2® 10.1 - Limited Use for 64-bit AIX®

CI6TYML IBM® DB2® 10.1 - Limited Use for Windows® on AMD64 and Intel® EM64T systems (x64)

CI71IVML IBM® DB2® 10.1, National Language Pack for Linux® on AMD64 and Intel® EM64T systems (x64)

CI71QML IBM® DB2® 10.1, National Language Pack for AIX®

CI6VIML IBM® DB2® Net Search Extender for Windows® on AMD64 and Intel® EM64T systems (x64)

Related information:

[ [WebSphere Portal detailed system requirements|

[ [[BM Passport Advantage|

Getting Web Content Manager software
This section describes how to download and assemble IBM WebSphere Portal
Version 8.5 components by using the Passport Advantage Online website.

Downloadable eAssembly images

The IBM WebSphere Portal Version 8.5 product consists of multiple offerings and
each offering includes multiple downloadable electronic images that are packaged
by platform. Each platform package is called an eAssembly and each eAssembly
contains all of the electronic images that are required for that offering to run on
that platform. The following table shows the eAssembly numbers for each of the
IBM WebSphere Portal Version 8.5 offerings.

Important: When you expand the eAssembly files, ensure that you expand the
files into the same parent directory to create a complete installable image. For
example, if you expand into a parent directory that is called download_directory, the
following directory structure results:

download directory/Setup
download_directory/IBMJAVA7
download _directory/WAS8552
download directory/WP85 Server
download _directory/WP85_WCM

Failure to expand all files in the same parent directory results in an installation
failure.

The following directories might also exist but are not required to be expanded in
the same parent directory:

download _directory/qsg_850_portal_wcm
download _directory/WP85_RemoteSearch
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Required software

Table 52. List of eAssembly images for IBM WebSphere Portal and Web Content Manager
V8.5 Multiplatform Multilingual Quick Start Guide

Part number

Description

CIYE7ML

IBM WebSphere Portal and Web Content Manager V8.5 Multiplatform Multilingual Quick Start Guide

Table 53. List of eAssembly images for IBM Web Content Manager V8.5 and IBM
WebSphere Application Server Setup V8.5.5.2

Part number

Description

CIZ5PML

IBM Web Content Manager Setup V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CIYVOML

IBM WebSphere Portal Server Install V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CIZ5QML

IBM Web Content Manager Install V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CIYWOML

IBM WebSphere Application Server Network Deployment V8.5.5.2 Multiplatform Multilingual
IMPORTANT: All parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same
directory to create an installable image.

CIYWIML

IBM WebSphere SDK Java Technology Edition V7.0.6.1 Multiplatform Multilingual IMPORTANT: All
parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create
an installable image.

CIYW2ML

IBM WebSphere Portal V8.5 Remote Search and Document Conversion Services Multiplatform
Multilingual

Optional software

Table 54. List of eAssembly images for IBM WebSphere Application Server Network
Deployment V8.5.5 Supplements and Edge Components

Part number

Description

CIK1VML IBM WebSphere Application Server V8.5.5 Supplements (1 of 3) for Multiplatform Multilingual

CIKIWML IBM WebSphere Application Server V8.5.5 Supplements (2 of 3) for Multiplatform Multilingual

CIK1XML IBM WebSphere Application Server V8.5.5 Supplements (3 of 3) for Multiplatform Multilingual

CIK2NML IBM WebSphere Edge Components: Load Balancer for IPv4 and IPv6 (for WebSphere Application
Server Network Deployment V8.5.5) Multiplatform Multilingual

CIL5DML IBM WebSphere Edge Components: Load Balancer for IPv4 (for WebSphere Application Server
Network Deployment V8.5.5) Multiplatform, Multilingual

CILS5EML IBM WebSphere Edge Components: Caching Proxy (for WebSphere Application Server Network

Deployment V8.5.5)Multiplatform, Multilingual

Table 55. List of eAssembly images for IBM DB2 Workgroup Server Edition 10.5

Part number

Description

CIXU9ML IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on AMD64 and Intel® EM64T
systems (x64)

CIWN3ML | IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on POWER® (System i® and
System p®) systems

CIWN4ML | IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on z Systems®

CIWN5ML | IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for AIX®

CIWN6ML IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for HP-UX on HP Integrity Itanium-based
systems

CIWN7ML IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Solaris on UltraSPARC systems

CIWNSML IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Solaris on x64 systems

CIWNIML | IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Windows® on AMD64 and Intel®
EM64T systems (x64)

CIWM5ML | IBM® DB2® National Language Pack 10.5 for Linux® on AMD64 and Intel® EM64T systems (x64)

CIWM6ML | IBM® DB2® National Language Pack 10.5 for Linux® on POWER® (System i® and System p®) systems
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Table 55. List of eAssembly images for IBM DB2 Workgroup Server Edition
10.5 (continueq)

Part number

Description

CIWM7ML

IBM® DB2® National Language Pack 10.5 for Linux® on z Systems®

CIWMSML

IBM® DB2® National Language Pack 10.5 for AIX®

CIWM9ML

IBM® DB2® National Language Pack 10.5 for HP-UX on HP Integrity Itanium-based systems

CIWNOML

IBM® DB2® National Language Pack 10.5 for Solaris on UltraSPARC systems

CIWN1ML

IBM® DB2® National Language Pack 10.5 for Solaris on x64 systems

Table 56. List of eAssembly images for IBM Tivoli Directory Integrator V7.1.1

Part number

Description

CZUE5ML

IBM Tivoli Directory Integrator V7.1.1 Quick Start Guide

CZUFOML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Windows - x86

CZUF7ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Windows - x86-64

CZUFIML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for AIX

CI772ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for AIX - PPC64

CZUF2ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux Linux - x86

CZUF3ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux Linux - x86-64

CZUE9ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux - zSeries & s/390

CZUF5ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux - POWER (i/p Series)

CZUF4ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Solaris - SPARC

CZUE6ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Solaris -Opteron

CZUE7ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for HP-UX - Integrity

Table 57. List of eAssembly images for IBM Security Directory Server V6.3.1

Part number

Description

CISOHML

IBM Security Directory Server V6.3.1 win-base.zip (with ENT, Only IM based Installer, supports
32/64 bit)

CISOJML

IBM Security Directory Server V6.3.1 win-IM.zip (contains ibm_IM_32bit, ibm_IM_64bit)

CISOKML

IBM Security Directory Server V6.3.1 win-jdk.zip (contains ibm_jdk_32bit, ibm_jdk_64bit)

CISOLML

IBM Security Directory Server V6.3.1 win-db2.zip (contains ibm_db2_32bit, ibm_db2_64bit)

CISOMML

IBM Security Directory Server V6.3.1 win-ewas.zip (contains ibm_ewas_32bit, ibm_ewas_64bit)

CISONML

IBM Security Directory Server V6.3.1 win-gskit.zip (contains ibm_gskit_32bit, ibm_gskit_64bit)

CISOPML

IBM Security Directory Server V6.3.1 win.iso (with ENT, IM based Installer, pre-req installables)

CISORML

IBM Security Directory Server V6.3.1 aix-ppc64-base.tar (with ENT, IM based Installer)

CISOTML

IBM Security Directory Server V6.3.1 aix-ppc64-IM.tar

CISOUML

IBM Security Directory Server V6.3.1 aix-ppc64-jdk.tar

CISOVML

IBM Security Directory Server V6.3.1 aix-ppc64-db2.tar

CISOWML

IBM Security Directory Server V6.3.1 aix-ppc64-ewas.tar

CISOXML

IBM Security Directory Server V6.3.1 aix-ppc64-gskit.tar

CISOYML

IBM Security Directory Server V6.3.1 aix-ppc64.iso (with ENT, IM based Installer, pre-req installables)

CIS10ML

IBM Security Directory Server V6.3.1 linux-x86-64-base.tar (with ENT, IM based Installer)

CIS12ML

IBM Security Directory Server V6.3.1 linux-x86-64-IM.tar

CIS13ML

IBM Security Directory Server V6.3.1 linux-x86-64-jdk.tar

CIS14ML

IBM Security Directory Server V6.3.1 linux-x86-64-db2.tar

CIS15ML

IBM Security Directory Server V6.3.1 linux-x86-64-ewas.tar

CIS16ML

IBM Security Directory Server V6.3.1 linux-x86-64-gskit.tar

CIS17ML

IBM Security Directory Server V6.3.1 linux-x86-64.iso (with ENT, IM based Installer, pre-req
installables)

CISTHML

IBM Security Directory Server V6.3.1 linux-x86-base.tar (with ENT, Native Installer)

CIS1JML

IBM Security Directory Server V6.3.1 linux-x86-jdk.tar

CIS1IKML

IBM Security Directory Server V6.3.1 linux-x86-db2.tar

CIS1ILML

IBM Security Directory Server V6.3.1 linux-x86-ewas.tar
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Table 57. List of eAssembly images for IBM Security Directory Server V6.3.1 (continued)

Part number | Description

CISIMML IBM Security Directory Server V6.3.1 linux-x86-gskit.tar

CISINML IBM Security Directory Server V6.3.1 linux-x86.iso (with ENT, native installer, pre-req installables)
CIS1I9ML IBM Security Directory Server V6.3.1 solaris-x86-64-base.tar (with ENT, Native Installer)

CIS1BML IBM Security Directory Server V6.3.1 solaris-x86-64-jdk.tar

CIS1ICML IBM Security Directory Server V6.3.1 solaris-x86-64-db2.tar

CISIDML IBM Security Directory Server V6.3.1 solaris-x86-64-ewas.tar

CISIEML IBM Security Directory Server V6.3.1 solaris-x86-64-gskit.tar

CIS1IFML IBM Security Directory Server V6.3.1solaris-x86-64.iso (with ENT, native installer, pre-req installables)
CISIQML IBM Security Directory Server V6.3.1 solaris-sparc-base.tar (with ENT, Native Installer)

CIS1SML IBM Security Directory Server V6.3.1 solaris-sparc-jdk.tar

CISITML IBM Security Directory Server V6.3.1 solaris-sparc-db2.tar

CISTUML IBM Security Directory Server V6.3.1 solaris-sparc-ewas.tar

CISIVML IBM Security Directory Server V6.3.1 solaris-sparc-gskit.tar

CISTWML IBM Security Directory Server V6.3.1 solaris-sparc.iso (with ENT, native installer, pre-req installables)
CIS1ZML IBM Security Directory Server V6.3.1 linux-ppc64-base.tar (with ENT, Native Installer)

CIS21ML IBM Security Directory Server V6.3.1 linux-ppc64-jdk.tar

CIS22ML IBM Security Directory Server V6.3.1 linux-ppc64-db2.tar

CIS23ML IBM Security Directory Server V6.3.1 linux-ppc64-ewas.tar

CIS24ML IBM Security Directory Server V6.3.1 linux-ppc64-gskit.tar

CIS26ML IBM Security Directory Server V6.3.1 linux-ppc64.iso (with ENT, native installer, pre-req installables)
CIS28ML IBM Security Directory Server V6.3.1 linux-s390x-base.tar (with ENT, Native Installer)

CIS2AML IBM Security Directory Server V6.3.1 linux-s390x-jdk.tar

CIS2BML IBM Security Directory Server V6.3.1 linux-s390x-db2.tar

CIS2CML IBM Security Directory Server V6.3.1 linux-s390x-ewas.tar

CIS2DML IBM Security Directory Server V6.3.1 linux-s390x-gskit.tar

CIS2EML IBM Security Directory Server V6.3.1 linux-s390x.iso (with ENT, native installer, pre-req installables)

Table 58. List of eAssembly images for IBM Worklight Consumer Edition V6.1

Part number

Description

CIQT7ML Quick Start Guide for Worklight Consumer Edition V6.1 for Multiplatforms Multiplatforms

CIQ5JEN IBM Worklight Consumer Edition V6.1 zip of Installation Manager Repository for IBM Worklight
Server Multiplatforms English

CIQ5KEN IBM Worklight Consumer Edition V6.1 zip of Eclipse update for IBM Worklight Studio Multiplatform
English

CIQ5LEN IBM Worklight Consumer Edition V6.1 zip of Eclipse Update Site for Mobile Test Workbench
Worklight Multiplatforms English

CILD7ML IBM Rational Enterprise Deployment V1.6.3 Windows Multilingual

CILD9ML IBM Rational Enterprise Deployment V1.6.3 Linux x86 Multilingual

CILEOML IBM Rational Enterprise Deployment V1.6.3 Linux x86-64 Multilingual

CILEIML IBM Rational Enterprise Deployment V1.6.3 Linux PPC Multilingual

CILE2ML IBM Rational Enterprise Deployment V1.6.3 Linux s390 Multilingual

CILE3ML IBM Rational Enterprise Deployment V1.6.3 AIX Multilingual

CILESML IBM Rational Enterprise Deployment V 1.6.3 for Solaris 10 SPARC

CILE6ML IBM Rational Enterprise Deployment V 1.6.3 for X86-64

CIK2UML Quick Start for IBM WebSphere Application Server - Liberty Core V8.5.5 for Multiplatform
Multilingual

CIK2VML IBM WebSphere Application Server - Liberty Core V8.5.5 for Multiplatform Multilingual

CIK2YML IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (1 of 3) for Multiplatform
Multilingual

CIK2ZML IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (2 of 3) for Multiplatform

Multilingual
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Table 58. List of eAssembly images for IBM Worklight Consumer Edition V6.1 (continued)
Part number | Description

CIK30ML IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (3 of 3) for Multiplatform

Multilingual
CI6TQML IBM® DB2® 10.1 - Limited Use for Linux® on AMD64 and Intel® EM64T
CI6TSML IBM® DB2® 10.1 - Limited Use for Linux® on POWER® (System i® and System p®) systems
CI6TRML IBM® DB2® 10.1 - Limited Use for Linux® on z Systems®
CI6TTML IBM® DB2® 10.1 - Limited Use for 64-bit ATX®
CI6TVML IBM® DB2® 10.1 - Limited Use for Solaris on UltraSPARC systems
CI6TWML IBM® DB2® 10.1 - Limited Use for Solaris on x64 systems
CI6TYML IBM® DB2® 10.1 - Limited Use for Windows® on AMD64 and Intel® EM64T systems (x64)
CI71VML IBM® DB2® 10.1, National Language Pack for Linux® on AMD64 and Intel® EM64T systems (x64)
CI7IWML IBM® DB2® 10.1, National Language Pack for Linux® on POWER® (System i® and System p®) systems
CI71XML IBM® DB2® 10.1, National Language Pack for Linux® on z Systems®
CI71QML IBM® DB2® 10.1, National Language Pack for AIX®
CI71SML IBM® DB2® 10.1, National Language Pack for Solaris on UltraSPARC systems
CI71TML IBM® DB2® 10.1, National Language Pack for Solaris on x64 systems

Related information:

[ [WebSphere Portal detailed system requirements|

[ [[BM Passport Advantage|

Getting Web Content Manager Standard Edition software
This section describes how to download and assemble IBM WebSphere Portal
Version 8.5 components by using the Passport Advantage Online website.

Downloadable eAssembly images

The IBM WebSphere Portal Version 8.5 product consists of multiple offerings and
each offering includes multiple downloadable electronic images that are packaged
by platform. Each platform package is called an eAssembly and each eAssembly
contains all of the electronic images that are required for that offering to run on
that platform. The following table shows the eAssembly numbers for each of the
IBM WebSphere Portal Version 8.5 offerings.

Important: When you expand the eAssembly files, ensure that you expand the
files into the same parent directory to create a complete installable image. For
example, if you expand into a parent directory that is called download_directory, the
following directory structure results:

download _directory/Setup
download _directory/IBMJAVA7
download directory/WAS8552
download _directory/WP85_Server
download_directory/WP85_WCMSE

Failure to expand all files in the same parent directory results in an installation
failure.

The following directories might also exist but are not required to be expanded in
the same parent directory:

download _directory/qsg_850_portal_wcm
download_directory/WP85_RemoteSearch
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Required software

Table 59. List of eAssembly images for IBM WebSphere Portal and Web Content Manager
V8.5 Multiplatform Multilingual Quick Start Guide

Part number

Description

CIYE7ML

IBM WebSphere Portal and Web Content Manager V8.5 Multiplatform Multilingual Quick Start Guide

Table 60. List of eAssembly images for IBM Web Content Manager Standard Edition V8.5
and IBM WebSphere Application Server Setup V8.5.5.2

Part number

Description

CIZ5RML

IBM Web Content Manager Standard Edition Setup V8.5 Multiplatform Multilingual IMPORTANT:
All parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to
create an installable image.

CIYVOML

IBM WebSphere Portal Server Install V8.5 Multiplatform Multilingual IMPORTANT: All parts of this
image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create an
installable image.

CNO6LML

IBM Web Content Manager Standard Edition Install V8.5 Multiplatform Multilingual IMPORTANT:
All parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to
create an installable image.

CIYWOML

IBM WebSphere Application Server Network Deployment V8.5.5.2 Multiplatform Multilingual
IMPORTANT: All parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same
directory to create an installable image.

CIYWIML

IBM WebSphere SDK Java Technology Edition V7.0.6.1 Multiplatform Multilingual IMPORTANT: All
parts of this image (Setup, Install, WAS ND, SDK) must be extracted into the same directory to create
an installable image.

CIYW2ML

IBM WebSphere Portal V8.5 Remote Search and Document Conversion Services Multiplatform
Multilingual

Optional software

Table 61. List of eAssembly images for IBM WebSphere Application Server Network
Deployment V8.5.5 Supplements and Edge Components

Part number

Description

CIK1VML IBM WebSphere Application Server V8.5.5 Supplements (1 of 3) for Multiplatform Multilingual

CIKIWML IBM WebSphere Application Server V8.5.5 Supplements (2 of 3) for Multiplatform Multilingual

CIK1XML IBM WebSphere Application Server V8.5.5 Supplements (3 of 3) for Multiplatform Multilingual

CIK2NML IBM WebSphere Edge Components: Load Balancer for IPv4 and IPv6 (for WebSphere Application
Server Network Deployment V8.5.5) Multiplatform Multilingual

CIL5DML IBM WebSphere Edge Components: Load Balancer for IPv4 (for WebSphere Application Server
Network Deployment V8.5.5) Multiplatform, Multilingual

CILS5EML IBM WebSphere Edge Components: Caching Proxy (for WebSphere Application Server Network

Deployment V8.5.5)Multiplatform, Multilingual

Table 62. List of eAssembly images for IBM DB2 Workgroup Server Edition 10.5

Part number

Description

CIXU9ML IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on AMD64 and Intel® EM64T
systems (x64)

CIWN3ML | IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on POWER® (System i® and
System p®) systems

CIWN4ML | IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Linux® on z Systems®

CIWN5ML | IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for AIX®

CIWN6ML IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for HP-UX on HP Integrity Itanium-based
systems

CIWN7ML IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Solaris on UltraSPARC systems

CIWNSML IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Solaris on x64 systems

CIWNIML | IBM® DB2® Workgroup Server Edition - Restricted Use 10.5 for Windows® on AMD64 and Intel®
EM64T systems (x64)

CIWM5ML | IBM® DB2® National Language Pack 10.5 for Linux® on AMD64 and Intel® EM64T systems (x64)

CIWM6ML | IBM® DB2® National Language Pack 10.5 for Linux® on POWER® (System i® and System p®) systems
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Table 62. List of eAssembly images for IBM DB2 Workgroup Server Edition
10.5 (continueq)

Part number

Description

CIWM7ML

IBM® DB2® National Language Pack 10.5 for Linux® on z Systems®

CIWMSML

IBM® DB2® National Language Pack 10.5 for AIX®

CIWM9ML

IBM® DB2® National Language Pack 10.5 for HP-UX on HP Integrity Itanium-based systems

CIWNOML

IBM® DB2® National Language Pack 10.5 for Solaris on UltraSPARC systems

CIWN1ML

IBM® DB2® National Language Pack 10.5 for Solaris on x64 systems

Table 63. List of eAssembly images for IBM Tivoli Directory Integrator V7.1.1

Part number

Description

CZUE5ML

IBM Tivoli Directory Integrator V7.1.1 Quick Start Guide

CZUFOML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Windows - x86

CZUF7ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Windows - x86-64

CZUFIML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for AIX

CI772ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for AIX - PPC64

CZUF2ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux Linux - x86

CZUF3ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux Linux - x86-64

CZUE9ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux - zSeries & s/390

CZUF5ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Linux - POWER (i/p Series)

CZUF4ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Solaris - SPARC

CZUE6ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for Solaris -Opteron

CZUE7ML

IBM Tivoli Directory Integrator Identity Edition V7.1.1 for HP-UX - Integrity

Table 64. List of eAssembly images for IBM Security Directory Server V6.3.1

Part number

Description

CISOHML

IBM Security Directory Server V6.3.1 win-base.zip (with ENT, Only IM based Installer, supports
32/64 bit)

CISOJML

IBM Security Directory Server V6.3.1 win-IM.zip (contains ibm_IM_32bit, ibm_IM_64bit)

CISOKML

IBM Security Directory Server V6.3.1 win-jdk.zip (contains ibm_jdk_32bit, ibm_jdk_64bit)

CISOLML

IBM Security Directory Server V6.3.1 win-db2.zip (contains ibm_db2_32bit, ibm_db2_64bit)

CISOMML

IBM Security Directory Server V6.3.1 win-ewas.zip (contains ibm_ewas_32bit, ibm_ewas_64bit)

CISONML

IBM Security Directory Server V6.3.1 win-gskit.zip (contains ibm_gskit_32bit, ibm_gskit_64bit)

CISOPML

IBM Security Directory Server V6.3.1 win.iso (with ENT, IM based Installer, pre-req installables)

CISORML

IBM Security Directory Server V6.3.1 aix-ppc64-base.tar (with ENT, IM based Installer)

CISOTML

IBM Security Directory Server V6.3.1 aix-ppc64-IM.tar

CISOUML

IBM Security Directory Server V6.3.1 aix-ppc64-jdk.tar

CISOVML

IBM Security Directory Server V6.3.1 aix-ppc64-db2.tar

CISOWML

IBM Security Directory Server V6.3.1 aix-ppc64-ewas.tar

CISOXML

IBM Security Directory Server V6.3.1 aix-ppc64-gskit.tar

CISOYML

IBM Security Directory Server V6.3.1 aix-ppc64.iso (with ENT, IM based Installer, pre-req installables)

CIS10ML

IBM Security Directory Server V6.3.1 linux-x86-64-base.tar (with ENT, IM based Installer)

CIS12ML

IBM Security Directory Server V6.3.1 linux-x86-64-IM.tar

CIS13ML

IBM Security Directory Server V6.3.1 linux-x86-64-jdk.tar

CIS14ML

IBM Security Directory Server V6.3.1 linux-x86-64-db2.tar

CIS15ML

IBM Security Directory Server V6.3.1 linux-x86-64-ewas.tar

CIS16ML

IBM Security Directory Server V6.3.1 linux-x86-64-gskit.tar

CIS17ML

IBM Security Directory Server V6.3.1 linux-x86-64.iso (with ENT, IM based Installer, pre-req
installables)

CISTHML

IBM Security Directory Server V6.3.1 linux-x86-base.tar (with ENT, Native Installer)

CIS1JML

IBM Security Directory Server V6.3.1 linux-x86-jdk.tar

CIS1IKML

IBM Security Directory Server V6.3.1 linux-x86-db2.tar

CIS1ILML

IBM Security Directory Server V6.3.1 linux-x86-ewas.tar
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Table 64. List of eAssembly images for IBM Security Directory Server V6.3.1 (continued)

Part number | Description

CISIMML IBM Security Directory Server V6.3.1 linux-x86-gskit.tar

CISINML IBM Security Directory Server V6.3.1 linux-x86.iso (with ENT, native installer, pre-req installables)
CIS1I9ML IBM Security Directory Server V6.3.1 solaris-x86-64-base.tar (with ENT, Native Installer)

CIS1BML IBM Security Directory Server V6.3.1 solaris-x86-64-jdk.tar

CIS1ICML IBM Security Directory Server V6.3.1 solaris-x86-64-db2.tar

CISIDML IBM Security Directory Server V6.3.1 solaris-x86-64-ewas.tar

CISIEML IBM Security Directory Server V6.3.1 solaris-x86-64-gskit.tar

CIS1IFML IBM Security Directory Server V6.3.1solaris-x86-64.iso (with ENT, native installer, pre-req installables)
CISIQML IBM Security Directory Server V6.3.1 solaris-sparc-base.tar (with ENT, Native Installer)

CIS1SML IBM Security Directory Server V6.3.1 solaris-sparc-jdk.tar

CISITML IBM Security Directory Server V6.3.1 solaris-sparc-db2.tar

CISTUML IBM Security Directory Server V6.3.1 solaris-sparc-ewas.tar

CISIVML IBM Security Directory Server V6.3.1 solaris-sparc-gskit.tar

CISTWML IBM Security Directory Server V6.3.1 solaris-sparc.iso (with ENT, native installer, pre-req installables)
CIS1ZML IBM Security Directory Server V6.3.1 linux-ppc64-base.tar (with ENT, Native Installer)

CIS21ML IBM Security Directory Server V6.3.1 linux-ppc64-jdk.tar

CIS22ML IBM Security Directory Server V6.3.1 linux-ppc64-db2.tar

CIS23ML IBM Security Directory Server V6.3.1 linux-ppc64-ewas.tar

CIS24ML IBM Security Directory Server V6.3.1 linux-ppc64-gskit.tar

CIS26ML IBM Security Directory Server V6.3.1 linux-ppc64.iso (with ENT, native installer, pre-req installables)
CIS28ML IBM Security Directory Server V6.3.1 linux-s390x-base.tar (with ENT, Native Installer)

CIS2AML IBM Security Directory Server V6.3.1 linux-s390x-jdk.tar

CIS2BML IBM Security Directory Server V6.3.1 linux-s390x-db2.tar

CIS2CML IBM Security Directory Server V6.3.1 linux-s390x-ewas.tar

CIS2DML IBM Security Directory Server V6.3.1 linux-s390x-gskit.tar

CIS2EML IBM Security Directory Server V6.3.1 linux-s390x.iso (with ENT, native installer, pre-req installables)

Table 65. List of eAssembly images for IBM Worklight Consumer Edition V6.1

Part number

Description

CIQT7ML Quick Start Guide for Worklight Consumer Edition V6.1 for Multiplatforms Multiplatforms

CIQ5JEN IBM Worklight Consumer Edition V6.1 zip of Installation Manager Repository for IBM Worklight
Server Multiplatforms English

CIQ5KEN IBM Worklight Consumer Edition V6.1 zip of Eclipse update for IBM Worklight Studio Multiplatform
English

CIQ5LEN IBM Worklight Consumer Edition V6.1 zip of Eclipse Update Site for Mobile Test Workbench
Worklight Multiplatforms English

CILD7ML IBM Rational Enterprise Deployment V1.6.3 Windows Multilingual

CILD9ML IBM Rational Enterprise Deployment V1.6.3 Linux x86 Multilingual

CILEOML IBM Rational Enterprise Deployment V1.6.3 Linux x86-64 Multilingual

CILEIML IBM Rational Enterprise Deployment V1.6.3 Linux PPC Multilingual

CILE2ML IBM Rational Enterprise Deployment V1.6.3 Linux s390 Multilingual

CILE3ML IBM Rational Enterprise Deployment V1.6.3 AIX Multilingual

CILESML IBM Rational Enterprise Deployment V 1.6.3 for Solaris 10 SPARC

CILE6ML IBM Rational Enterprise Deployment V 1.6.3 for X86-64

CIK2UML Quick Start for IBM WebSphere Application Server - Liberty Core V8.5.5 for Multiplatform
Multilingual

CIK2VML IBM WebSphere Application Server - Liberty Core V8.5.5 for Multiplatform Multilingual

CIK2YML IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (1 of 3) for Multiplatform
Multilingual

CIK2ZML IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (2 of 3) for Multiplatform

Multilingual
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Table 65. List of eAssembly images for IBM Worklight Consumer Edition V6.1 (continued)

Part number | Description
CIK30ML IBM WebSphere Application Server Liberty Core V8.5.5 Supplements (3 of 3) for Multiplatform
P PP ty PP p

Multilingual

CI6TQML IBM® DB2® 10.1 - Limited Use for Linux® on AMD64 and Intel® EM64T

CI6TSML IBM® DB2® 10.1 - Limited Use for Linux® on POWER® (System i® and System p®) systems

CI6TRML IBM® DB2® 10.1 - Limited Use for Linux® on z Systems®

CI6TTML IBM® DB2® 10.1 - Limited Use for 64-bit ATX®

CI6TVML IBM® DB2® 10.1 - Limited Use for Solaris on UltraSPARC systems

CI6TWML IBM® DB2® 10.1 - Limited Use for Solaris on x64 systems

CI6TYML IBM® DB2® 10.1 - Limited Use for Windows® on AMD64 and Intel® EM64T systems (x64)

CI71IVML IBM® DB2® 10.1, National Language Pack for Linux® on AMD64 and Intel® EM64T systems (x64)

CI7IWML IBM® DB2® 10.1, National Language Pack for Linux® on POWER® (System i® and System p®) systems

CI71IXML IBM® DB2® 10.1, National Language Pack for Linux® on z Systems®

CI71QML IBM® DB2® 10.1, National Language Pack for AIX®

CI71SML IBM® DB2® 10.1, National Language Pack for Solaris on UltraSPARC systems

CI71ITML IBM® DB2® 10.1, National Language Pack for Solaris on x64 systems

Related information:

[ [WebSphere Portal detailed system requirements|

[ [[BM Passport Advantage|

Installing and preparing the prerequisite software

Before you install the digital experience software, make sure that the prerequisite
software is installed and configured. Depending on your environment, you might
already have the prerequisites, such as a database server and user registry. Verify
that the prerequisite software is the correct version, has the required fix packs
applied, and is configured to work with the digital experience software.

[“Installing and preparing the database software” on page 205|

You might already have a database software installed. You still need to make
sure that the installed database software is a supported version and has the
required fix packs applied. In addition, you might need to configure the
supported database software to work with the digital experience software.

[‘Preparing the user registry software” on page 214|

You probably already have a user registry that is deployed and configured for
your network. Before you install and deploy the digital experience software,
make sure that your user registry software is a support version. In addition,
you might need to configure the user registry to work with the digital
experience software.

[‘Preparing a remote web server” on page 222|

Install and configure the web server plug-in. The IBM WebSphere Application
Server provides the plug-in. Configure the web server to communicate with
IBM WebSphere Portal.

Related tasks:

[“Planning to install WebSphere Portal” on page 119|

Before you install IBM WebSphere Portal in a production environment, you need to
assess your hardware and software needs, possible database configurations,
security options, and LDAP server options. Skipping this important step can lead
to unexpected results and costly delays.
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Installing and preparing the database software

You might already have a database software installed. You still need to make sure
that the installed database software is a supported version and has the required fix
packs applied. In addition, you might need to configure the supported database
software to work with the digital experience software.

[“Installing and preparing DB2”
Use this information to install DB2 or DB2 pureScale for use with IBM
WebSphere Portal.

[“Installing and preparing Oracle or Oracle RAC” on page 207
You can use Oracle or Oracle RAC as the database software.

[“Installing and preparing SQL Server” on page 208

Use this information to install and configure SQL Server for use with
WebSphere Portal.

[“Installing and preparing DB2 for z/OS” on page 210)|

Use this information to install DB2 for z/OS for use with IBM WebSphere
Portal.

[‘Preparing IBM DB2 for i” on page 213|

DB2 is integrated with IBM i. However, the databases and users that are
required for WebSphere Portal must be created.

Installing and preparing DB2
Use this information to install DB2 or DB2 pureScale for use with IBM WebSphere
Portal.

Before you begin

* Review the database considerations.

* Ensure the database that you plan to use is supported by this version of
WebSphere Portal. Refer to the list of supported databases in the WebSphere
Portal detailed system requirements.

* Set up the operating system with updated kernel parameters according to the
DB2 Quick Beginnings guide at DB2 Technical Support.

* When you install DB2 with the DB2 installation program, it automatically creates
a DB2 administrative user with the correct operating system rights.

* Ensure that you have enough disk space for the DB2 instance home directory to
be able to create the required databases.

* A DB2 instance supports a limited number (NUMDB) of concurrently active
databases. Increase this value if the DB2 instance maintains databases for
WebSphere Portal and other applications. The NUMDB value depends on how
many databases are concurrently used on the DB2 instance. Examples of
concurrent usage include two portals that access the same DB2 instance or
transferring data from multiple portals that use the same DB2 instance. To
change the default to 30, enter the following command at the database prompt:
UPDATE DATABASE MANAGER CONFIGURATION USING NUMDB 30. A message displays
that confirms a successful completion of the update.

* WebSphere Portal supports DB2 JDBC Type 2 (CLI-based) and Type 4 (JCC)
drivers.

About this task

All DB2 instructions apply to DB2 pureScale except where specifically noted.
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Procedure

1. To install DB2 or the DB2 client and the required fix pack, follow the
instructions that are provided with the DB2 documentation.

2. If DB2 is installed on another system than WebSphere Portal, copy the driver
JAR files from the DB2 server to the Portal server. The typical location for these
files on the DB2 server is in the db2_home/java directory. Place these driver files

within the directory, for example:
Porta] Server/dbdrivers/db2jcc4.jar
[wp_profile_roof/PortalServer/dbdrivers/db2jcc_license_cu.jar

3. Ensure that the DB2 instance port was added to the services file during the
DB2 installation.

AIX HP-UX Linux Solaris:

a. Get the value for the TCP/IP service name (SVCENAME). Open a shell and
log in as the instance owner. Enter the following command:

db2 "get dbm cfg"|grep (SVCENAME)
A typical value for the SVCENAME is (SVCENAME) = db2c_db2instl

b. Get the DB2 port number by using the SVCENAME value. Enter the
following command:

echo /etc/services | grep your SVCENAME value
A typical output for the port number:
your SVCENAME value 50000/tcp
In this example, 50000 is the port number.
Windows:
a. Get the value for the TCP/IP service name (SVCENAME). Open a DB2
Command Window and enter the following command:
db2 get dbm cfg | findstr (SVCENAME)
A typical value for the SVCENAME is (SVCENAME) = db2c_DB2
b. Get the DB2 port number by using the SVCENAME value. Enter the
following command:
type %SystemRoot%\system32\drivers\etc\services | findstr db2c_DB2
A typical output for the port number:
your_SVCENAME value 50000/tcp
In this example, 50000 is the port number.

What to do next

Use the Configuration Wizard to set up and configure the database to work with
WebSphere Portal. You can use the wizard to create custom scripts that you or
your database administrator can use to configure the database. You can also use
the wizard to automatically set up and configure the database. The wizard creates
instructions and scripts that are based on your selections and provided data.

When you use the wizard and provide information about the database for your
environment, be aware of the following considerations:

¢ The value for the database name, database server node, or schema name must
be unique.

* When the DB2 Universal JDBC driver (type 4 mode) is used, connect to the
database directly. Do not connect to an alias database (gateway), instead specify
the real database name in the JDBC connection URL (dbdomain.DbUr1) and in the
database name property (dbdomain.DbName).
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* The Configuration Wizard's default configuration uses the instance (db2inst1)
that is created by the installation program. Using separate databases can
improve scalability and performance. The wizard allows you to change the
default behavior. You can select whether each of the portal database domains
exist in one or many instances.

* Your database name (dbdomain.DbName) cannot exceed eight characters.

* You cannot use the Database Transfer option in the configuration wizard to
assign custom table spaces on your database server. You can perform manual

steps to assign custom table spaces. Go to [“Assigning custom table spaces” on|
page 702

for more information.

(Optional) After you transfer your data to DB2, run a configuration task to enable
support for high availability recovery (HADR) and rollforward recovery.
Related tasks:

“DB2: Enabling support for high availability recovery and rollforward recovery “|

on page 7OZ|

Optional: To prevent data loss on DB2, modify the JCR schema to support High
Availability Disaster Recovery and rollforward recovery.

Installing and preparing Oracle or Oracle RAC
You can use Oracle or Oracle RAC as the database software.

Before you begin
* Review the database considerations.
* Ensure the database that you plan to use is supported by this version of

WebSphere Portal. Refer to the list of supported databases in the WebSphere
Portal detailed system requirements.

* For Linux and Oracle OCI Type-2 JDBC driver: The Oracle OCI Type-2 JDBC
driver with the full oracle client works with WebSphere Portal. However, to
successfully complete the database transfer task, the Oracle Thin Type-4 JDBC is
required for Linux. After successfully completing the database transfer task
using the thin driver, if needed, you can specify and then return to using the
Oracle OCI Type-2 full client.

Procedure

1. Install the Oracle client and any required fix packs. Follow the instructions that
are provided with the Oracle documentation.

2. Install Oracle JDBC Type 4 drivers or Oracle JDBC OCI Type 2 drivers as
appropriate.

Refer to the Oracle or Oracle RAC product documentation for installation
instructions.
Oracle RAC

3. Ensure the Oracle CRS (Cluster Ready Service) and Oracle RAC databases are
installed and configured on the primary and secondary nodes.

4. Start global services daemon (GSD), oracle listeners, and agents in both RAC
nodes. Run the following commands:

$ gsdctl start
$ Tsnrctl start
$ agentctl start

5. The default tablespace size for Oracle RAC may need to be set to 1024MB with
autoextend turned on for database transfer to be successful.
Update environment variables
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6. JDBC OCI Type 2 drivers only (AIX): Set the environment variable on the IBM
WebSphere Portal server to point to the directory where you downloaded and
extracted the compressed Oracle client files.
LIBPATH=/u01/app/oracle/product/11.2.0/client_1l;export LIBPATH

7. JDBC OCI (Linux and Solaris): Set the environment variable on the IBM
WebSphere Portal server to point to the directory where you downloaded and
extracted the compressed Oracle client files.

LD_LIBRARY_PATH=/u@l/app/oracle/product/11.2.0/cl1ient_1;export LD_LIBRARY_PATH
8. Restart serverl to ensure that the Configuration Wizard uses the updated

environment variables. Go to AppServer_home/profiles/cw_profile/bin and
stop the server:

» AIX HP-UX Linux Solaris: ./stopServer.sh serverl -username username
-password password

* IBM i: stopServer serverl -username username -password password

* Windows: stopServer.bat serverl -username username -password password

Then, start the server:

* AIX HP-UX Linux Solaris: ./startServer.sh serverl

* IBM i: startServer serverl

* Windows: startServer.bat serverl

What to do next

Use the Configuration Wizard to set up and configure the database to work with
WebSphere Portal. You can use the wizard to create custom scripts that you or
your database administrator can use to configure the database. You can also use
the wizard to automatically set up and configure the database. The wizard creates
instructions and scripts that are based on your selections and provided data.

Important: To successfully complete the database transfer task, the Oracle Thin
Type-4 JDBC is required for Linux.

When you use the wizard, you provide information about the database for your
environment.

Note: Before you enter your database name (dbdomain.DbName) in the
Configuration Wizard, check your database documentation for restrictions on
character length.

You cannot use the Database Transfer option in the configuration wizard to assign
custom table spaces on your database server. You can perform manual steps to
assign custom table spaces. Go to [“Assigning custom table spaces” on page 702| for
more information.

Installing and preparing SQL Server
Use this information to install and configure SQL Server for use with WebSphere
Portal.

Before you begin
¢ Review the database considerations.

* Ensure the database that you plan to use is supported by this version of
WebSphere Portal. Refer to the list of supported databases in the WebSphere
Portal detailed system requirements.

* Download a JDBC 4.0 compliant driver from Microsoft
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Procedure
1. Install SQL Server and all required patches.

2. In the SQL Server Setup, choose the following;:

a.
b.
c.

In the Setup Role panel, choose SQL Server Feature Installation.
In the Features Selection panel, choose at least Database Engine Services.

In the Database Engine Configuration, select Mixed Mode (SQL Server
Authentication and Windows authentication).

Important:

Mixed Mode authentication allows either a Windows user or an SQL Server
user to log in to the SQL Server. However, WebSphere Portal requires the
user to be an SQL Server user.

3. Complete the installation. Use the SQL Server documentation as a guide.

4. Install the JDBC driver. Use Microsoft SQL Server JDBC drivers and enable XA
connections:

a.

b.

Download and install the Microsoft SQL Server JDBC driver; see
[Download Center| for information.

Copy the sqljdbc_xa.d11 file from the xa subdirectory to the following
directory of the SQL Server installation:

* Microsoft SQL Server 2012: C:\Program Files\Microsoft SQL
Server\MSSQL11.MSSQLSERVER\MSSQL\Binn

» cros Microsoft SQL Server 2014: C:\Program Files\Microsoft SQL
Server\MSSQL12.MSSQLSERVER\MSSQL\Binn

Start the database server.

Ensure that the Distributed Transaction Coordinator is started. Verify this
status in the list of services in the Computer Management console.

Start the Microsoft SQL Server Management Studio and connect to the local
database engine as the system administrator, sa.

Select File > Open > File and select xa_install.sql from the subdirectory of
the downloaded and extracted JDBC driver.

Run the script by Select Query > Execute to run the script.

Note: Ignore any warnings that say that stored procedures cannot be found.

To grant permission to a specific user to participate in distributed
transactions with the JDBC driver, add the user to the SqIJDBCXAUser role.

5. Complete the following steps to enable XA Transactions in Windows
Component Services:

a.
b.

—h

Q@

Choose Component Services of the Administrative Tools.

Expand the tree view to locate the computer where you want to turn on
support for XA transactions. For example, My Computer.

Display the menu for the computer name and click Properties.

Click Options and tune the Transaction Timeout. The minimum
requirement is 180 seconds.

Click OK to save your changes.

Expand Component Services, > Computers, > My Computer, > Distributed
Transaction Coordinator.

Right-click Local DTC and then select Properties.
Click the Security tab on the Local DTC Properties dialog box.
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i. Select the Enable XA Transactions check box, and then click OK. This action
causes a MS DTC service restart.

6. Start SQL Server.

7. Connect at least one user to the SQL Server instance. A user can be granted
permission to use several schema names, so a single user for each instance is
sufficient.

What to do next

Use the Configuration Wizard to set up and configure the database to work with
WebSphere Portal. You can use the wizard to create custom scripts that you or
your database administrator can use to configure the database. You can also use
the wizard to automatically set up and configure the database. The wizard creates
instructions and scripts that are based on your selections and provided data.

When you use the wizard, you provide information about the database for your
environment.

Note: Before you enter your database name (dbdomain.DbName) in the
Configuration Wizard, check your database documentation for restrictions on
character length.

You cannot use the Database Transfer option in the configuration wizard to assign
custom table spaces on your database server. You can perform manual steps to
assign custom table spaces. Go to [“Assigning custom table spaces” on page 702| for
more information.

Installing and preparing DB2 for z/OS
Use this information to install DB2 for z/OS for use with IBM WebSphere Portal.

Before you begin

* Review the database considerations.

* Ensure the database that you plan to use is supported by this version of
WebSphere Portal. Refer to the list of supported databases in the WebSphere
Portal detailed system requirements.

* The DB2 subsystem must be on a supported z/OS operating system.

* Ensure that Java Database Connectivity requirements are met. Consult the
following references:

— DB2 Universal Database for OS/390 and z/OS: Application Programming Guide and
Reference for Java

— The IBM Redbooks publication, [DB2 for z/OS and OS/390: Ready for Java|

G24-6435-00)

* If the current version of WebSphere Portal and an earlier version coexist with
the same DB2 for z/OS subsystem, the database user IDs for the current version
must be different from the earlier version to avoid conflicts during installation. If
the two versions of WebSphere Portal connect to two different DB2 for z/OS
subsystems, using the same user ID does not cause conflict.

Procedure

1. To use DB2 for z/OS as the database software for WebSphere Portal, you must
have DB2 for z/OS installed on your z/OS system. Refer to the DB2 for z/OS
product documentation for instructions.
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Read the Planning for DB2 for z/OS topic before you configure DB2 for z/OS
as the WebSphere Portal database.

Check the buffer pool allocations for your system and define the buffer pools
as appropriate for your installation and define a large enough size.

-db2 display bufferpool (bp2)
-db2 alter bufferpool(bp2) vpsize(15000)

a. Repeat for extra buffer pools as needed. For example:
bp3
bp4
bp5
bp32k1
bp32k2

Update the BP8KO catalog buffer pool to 35,000 buffers before you transfer the
database. Change this value according to your environment. The
SYSIBM.SYSDATABASE table is in this buffer pool and is used extensively by
DB2 for z/OS for the database transfer.

Change the Common Service Area (CSA) setting to 3500,350000. Read the
appropriate DB2 for z/OS topic for complete information about calculating
and setting CSA:

+ DB2 for z/OS Version 10.1,|Common service areal

+ DB2 for z/OS Version 11.1, [Common service area storage requirements|

During database transfer from Derby to DB2 for z/OS, a supporting low-order
byte table space is created for the database tables that store documents. The
PRIQTY and SECQTY for the table space are assigned with the default values.
If you plan to store many documents, use an automatic class selection (ACS)
routine to allocate the DB2 for z/OS data sets with a primary and secondary
space allocation of at least 10 cylinders. Or, specify a large enough value for
PRIQTY and SEQTY in the DB2 DSNTIJUZ member. The table spaces can be
identified by their name, having a structure like JCRDB.Sxxxxxxx, where
xxxxxxx is a system-assigned combination of seven numbers and characters.

a. Also, in member DSNTIJUZ, update the following parameters and then
verify DSNTIJUZ runs successfully.

edmdbdc = 204800

edmpoo1=409600

edmstmtc=204800

rrulock=no

cachedyn=yes (prepared, dynamic SQL statements are cached)
dbacrvw=yes (to allow database administrators to create Views)

+++thsbpxm1=BP16K1 (to explicitly create an XML table space. This
value can be changed to any valid 16 K buffer pool where the
Administrative User has the USE privilege.)

Ensure that the job DSNTIJSG ran to create the objects that are needed for the
DB2 JDBC and ODBC metadata methods. See the DB2 Installation Guide
Enabling stored procedures and tables for JDBC and ODBC support.

Ensure that job DSNTIJMS runs successfully (re-execute binds).

Ensure that job DSNTIJEX runs successfully.

Because large objects are stored in columns that can become large, logging
changes to these columns requires a huge amount of log space. For this
reason, large object (LOB) logging is disabled by default for table spaces that
contain such data. With LOB logging disabled, you can recover full backups,
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but not incremental backups that can be used for point in time recovery. To

recover point in time backups, you must enable LOB logging. For detailed

instructions, see technote 1306637, Managing LOB logging in DB2 for z/OS.
LikeMinds

11. If you intend to run the LikeMinds sample, increase the NUMLKTS and NUMLKUS
parameters: Ten times the default is sufficient, more depending on your usage
of the sample. For example, if NUMLKTS=1000 and NUMLKUS=10000 are the
installation default values, then update these values to NUMLKTS=10000 and
NUMLKUS=100000.

12.

Type 2 driver configuration

13. If you are planning to use Type 2 driver with DB2 for z/OS Version 9.1.2,
ensure that DB2 for z/OS APAR PK58105 is installed.

14. If you are using the older DB2 Type 2 JDBC driver, enable extended shared
memory usage with the following commands:

export EXTSHM=ON
db2set DB2ENVLIST=EXTSHM
db2start

For permanent changes, add the environment variable to the profile.env file:
DB2ENVLIST="'EXTSHM'

in /home/db2inst/sql1ib/userprofile add:
export EXTSHM=ON

Note: The shell must be reopened before you restart DB2 for z/OS.

15. If you are using the older DB2 Type 2 JDBC driver, configure your DB2
Connect client with the following commands:

db2 update dbm cfg using tp_mon_name WAS
db2 update dbm cfg using spm_name hostname

where hostname is the host name for the server where the DB2 Connect client
is installed (same as portal server).\

16. If you are using the older DB2 Type 2 JDBC driver, install the DB2 Connect
client on the WebSphere Portal server to connect to the remote database.

What to do next

Use the Configuration Wizard to set up and configure the database to work with
WebSphere Portal. You can use the wizard to create custom scripts that you or
your database administrator can use to configure the database. You can also use
the wizard to automatically set up and configure the database. The wizard creates
instructions and scripts that are based on your selections and provided data.

When you use the Configuration wizard and provide information about your
database, consider the following points:

* If you plan to use a single DB2 for z/OS subsystem to hold data for more
multiple installations, use the same user name but a separate schema name for
each database domain. For Member Manager, the user name must match the
schema; the same database user cannot be used for the Member Manager
databases of two distinct portal installations.

* Each portal installation must be in separate and distinct WebSphere Application
Server cells. If the portals are installed in the same file system, each must be
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installed in a separate and unique directory. If the portals are installed in
different file systems, the same directory name can be used.

* In a remote database environment, WebSphere Portal and DB2 Connect are
installed on one server (the local server) and the DB2 for z/OS server is installed
on a separate server (the remote server).

* Before you enter your database name (dbdomain.DbName) in the Configuration
Wizard, check your database documentation for restrictions on character length.

* You cannot use the Database Transfer option in the configuration wizard to
assign custom table spaces on your database server. You can perform manual

steps to assign custom table spaces. Go to [“Assigning custom table spaces” on|
page 702| for more information.

Preparing IBM DB2 for i

DB2 is integrated with IBM i. However, the databases and users that are required
for WebSphere Portal must be created.

Before you begin

* Ensure the database that you plan to use is supported by this version of
WebSphere Portal. Refer to the list of supported databases in the WebSphere
Portal detailed system requirements.

What to do next

Use the Configuration Wizard to set up and configure the database to work with
WebSphere Portal. You can use the wizard to create custom scripts that you or
your database administrator can use to configure the database. You can also use
the wizard to automatically set up and configure the database. The wizard creates
instructions and scripts that are based on your selections and provided data.

When you use the wizard and provide information about the database for your
environment, be aware of the following considerations:

* If you choose to use one database to store all WebSphere Portal, Member
Manager, and content publishing information, only one user profile is required.
Additional user profiles are necessary only if using multiple IBM i systems or
separate databases are required.

* Before you enter your database name (dbdomain.DbName) in the Configuration
Wizard, check your database documentation for restrictions on character length.

* The Configuration Wizard uses JDBC type 4 drivers by default. The examples in
the Configuration Wizard apply only to JDBC type 4 drivers. You can change the
default selection in the Configuration Wizard to JDBC type 2 during step 2,
Customize Values. If you select JDBC type 2, apply these examples to your
configuration:

Table 66. Example values for JDBC type 2 driver

Field label in Configuration Wizard Example value

Database name *LOCAL/wpsdb

Database URL jdbec:db2:*LOCAL /wpsdb

DB2 for IBM i library /QIBM /ProdData/0S5400/Java400/ext/
db2_classes16.jar

DB2 for IBM i driver class name com.ibm.db2.jdbc.app.DB2Driver

Chapter 4. Installing 213



Preparing the user registry software

You probably already have a user registry that is deployed and configured for your
network. Before you install and deploy the digital experience software, make sure
that your user registry software is a support version. In addition, you might need
to configure the user registry to work with the digital experience software.

[“Preparing an Active Directory-Lightweight-Directory-Services on Windows”]
If you plan to use an Active Directory-Lightweight-Directory-Services as an
LDAP user registry, you must install and set up the server so that it
communicates with IBM WebSphere Portal.

[“Preparing a Domino Directory server” on page 215|

If you plan to use a Domino Directory as an LDAP user registry, you must
install and set up the server so that it communicates with IBM WebSphere
Portal.

[“Preparing a IBM Directory Server” on page 217|

If you plan to use a IBM Directory Server as an LDAP user registry, you must
install and set up the server so that it communicates with IBM WebSphere
Portal.

[“Preparing an Active Directory server” on page 218|
If you plan to use Active Directory as an LDAP user registry, you must install
and set up the server so that it can communicate with IBM WebSphere Portal.

[“Preparing a Novell eDirectory” on page 218§|

If you plan to use a Novell eDirectory as an LDAP user registry, you must
install and set up the server so that it communicates with IBM WebSphere
Portal.

[“Preparing a SecureWay Security Server” on page 219|

If you plan to use a SecureWay Security Server as an LDAP user registry, you
must install and set up the server so that it communicates with IBM WebSphere
Portal.

[“Preparing an Oracle Directory Server” on page 221

If you plan to use an Oracle Directory Server as an LDAP user registry, you
must install and set up the server so that it communicates with IBM WebSphere
Portal. Oracle Directory Server was formerly known as Sun Java System
Directory Server.

Preparing an Active Directory-Lightweight-Directory-Services on
Windows
If you plan to use an Active Directory-Lightweight-Directory-Services as an LDAP

user registry, you must install and set up the server so that it communicates with
IBM WebSphere Portal.

Procedure

1.
2.

214 WebSphere Portal v8.5

Download and install [Active Directory Application Model

Complete the following steps as a guide to create the WebSphere Portal
administrative user:

a. Create a user with the Windows administrative tools.

Note: There is a 20 character limitation for the user account name.
b. Set the password for the new user.

c. Activate the new user with the Windows administrative tools. Set the
msDS-UserAccountDisabled attribute to false.


http://www.microsoft.com/en-us/download/details.aspx?id=4201

Preparing a Domino Directory server
If you plan to use a Domino Directory as an LDAP user registry, you must install
and set up the server so that it communicates with IBM WebSphere Portal.

Procedure
1. Complete the following steps to install the Domino Directory:

a.
b.
c.

Go to [Domino documentation|

Select the appropriate version tab for your product.

Click the Download/View online link for the Lotus Domino Information
Center.

Click Domino Administrator Help > Installation > Installing and setting
up Domino servers > Server installation > Installing Domino and
complete this task.

Click Domino Administrator Help > Installation > Installing and setting
up Domino servers > The Domino server setup program and complete this
task.

2. Complete the following steps to install the Domino Directory:

a.
b.
c.

Go to[Domino documentation|

Select the appropriate version tab for your product.

Click the Download/View online link for Installing and Managing Domino
for System i.

d. Complete the tasks under Chapter 3 Installing Domino on your system.

e. Complete the tasks under Chapter 6 Setting up a First Domino server.

f.

Complete the tasks under Chapter 8 Setting up an Additional Domino
server.

3. Complete the following steps as a guide to create the WebSphere Portal
administrative user:

a.
b.

Go to the People view of the Domino Directory and then click Add Person.
Enter the following values in the New Person form to create the LDAP bind
user. The following example uses wpsbind to represent the LDAP bind user:
Last Name

wpshind

User name
wpsbind/DominoDomain, where DominoDomain is your Domino
Internet domain.

wpshind

Note: Make sure that you enter two values in the User Name field,
where the first value includes the Domino domain.

Short name/UserID
wpshind

Internet password
wpshind

Click Save and Close to save the new person record for wpsbhind and return
to the People view.

Click Add Person and enter the following values in the New Person form
to create the Portal administration user. The following example uses
wpsadmin to represent the Portal administration user:
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Last Name
wpsadmin, where wpsadmin is the user ID for the WebSphere Portal
Administrator.

User name
wpsadmin/DominoDomain, where DominoDomain is your Domino
Internet domain.

wpsadmin

Note: Make sure that you enter two values in the User Name field,
where the first value includes the Domino domain.

Short name/UserID
wpsadmin

Internet password
wpsadmin

e. Click Save and Close to save the new person record for wpsadmin and
return to the People view.

f. Go to the Groups view and click Add Group.
g. Enter the following values in the New Group form on the Basic tab:

Group name
wpsadmins

Note: If your Domino LDAP shares a realm with another user
registry, you must use the hierarchical naming convention for the
group names. Enter wpsadmins/DominoDomain to avoid unexpected
results during WebSphere Portal run time.

Group type
Multi-purpose

Members
wpsbind/DominoDomain

wpsadmin/DominoDomain

Note: You can add more administrator users.

h. Click Save and Close to save the wpsadmins group with the wpsbind and
wpsadmin users as members.

4. Complete the following steps to update the access control list for the Domino
Directory:

a. Open the names.nsf file in the Domino Administrator or Lotus Notes client.

b. Click File > Application > Access Control from the main menu to open the
access control list for the file.

C. In the Access Control List > Basics panel, ensure that the wpsadmins group
has either Author or Editor access.

d. Add the following Role Types to the wpsadmins group:
GroupCreator
GroupModifier
UserCreator
UserModifier
e. Click OK.
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Preparing a IBM Directory Server
If you plan to use a IBM Directory Server as an LDAP user registry, you must
install and set up the server so that it communicates with IBM WebSphere Portal.

Procedure

1.

Install IBM Directory Server. Refer to the [[BM Directory Server Installation and|
[Configuration Guide| for instructions.

Restriction: Users or groups must not contain a Turkish uppercase dotted I or
lowercase dotted i in the distinguished name. It prevents correct retrieval of
that user or group.

Complete the following steps with the IBM Directory Server web
administration tool to create the WebSphere Portal administrative user:

a. Optional: Complete the following steps to create a directory suffix:

1) Click the Server Administration folder in the directory server console
navigation.

2) Click the Manage Server Properties folder under the Server
Administration folder and then select Suffixes on the main page.

3) Type the Base DN name for the suffix; for example:
dc=yourcompany,dc=com.

4) Click Add.
5) Click OK to save your changes.

b. Open the appropriate LDIF file in the [PortalServer_root}/ installer/wp.iim/
1dif directory, with a text editor:

Use the PortalUsers.1dif file as a working example and adapt
appropriately to work with your LDAP server.

Use the ContentUsers.1dif file for the IBM Content Manager group and
user ID if you configured IBM Content Manager.

c. Replace every dc=yourco,dc=com with your suffix.
d. Replace any prefixes and suffixes that are unique to your LDAP server.

e. You can specify user names other than wpsadmin and wpsbind. For security
reasons, specify nontrivial passwords for these administrator accounts.

f. Save your changes.

g. Complete the instructions that are provided with your directory server to
import the LDIF file.

Complete the following steps to create the WebSphere Portal administrative
user:

a. Open the appropriate LDIF file in the [PortalServer_root}/ installer/wp.iim/
1dif directory, with a text editor:

Use the PortalUsers.1dif file as a working example and adapt
appropriately to work with your LDAP server.

Use the ContentUsers.1dif file for the IBM Content Manager group and
user ID if you configured IBM Content Manager.

b. Replace every dc=yourco,dc=com with your suffix.
c. Replace any prefixes and suffixes that are unique to your LDAP server.

d. You can specify user names other than wpsadmin and wpsbind. For security
reasons, specify nontrivial passwords for these administrator accounts.

e. Optional: If you use IBM Security Access Manager Version 5.1, set the
objectclasses to accessGroup. If you use Security Access Manager Version
6, set the objectclasses to groupOfNames.
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f. Save your changes.

g. Complete the instructions that are provided with your directory server to
import the LDIF file.

Preparing an Active Directory server
If you plan to use Active Directory as an LDAP user registry, you must install and
set up the server so that it can communicate with IBM WebSphere Portal.

Procedure
1. Complete the following steps to install and configure Active Directory:

a. Install Windows Server version 2008 or 2012, which includes Active
Directory. Refer to |http://www.microsoft.com/windows2000/ technologies / |
[directory /ad /default.asp| for information.

b. Install the necessary Service Packs.

c. Use the Windows Server documentation to install Internet Information
Services (IIS). Use IIS to export server certificates. It must be installed before
you install Certificate Services.

d. Use the Windows Server documentation to install Certificate Services if you
plan on using Active Directory over SSL.

2. Complete the following steps as a guide to create the WebSphere Portal
administrative user:

a. Create a user with the Windows administrative tools.

Note: There is a 20 character limitation for the user account name.
b. Set the password for the new user.

c. Activate the new user with the Windows administrative tools. Set the
msDS-UserAccountDisabled attribute to false.

3. Complete the following steps to enable SSL for Active Directory; this step sets
passwords during sign-up and user creation:

a. Install an Enterprise certificate authority on a Windows Domain Controller.
It installs a certificate on a server or a third-party certificate on the Domain
Controller.

b. Click Start > All Programs > Administrative Tools > Active Directory
Users and Computer.

c. In the Active Directory Users and Computers window, right-click on your
domain name and select Properties.

In the Domain Properties dialog box, select the Group Policy tab.
Select the Default Domain Policy group policy and then click Edit.
Select Windows Settings under Computer Configuration.

Select Security Settings and then select Public Key Policies.

Se "o o

. Select Automatic Certificate Request Settings.

Use the wizard to add a policy for Domain Controllers.

Note: When these requirements are complete, all domain controllers request
a certificate and support LDAP over SSL with port 636.

Preparing a Novell eDirectory
If you plan to use a Novell eDirectory as an LDAP user registry, you must install
and set up the server so that it communicates with IBM WebSphere Portal.
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Procedure
1. Install Novell eDirectory. Refer to for information.

2. Complete the following steps with the web administration tool to create the
WebSphere Portal administrative user:

a. Optional: Complete the following steps to create a directory suffix:

1) Click the Server Administration folder in the directory server console
navigation.

2) Click the Manage Server Properties folder under the Server
Administration folder and then select Suffixes on the main page.

3) Type the Base DN name for the suffix; for example:
dc=yourcompany,dc=com.

4) Click Add.
5) Click OK to save your changes.

b. Open the appropriate LDIF file in the [PortalServer_root)/installer/wp.iim/
1dif directory, with a text editor:

Use the PortalUsers.1dif file as a working example and adapt
appropriately to work with your LDAP server.

Use the ContentUsers.1dif file for the IBM Content Manager group and
user ID if you configured IBM Content Manager.

c. Replace every dc=yourco,dc=com with your suffix.
d. Replace any prefixes and suffixes that are unique to your LDAP server.

e. You can specify user names other than wpsadmin and wpsbind. For security
reasons, specify nontrivial passwords for these administrator accounts.

f. Save your changes.

g. Complete the instructions that are provided with your directory server to
import the LDIF file.

3. Complete the following steps to create the WebSphere Portal administrative
user:

a. Open the appropriate LDIF file in the [PortalServer_root}/ installer/wp.iim/
1dif directory, with a text editor:

Use the PortalUsers.1dif file as a working example and adapt
appropriately to work with your LDAP server.

Use the ContentUsers.1dif file for the IBM Content Manager group and
user ID if you configured IBM Content Manager.

b. Replace every dc=yourco,dc=com with your suffix.
c. Replace any prefixes and suffixes that are unique to your LDAP server.

d. You can specify user names other than wpsadmin and wpsbind. For security
reasons, specify nontrivial passwords for these administrator accounts.

e. Optional: If you use IBM Security Access Manager Version 5.1, set the
objectclasses to accessGroup. If you use Security Access Manager Version
6, set the objectclasses to groupOfNames.

f. Save your changes.

g. Complete the instructions that are provided with your directory server to
import the LDIF file.

Preparing a SecureWay Security Server
If you plan to use a SecureWay Security Server as an LDAP user registry, you must
install and set up the server so that it communicates with IBM WebSphere Portal.
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Procedure

1.
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Install SecureWay Security Server. Refer to [IBM SecureWay Security Server for

[z/OS and OS/390% for information.

Complete the following steps with the web administration tool to create the
WebSphere Portal administrative user:

a.

Optional: Complete the following steps to create a directory suffix:

1) Click the Server Administration folder in the directory server console
navigation.

2) Click the Manage Server Properties folder under the Server
Administration folder and then select Suffixes on the main page.

3) Type the Base DN name for the suffix; for example:
dc=yourcompany,dc=com.

4) Click Add.
5) Click OK to save your changes.

Open the appropriate LDIF file in the [PortalServer_roo{/installer/wp.iim/
1dif directory, with a text editor:

Use the PortalUsers.1dif file as a working example and adapted
appropriately to work with your LDAP server.

Use the ContentUsers.1dif file for the IBM Content Manager group and
user ID if you configured IBM Content Manager.

Replace every dc=yourco,dc=com with your suffix.

. Replace any prefixes and suffixes that are unique to your LDAP server.

e. You can specify user names other than wpsadmin and wpsbind. For security

f.

g.

reasons, specify nontrivial passwords for these administrator accounts.
Save your changes.

Complete the instructions that are provided with your directory server to
import the LDIF file.

Complete the following steps to create the WebSphere Portal administrative
user:

a.

Optional: Complete the following steps to create a directory suffix:

1) Go to[IBM System i and IBM i Information Center} select the appropriate
documentation version and go to Networking > TCP/IP applications,
protocols, and services > IBM Directory Server for iSeries (LDAP) >
Administering Directory Server > General administration tasks >
Adding and Removing Directory Server suffixes for information.

2) Stop and restart the LDAP server.

Open the appropriate LDIF file in the |[PortalServer_roo{/installer/wp.iim/
1dif directory, with a text editor:

Use the PortalUsers.1dif file as a working example and adapted
appropriately to work with your LDAP server.

Use the ContentUsers.1dif file for the IBM Content Manager group and
user ID if you configured IBM Content Manager.

Replace every dc=yourco,dc=com with your suffix.
Replace any prefixes and suffixes that are unique to your LDAP server.

e. You can specify user names other than wpsadmin and wpsbind. For security

reasons, specify nontrivial passwords for these administrator accounts.

Optional: If you use IBM Security Access Manager Version 5.1, set the
objectclasses to accessGroup. If you use Security Access Manager Version
6, set the objectclasses to par.
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g.
h.

Save your changes.

Complete the instructions that are provided with your directory server to
import the LDIF file.

Preparing an Oracle Directory Server

If you plan to use an Oracle Directory Server as an LDAP user registry, you must

install and set up the server so that it communicates with IBM WebSphere Portal.

Oracle Directory Server was formerly known as Sun Java System Directory Server.

Procedure

1. Install Oracle Directory Server. Refer to [Oracle software] for information.

2. Complete the following steps with the web administration tool to create the
WebSphere Portal administrative user:

a.

Optional: Complete the following steps to create a directory suffix:

1) Click the Server Administration folder in the directory server console
navigation.

2) Click the Manage Server Properties folder under the Server
Administration folder and then select Suffixes on the main page.

3) Type the Base DN name for the suffix; for example:
dc=yourcompany,dc=com.

4) Click Add.
5) Click OK to save your changes.

Open the appropriate LDIF file in the [PortalServer_roof{/installer/wp.iim/
1dif directory, with a text editor:

Use the PortalUsers.1dif file as a working example and adapt
appropriately to work with your LDAP server.

Use the ContentUsers.1dif file for the IBM Content Manager group and
user ID if you configured IBM Content Manager.

Replace every dc=yourco,dc=com with your suffix.

. Replace any prefixes and suffixes that are unique to your LDAP server.

e. You can specify user names other than wpsadmin and wpsbind. For security

f.

g.

reasons, specify nontrivial passwords for these administrator accounts.
Save your changes.

Complete the instructions that are provided with your directory server to
import the LDIF file.

3. Complete the following steps to create the WebSphere Portal administrative
user:

a.

Open the appropriate LDIF file in the |PortalServer_root{/installer/wp.iim/
1dif directory, with a text editor:

Use the PortalUsers.1dif file as a working example and adapt
appropriately to work with your LDAP server.

Use the ContentUsers.1dif file for the IBM Content Manager group and
user ID if you configured IBM Content Manager.

b. Replace every dc=yourco,dc=com with your suffix.

. Replace any prefixes and suffixes that are unique to your LDAP server.

You can specify user names other than wpsadmin and wpsbind. For security
reasons, specify nontrivial passwords for these administrator accounts.

Optional: If you use IBM Security Access Manager Version 5.1, set the
objectclasses to accessGroup. If you use Security Access Manager Version
6, set the objectclasses to groupOfNames.
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f. Save your changes.

g. Complete the instructions that are provided with your directory server to
import the LDIF file.

Preparing a remote web server

Install and configure the web server plug-in. The IBM WebSphere Application
Server provides the plug-in. Configure the web server to communicate with IBM
WebSphere Portal.

Procedure

1.

2.

Install and configure the web server. Refer to the web server documentation
for information.

Dynamic cluster: If you are creating a dynamic cluster environment, install
and configure an OnDemand Router (ODR). Go to [Creating and configuring|

for information.

If you are using Microsoft Internet Information Server, update the
UrlSegmentMaxLength Registry key. Change it to a value of 0 to eliminate
potential problems in a WebSphere Portal environment with the default IIS
limitation on the length of URL path segments. Update the
AllowRestrictedChars Registry key to a value of 1 to accept hex-escaped
characters in request URLs that decode to the U+0000 - U+001F and U+007F -
U+009F ranges.

Refer to |Configuring Microsoft Internet Information Services (IIS)| for
information.

Note: Refer to [Http.sys registry settings for IIS| for information.

If you are using IBM Domino, edit the NOTES.INI file on the web server. Set
the HTTPEnableConnectorHeaders and HTTPAT11owDecodedUr1Percent parameters
to 1. Also, if you are using WebDAYV, enable it in the Domino web server
administrative console.

If you are using IBM HTTP Server or Apache Server, edit the httpd.conf file
on the web server. Set the A1TowEncodedS1ashes directive to On. Add the
directive to the root level as a global directive.

Table 67. Links to HTTP and Apache server documentation

HTTP server type Documentation link

Read the appropriate HTTP Server [[BM HTTP Server|
documentation

Read the appropriate Apache Server [A11owEncodedS1ashes directives
documentation

5. Stop the web server.

6.
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Install and configure the web server plug-in on the system where the web
server is located. Use the plug-ins installation wizard that is provided with
WebSphere Application Server. Refer to the following topic for information:

+ AIXHP-UXIBM i: LinuxSolarisWindows: [Selecting a Web server topology|
[diagram and road map|

Important: Depending on how you use the web server, you must adjust the
ServerIOTimeout parameter. It defines how long the plug-in must wait for a
response from the application. The minimum value is 60 but you must



http://www-01.ibm.com/support/knowledgecenter/SSAW57_8.5.5/com.ibm.websphere.wve.doc/ae/twve_odr.html?cp=SSAW57_8.5.5%2F1-9-0-2-2
http://www-01.ibm.com/support/knowledgecenter/SSAW57_8.5.5/com.ibm.websphere.wve.doc/ae/twve_odr.html?cp=SSAW57_8.5.5%2F1-9-0-2-2
http://www-01.ibm.com/support/knowledgecenter/SSAW57_8.5.5/com.ibm.websphere.nd.doc/ae/tins_manualWebIIS.html
http://support.microsoft.com/kb/820129
http://www.ibm.com/software/webservers/httpservers/library/
http://httpd.apache.org/docs/2.0/mod/core.html#allowencodedslashes
http://www-01.ibm.com/support/knowledgecenter/SSAW57_8.5.5/com.ibm.websphere.nd.multiplatform.doc/ae/tins_road_plugins.html
http://www-01.ibm.com/support/knowledgecenter/SSAW57_8.5.5/com.ibm.websphere.nd.multiplatform.doc/ae/tins_road_plugins.html

increase this value if you are retrieving data from a database. To update this
value, locate and open your plugin-cfg.xml file and set ServerI0Timeout to
an appropriate value.

7. If you are using an Oracle iPlanet web server, some portlets require that you
disable the unix-uri-clean or nt-uri-clean directives. Edit the obj.conf file
to enable or disable these directives. Refer to the Oracle iPlanet web server
documentation to determine the appropriate setting for your environment.

Note: If you are using Oracle iPlanet web server Version 7, you must disable
uri-clean.

8. Web 2.0 REST features in portal might require an enabled PUT and DELETE
method. If your web server has these methods disabled, complete one of the
following options:

* Enable HTTP tunneling to simulate PUT and DELETE requests, which
means that POST requests are used instead. See the "Switch for tunneling of
HTTP methods" link for information.

* Follow the instructions for your web server to enable PUT and DELETE
requests.

9. Start the web server.

10. Optional: Complete the following steps if you plan to use the web application
bridge feature:

a. Log on to the WebSphere Integrated Solutions Console.

b. Go to Applications > Application Types > WebSphere enterprise
applications.
¢. Find and click the wp.vwat.servlet.ear application link.

d. Under the Web Module Properties heading, click Context Root For Web
Modules.

e. Change the context root to /. This step can create name conflicts. Add a
rewrite rule to avoid these conflicts. For more information read Apache
Module mod_rewrite and Providing short vanity URLs.

f. Click OK.
g. Click Save to save your changes to the master configuration.
h. Stop and restart the wp.vwat.servlet.ear application.

11. Optional: If you want to use the short version of vanity URLs, add a rewrite
rule to your web server. For more information, read Providing short vanity
URLs.

Installing the digital experience software

IBM's Exceptional Digital Experience is designed to help create, manage, simplify,
and integrate your processes into an engaging online experience. IBM WebSphere
Portal and IBM Web Content Manager are a part of the Exceptional Digital
Experience. The product documentation uses digital experience software as a
shorthand for IBM WebSphere Portal and IBM Web Content Manager.

About this task

Select a roadmap to guide you through the installation and deployment process.
The installation process uses IBM Installation Manager to install the digital
experience. Select your operating system to get started. After you complete the
installation, you have a functional portal, unless you selected to install only the
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binaries for a migration path. Then, use the Configuration Wizard to complete the
deployment.

[“AIX: Installing WebSphere Portal and Web Content Manager” on page 225|
Installing the digital experience software includes preparing your operating
system and using IBM Installation Manager to install IBM WebSphere Portal
and Web Content Manager. Then, use the Configuration Wizard to complete the
deployment configuration.

[“HP: Installing WebSphere Portal and Web Content Manager” on page 239
Installing the digital experience software includes preparing your operating
system and using IBM Installation Manager to install IBM WebSphere Portal
and Web Content Manager. Then, use the Configuration Wizard to complete the
deployment configuration.

[“IBM i: Installing WebSphere Portal and Web Content Manager” on page 253|
Installing the digital experience software includes preparing your operating
system and using IBM Installation Manager to install IBM WebSphere Portal
and Web Content Manager. Then, use the Configuration Wizard to complete the
deployment configuration.

[“Linux: Installing WebSphere Portal and Web Content Manager” on page 266|
Installing the digital experience software includes preparing your operating
system and using IBM Installation Manager to install IBM WebSphere Portal
and Web Content Manager. Then, use the Configuration Wizard to complete the
deployment configuration.

[“Solaris: Installing WebSphere Portal and Web Content Manager” on page 280
Installing the digital experience software includes preparing your operating
system and using IBM Installation Manager to install IBM WebSphere Portal
and Web Content Manager. Then, use the Configuration Wizard to complete the
deployment configuration.

“Windows: Installing WebSphere Portal and Web Content Manager” on page|
K

Installing the digital experience software includes preparing your operating
system and using IBM Installation Manager to install IBM WebSphere Portal
and Web Content Manager. Then, use the Configuration Wizard to complete the
deployment configuration.

Related concepts:

[Chapter 3, “Roadmaps,” on page 69|

Review the roadmaps to understand the common deployment patterns that are
supported by the configuration wizard.

Related tasks:

[“Planning to install WebSphere Portal” on page 119|

Before you install IBM WebSphere Portal in a production environment, you need to
assess your hardware and software needs, possible database configurations,
security options, and LDAP server options. Skipping this important step can lead
to unexpected results and costly delays.

Related reference:

[“Getting the software” on page 174|

There are different ways for you to get WebSphere Portal and Web Content
Manager Version 8.5 software.
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AIX: Installing WebSphere Portal and Web Content Manager

Installing the digital experience software includes preparing your operating system
and using IBM Installation Manager to install IBM WebSphere Portal and Web
Content Manager. Then, use the Configuration Wizard to complete the deployment
configuration.

Before you begin

Roadmaps for installation and deployment are included in this product
documentation to guide you through the process. Roadmaps provide a high-level
overview of the process from beginning to end. Select the configuration that is
closest to the configuration that you need.

1. [“AIX: Preparing your operating system”|
Prepare the operating system to ensure a successful installation.

2. ["AIX: Preparing the Installation Manager” on page 226
The IBM Installation Manager is used to install installation packages such as
IBM WebSphere Portal and IBM WebSphere Application Server.

3. ["AIX: Running the installation program” on page 227
Use the IBM Installation Manager program to install the software. IBM
Installation Manager provides multiple user interfaces. Select the one that you
are more comfortable with. You can use the graphical user interface or the
console to create a response file for automated installations.

4. |"AIX: Next steps” on page 236|
The configuration process has changed. Use the Configuration Wizard to set up
your integration with prerequisites, clusters, and more.

5. ["AIX: Upgrading the SDK” on page 237|
Starting with IBM WebSphere Portal Combined Cumulative Fix 05, you can
change your SDK Java Technology Edition from version 7.0 to version 7.1.

AIX: Preparing your operating system
Prepare the operating system to ensure a successful installation.

Procedure
1. If you have AIX 7.1 Technology Level (TL) 1, Service Pack (SP) 0 or 1, complete

the steps in this m
2. Set the file descriptor limit to 10240.
ulimit -n 10240
3. If you are using IBM GPFS file sharing, set the file system inodes limit to 25000

or higher. For example, run the mmchfs /dev/gpfslnsd -F 250000 command.
/dev/gpfsinsd is the IBM WebSphere Portal installation file system.

4. Web Content Manager only: Use the ulimit -f command to set the maximum
size of files that can be created. Set the value to be at least the size of the
largest file you must upload to the content server. The command ulimit -f
unlimited removes any limit on file size.

5. Install and configure X server on AIX (such as X Window System or GNOME)
to use the graphical user interface the installation program provides.

Note: If you plan to use a response file to install the software, X server is not
required.

6. Increase the paging space from 1024 MB to 8192 MB.

7. Complete the following steps to use the Work Load Partition (WPAR) software
that is installed with your AIX operating system software:
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a. Read and follow the guidelines in this to install in a WPAR.
b. Set up the host system with enough disk space.

c. Request new IP address and host name on the same subnet as the host
system.

d. After you get the new IP address and host name, run the following
command to create a WPAR that contains a non-shared file system:

Note: A non-shared file system means /usr and /opt are private to this
new WPAR.

mkwpar -r -1 -n newhostname

e. Verify that the mkwpar task completed successfully.

—h

Use the host system smitty to configure network interfaces with the new
information.

g. Use the telnet or ssh command to connect and log in to the system.
h. Verify that the /usr and /opt directories are writable.

The WPAR instance is now ready to install IBM Installation Manager and
WebSphere Portal.

AIX: Preparing the Installation Manager
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

Procedure

If you have an existing Installation Manager, start it and go to File > Preferences.
Then, click Updates. Click the Search for Installation Manager updates check box.
This box enables the Installation Manager to search for updates the next time you
run an installation or update.

If you do not have an existing Installation Manager, then complete the following
procedure:

1.
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Start all servers and applications that require a port number to avoid port
conflicts when installing WebSphere Portal.

Type ping yourserver.yourcompany.com on a command line to verify that your
fully qualified host name is properly configured.

Type ping localhost on a command line to verify that your network is
properly configured.

If you are installing on a server with a firewall, antivirus, screen saver, or
desktop search engine that is enabled, disable them before you install. If you do
not disable them and the installation program detects them, a warning message
displays during the installation.

Optional: Complete the following steps to install as a non-root user:

a. Log in to the operating system as the root user.

b. Open a command line.

c. Use the appropriate system commands to create the following items:
Non-root user, including password
Group

Directory, used when you install IBM Installation Manager and
WebSphere Portal

d. Set the user profile for the number of open files. Set the value to ulimit -n
10240.


http://www.ibm.com/support/docview.wss?uid=swg21377268

e. Add the non-root user to the new group.

f. Run the following task to change the owner of the directory to the non-root
user:

chown user:group /directory

g. Run the following task to change permissions for the directory:
chmod 755 /directory

h. Log in as the non-root user.

i. Use the following command to install IBM Installation Manager:
./userinst

Set the IBM Installation Manager installation location to
/directory/IBM/InstallationManager.

6. Run the following task from the IIM directory: ./install

7. Run the following task from the Portal Setup disk if you want to start the
launchpad to complete all necessary installation steps: ./setup.sh

Launchpad tip: On the Launchpad: Install Portal panel, you have the following
options:

Install IBM WebSphere Portal from media
Choose this option if you are installing directly from the DVD.

Install IBM WebSphere Portal from network
Choose this option if you downloaded the electronic images.

Install IBM Installation Manager only
Choose this option if you want to install multiple IBM products, or if
you want to install WebSphere Portal directly from IBM Passport
Advantage, and a previous version of Installation Manager is not
already installed on your system.

Tip: Add the LaunchPadlLocale language_code to the setup task to change the
display to your user locale or to another language.

Note: If the language is not currently supported for the user interface, you
might see the English version. For details on supported languages and the
language codes for all of the WebSphere Portal user interfaces, see
[languages” on page 3924

After you complete all necessary steps from the launchpad, verify that your
installation was successful.

AIX: Running the installation program

Use the IBM Installation Manager program to install the software. IBM Installation
Manager provides multiple user interfaces. Select the one that you are more
comfortable with. You can use the graphical user interface or the console to create
a response file for automated installations.

[“AIX: Installing with the graphical user interface” on page 228
Use the IBM Installation Manager to install IBM WebSphere Portal, IBM
WebSphere Application Server, and the Apache Derby database.

[AIX: Installing with the console” on page 230
Use the IBM Installation Manager to install IBM WebSphere Portal with an
existing IBM WebSphere Application Server.

[“AIX: Creating a response file” on page 232|
After IBM Installation Manager is installed, you can use it to record a response
file that is based on your environment. Record a response file on the same
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operating system you plan for the installation. If you have multiple operating
systems, you must record a response file for each operating system. Use a
response file to automate your installation on multiple servers.

[“AIX: Installing with the response file” on page 235|

Use either a sample response file or a response file that you created to install
WebSphere Application Server and WebSphere Portal. You can create a response
file with the graphical or console mode interface.

Related tasks:

[“AIX: Preparing your operating system” on page 225|
Prepare the operating system to ensure a successful installation.

AIX: Installing with the graphical user interface:

Use the IBM Installation Manager to install IBM WebSphere Portal, IBM
WebSphere Application Server, and the Apache Derby database.

About this task

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.

Procedure

1. Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

2. If necessary, start the Installation Manager.

3. After you install or upgrade the Installation Manager, complete the following
steps to add the repositories where the installation media exists:

a. Open the IBM Installation Manager and go to File > Preferences >
Repositories.

b. Select Add Repositories.

C. Select Browse and go to the Portal-install-eimage/Setup/
repository.config file and then click OK.

d. Ensure that all required repositories are checked. Then, click Test
Connections to ensure that the IBM Installation Manager can successfully
access the directory where the service repositories are stored.

e. Select Apply.
f. Select OK.
4. On the main IBM Installation Manager panel, select Install.

5. Optional: If you are installing Portal to an existing copy of WebSphere
Application Server, then select only IBM WebSphere Portal Server on the
Install Packages screen. To complete this installation option, your existing
copy of WebSphere Application Server must meet the following requirements:

* WebSphere Application Server Version 8.5.5.2 or later

* Java Version 7

* No existing Portal profile

Skip the following step, if you choose to install to an existing copy of
WebSphere Application Server.
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10.

11.
12.

13.

14.

15.

On Install Packages: Select packages to install, select the following packages,
and then click Next:

* IBM WebSphere Application Server Network Deployment
* IBM WebSphere Portal Server
* IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional" on the Select packages to install screen.

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

On Install Packages: Select the fixes to install screen, select any required fixes.
Then, click Next.

Accept the license agreement and then click Next.

Enter the directory where you want to store shared resources and then click
Next.

Complete the following steps on the Install Packages: Installation Directory
panel:

Remember: The installation directory that you specify must NOT contain any
files or the following characters: ¥ ! @ # § $~ & * () + { } |<>2-=[1;",
" and spaces.
a. Select the WebSphere Application Server Package Group Name and then
enter the installation directory path.

b. Select the WebSphere Portal Package Group Name and then enter the
installation directory path.

c. Click Next.
Select the translations to install and then click Next.

Optional: If you chose to install Portal to an existing copy of WebSphere
Application Server, select the available copy of WebSphere Application Server,
and click Next.

Note: Skip this step, if you are not installing Portal to an existing copy of
WebSphere Application Server.

On Install Packages: Select the features to install, expand the WebSphere
Application Server and WebSphere Portal packages to modify the features you
want to install and then click Next.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.

Note: As you select the items, read the Details section for information.
On Profile configuration details, enter the user ID and password for the
configuration wizard administrator. Then, click Next.

If you selected the Portal Server Profile package, click Enter the
Administrator user ID and password for the Portal Server. Then, select either
the Standard or Advanced configuration mode and then enter the parameter
details for the selected configuration mode.
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Note: Select Advanced if you want to specify Uniform Resource Identifier
(URI) information that is specific to your company.

16. Confirm the Summary information and then click Install.
What to do next

After a successful installation, the summary displays. Choose the Portal First Steps
radio button and then click Finish to start the servers and begin configuring
WebSphere Portal with the Configuration Wizard.

Tip: To access First Steps later, you can either select First Steps from the Start
menu or you can run the ./firststeps.sh task from the
PortalServer/installer/wp.firststeps directory. Add the LaunchPadLocale

language_code to the firststeps task to change the display to your user locale or
to another language.

Attention: When you install WebSphere Application Server and WebSphere Portal
together, you might find the following message in the SystemErr.Tog file:

lppServer_root)/properties/version/installed.xml (No such file or directory)

This message is part of the installation process and is not repeated after the
installation is complete. Therefore, the message can be ignored.

AIX: Installing with the console:

Use the IBM Installation Manager to install IBM WebSphere Portal with an existing
IBM WebSphere Application Server.

Before you begin

A working installation of IBM WebSphere Application Server is required. Ensure
that it is not used by another copy of WebSphere Portal. Before you install the
WebSphere Portal package, install IBM WebSphere SDK Java Technology Edition
into the same directory where IBM WebSphere Application Server is installed.

About this task

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.

Procedure

1. Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

2. Open a command prompt and change to the InstallationManager_root/
eclipse/tools directory.

3. Run the command to start the IBM Installation Manager in console mode:
./imel -c

4. Complete the following steps to add the repositories:

a. Enter P to go to the Preferences menu.
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10.
11.

12.

13.

14.

b. Enter 1 to go to the Repositories menu.

c. Enter D to add repositories.

d. Type the path for your WebSphere Portal repository file.

e. Enter A to apply your repositories and return to the Preferences menu.
f. Enter R to return to the Main menu.

Enter 1 to install the software packages.

Select the software packages that you want to install.

* If you are installing Portal to an existing copy of WebSphere Application
Server, then select only IBM WebSphere Portal Server. To complete this
installation option, your existing copy of WebSphere Application Server
must meet the following requirements:

— WebSphere Application Server Version 8.5.5.2 or later
— Java Version 7
— No existing Portal profile

* If you are not installing Portal to an existing copy of WebSphere
Application Server, then select the following packages:

— IBM WebSphere Application Server Network Deployment
— IBM WebSphere Portal Server
— IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional."

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

Choose one of the following options:

* Enter 1 to choose version 8.5.0.0 for installation.

* Enter 2 to show all available versions of the package.

Enter N.

Enter A to accept the license agreement.

Enter N.

Choose one of the following options for translation packages:

* Enter N to select the default English package only.

* Enter the number for the translation package you want to install.

On the Incompatible package group menu, choose one of the following

options:

* Enter M to change the installation directory. Then, enter the new installation
directory.

* Enter N to keep the existing directory.

Enter the number for the WebSphere Application Server root directory to use
as the existing WebSphere Application Server.

On the IBM Installation Manager > Install > Licenses > Location > Features
menu, enter 1 to select the Portal Server Profile feature. Then, enter N to
continue.
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15.
16.

17.

18.
19.
20.

21.

22.

23.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.

Enter the configuration wizard administrator user ID and password.

If you selected the Portal Server Profile feature, enter the information for the
following prompts:

* Enter the host name

* Enter the node name

* Enter the cell name

* Enter an administrator user ID for the portal server

* Enter an administrator user password for the portal server
* Confirm administrator user password for the portal server

Enter Y to enter advanced parameters such as customized Uniform Resource
Identifier (URI) settings, profile name, and port numbers. Enter N to accept the
default parameters.

 Enter the context root

* Enter the default home

* Enter the personalized home

* Enter the profile name

* Enter the starting port number

* Enter the profile path

Enter N.

Review the summary information.
Choose one of the following options:
* Enter G to generate a response file.
* Enter I to install WebSphere Portal.

When the installation is complete, enter F to return to the main installation
menu.

Access the Configuration Wizard. Go to http://your_server:10200/ibm/
wizard.

Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924

AIX: Creating a response file:

After IBM Installation Manager is installed, you can use it to record a response file
that is based on your environment. Record a response file on the same operating
system you plan for the installation. If you have multiple operating systems, you
must record a response file for each operating system. Use a response file to
automate your installation on multiple servers.
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About this task

You can also use the console mode to generate a response file. After you review
the summary information, enter G to generate a response file instead of I to install.

Procedure

1. Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

2. Go to the InstallationManager_root/eclipse directory.

3. Run the following task to start the recording: ./IBMIM -record
pathtoresponsexmlfile -skipInstall tempinstalldirectory

-record
This parameter indicates recording the actions and parameters into the
response file. The pathtoresponsexmlfile text is the name of the response
file, for example Wp8SampleResp.xml. The tempinstalldirectory text is the
directory where the response file is recorded.

-skipInstall
This parameter indicates that no actual installation is completed even
though it leads to the final pane.

tempinstalldirectory
This value is a directory where the installation saves the history and
data when you record the response files.

4. Complete the following steps to add the repositories where the installation
media exists:

a. Open the IBM Installation Manager and go to File > Preferences >
Repositories.

b. Select Add Repositories.

c. Select Browse and go to the Portal-install-eimage/Setup/
repository.config file and then click OK.

d. Ensure that all required repositories are checked. Then, click Test
Connections to ensure that the IBM Installation Manager can successfully
access the directory where the service repositories are stored.

e. Select Apply.
f. Select OK.
5. On the main IBM Installation Manager panel, select Install.

6. Optional: If you are installing Portal to an existing copy of WebSphere
Application Server, then select only IBM WebSphere Portal Server on the
Install Packages screen. To complete this installation option, your existing
copy of WebSphere Application Server must meet the following requirements:

* WebSphere Application Server Version 8.5.5.2 or later
* Java Version 7
* No existing Portal profile

Skip the following step, if you choose to install to an existing copy of
WebSphere Application Server.

7. On Install Packages: Select packages to install, select the following packages,
and then click Next:

* IBM WebSphere Application Server Network Deployment
* IBM WebSphere Portal Server
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11.

12.
13.

14.

15.

16.

17.
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* IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional" on the Select packages to install screen.

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

On Install Packages: Select the fixes to install screen, select any required fixes.
Then, click Next.

Accept the license agreement and then click Next.

Enter the directory where you want to store shared resources and then click
Next.

Complete the following steps on the Install Packages: Installation Directory
panel:

Remember: The installation directory that you specify must NOT contain any
files or the following characters: ¥ ! @ # § S~ & * () + { } |<>?2-=[1;",
" and spaces.
a. Select the WebSphere Application Server Package Group Name and then
enter the installation directory path.

b. Select the WebSphere Portal Package Group Name and then enter the
installation directory path.

c. Click Next.
Select the translations to install and then click Next.

Optional: If you chose to install Portal to an existing copy of WebSphere
Application Server, select the available copy of WebSphere Application Server,
and click Next.

Note: Skip this step, if you are not installing Portal to an existing copy of
WebSphere Application Server.

On Install Packages: Select the features to install, expand the WebSphere
Application Server and WebSphere Portal packages to modify the features you
want to install and then click Next.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.

Note: As you select the items, read the Details section for information.
On Profile configuration details, enter the user ID and password for the
configuration wizard administrator. Then, click Next.

If you selected the Portal Server Profile package, click Enter the
Administrator user ID and password for the Portal Server. Then, select either
the Standard or Advanced configuration mode and then enter the parameter
details for the selected configuration mode.

Note: Select Advanced if you want to specify Uniform Resource Identifier
(URI) information that is specific to your company.

Confirm the Summary information and then click Install.



18. After the Installation Manager finishes creating the response file, click Finish
and then close the Installation Manager to complete the response file
recording.

19. If you plan to install on a different computer, copy the response file to the
response file directory on that computer.

AIX: Installing with the response file:

Use either a sample response file or a response file that you created to install
WebSphere Application Server and WebSphere Portal. You can create a response
file with the graphical or console mode interface.

About this task

Locate the sample response file in the setup_root/responsefiles directory. Modify
the file with your environment values.

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.

Procedure

1. If the repository URL requires authentication, use the IBM Installation Manager
command-line tool to create a secure Storage File.

The secure Storage File stores the credentials that are required for the
repositories. The IBM Installation Manager command-line tool imutilsc is
available from the installation tools directory. The following information is an
example of the imutilsc key ring file command:

./imutilsc saveCredential -url repository_URL -userName credential_userName
-userPassword password -secureStorageFile storage_file
[ -masterPasswordFile master_password file ]
[ -preferences com.1'bm.cic.common.core.pr‘eferences.ss].nonsecureMode=true|fa]se 1
[ -proxyHost proxy_host -proxyPort proxy_port

[ -proxyUsername proxy_username -proxyUserPassword proxyuser_password ]

[ -useSocks ] ]

[ -verbose ]

Tip: If you install on a different computer, copy the secure Storage File to that
computer.

2. Go to the InstallationManager_root/eclipse/tools directory.

3. Run the following task to install WebSphere Portal and IBM WebSphere
Application Server:

Tip: Add the -secureStorageFile pathtosecureStoragefile
-masterPasswordFile pathtomasterPasswordFile parameters to the imcl
command if you are using a secure Storage File to store credentials.

./imc1 -acceptlLicense input pathtoresponse.xml -log dirpath/logfilename

What to do next

Attention: When you install WebSphere Application Server and WebSphere Portal
together, you might find the following message in the SystemErr.Tog file:

properties/ver‘sion/insta11ed.xm1 (No such file or directory)

This message is part of the installation process and is not repeated after the
installation is complete. Therefore, the message can be ignored.
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AIX: Next steps

The configuration process has changed. Use the Configuration Wizard to set up
your integration with prerequisites, clusters, and more.

Verify that the installation was successful

Unless you selected to install only the binary files, you can log in to the portal and
verify that your installation was successful. Access WebSphere Portal with the
http://yourserver:yourport/wps/portal format.

If you are not sure what your port number is, use the Tist-server-ports
command to determine the port number. Change to the
ConfigEngine/Tog. Run the 1ist-server-ports task to generate the

WebSphere_Portal_PortMatrix.txt file. For example: ./ConfigEngine.sh
list-server-ports -DWasPassword=password.

Change to the /opt/IBM/WebSphere/AppServer/profiles/cw_profile/ConfigEngine.
Run the Tist-server-ports task to generate the serverl_PortMatrix.txt file. For
example: ./ConfigEngine.sh list-server-ports -DWasPassword=password.

Modify the uri.home.substitution custom property in the Resource
Environment Provider

In the WP ConfigService, set the uri.home.substitution custom property to true
to avoid functional errors that might occur in certain unusual use cases. For more
information on uri.home.substitution, see Configuration Service in the related
links.

Select a roadmap

If you have not already selected a roadmap to guide you through the installation
and deployment process, look at the available roadmaps. The roadmaps are based
on typical environments, such as development environment, test environment, and
more. They provide a high-level overview of the installation and deployment
process. Each roadmap includes a topology diagram, usage recommendations, and
instructions. Roadmaps are available for both new deployments and migrations
scenarios.

[“Roadmaps for installation and deployment” on page 69|

[“Roadmaps for migration” on page 110|

Run the Configuration Wizard to finish the deployment

Then, start the Configuration Wizard and select the option that is defined in your
selected roadmap. Use the wizard to run the configuration steps in real time or to
generate scripts. The wizard generates instructions and scripts specific to your
environment and the data that you entered. You can save the selection and data
that you entered as an XML file. Then, you can load the XML file during a
subsequent wizard session to set up a similar configuration on a different server.

If you select to run the configuration in real time, you still have the opportunity to
download scripts for selected steps. For example, if only the database
administrator can databases, then you can download the database creation script
and give it to your database administrator to run.
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Default URLs

During the configuration process, you might need to following URLs to access
different administration user interfaces.

Use the following default URLs to access IBM WebSphere Portal, the WebSphere
Integrated Solutions Console, and the Configuration Wizard:
IBM WebSphere Portal
http://localhost:10039/wps/portal
https://Tocalhost:10042/wps/portal
WebSphere Integrated Solutions Console
http://lTocalhost:10038/ibm/console
https://Tocalhost:10041/ibm/console
Configuration Wizard
http://localhost:10200/1bm/wizard
https://Tocalhost:10202/1ibm/wizard

If you had any processes from other software in the default port range when the
installation started, you might have different port numbers than the defaults.

Related concepts:

[Chapter 3, “Roadmaps,” on page 69|
Review the roadmaps to understand the common deployment patterns that are
supported by the configuration wizard.

[‘Configuration Wizard” on page 340

Use the Configuration Wizard to set up stand-alone servers and new deployments,
create clusters, migrate and update to new versions, and add new capabilities to
existing deployments.

Related tasks:
[“AIX: Preparing your operating system” on page 225|
Prepare the operating system to ensure a successful installation.

[“AIX: Preparing the Installation Manager” on page 226|
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

Related reference:

[“Configuration Service” on page 418|
The portal Configuration Service is responsible for collecting the most essential
configuration data of the IBM WebSphere Portal engine.

AIX: Upgrading the SDK

Starting with IBM WebSphere Portal Combined Cumulative Fix 05, you can change
your SDK Java Technology Edition from version 7.0 to version 7.1.

Before you begin

Ensure that IBM WebSphere Application Server and WebSphere Portal are installed
with SDK version 7.0.
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Procedure
Start the IBM Installation Manager.
2. Install IBM WebSphere SDK Java Technology Edition version 7.1.

3. Read the following information before you run the managesdk task:

1.

7.

* For stand-alone environments: Stop the profile server (node) before you run
the managesdk command.

¢ For clustered environments:

If the profile is a federated node of a deployment manager, ensure that the
deployment manager is running before you run the managesdk command
to update the profile.

Stop all the nodes.
Ensure that the node agent for each node is started.

When you enable the SDK for a node, run the managesdk command from
the /bin directory to which the node belongs. You can also run the
command from the /bin directory of the profile that contains the node
that you want to update.

A connection to the deployment manager must exist with a supported
connector protocol in the following order of preference:

- SOAP
- Inter-Process Communications (IPC)
- Remote Method Invocation (RMI)

If the SOAP protocol is enabled, the managesdk command uses the SOAP
protocol. If the SOAP protocol is not enabled but the IPC protocol is
enabled, the command uses the IPC protocol. If the SOAP and IPC
protocol are not enabled, then the command uses the RMI protocol.

You must provide the administrative user name and password with the
managesdk command for each profile that contains a federated node or
deployment manager node in a cell with security enabled. If you do not
specify the -user and -password parameters, the managesdk command
might fail or stop processing.

When you enable the SDK for a deployment manager, only the
deployment manager server is enabled. None of the managed nodes of the
deployment manager are enabled to use the specific SDK.

Open a command prompt and change to the b1' n directory.

Run the following command to enable all existing profiles to use the new SDK
version:

Go to jmanagesdk command| for information about the managesdk commands.

* AIX : ./managesdk.sh -enableProfileAll -sdkname 1.7.1 64
-enableServers

Run the following commands to make the new SDK version the new default:

» AIX : ./managesdk.sh -setCommandDefault -sdkname 1.7.1 64
./managesdk.sh -setNewProfileDefault -sdkname 1.7.1_64

Repeat these steps on each node in your environment.

Related tasks:

[“AIX: Preparing your operating system” on page 225|

Prepare the operating system to ensure a successful installation.

[“AIX: Preparing the Installation Manager” on page 226|

The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.
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[“AIX: Running the installation program” on page 227

Use the IBM Installation Manager program to install the software. IBM Installation
Manager provides multiple user interfaces. Select the one that you are more
comfortable with. You can use the graphical user interface or the console to create
a response file for automated installations.

HP: Installing WebSphere Portal and Web Content Manager

Installing the digital experience software includes preparing your operating system
and using IBM Installation Manager to install IBM WebSphere Portal and Web
Content Manager. Then, use the Configuration Wizard to complete the deployment
configuration.

Before you begin

Roadmaps for installation and deployment are included in this product
documentation to guide you through the process. Roadmaps provide a high-level
overview of the process from beginning to end. Select the configuration that is
closest to the configuration that you need.

1. [“HP: Preparing your operating system”|
Prepare the operating system to ensure a successful installation.

2. [“HP: Preparing the Installation Manager” on page 242
The IBM Installation Manager is used to install installation packages such as
IBM WebSphere Portal and IBM WebSphere Application Server.

3. [“HP: Running the installation program” on page 243|
Use the IBM Installation Manager program to install the software. IBM
Installation Manager provides multiple user interfaces. Select the one that you
are more comfortable with. You can use the graphical user interface or the
console to create a response file for automated installations.

4. |"HP: Next steps” on page 251|
The configuration process has changed. Use the Configuration Wizard to set up
your integration with prerequisites, clusters, and more.

5. ["HP: Upgrading the SDK” on page 253|
Starting with IBM WebSphere Portal Combined Cumulative Fix 05, you can
change your SDK Java Technology Edition from version 7.0 to version 7.1.

HP: Preparing your operating system
Prepare the operating system to ensure a successful installation.

Procedure
1. Log in to the host server with superuser (root) privileges.

2. Choose one of the following options to determine the physical memory, which
you must know to avoid setting certain kernel parameters higher than the
physical capacity:

» HP-UX 11i Version 3 and later: Use the /usr/sbin/dmesg command.
* HP-UX 11i Version 2 and earlier: Complete the following steps:

a. Start the HP-UX System Administration Manager (SAM) utility with the
/usr/sbin/sam command.

b. Select Performance Monitors > System Properties > Memory.
c. View the value for Physical Memory and click OK.
d. Exit from the SAM utility.

3. Set the maxfiles and maxfiles_1lim parameters to at least 4096.
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The minimum value for maxfiles is 8000. The minimum value for
maxfiles_1im is 8196.

To allow the SAM utility to set values greater than 2048, edit the
/usr/conf/master.d/core-hpux file.

Note: If you are using HP-UX 11i Version 2, the /usr/conf/master.d/core-hpux

file does not exist; instead, use the SAM utility to set the new kernel parameter

values. See [Reconfiguring the Kernel (HP-UX 11i Version 2)| for details.

a. Open the file /usr/conf/master.d/core-hpux in a text editor.

b. Change the line, "*range maxfiles<=2048" to "*range maxfiles<=60000"

c. Change the line, "*range maxfiles_1im<=2048" to "+range
maxfiles_1im<=60000"

d. Save and close the file. Old values might be stored in the
/var/sam/boot.config file. Force the SAM utility to create a boot.config
file:

1) Move the existing version of the /var/sam/boot.config file to another
location, such as the /tmp directory.

2) Start the SAM utility.

3) Select Kernel Configuration > Configurable Parameters. When the
Kernel Configuration window opens, a new boot.config file exists.

Alternatively, rebuild the boot.config file with this command: #
/usr/sam/1bin/getkinfo -b

4. Web Content Manager only: Use the ulimit -f command to set the maximum
size of files that can be created. Set this value to be at least the size of the
largest file you must upload to the content server. The command ulimit -f -1
removes any limit on file size.

5. Complete the following steps to configure the HP-UX system kernel:
a. Start the SAM utility.
b. Select Kernel Configuration > Configurable Parameters.
C. Repeat the following steps for each parameter in the table:
1) Highlight the parameter to change.

2) Select Actions > Modify Configurable Parameter.
3) Type the new value in the Formula/Value field.
4) Click OK.

Note: When WebSphere Portal and DB2 are installed on the same server,
some kernel values are higher than the values shown in the table. For
information about kernel values, go to |http:/ /publib.boulder.ibm.com /|
infocenter /db2luw /v8/index.jsp?topic=/com.ibm.db2.udb.doc/start/|
0004692 htm|

Typical kernel settings for running WebSphere Portal.

Table 68. The typical kernel settings for running WebSphere Portal

Parameter Value

dbc_max_pct 25

maxdsiz 805306358

maxdsiz 2048000000 (when WebSphere Application Server Base
and Network Deployment products are on the same
server)

maxfiles_lim 8196 (Change this one before maxfiles.)
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Table 68. The typical kernel settings for running WebSphere Portal (continued)

Parameter Value

maxfiles 8000

maxssiz 8388608

maxswapchunks (valid for HP-UX 11livl only) 8192

max_thread_proc 3000

maxuprc 512

maxusers (valid for HP-UX 1livl only) 512

msgmap 2048

msgmax 65535

msgmax 131070 (when WebSphere Application Server Base and
Network Deployment products are on the same server)

msgmnb 65535

msgmnb 131070 (when WebSphere Application Server Base and
Network Deployment products are on the same server)

msgmni 50

msgseg 32767

msgssz 96

msgtql 2046

nfile 58145

nflocks 3000

ninode 60000

nkthread 7219

nproc 4116

npty 2024

nstrpty 1024

nstrtel 60

sema (valid for HP-UX 11iv1 only)

1 (with embedded Messaging)

semaem 16384 (with embedded Messaging)
semmap (valid for HP-UX 11iv1 only) 514

semmn i 2048

semmns 16384 (with embedded Messaging)
semmnu 1024

semume 200

semvmx 32767 (with embedded Messaging)
shmmax 2147483647

shmem (valid for HP-UX 11iv1 only) 1 (with embedded Messaging)
shmmni 1024

shmseg 1024

STRMSGSZ (valid for HP-UX 11iv1 only) 65535

6. Select Actions > Process New Kernel.
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Click Yes on the information window to confirm your decision to restart the
server.

Follow on-screen instructions to restart your server and to enable the new
settings.

HP: Preparing the Installation Manager
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

Procedure

If you have an existing Installation Manager, start it and go to File > Preferences.
Then, click Updates. Click the Search for Installation Manager updates check box.
This box enables the Installation Manager to search for updates the next time you
run an installation or update.

If you do not have an existing Installation Manager, then complete the following
procedure:

1.
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Start all servers and applications that require a port number to avoid port
conflicts when installing WebSphere Portal.

Type ping yourserver.yourcompany.com on a command line to verify that your
fully qualified host name is properly configured.

Type ping localhost on a command line to verify that your network is
properly configured.

If you are installing on a server with a firewall, antivirus, screen saver, or
desktop search engine that is enabled, disable them before you install. If you do
not disable them and the installation program detects them, a warning message
displays during the installation.

Optional: Complete the following steps to install as a non-root user:

a. Log in to the operating system as the root user.

b. Open a command line.

c. Use the appropriate system commands to create the following items:
Non-root user, including password
Group

Directory, used when you install IBM Installation Manager and
WebSphere Portal

d. Set the user profile for the number of open files. Set the value to ulimit -n
10240.

Add the non-root user to the new group.

o

f. Run the following task to change the owner of the directory to the non-root
user:

chown user:group /directory

g. Run the following task to change permissions for the directory:
chmod 755 /directory

h. Log in as the non-root user.

i. Use the following command to install IBM Installation Manager:
./userinst

Set the IBM Installation Manager installation location to
/directory/IBM/InstallationManager.

Run the following task from the IIM directory: ./install



7. Run the following task from the Portal Setup disk if you want to start the
launchpad to complete all necessary installation steps: ./setup.sh

Launchpad tip: On the Launchpad: Install Portal panel, you have the following
options:

Install IBM WebSphere Portal from media
Choose this option if you are installing directly from the DVD.

Install IBM WebSphere Portal from network
Choose this option if you downloaded the electronic images.

Install IBM Installation Manager only
Choose this option if you want to install multiple IBM products, or if
you want to install WebSphere Portal directly from IBM Passport
Advantage, and a previous version of Installation Manager is not
already installed on your system.

Tip: Add the LaunchPadLocale language_code to the setup task to change the
display to your user locale or to another language.

Note: If the language is not currently supported for the user interface, you
might see the English version. For details on supported languages and the
language codes for all of the WebSphere Portal user interfaces, see
[languages” on page 3924

After you complete all necessary steps from the launchpad, verify that your
installation was successful.

HP: Running the installation program

Use the IBM Installation Manager program to install the software. IBM Installation
Manager provides multiple user interfaces. Select the one that you are more
comfortable with. You can use the graphical user interface or the console to create
a response file for automated installations.

["HP: Installing with the graphical user interface” on page 244|
Use the IBM Installation Manager to install IBM WebSphere Portal, IBM
WebSphere Application Server, and the Apache Derby database.

[“HP: Installing with the console” on page 246|
Use the IBM Installation Manager to install IBM WebSphere Portal with an
existing IBM WebSphere Application Server.

[“HP: Creating a response file” on page 248|

After IBM Installation Manager is installed, you can use it to record a response
file that is based on your environment. Record a response file on the same
operating system you plan for the installation. If you have multiple operating
systems, you must record a response file for each operating system. Use a
response file to automate your installation on multiple servers.

[“HP: Installing with the response file” on page 250

Use either a sample response file or a response file that you created to install
WebSphere Application Server and WebSphere Portal. You can create a response
file with the graphical or console mode interface.

Related tasks:
[“HP: Preparing your operating system” on page 239
Prepare the operating system to ensure a successful installation.
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HP: Installing with the graphical user interface:

Use the IBM Installation Manager to install IBM WebSphere Portal, IBM
WebSphere Application Server, and the Apache Derby database.

About this task

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.

Procedure

1.
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Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

If necessary, start the Installation Manager.

After you install or upgrade the Installation Manager, complete the following
steps to add the repositories where the installation media exists:

a. Open the IBM Installation Manager and go to File > Preferences >
Repositories.

b. Select Add Repositories.

C. Select Browse and go to the Portal-install-eimage/Setup/
repository.config file and then click OK.

d. Ensure that all required repositories are checked. Then, click Test
Connections to ensure that the IBM Installation Manager can successfully
access the directory where the service repositories are stored.

e. Select Apply.
f. Select OK.
On the main IBM Installation Manager panel, select Install.

Optional: If you are installing Portal to an existing copy of WebSphere
Application Server, then select only IBM WebSphere Portal Server on the
Install Packages screen. To complete this installation option, your existing
copy of WebSphere Application Server must meet the following requirements:

* WebSphere Application Server Version 8.5.5.2 or later
* Java Version 7
* No existing Portal profile

Skip the following step, if you choose to install to an existing copy of
WebSphere Application Server.

On Install Packages: Select packages to install, select the following packages,
and then click Next:

* IBM WebSphere Application Server Network Deployment
* IBM WebSphere Portal Server
* IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional" on the Select packages to install screen.



10.

11.
12.

13.

14.

15.

16.

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

On Install Packages: Select the fixes to install screen, select any required fixes.
Then, click Next.

Accept the license agreement and then click Next.

Enter the directory where you want to store shared resources and then click
Next.

Complete the following steps on the Install Packages: Installation Directory
panel:

Remember: The installation directory that you specify must NOT contain any

files or the following characters: ™ ! @ # § S~ & * () + { } | <>?2-=[1;",

. " and spaces.

a. Select the WebSphere Application Server Package Group Name and then
enter the installation directory path.

b. Select the WebSphere Portal Package Group Name and then enter the
installation directory path.

c. Click Next.
Select the translations to install and then click Next.

Optional: If you chose to install Portal to an existing copy of WebSphere
Application Server, select the available copy of WebSphere Application Server,
and click Next.

Note: Skip this step, if you are not installing Portal to an existing copy of
WebSphere Application Server.

On Install Packages: Select the features to install, expand the WebSphere
Application Server and WebSphere Portal packages to modify the features you
want to install and then click Next.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.

Note: As you select the items, read the Details section for information.
On Profile configuration details, enter the user ID and password for the
configuration wizard administrator. Then, click Next.

If you selected the Portal Server Profile package, click Enter the
Administrator user ID and password for the Portal Server. Then, select either
the Standard or Advanced configuration mode and then enter the parameter
details for the selected configuration mode.

Note: Select Advanced if you want to specify Uniform Resource Identifier
(URI) information that is specific to your company.

Confirm the Summary information and then click Install.

What to do next

After a successful installation, the summary displays. Choose the Portal First Steps
radio button and then click Finish to start the servers and begin configuring
WebSphere Portal with the Configuration Wizard.
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Tip: To access First Steps later, you can either select First Steps from the Start
menu or you can run the ./firststeps.sh task from the
PortalServer/installer/wp.firststeps directory. Add the LaunchPadLocale

language_code to the firststeps task to change the display to your user locale or
to another language.

Attention: When you install WebSphere Application Server and WebSphere Portal
together, you might find the following message in the SystemErr.Tlog file:

AppServer rootl/properties/version/installed.xml (No such file or directory)

This message is part of the installation process and is not repeated after the
installation is complete. Therefore, the message can be ignored.

HP: Installing with the console:

Use the IBM Installation Manager to install IBM WebSphere Portal with an existing
IBM WebSphere Application Server.

Before you begin

A working installation of IBM WebSphere Application Server is required. Ensure
that it is not used by another copy of WebSphere Portal. Before you install the
WebSphere Portal package, install IBM WebSphere SDK Java Technology Edition
into the same directory where IBM WebSphere Application Server is installed.

About this task

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.

Procedure

1. Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

2. Open a command prompt and change to the InstallationManager_root/
eclipse/tools directory.

3. Run the command to start the IBM Installation Manager in console mode:
./imcl -c
4. Complete the following steps to add the repositories:
. Enter P to go to the Preferences menu.

. Enter 1 to go to the Repositories menu.

a
b
c. Enter D to add repositories.
d. Type the path for your WebSphere Portal repository file.
e. Enter A to apply your repositories and return to the Preferences menu.
f. Enter R to return to the Main menu.
5. Enter 1 to install the software packages.
6. Select the software packages that you want to install.

* If you are installing Portal to an existing copy of WebSphere Application
Server, then select only IBM WebSphere Portal Server. To complete this
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10.
11.

12.

13.

14.

15.
16.

installation option, your existing copy of WebSphere Application Server
must meet the following requirements:

— WebSphere Application Server Version 8.5.5.2 or later
— Java Version 7
- No existing Portal profile

* If you are not installing Portal to an existing copy of WebSphere
Application Server, then select the following packages:

— IBM WebSphere Application Server Network Deployment
— IBM WebSphere Portal Server
— IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional."

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

Choose one of the following options:

* Enter 1 to choose version 8.5.0.0 for installation.

* Enter 2 to show all available versions of the package.

Enter N.

Enter A to accept the license agreement.

Enter N.

Choose one of the following options for translation packages:

* Enter N to select the default English package only.

* Enter the number for the translation package you want to install.

On the Incompatible package group menu, choose one of the following

options:

* Enter M to change the installation directory. Then, enter the new installation
directory.

* Enter N to keep the existing directory.

Enter the number for the WebSphere Application Server root directory to use
as the existing WebSphere Application Server.

On the IBM Installation Manager > Install > Licenses > Location > Features
menu, enter 1 to select the Portal Server Profile feature. Then, enter N to
continue.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.

Enter the configuration wizard administrator user ID and password.

If you selected the Portal Server Profile feature, enter the information for the
following prompts:

* Enter the host name

* Enter the node name

* Enter the cell name

* Enter an administrator user ID for the portal server

* Enter an administrator user password for the portal server

Chapter 4. Installing 247



17.

18.
19.
20.

21.

22.

23.

* Confirm administrator user password for the portal server

Enter Y to enter advanced parameters such as customized Uniform Resource
Identifier (URI) settings, profile name, and port numbers. Enter N to accept the
default parameters.

* Enter the context root

* Enter the default home

* Enter the personalized home

* Enter the profile name

* Enter the starting port number

* Enter the profile path

Enter N.

Review the summary information.

Choose one of the following options:

* Enter G to generate a response file.

* Enter I to install WebSphere Portal.

When the installation is complete, enter F to return to the main installation
menu.

Access the Configuration Wizard. Go to http://your_server:10200/ibm/
wizard.

Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924

HP: Creating a response file:

After IBM Installation Manager is installed, you can use it to record a response file
that is based on your environment. Record a response file on the same operating
system you plan for the installation. If you have multiple operating systems, you
must record a response file for each operating system. Use a response file to
automate your installation on multiple servers.

About this task

You can also use the console mode to generate a response file. After you review
the summary information, enter G to generate a response file instead of I to install.

Procedure

1.
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Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

Go to the InstallationManager_root/eclipse directory.
Run the following task to start the recording: ./IBMIM -record
pathtoresponsexmlfile -skipInstall tempinstalldirectory

-record
This parameter indicates recording the actions and parameters into the
response file. The pathtoresponsexmlfile text is the name of the response



11.

file, for example Wp8SampleResp.xml. The tempinstalldirectory text is the
directory where the response file is recorded.

-skipInstall
This parameter indicates that no actual installation is completed even
though it leads to the final pane.

tempinstalldirectory
This value is a directory where the installation saves the history and
data when you record the response files.

Complete the following steps to add the repositories where the installation
media exists:

a. Open the IBM Installation Manager and go to File > Preferences >
Repositories.

b. Select Add Repositories.

c. Select Browse and go to the Portal-install-eimage/Setup/
repository.config file and then click OK.

d. Ensure that all required repositories are checked. Then, click Test
Connections to ensure that the IBM Installation Manager can successfully
access the directory where the service repositories are stored.

e. Select Apply.
f. Select OK.
On the main IBM Installation Manager panel, select Install.

Optional: If you are installing Portal to an existing copy of WebSphere
Application Server, then select only IBM WebSphere Portal Server on the
Install Packages screen. To complete this installation option, your existing
copy of WebSphere Application Server must meet the following requirements:

* WebSphere Application Server Version 8.5.5.2 or later
* Java Version 7
* No existing Portal profile

Skip the following step, if you choose to install to an existing copy of
WebSphere Application Server.

On Install Packages: Select packages to install, select the following packages,
and then click Next:

* IBM WebSphere Application Server Network Deployment
* IBM WebSphere Portal Server
* IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional" on the Select packages to install screen.

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

On Install Packages: Select the fixes to install screen, select any required fixes.
Then, click Next.

Accept the license agreement and then click Next.

Enter the directory where you want to store shared resources and then click
Next.

Complete the following steps on the Install Packages: Installation Directory
panel:
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12.
13.

14.

15.

16.

17.
18.

19.

Remember: The installation directory that you specify must NOT contain any
files or the following characters: ™ ! @ # § S~ & * () + { } |<>?2-=[1;",
" and spaces.

a. Select the WebSphere Application Server Package Group Name and then
enter the installation directory path.

b. Select the WebSphere Portal Package Group Name and then enter the
installation directory path.

c. Click Next.
Select the translations to install and then click Next.

Optional: If you chose to install Portal to an existing copy of WebSphere
Application Server, select the available copy of WebSphere Application Server,
and click Next.

Note: Skip this step, if you are not installing Portal to an existing copy of
WebSphere Application Server.

On Install Packages: Select the features to install, expand the WebSphere
Application Server and WebSphere Portal packages to modify the features you
want to install and then click Next.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.

Note: As you select the items, read the Details section for information.

On Profile configuration details, enter the user ID and password for the
configuration wizard administrator. Then, click Next.

If you selected the Portal Server Profile package, click Enter the
Administrator user ID and password for the Portal Server. Then, select either
the Standard or Advanced configuration mode and then enter the parameter
details for the selected configuration mode.

Note: Select Advanced if you want to specify Uniform Resource Identifier
(URI) information that is specific to your company.

Confirm the Summary information and then click Install.

After the Installation Manager finishes creating the response file, click Finish
and then close the Installation Manager to complete the response file
recording.

If you plan to install on a different computer, copy the response file to the
response file directory on that computer.

HP: Installing with the response file:

Use either a sample response file or a response file that you created to install
WebSphere Application Server and WebSphere Portal. You can create a response
file with the graphical or console mode interface.

About this task

Locate the sample response file in the setup_root/responsefiles directory. Modify
the file with your environment values.
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The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.

Procedure

1. If the repository URL requires authentication, use the IBM Installation Manager
command-line tool to create a secure Storage File.

The secure Storage File stores the credentials that are required for the
repositories. The IBM Installation Manager command-line tool imutilsc is
available from the installation tools directory. The following information is an
example of the imutilsc key ring file command:

./imutilsc saveCredential -url repository_URL -userName credential_userName
-userPassword password -secureStorageFile storage_file
[ -masterPasswordFile master_password_file ]
[ -preferences com.1'bm.cic.common.core.preferences.ss].nonsecureMode=true|fa]se 1
[ -proxyHost proxy_host -proxyPort proxy_port

[ -proxyUsername proxy_username -proxyUserPassword proxyuser_password ]

[ -useSocks ] ]

[ -verbose ]

Tip: If you install on a different computer, copy the secure Storage File to that
computer.

2. Go to the InstallationManager_root/eclipse/tools directory.

3. Run the following task to install WebSphere Portal and IBM WebSphere
Application Server:

Tip: Add the -secureStorageFile pathtosecureStorageFile
-masterPasswordFile pathtomasterPasswordFile parameters to the imcl
command if you are using a secure Storage File to store credentials.

./imc1 -acceptlLicense input pathtoresponse.xml -log dirpath/logfilename

What to do next

Attention: When you install WebSphere Application Server and WebSphere Portal
together, you might find the following message in the SystemErr.Tog file:

AppServer rootl/properties/version/installed.xml (No such file or directory)

This message is part of the installation process and is not repeated after the
installation is complete. Therefore, the message can be ignored.

HP: Next steps
The configuration process has changed. Use the Configuration Wizard to set up
your integration with prerequisites, clusters, and more.

Verify that the installation was successful
Unless you selected to install only the binary files, you can log in to the portal and

verify that your installation was successful. Access WebSphere Portal with the
http://yourserver:yourport/wps/portal format.

If you are not sure what your port number is, use the 1ist-server-ports
command to determine the port number. Change to the
ConfigEngine/Tog. Run the 1ist-server-ports task to generate the

WebSphere_Portal_PortMatrix.txt file. For example: ./ConfigEngine.sh
list-server-ports -DWasPassword=password.
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Change to the /opt/IBM/WebSphere/AppServer/profiles/cw_profile/ConfigEngine
Run the Tist-server-ports task to generate the serverl_PortMatrix.txt file. For
example: ./ConfigEngine.sh 1ist-server-ports -DWasPassword=password.

Modify the uri.home.substitution custom property in the Resource
Environment Provider

In the WP ConfigService, set the uri.home.substitution custom property to true
to avoid functional errors that might occur in certain unusual use cases. For more
information on uri.home.substitution, see Configuration Service in the related
links.

Select a roadmap

If you have not already selected a roadmap to guide you through the installation
and deployment process, look at the available roadmaps. The roadmaps are based
on typical environments, such as development environment, test environment, and
more. They provide a high-level overview of the installation and deployment
process. Each roadmap includes a topology diagram, usage recommendations, and
instructions. Roadmaps are available for both new deployments and migrations
scenarios.

[“Roadmaps for installation and deployment” on page 69|

["Roadmaps for migration” on page 110|

Run the Configuration Wizard to finish the deployment

Then, start the Configuration Wizard and select the option that is defined in your
selected roadmap. Use the wizard to run the configuration steps in real time or to
generate scripts. The wizard generates instructions and scripts specific to your
environment and the data that you entered. You can save the selection and data
that you entered as an XML file. Then, you can load the XML file during a
subsequent wizard session to set up a similar configuration on a different server.

If you select to run the configuration in real time, you still have the opportunity to
download scripts for selected steps. For example, if only the database
administrator can databases, then you can download the database creation script
and give it to your database administrator to run.

Default URLs

During the configuration process, you might need to following URLs to access
different administration user interfaces.

Use the following default URLs to access IBM WebSphere Portal, the WebSphere

Integrated Solutions Console, and the Configuration Wizard:

IBM WebSphere Portal
http://localhost:10039/wps/portal
https://lTocalhost:10042/wps/portal

WebSphere Integrated Solutions Console
http://localhost:10038/ibm/console
https://Tocalhost:10041/ibm/console

Configuration Wizard
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IBM i

http://localhost:10200/1bm/wizard
https://Tocalhost:10202/1ibm/wizard

If you had any processes from other software in the default port range when the
installation started, you might have different port numbers than the defaults.

Related concepts:

[Chapter 3, “Roadmaps,” on page 69|
Review the roadmaps to understand the common deployment patterns that are
supported by the configuration wizard.

[‘Configuration Wizard” on page 340

Use the Configuration Wizard to set up stand-alone servers and new deployments,
create clusters, migrate and update to new versions, and add new capabilities to
existing deployments.

Related tasks:

[“HP: Preparing your operating system” on page 239
Prepare the operating system to ensure a successful installation.

[“HP: Preparing the Installation Manager” on page 242|
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

Related reference:

[“Configuration Service” on page 418|
The portal Configuration Service is responsible for collecting the most essential
configuration data of the IBM WebSphere Portal engine.

HP: Upgrading the SDK

Starting with IBM WebSphere Portal Combined Cumulative Fix 05, you can change
your SDK Java Technology Edition from version 7.0 to version 7.1.

About this task

HP-UX restriction: SDK version 7.1 is not available for HP-UX.
Related tasks:

[“HP: Preparing your operating system” on page 239

Prepare the operating system to ensure a successful installation.

[“HP: Preparing the Installation Manager” on page 242|
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

[“HP: Running the installation program” on page 243|

Use the IBM Installation Manager program to install the software. IBM Installation
Manager provides multiple user interfaces. Select the one that you are more
comfortable with. You can use the graphical user interface or the console to create
a response file for automated installations.

Installing WebSphere Portal and Web Content Manager

Installing the digital experience software includes preparing your operating system
and using IBM Installation Manager to install IBM WebSphere Portal and Web
Content Manager. Then, use the Configuration Wizard to complete the deployment
configuration.
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Before you begin

Roadmaps for installation and deployment are included in this product
documentation to guide you through the process. Roadmaps provide a high-level
overview of the process from beginning to end. Select the configuration that is
closest to the configuration that you need.

1. ["IBM i: Preparing your operating system”]
Prepare the operating system to ensure a successful installation.

2. [“IBM i: Preparing the Installation Manager”|
The IBM Installation Manager is used to install installation packages such as
IBM WebSphere Portal and IBM WebSphere Application Server.

3. ["IBM i: Running the installation program” on page 255|
Use the IBM Installation Manager program to install the software. IBM
Installation Manager provides multiple user interfaces. Select the one that you
are more comfortable with. You can use the graphical user interface or the
console to create a response file for automated installations.

4. |"IBM i: Next steps” on page 260
The configuration process has changed. Use the Configuration Wizard to set up
your integration with prerequisites, clusters, and more.

5. ['IBM i: Upgrading the SDK” on page 262|
Starting with IBM WebSphere Portal Combined Cumulative Fix 05, you can
change your SDK Java Technology Edition from version 7.0 to version 7.1.

6. [“IBM i: Rendering documents on IBM i” on page 264|
To enable document preview function for IBM Web Content Manager and the
Common Mail portlet, you must set up an HITML rendering server to work
with WebSphere Portal. Because IBM i does not contain native graphics
support, you must install extra fonts to run the document conversion that is
required by these functions. Document conversion enables WebSphere Portal to
convert documents that are produced by commonly used office programs into
web pages so that they can be viewed and searched by users online. The
additional fonts include an HTML rendering server that is known as X virtual
frame buffer for the X server.

IBM i: Preparing your operating system
Prepare the operating system to ensure a successful installation.

Procedure

1. Make sure that you have a CD drive

2. Make sure that the server is in an unrestricted state

3. If you do not have one, create a valid IBM i user ID and password
4

. Create a user profile with a user type (user class) of *SECOFR (other than
QSECOFR) to install and configure WebSphere Portal

IBM i: Preparing the Installation Manager
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

Procedure
If you have an existing Installation Manager, start it and go to File > Preferences.

Then, click Updates. Click the Search for Installation Manager updates check box.
This box enables the Installation Manager to search for updates the next time you
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run an installation or update.
If you do not have an existing Installation Manager, then complete the following
procedure:

1. Start all servers and applications that require a port number to avoid port
conflicts when installing WebSphere Portal.

2. Type ping yourserver.yourcompany.com on a command line to verify that your
fully qualified host name is properly configured.

3. Type ping localhost on a command line to verify that your network is
properly configured.

4. If you are installing on a server with a firewall, antivirus, screen saver, or
desktop search engine that is enabled, disable them before you install. If you do
not disable them and the installation program detects them, a warning message
displays during the installation.

5. Run the following task from the IIM directory: installc -acceptLicense

Note: If you have an existing Installation Manager, search for updates to the
latest supported version.

IBM i: Running the installation program

Use the IBM Installation Manager program to install the software. IBM Installation
Manager provides multiple user interfaces. Select the one that you are more
comfortable with. You can use the graphical user interface or the console to create
a response file for automated installations.

[“IBM i: Installing with the console”]
Use the IBM Installation Manager to install IBM WebSphere Portal with an
existing IBM WebSphere Application Server.

[“IBM i: Creating a response file” on page 258|

After IBM Installation Manager is installed, you can use it to record a response
file that is based on your environment. Record a response file on the same
operating system you plan for the installation. If you have multiple operating
systems, you must record a response file for each operating system. Use a
response file to automate your installation on multiple servers.

[“IBM i: Installing with the response file” on page 259

Use either a sample response file or a response file that you created to install
WebSphere Application Server and WebSphere Portal. You can create a response
file with the graphical or console mode interface.

Related tasks:

[“IBM i: Preparing your operating system” on page 254|
Prepare the operating system to ensure a successful installation.

IBM i: Installing with the console:

Use the IBM Installation Manager to install IBM WebSphere Portal with an existing
IBM WebSphere Application Server.

Before you begin

A working installation of IBM WebSphere Application Server is required. Ensure
that it is not used by another copy of WebSphere Portal.

About this task

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
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You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.

Procedure

1.

10.
11.
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Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

Open a command prompt and change to the InstallationManager_root/
eclipse/tools directory.

Run the command to start the IBM Installation Manager in console mode:
imcl -c
Complete the following steps to add the repositories:

. Enter P to go to the Preferences menu.

. Enter 1 to go to the Repositories menu.

a

b

c. Enter D to add repositories.

d. Type the path for your WebSphere Portal repository file.

e. Enter A to apply your repositories and return to the Preferences menu.
f. Enter R to return to the Main menu.

Enter 1 to install the software packages.

Select the software packages that you want to install.

* If you are installing Portal to an existing copy of WebSphere Application
Server, then select only IBM WebSphere Portal Server. To complete this
installation option, your existing copy of WebSphere Application Server
must meet the following requirements:

— WebSphere Application Server Version 8.5.5.2 or later
— Java Version 7
— No existing Portal profile

* If you are not installing Portal to an existing copy of WebSphere
Application Server, then select the following packages:

— IBM WebSphere Application Server Network Deployment
— IBM WebSphere Portal Server
— IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional."

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

Choose one of the following options:

* Enter 1 to choose version 8.5.0.0 for installation.

* Enter 2 to show all available versions of the package.
Enter N.

Enter A to accept the license agreement.

Enter N.

Choose one of the following options for translation packages:
* Enter N to select the default English package only.



12.

13.

14.

15.
16.

17.

18.
19.
20.

21.

22.

23.

* Enter the number for the translation package you want to install.

On the Incompatible package group menu, choose one of the following

options:

* Enter M to change the installation directory. Then, enter the new installation
directory.

* Enter N to keep the existing directory.

Enter the number for the WebSphere Application Server root directory to use
as the existing WebSphere Application Server.

On the IBM Installation Manager > Install > Licenses > Location > Features
menu, enter 1 to select the Portal Server Profile feature. Then, enter N to
continue.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.

Enter the configuration wizard administrator user ID and password.

If you selected the Portal Server Profile feature, enter the information for the
following prompts:

* Enter the host name

* Enter the node name

* Enter the cell name

* Enter an administrator user ID for the portal server

* Enter an administrator user password for the portal server
* Confirm administrator user password for the portal server

Enter Y to enter advanced parameters such as customized Uniform Resource
Identifier (URI) settings, profile name, and port numbers. Enter N to accept the
default parameters.

* Enter the context root

* Enter the default home

* Enter the personalized home

* Enter the profile name

* Enter the starting port number

* Enter the profile path

Enter N.

Review the summary information.
Choose one of the following options:
* Enter G to generate a response file.
* Enter I to install WebSphere Portal.

When the installation is complete, enter F to return to the main installation
menu.

Access the Configuration Wizard. Go to http://your_server:10200/1ibm/
wizard.

Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profile.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
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details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924

What to do next

Before you access WebSphere Application Server, configure the software license
agreement to set the usage limit from the Proof of Entitlement (POE) or invoice. Go
to [Configuring software license information| for information.

IBM i: Creating a response file:

After IBM Installation Manager is installed, you can use it to record a response file
that is based on your environment. Record a response file on the same operating
system you plan for the installation. If you have multiple operating systems, you
must record a response file for each operating system. Use a response file to
automate your installation on multiple servers.

About this task

Procedure

1. Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

2. Go to the InstallationManager_root/eclipse/tools directory.
3. Run the following task to start the recording: imc1 -c
4. Complete the following steps to add the repositories:

. Enter P to go to the Preferences menu.

. Enter 1 to go to the Repositories menu.

a
b
c. Enter D to add repositories.
d. Type the path for your WebSphere Portal repository file.
e. Enter A to apply your repositories and return to the Preferences menu.
f. Enter R to return to the Main menu.
5. Enter 1 to install the software packages.
6. Select the software packages that you want to install.

* If you are installing Portal to an existing copy of WebSphere Application
Server, then select only IBM WebSphere Portal Server. To complete this
installation option, your existing copy of WebSphere Application Server
must meet the following requirements:

— WebSphere Application Server Version 8.5.5.2 or later
— Java Version 7
— No existing Portal profile

* If you are not installing Portal to an existing copy of WebSphere
Application Server, then select the following packages:

— IBM WebSphere Application Server Network Deployment

— IBM WebSphere Portal Server

— IBM WebSphere SDK Java Technology Edition
Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be

marked as "Optional."
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Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

7. Choose one of the following options:
* Enter 1 to choose version 8.5.0.0 for installation.

* Enter 2 to show all available versions of the package.

8. Enter N.
9. Enter A to accept the license agreement.
10. Enter N.

11. Choose one of the following options for translation packages:
* Enter N to select the default English package only.
* Enter the number for the translation package you want to install.
12. On the Incompatible package group menu, choose one of the following
options:
* Enter M to change the installation directory. Then, enter the new installation
directory.
* Enter N to keep the existing directory.

13. Enter the number for the WebSphere Application Server root directory to use
as the existing WebSphere Application Server.

14. Enter the configuration wizard administrator user ID and password.

15. If you selected the Portal Server Profile feature, enter the information for the
following prompts:

* Enter the host name

* Enter the node name

* Enter the cell name

* Enter an administrator user ID for the portal server

* Enter an administrator user password for the portal server
* Confirm administrator user password for the portal server

16. Enter Y to enter advanced parameters such as customized Uniform Resource
Identifier (URI) settings, profile name, and port numbers. Enter N to accept the
default parameters.

* Enter the context root
* Enter the default home
* Enter the personalized home
* Enter the profile name
* Enter the starting port number
* Enter the profile path
17. Enter N.
18. Review the summary information.
19. Enter G to generate a response file.

20. If you plan to install on a different computer, copy the response file to the
response file directory on that computer.

IBM i: Installing with the response file:
Use either a sample response file or a response file that you created to install

WebSphere Application Server and WebSphere Portal. You can create a response
file with the graphical or console mode interface.
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About this task

Locate the sample response file in the setup_root/responsefiles directory. Modify
the file with your environment values.

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.

Procedure

1. If the repository URL requires authentication, use the IBM Installation Manager
command-line tool to create a secure Storage File.

The secure Storage File stores the credentials that are required for the
repositories. The IBM Installation Manager command-line tool imutilsc is
available from the installation tools directory. The following information is an
example of the imutilsc key ring file command:

imutilsc saveCredential -url repository URL -userName credential_userName
-userPassword password -secureStorageFile storage _file [ -masterPasswordFile master_password file ]
[ -preferences com.ibm.cic.common.core.preferences.ss].nonsecureMode=true|fa1se ]
[ -proxyHost proxy_host -proxyPort proxy_port
[ -proxyUsername proxy_username -proxyUserPassword proxyuser_password ]
[ -useSocks ] ]
[ -verbose ]

Tip: If you install on a different computer, copy the secure Storage File to that
computer.

2. Go to the InstallationManager_root/eclipse/tools directory.

3. Run the following task to install WebSphere Portal and IBM WebSphere
Application Server:

Tip: Add the -secureStorageFile pathtosecureStoragefile
-masterPasswordFile pathtomasterPasswordFile parameters to the imcl
command if you are using a secure Storage File to store credentials.

imc1 -acceptLicense input pathtoresponse.xml -log dirpath/logfilename

What to do next
Before you access WebSphere Application Server, configure the software license

agreement to set the usage limit from the Proof of Entitlement (POE) or invoice. Go
to [Configuring software license information| for information.

Attention: When you install WebSphere Application Server and WebSphere Portal
together, you might find the following message in the SystemErr.Tog file:

AppServer rootl/properties/version/installed.xml (No such file or directory)

This message is part of the installation process and is not repeated after the
installation is complete. Therefore, the message can be ignored.

IBM i: Next steps

The configuration process has changed. Use the Configuration Wizard to set up
your integration with prerequisites, clusters, and more.
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Verify that the installation was successful

Unless you selected to install only the binary files, you can log in to the portal and
verify that your installation was successful. Access WebSphere Portal with the
http://yourserver:yourport/wps/portal format.

If you are not sure what your port number is, use the 1ist-server-ports
command to determine the port number. Change to the . Run the
list-server-ports task to generate the WebSphere_Portal_PortMatrix.txt file. For
example: ConfigEngine.sh list-server-ports -DWasPassword=password.

Change to the . Run the Tist-server-ports task to generate the
serverl_PortMatrix.txt file. For example: ConfigEngine.sh 1ist-server-ports
-DWasPassword=password.

Modify the uri.home.substitution custom property in the Resource
Environment Provider

In the WP ConfigService, set the uri.home.substitution custom property to true
to avoid functional errors that might occur in certain unusual use cases. For more
information on uri.home.substitution, see Configuration Service in the related
links.

Select a roadmap

If you have not already selected a roadmap to guide you through the installation
and deployment process, look at the available roadmaps. The roadmaps are based
on typical environments, such as development environment, test environment, and
more. They provide a high-level overview of the installation and deployment
process. Each roadmap includes a topology diagram, usage recommendations, and
instructions. Roadmaps are available for both new deployments and migrations
scenarios.

[“Roadmaps for installation and deployment” on page 69|

["Roadmaps for migration” on page 110|

Run the Configuration Wizard to finish the deployment

Then, start the Configuration Wizard and select the option that is defined in your
selected roadmap. Use the wizard to run the configuration steps in real time or to
generate scripts. The wizard generates instructions and scripts specific to your
environment and the data that you entered. You can save the selection and data
that you entered as an XML file. Then, you can load the XML file during a
subsequent wizard session to set up a similar configuration on a different server.

If you select to run the configuration in real time, you still have the opportunity to
download scripts for selected steps. For example, if only the database
administrator can databases, then you can download the database creation script
and give it to your database administrator to run.

Default URLs

During the configuration process, you might need to following URLs to access
different administration user interfaces.
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Use the following default URLs to access IBM WebSphere Portal, the WebSphere
Integrated Solutions Console, and the Configuration Wizard:

IBM WebSphere Portal
http://localhost:10039/wps/portal
https://lTocalhost:10042/wps/portal

WebSphere Integrated Solutions Console
http://Tocalhost:10038/ibm/console
https://localhost:10041/ibm/console

Configuration Wizard
http://localhost:10200/1ibm/wizard
https://localhost:10202/1ibm/wizard

If you had any processes from other software in the default port range when the
installation started, you might have different port numbers than the defaults.

Related concepts:

[Chapter 3, “Roadmaps,” on page 69|
Review the roadmaps to understand the common deployment patterns that are
supported by the configuration wizard.

[“Configuration Wizard” on page 340|

Use the Configuration Wizard to set up stand-alone servers and new deployments,
create clusters, migrate and update to new versions, and add new capabilities to
existing deployments.

Related tasks:

[“IBM i: Preparing your operating system” on page 254|
Prepare the operating system to ensure a successful installation.

[“IBM i: Preparing the Installation Manager” on page 254|
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

Related reference:

[‘Configuration Service” on page 418|
The portal Configuration Service is responsible for collecting the most essential
configuration data of the IBM WebSphere Portal engine.

IBM i: Upgrading the SDK

Starting with IBM WebSphere Portal Combined Cumulative Fix 05, you can change
your SDK Java Technology Edition from version 7.0 to version 7.1.

About this task

IBM i note: SDK version 7.1 is an optional prerequisite for WebSphere
Application Server on IBM i and has a separate, non-Installation Manager based
installation.

Procedure
1. Install one of the following PTF Groups or higher:
* V7R1: PTF Group SF99572 level 15 or higher
* V7R2: PTF Group SF99716 level 4 or higher
2. Read the following information before you run the managesdk task:
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* For stand-alone environments: Stop the profile server (node) before you run
the managesdk command.

e For clustered environments:

— If the profile is a federated node of a deployment manager, ensure that the
deployment manager is running before you run the managesdk command
to update the profile.

— Stop all the nodes.
— Ensure that the node agent for each node is started.

— When you enable the SDK for a node, run the managesdk command from
the /bin directory to which the node belongs. You can also run the
command from the /bin directory of the profile that contains the node
that you want to update.

— A connection to the deployment manager must exist with a supported
connector protocol in the following order of preference:

- SOAP
- Inter-Process Communications (IPC)
- Remote Method Invocation (RMI)

If the SOAP protocol is enabled, the managesdk command uses the SOAP
protocol. If the SOAP protocol is not enabled but the IPC protocol is
enabled, the command uses the IPC protocol. If the SOAP and IPC
protocol are not enabled, then the command uses the RMI protocol.

— You must provide the administrative user name and password with the
managesdk command for each profile that contains a federated node or
deployment manager node in a cell with security enabled. If you do not
specify the -user and -password parameters, the managesdk command
might fail or stop processing.

— When you enable the SDK for a deployment manager, only the
deployment manager server is enabled. None of the managed nodes of the
deployment manager are enabled to use the specific SDK.

3. Open a command prompt and change to the b1' n directory.

4. Run the following command to enable all existing profiles to use the new SDK
version:

Go to [managesdk command| for information about the managesdk commands.
* IBM i: managesdk -enableProfileAll -sdkname 1.7.1_64 -enableServers

5. Run the following commands to make the new SDK version the new default:
* IBM i: managesdk -setCommandDefault -sdkname 1.7.1 64
managesdk -setNewProfileDefault -sdkname 1.7.1 64
6. Repeat these steps on each node in your environment.
Related tasks:
[“IBM i: Preparing your operating system” on page 254
Prepare the operating system to ensure a successful installation.

[‘TBM i: Preparing the Installation Manager” on page 254
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

[‘IBM i: Running the installation program” on page 255|

Use the IBM Installation Manager program to install the software. IBM Installation
Manager provides multiple user interfaces. Select the one that you are more
comfortable with. You can use the graphical user interface or the console to create
a response file for automated installations.
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IBM i: Rendering documents on IBM i

To enable document preview function for IBM Web Content Manager and the
Common Mail portlet, you must set up an HTML rendering server to work with
WebSphere Portal. Because IBM i does not contain native graphics support, you
must install extra fonts to run the document conversion that is required by these
functions. Document conversion enables WebSphere Portal to convert documents
that are produced by commonly used office programs into web pages so that they
can be viewed and searched by users online. The additional fonts include an
HTML rendering server that is known as X virtual frame buffer for the X server.

About this task

Before you begin, you must have:
A WebSphere Portal profile that runs on your IBM i system; record the name of
your WebSphere Portal profile for future reference.
0S5/400 - Additional Fonts (5770551, Option 43).

After you set up your HTML rendering server, you must also enable the Document
Conversion Services.

Complete the following tasks on each WebSphere Portal node to render documents
on IBM i:

Note: Use the HTML rendering server that you associate with your WebSphere
Portal profile only for WebSphere Portal. Using the HTML rendering server with
other applications might cause problems.

[“IBM i: Configuring an HTML rendering server on IBM i” on page 265|

After you have installed OS/400 - Additional Fonts (5770551, Option 43), on
your IBM i system, an HTML rendering server (X virtual frame buffer for X
server) is present. You must select a display number for the HTML rendering
server.

“IBM i: Associating an HTML rendering server with WebSphere Portal on IBM|
i” on page 265|

After you select a display number for the HTML rendering server (X virtual
frame buffer for X server), you must associate this server with the installed IBM
WebSphere Portal profile.

Related concepts:

[“IBM i: Next steps” on page 260|

The configuration process has changed. Use the Configuration Wizard to set up
your integration with prerequisites, clusters, and more.

Related tasks:

[“IBM i: Preparing your operating system” on page 254

Prepare the operating system to ensure a successful installation.

[“IBM i: Preparing the Installation Manager” on page 254
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

[“IBM i: Running the installation program” on page 255|

Use the IBM Installation Manager program to install the software. IBM Installation
Manager provides multiple user interfaces. Select the one that you are more
comfortable with. You can use the graphical user interface or the console to create
a response file for automated installations.
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IBM i: Configuring an HTML rendering server on IBM i:

After you have installed OS/400 - Additional Fonts (5770SS1, Option 43), on your
IBM i system, an HTML rendering server (X virtual frame buffer for X server) is
present. You must select a display number for the HTML rendering server.

Procedure
1. If the QShell Interpreter is running, perform the following commands on the
IBM i command line to stop it:
QSH
Press F3
2. Type CALL QP2TERM on the command line to start the OS/400 Portable
Application Solutions Environment (OS/400 PASE) console.

3. Type ps gaxuw | grep Xvnc ; ps gaxuw | grep vfb on the command line to
list all active HTML rendering servers:

Note: If other rendering servers are already active, you might see output such
as this (the number after the colon is the display number already in use):

v2keab54 40571 0.0 0.0 12484 0 - A Jul 13 4:08
/Q0penSys/QIBM/ProdData/DeveloperTools/vnc/Xvnc:6 -desktop X -httpd

4. Select any number from 1 to 99 that is not in use.
5. Press F3 to return to the command line interface.

6. Type SBMJOB CMD(CALL PGM(QP2SHELL) PARM('/usr/bin/X11/X"' '-vfb' ':N'))
JOB(XVFB) JOBQ(QSYSNOMAX) ALWMLTTHD(*YES) on the command line to start the
HTML rendering server, where N is the display number.

7. Verify that the HTML rendering server is started by repeating the prior steps to
start PASE and list the active servers, confirming that an HTML rendering
server with your display number is in the list.

What to do next
After you render your documents, you must enable the document conversion

services. Go to |[Chapter 6, “Document Conversion Services,” on page 875| for
information.

IBM i: Associating an HTML rendering server with WebSphere Portal on IBM
i

After you select a display number for the HTML rendering server (X virtual frame
buffer for X server), you must associate this server with the installed IBM
WebSphere Portal profile.

Procedure
1. Log on to the WebSphere Integrated Solutions Console.

2. Go to Servers > Server Types > WebSphere application servers >
WebSphere_Portal > Server Infrastructure > Java and Process Management >
Process definition > Environment Entries.

3. Click New.
4. In the Name field type DISPLAY.

5. In the Value field type host_name:n, where host_name is the TCP/IP host name
of your system and # is the display number of the HTML rendering server.
(Example: mysystem.x1and.company.com:1).
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6. Click OK.

7. Save your changes to the master WebSphere Application Server configuration
file.

8. Restart the server.
What to do next

After you render your documents, you must enable the document conversion
services. Go to [Chapter 6, “Document Conversion Services,” on page 875| for
information.

Linux: Installing WebSphere Portal and Web Content Manager

Installing the digital experience software includes preparing your operating system
and using IBM Installation Manager to install IBM WebSphere Portal and Web
Content Manager. Then, use the Configuration Wizard to complete the deployment
configuration.

Before you begin

Roadmaps for installation and deployment are included in this product
documentation to guide you through the process. Roadmaps provide a high-level
overview of the process from beginning to end. Select the configuration that is
closest to the configuration that you need.

1. [“Linux: Preparing your operating system”|
Prepare the operating system to ensure a successful installation.

2. [“Linux: Preparing the Installation Manager” on page 267
The IBM Installation Manager is used to install installation packages such as
IBM WebSphere Portal and IBM WebSphere Application Server.

3. ["Linux: Running the installation program” on page 268|
Use the IBM Installation Manager program to install the software. IBM
Installation Manager provides multiple user interfaces. Select the one that you
are more comfortable with. You can use the graphical user interface or the
console to create a response file for automated installations.

4. |"Linux: Next steps” on page 277
The configuration process has changed. Use the Configuration Wizard to set up
your integration with prerequisites, clusters, and more.

5. ["Linux: Upgrading the SDK” on page 278§
Starting with IBM WebSphere Portal Combined Cumulative Fix 05, you can
change your SDK Java Technology Edition from version 7.0 to version 7.1.

Linux: Preparing your operating system
Prepare the operating system to ensure a successful installation.

Procedure

1. If you are using IBM GPFS file sharing, set the file system inodes limit to 25000
or higher. For example, run the mmchfs /dev/gpfslnsd -F 256000 command.
/dev/gpfsinsd is the IBM WebSphere Portal installation file system.

2. Set the file descriptor limit to 10240.
ulimit -n 10240

3. Web Content Manager only: Complete the following steps to remove any file
size limits: Use the ulimit -f command to set the maximum size of files that
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can be created. Set this value to at least the size of the largest file you would
upload to the content server. The ulimit -f unlimited command removes any
limit on file size.

a. Open a command prompt.
b. Run the ulimit -a command to get a list of all the ulimit settings.

c. Find the -f parameter. If the value is unlimited, no further action is
required.

d. If the -f parameter is not unlimited, choose one of the following options:

* Remove the file size limit permanently. For information about how to
remove the file size limit see your system documentation.

* Run the ulimit -f unlimited command for each session.

Install and configure X server on Linux (such as X Window System or
GNOME) to use the graphical user interface the installation program provides.
For information about adding packages, read your system documentation.

Note: If you plan to install with a response file, X server is not required.

Linux: Preparing the Installation Manager
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

Procedure

If you have an existing Installation Manager, start it and go to File > Preferences.
Then, click Updates. Click the Search for Installation Manager updates check box.
This box enables the Installation Manager to search for updates the next time you
run an installation or update.

If you do not have an existing Installation Manager, then complete the following
procedure:

1.

2.

5.

Start all servers and applications that require a port number to avoid port
conflicts when installing WebSphere Portal.

Type ping yourserver.yourcompany.com on a command line to verify that your
fully qualified host name is properly configured.

Type ping Tocalhost on a command line to verify that your network is
properly configured.

If you are installing on a server with a firewall, antivirus, screen saver, or
desktop search engine that is enabled, disable them before you install. If you do
not disable them and the installation program detects them, a warning message
displays during the installation.

Optional: Complete the following steps to install as a non-root user:

a. Log in to the operating system as the root user.

b. Open a command line.

c. Use the appropriate system commands to create the following items:
Non-root user, including password
Group

Directory, used when you install IBM Installation Manager and
WebSphere Portal

d. Set the user profile for the number of open files. Set the value to ulimit -n
10240.

e. Add the non-root user to the new group.
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f. Run the following task to change the owner of the directory to the non-root
user:
chown user:group /directory

g. Run the following task to change permissions for the directory:
chmod 755 /directory

h. Log in as the non-root user.

i. Use the following command to install IBM Installation Manager:
./userinst
Set the IBM Installation Manager installation location to
/directory/IBM/InstallationManager.

6. Run the following task from the IIM directory: ./install

7. Run the following task from the Portal Setup disk if you want to start the
launchpad to complete all necessary installation steps: ./setup.sh

Launchpad tip: On the Launchpad: Install Portal panel, you have the following
options:

Install IBM WebSphere Portal from media
Choose this option if you are installing directly from the DVD.

Install IBM WebSphere Portal from network
Choose this option if you downloaded the electronic images.

Install IBM Installation Manager only
Choose this option if you want to install multiple IBM products, or if
you want to install WebSphere Portal directly from IBM Passport
Advantage, and a previous version of Installation Manager is not
already installed on your system.

Restriction: If you have a previously installed 32-bit version of
Installation Manager, then you cannot proceed with this option. You
must manually install the 64-bit version of Installation Manager that is
specific to your operating system using the Setup disc before you
proceed with the WebSphere Portal installation.

Tip: Add the LaunchPadlLocale language_code to the setup task to change the
display to your user locale or to another language.

Note: If the language is not currently supported for the user interface, you
might see the English version. For details on supported languages and the
language codes for all of the WebSphere Portal user interfaces, see
[languages” on page 3924

After you complete all necessary steps from the launchpad, verify that your
installation was successful.

Linux: Running the installation program

Use the IBM Installation Manager program to install the software. IBM Installation
Manager provides multiple user interfaces. Select the one that you are more
comfortable with. You can use the graphical user interface or the console to create
a response file for automated installations.

[‘Linux: Installing with the graphical user interface” on page 269
Use the IBM Installation Manager to install IBM WebSphere Portal, IBM
WebSphere Application Server, and the Apache Derby database.
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[“Linux: Installing with the console” on page 271|
Use the IBM Installation Manager to install IBM WebSphere Portal with an
existing IBM WebSphere Application Server.

[“Linux: Creating a response file” on page 274

After IBM Installation Manager is installed, you can use it to record a response
file that is based on your environment. Record a response file on the same
operating system you plan for the installation. If you have multiple operating
systems, you must record a response file for each operating system. Use a
response file to automate your installation on multiple servers.

[“Linux: Installing with the response file” on page 276|

Use either a sample response file or a response file that you created to install
WebSphere Application Server and WebSphere Portal. You can create a response
file with the graphical or console mode interface.

Related tasks:

[‘Linux: Preparing your operating system” on page 266|

Prepare the operating system to ensure a successful installation.

Linux: Installing with the graphical user interface:

Use the IBM Installation Manager to install IBM WebSphere Portal, IBM
WebSphere Application Server, and the Apache Derby database.

About this task

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.

Procedure

1. Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

2. If necessary, start the Installation Manager.

3. After you install or upgrade the Installation Manager, complete the following
steps to add the repositories where the installation media exists:

a. Open the IBM Installation Manager and go to File > Preferences >
Repositories.

b. Select Add Repositories.

c. Select Browse and go to the Portal-install-eimage/Setup/
repository.config file and then click OK.

d. Ensure that all required repositories are checked. Then, click Test
Connections to ensure that the IBM Installation Manager can successfully
access the directory where the service repositories are stored.

e. Select Apply.
f. Select OK.
4. On the main IBM Installation Manager panel, select Install.

5. Optional: If you are installing Portal to an existing copy of WebSphere
Application Server, then select only IBM WebSphere Portal Server on the
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10.

11.
12.

13.
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Install Packages screen. To complete this installation option, your existing
copy of WebSphere Application Server must meet the following requirements:

* WebSphere Application Server Version 8.5.5.2 or later

* Java Version 7

* No existing Portal profile

Skip the following step, if you choose to install to an existing copy of
WebSphere Application Server.

On Install Packages: Select packages to install, select the following packages,
and then click Next:

* IBM WebSphere Application Server Network Deployment
* IBM WebSphere Portal Server
* IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional" on the Select packages to install screen.

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

On Install Packages: Select the fixes to install screen, select any required fixes.
Then, click Next.

Accept the license agreement and then click Next.

Enter the directory where you want to store shared resources and then click
Next.

Complete the following steps on the Install Packages: Installation Directory
panel:

Remember: The installation directory that you specify must NOT contain any
files or the following characters: ¥ 1 @ # $ %~ &= () +{} | <>?2"=[]1; ",
. " and spaces.

a. Select the WebSphere Application Server Package Group Name and then
enter the installation directory path.

b. Select the WebSphere Portal Package Group Name and then enter the
installation directory path.

c. Click Next.
Select the translations to install and then click Next.

Optional: If you chose to install Portal to an existing copy of WebSphere
Application Server, select the available copy of WebSphere Application Server,
and click Next.

Note: Skip this step, if you are not installing Portal to an existing copy of
WebSphere Application Server.

On Install Packages: Select the features to install, expand the WebSphere
Application Server and WebSphere Portal packages to modify the features you
want to install and then click Next.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.



Note: As you select the items, read the Details section for information.

14. On Profile configuration details, enter the user ID and password for the
configuration wizard administrator. Then, click Next.

15. If you selected the Portal Server Profile package, click Enter the
Administrator user ID and password for the Portal Server. Then, select either
the Standard or Advanced configuration mode and then enter the parameter
details for the selected configuration mode.

Note: Select Advanced if you want to specify Uniform Resource Identifier
(URI) information that is specific to your company.

16. Confirm the Summary information and then click Install.
What to do next

After a successful installation, the summary displays. Choose the Portal First Steps
radio button and then click Finish to start the servers and begin configuring
WebSphere Portal with the Configuration Wizard.

Tip: To access First Steps later, you can either select First Steps from the Start
menu or you can run the ./firststeps.sh task from the
PortalServer/installer/wp.firststeps directory. Add the LaunchPadLocale
language_code to the firststeps task to change the display to your user locale or

to another language.

Attention: When you install WebSphere Application Server and WebSphere Portal
together, you might find the following message in the SystemErr.Tog file:

lBppServer_root)/properties/version/installed.xml (No such file or directory)

This message is part of the installation process and is not repeated after the
installation is complete. Therefore, the message can be ignored.

Linux: Installing with the console:

Use the IBM Installation Manager to install IBM WebSphere Portal with an existing
IBM WebSphere Application Server.

Before you begin

A working installation of IBM WebSphere Application Server is required. Ensure
that it is not used by another copy of WebSphere Portal. Before you install the
WebSphere Portal package, install IBM WebSphere SDK Java Technology Edition
into the same directory where IBM WebSphere Application Server is installed.

About this task

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.
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Procedure

1. Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

2. Open a command prompt and change to the InstallationManager_root/
eclipse/tools directory.

3. Run the command to start the IBM Installation Manager in console mode:
./imcl -c

4. Complete the following steps to add the repositories:
. Enter P to go to the Preferences menu.

. Enter 1 to go to the Repositories menu.

a
b
c. Enter D to add repositories.
d. Type the path for your WebSphere Portal repository file.
e. Enter A to apply your repositories and return to the Preferences menu.
f. Enter R to return to the Main menu.
5. Enter 1 to install the software packages.
6. Select the software packages that you want to install.

* If you are installing Portal to an existing copy of WebSphere Application
Server, then select only IBM WebSphere Portal Server. To complete this
installation option, your existing copy of WebSphere Application Server
must meet the following requirements:

— WebSphere Application Server Version 8.5.5.2 or later
— Java Version 7
— No existing Portal profile

* If you are not installing Portal to an existing copy of WebSphere
Application Server, then select the following packages:

— IBM WebSphere Application Server Network Deployment
— IBM WebSphere Portal Server
— IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional."

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

7. Choose one of the following options:
* Enter 1 to choose version 8.5.0.0 for installation.
* Enter 2 to show all available versions of the package.

8. Enter N.
9. Enter A to accept the license agreement.
10. Enter N.

11. Choose one of the following options for translation packages:
* Enter N to select the default English package only.
* Enter the number for the translation package you want to install.

12. On the Incompatible package group menu, choose one of the following
options:
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13.

14.

15.
16.

17.

18.
19.
20.

21.

22.

23.

* Enter M to change the installation directory. Then, enter the new installation
directory.

* Enter N to keep the existing directory.

Enter the number for the WebSphere Application Server root directory to use
as the existing WebSphere Application Server.

On the IBM Installation Manager > Install > Licenses > Location > Features
menu, enter 1 to select the Portal Server Profile feature. Then, enter N to
continue.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.

Enter the configuration wizard administrator user ID and password.

If you selected the Portal Server Profile feature, enter the information for the
following prompts:

* Enter the host name

* Enter the node name

* Enter the cell name

* Enter an administrator user ID for the portal server

* Enter an administrator user password for the portal server
* Confirm administrator user password for the portal server

Enter Y to enter advanced parameters such as customized Uniform Resource
Identifier (URI) settings, profile name, and port numbers. Enter N to accept the
default parameters.

* Enter the context root

* Enter the default home

* Enter the personalized home

* Enter the profile name

* Enter the starting port number

* Enter the profile path

Enter N.

Review the summary information.
Choose one of the following options:
* Enter G to generate a response file.
* Enter I to install WebSphere Portal.

When the installation is complete, enter F to return to the main installation
menu.

Access the Configuration Wizard. Go to http://your_server:10200/ibm/
wizard.

Log in to the Configuration Wizard with the administrative ID for the
configuration wizard profile, cw_profiTe.

Note: The wizard user interface might not be available in all languages. If the
language is not currently supported, you might see the English version. For
details on the supported languages for all of the WebSphere Portal user
interfaces, see [“Supported languages” on page 3924
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Linux: Creating a response file:

After IBM Installation Manager is installed, you can use it to record a response file
that is based on your environment. Record a response file on the same operating
system you plan for the installation. If you have multiple operating systems, you
must record a response file for each operating system. Use a response file to
automate your installation on multiple servers.

About this task

You can also use the console mode to generate a response file. After you review
the summary information, enter G to generate a response file instead of I to install.

Procedure

1. Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

2. Go to the InstallationManager_root/eclipse directory.

3. Run the following task to start the recording: ./IBMIM -record
pathtoresponsexmlfile -skipInstall tempinstalldirectory

-record
This parameter indicates recording the actions and parameters into the
response file. The pathtoresponsexmlfile text is the name of the response
file, for example Wp8SampleResp.xml. The tempinstalldirectory text is the
directory where the response file is recorded.

-skipInstall
This parameter indicates that no actual installation is completed even
though it leads to the final pane.

tempinstalldirectory
This value is a directory where the installation saves the history and
data when you record the response files.

4. Complete the following steps to add the repositories where the installation
media exists:

a. Open the IBM Installation Manager and go to File > Preferences >
Repositories.

b. Select Add Repositories.

c. Select Browse and go to the Portal-install-eimage/Setup/
repository.config file and then click OK.

d. Ensure that all required repositories are checked. Then, click Test
Connections to ensure that the IBM Installation Manager can successfully
access the directory where the service repositories are stored.

e. Select Apply.
f. Select OK.
5. On the main IBM Installation Manager panel, select Install.

6. Optional: If you are installing Portal to an existing copy of WebSphere
Application Server, then select only IBM WebSphere Portal Server on the
Install Packages screen. To complete this installation option, your existing
copy of WebSphere Application Server must meet the following requirements:

* WebSphere Application Server Version 8.5.5.2 or later

* Java Version 7
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11.

12.
13.

14.

15.

16.

* No existing Portal profile

Skip the following step, if you choose to install to an existing copy of
WebSphere Application Server.

On Install Packages: Select packages to install, select the following packages,
and then click Next:

* IBM WebSphere Application Server Network Deployment

* IBM WebSphere Portal Server

* IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional" on the Select packages to install screen.

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

On Install Packages: Select the fixes to install screen, select any required fixes.
Then, click Next.

Accept the license agreement and then click Next.
Enter the directory where you want to store shared resources and then click
Next.

Complete the following steps on the Install Packages: Installation Directory
panel:

Remember: The installation directory that you specify must NOT contain any
files or the following characters: ™ ! @ # § S~ & * () + { } | <>?2-=[1;",
" and spaces.
a. Select the WebSphere Application Server Package Group Name and then
enter the installation directory path.
b. Select the WebSphere Portal Package Group Name and then enter the
installation directory path.

c. Click Next.
Select the translations to install and then click Next.

Optional: If you chose to install Portal to an existing copy of WebSphere
Application Server, select the available copy of WebSphere Application Server,
and click Next.

Note: Skip this step, if you are not installing Portal to an existing copy of
WebSphere Application Server.
On Install Packages: Select the features to install, expand the WebSphere

Application Server and WebSphere Portal packages to modify the features you
want to install and then click Next.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.

Note: As you select the items, read the Details section for information.

On Profile configuration details, enter the user ID and password for the
configuration wizard administrator. Then, click Next.

If you selected the Portal Server Profile package, click Enter the
Administrator user ID and password for the Portal Server. Then, select either
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the Standard or Advanced configuration mode and then enter the parameter
details for the selected configuration mode.

Note: Select Advanced if you want to specify Uniform Resource Identifier
(URI) information that is specific to your company.

17. Confirm the Summary information and then click Install.

18. After the Installation Manager finishes creating the response file, click Finish
and then close the Installation Manager to complete the response file
recording.

19. If you plan to install on a different computer, copy the response file to the
response file directory on that computer.

Linux: Installing with the response file:

Use either a sample response file or a response file that you created to install
WebSphere Application Server and WebSphere Portal. You can create a response
file with the graphical or console mode interface.

About this task

Locate the sample response file in the setup_root/responsefiles directory. Modify
the file with your environment values.

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.

Procedure

1. If the repository URL requires authentication, use the IBM Installation Manager
command-line tool to create a secure Storage File.

The secure Storage File stores the credentials that are required for the
repositories. The IBM Installation Manager command-line tool imutilsc is
available from the installation tools directory. The following information is an
example of the imutilsc key ring file command:

./imutilsc saveCredential -url repository_URL -userName credential_userName
-userPassword password -secureStorageFile storage_file
[ -masterPasswordFile master_password_file ]
[ -preferences com.1'bm.c1'c.common.core.preferences.ss].nonsecureMode=true|fa]se ]
[ -proxyHost proxy_host -proxyPort proxy_port

[ -proxyUsername proxy_username -proxyUserPassword proxyuser_password ]

[ -useSocks ] 1]

[ -verbose ]

Tip: If you install on a different computer, copy the secure Storage File to that
computer.

2. Go to the InstallationManager_root/eclipse/tools directory.

3. Run the following task to install WebSphere Portal and IBM WebSphere
Application Server:

Tip: Add the -secureStorageFile pathtosecureStoragefile
-masterPasswordFile pathtomasterPasswordFile parameters to the imcl
command if you are using a secure Storage File to store credentials.

./imc1 -acceptlicense input pathtoresponse.xml -log dirpath/logfilename
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What to do next

Attention: When you install WebSphere Application Server and WebSphere Portal
together, you might find the following message in the SystemErr.Tog file:

lBppServer_root)/properties/version/installed.xml (No such file or directory)

This message is part of the installation process and is not repeated after the
installation is complete. Therefore, the message can be ignored.

Linux: Next steps
The configuration process has changed. Use the Configuration Wizard to set up
your integration with prerequisites, clusters, and more.

Verify that the installation was successful

Unless you selected to install only the binary files, you can log in to the portal and
verify that your installation was successful. Access WebSphere Portal with the
http://yourserver:yourport/wps/portal format.

If you are not sure what your port number is, use the Tist-server-ports
command to determine the port number. Change to the
ConfigEngine/Tog. Run the 1ist-server-ports task to generate the

WebSphere_Portal_PortMatrix.txt file. For example: ./ConfigEngine.sh
list-server-ports -DWasPassword=password.

Change to the /opt/IBM/WebSphere/AppServer/profiles/cw_profile/ConfigEngine.
Run the Tist-server-ports task to generate the serverl_PortMatrix.txt file. For
example: ./ConfigEngine.sh list-server-ports -DWasPassword=password.

Modify the uri.home.substitution custom property in the Resource
Environment Provider

In the WP ConfigService, set the uri.home.substitution custom property to true
to avoid functional errors that might occur in certain unusual use cases. For more
information on uri.home.substitution, see Configuration Service in the related
links.

Select a roadmap

If you have not already selected a roadmap to guide you through the installation
and deployment process, look at the available roadmaps. The roadmaps are based
on typical environments, such as development environment, test environment, and
more. They provide a high-level overview of the installation and deployment
process. Each roadmap includes a topology diagram, usage recommendations, and
instructions. Roadmaps are available for both new deployments and migrations
scenarios.

[“Roadmaps for installation and deployment” on page 69|

[“Roadmaps for migration” on page 110|

Run the Configuration Wizard to finish the deployment

Then, start the Configuration Wizard and select the option that is defined in your
selected roadmap. Use the wizard to run the configuration steps in real time or to
generate scripts. The wizard generates instructions and scripts specific to your
environment and the data that you entered. You can save the selection and data

Chapter 4. Installing 277



that you entered as an XML file. Then, you can load the XML file during a
subsequent wizard session to set up a similar configuration on a different server.

If you select to run the configuration in real time, you still have the opportunity to
download scripts for selected steps. For example, if only the database
administrator can databases, then you can download the database creation script
and give it to your database administrator to run.

Default URLs

During the configuration process, you might need to following URLs to access
different administration user interfaces.

Use the following default URLs to access IBM WebSphere Portal, the WebSphere
Integrated Solutions Console, and the Configuration Wizard:
IBM WebSphere Portal
http://Tocalhost:10039/wps/portal
https://lTocalhost:10042/wps/portal
WebSphere Integrated Solutions Console
http://localhost:10038/ibm/console
https://localhost:10041/ibm/console
Configuration Wizard
http://Tocalhost:10200/1bm/wizard
https://localhost:10202/ibm/wizard

If you had any processes from other software in the default port range when the
installation started, you might have different port numbers than the defaults.

Related concepts:

[Chapter 3, “Roadmaps,” on page 69|
Review the roadmaps to understand the common deployment patterns that are
supported by the configuration wizard.

[‘Configuration Wizard” on page 340|

Use the Configuration Wizard to set up stand-alone servers and new deployments,
create clusters, migrate and update to new versions, and add new capabilities to
existing deployments.

Related tasks:

[“Linux: Preparing your operating system” on page 266|
Prepare the operating system to ensure a successful installation.

[‘Linux: Preparing the Installation Manager” on page 267
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

Related reference:

[“Configuration Service” on page 418|
The portal Configuration Service is responsible for collecting the most essential
configuration data of the IBM WebSphere Portal engine.

Linux: Upgrading the SDK
Starting with IBM WebSphere Portal Combined Cumulative Fix 05, you can change
your SDK Java Technology Edition from version 7.0 to version 7.1.
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Before you begin

Ensure that IBM WebSphere Application Server and WebSphere Portal are installed
with SDK version 7.0.

Procedure

1. Start the IBM Installation Manager.

2. Install IBM WebSphere SDK Java Technology Edition version 7.1.
3. Read the following information before you run the managesdk task:

* For stand-alone environments: Stop the profile server (node) before you run
the managesdk command.

* For clustered environments:

If the profile is a federated node of a deployment manager, ensure that the
deployment manager is running before you run the managesdk command
to update the profile.

Stop all the nodes.
Ensure that the node agent for each node is started.

When you enable the SDK for a node, run the managesdk command from
the /bin directory to which the node belongs. You can also run the
command from the /bin directory of the profile that contains the node
that you want to update.

A connection to the deployment manager must exist with a supported
connector protocol in the following order of preference:

- SOAP
- Inter-Process Communications (IPC)
- Remote Method Invocation (RMI)

If the SOAP protocol is enabled, the managesdk command uses the SOAP
protocol. If the SOAP protocol is not enabled but the IPC protocol is
enabled, the command uses the IPC protocol. If the SOAP and IPC
protocol are not enabled, then the command uses the RMI protocol.

You must provide the administrative user name and password with the
managesdk command for each profile that contains a federated node or
deployment manager node in a cell with security enabled. If you do not
specify the -user and -password parameters, the managesdk command
might fail or stop processing.

When you enable the SDK for a deployment manager, only the
deployment manager server is enabled. None of the managed nodes of the
deployment manager are enabled to use the specific SDK.

4. Open a command prompt and change to the b1' n directory.

5. Run the following command to enable all existing profiles to use the new SDK
version:

Go to|managesdk command| for information about the managesdk commands.

* Linux: ./managesdk.sh -enableProfileAll -sdkname 1.7.1 64
-enableServers

6. Run the following commands to make the new SDK version the new default:

* Linux: ./managesdk.sh -setCommandDefault -sdkname 1.7.1 64

./managesdk.sh -setNewProfileDefault -sdkname 1.7.1 64

7. Repeat these steps on each node in your environment.
Related tasks:
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[“Linux: Preparing your operating system” on page 266|

Prepare the operating system to ensure a successful installation.

[‘Linux: Preparing the Installation Manager” on page 267

The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.

[‘Linux: Running the installation program” on page 268|

Use the IBM Installation Manager program to install the software. IBM Installation
Manager provides multiple user interfaces. Select the one that you are more
comfortable with. You can use the graphical user interface or the console to create
a response file for automated installations.

Solaris: Installing WebSphere Portal and Web Content
Manager

Installing the digital experience software includes preparing your operating system
and using IBM Installation Manager to install IBM WebSphere Portal and Web
Content Manager. Then, use the Configuration Wizard to complete the deployment
configuration.

Before you begin

Roadmaps for installation and deployment are included in this product
documentation to guide you through the process. Roadmaps provide a high-level
overview of the process from beginning to end. Select the configuration that is
closest to the configuration that you need.

1. [“Solaris: Preparing your operating system”|
Prepare the operating system to ensure a successful installation.

2. [“Solaris: Preparing the Installation Manager” on page 281
The IBM Installation Manager is used to install installation packages such as
IBM WebSphere Portal and IBM WebSphere Application Server.

3. [“Solaris: Running the installation program” on page 283|
Use the IBM Installation Manager program to install the software. IBM
Installation Manager provides multiple user interfaces. Select the one that you
are more comfortable with. You can use the graphical user interface or the
console to create a response file for automated installations.

4. |“Solaris: Next steps” on page 291
The configuration process has changed. Use the Configuration Wizard to set up
your integration with prerequisites, clusters, and more.

5. [“Solaris: Upgrading the SDK” on page 293|
Starting with IBM WebSphere Portal Combined Cumulative Fix 05, you can
change your SDK Java Technology Edition from version 7.0 to version 7.1.

Solaris: Preparing your operating system
Prepare the operating system to ensure a successful installation.

About this task

Several Solaris kernel values are typically too small for the messaging requirements
of WebSphere Portal. Starting the internal JMS server or client with insufficient
kernel resources produces a First Failure Support Technology (FFST) file in the
/var/errors directory. Before you install WebSphere Portal, review the server
configuration.
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Procedure

1. The values that are described here are a starting point for messaging in
WebSphere Portal only. If your system has other applications that are installed,
the value requirements are likely different. For example, if values that are
already set are higher than the settings listed here, do not change the values. Be
sure to check the requirements that are made on /etc/system by other
already-installed applications before you alter existing values.

Type the sysdef -1 command to review the configuration.

Set shmsys:shminfo_shmmax to 4294967295 (valid for Solaris Version 9 only).
Set shmsys:shminfo_shmmni to 1024 (valid for Solaris Version 9 only).

Set semsys:seminfo_semaem to 16384 (valid for Solaris Version 9 only).

Set semsys:seminfo_semmni to 1024 (valid for Solaris Version 9 only).

Set semsys:seminfo_semmns to 16384 (valid for Solaris Version 9 only).

. Set semsys:seminfo_semms1 to 100 (valid for Solaris Version 9 only).

SQ@ "0 o0 oy

. Set semsys:seminfo_semopm to 100 (valid for Solaris Version 9 only).

Set semsys:seminfo_semmnu to 2048 (valid for Solaris Version 9 only).
j. Set semsys:seminfo_semume to 256 (valid for Solaris Version 9 only).
K. Set msgsys:msginfo_msgmap to 1026 (valid for Solaris Version 9 only).
I. Set msgsys:msginfo_msgmax to 65535 (valid for Solaris Version 9 only).
m. Set rlim_fd_cur to 1024.

n. Restart the operating system to apply the updates.

2. Web Content Manager only: Complete the following steps to remove any file
size limits: Use the ulimit -f command to set the maximum size of files that
can be created. Set this value to at least the size of the largest file you would
upload to the content server. The ulimit -f unlimited command removes any
limit on file size.

a. Open a command prompt.
b. Run the ulimit -a command to get a list of all the ulimit settings.

c. Find the -f parameter. If the value is unlimited, no further action is
required.

d. If the -f parameter is not unlimited, choose one of the following options:

* Remove the file size limit permanently. For information about how to
remove the file size limit see your system documentation.

* Run the ulimit -f unlimited command for each session.
3. Prepare for non-global zone:

a. Do not inherit package directories when you create the non-global zone
because the inherited software packages are read-only.

b. Stop WebSphere Portal and all related processes before you install or
uninstall.

C. Verify that the following processes are stopped:
/opt/IBM/WebSphere/AppServer/java/bin/java
/opt/1BM/WebSphere/AppServer/java/jre/bin/java

Solaris: Preparing the Installation Manager
The IBM Installation Manager is used to install installation packages such as IBM
WebSphere Portal and IBM WebSphere Application Server.
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Procedure

If you have an existing Installation Manager, start it and go to File > Preferences.
Then, click Updates. Click the Search for Installation Manager updates check box.
This box enables the Installation Manager to search for updates the next time you
run an installation or update.

If you do not have an existing Installation Manager, then complete the following
procedure:

1.
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Start all servers and applications that require a port number to avoid port
conflicts when installing WebSphere Portal.

Type ping yourserver.yourcompany.com on a command line to verify that your
fully qualified host name is properly configured.

Type ping localhost on a command line to verify that your network is
properly configured.

If you are installing on a server with a firewall, antivirus, screen saver, or
desktop search engine that is enabled, disable them before you install. If you do
not disable them and the installation program detects them, a warning message
displays during the installation.

Optional: Complete the following steps to install as a non-root user:

a. Log in to the operating system as the root user.

b. Open a command line.

c. Use the appropriate system commands to create the following items:
Non-root user, including password
Group

Directory, used when you install IBM Installation Manager and
WebSphere Portal

d. Set the user profile for the number of open files. Set the value to ulimit -n
10240.

e. Add the non-root user to the new group.

f. Run the following task to change the owner of the directory to the non-root
user:

chown user:group /directory

g. Run the following task to change permissions for the directory:
chmod 755 /directory

h. Log in as the non-root user.

i. Use the following command to install IBM Installation Manager:
./userinst

Set the IBM Installation Manager installation location to
/directory/IBM/InstallationManager.

Run the following task from the IIM directory: ./install

Run the following task from the Portal Setup disk if you want to start the
launchpad to complete all necessary installation steps: ./setup.sh

Launchpad tip: On the Launchpad: Install Portal panel, you have the following
options:

Install IBM WebSphere Portal from media
Choose this option if you are installing directly from the DVD.

Install IBM WebSphere Portal from network
Choose this option if you downloaded the electronic images.



Install IBM Installation Manager only
Choose this option if you want to install multiple IBM products, or if
you want to install WebSphere Portal directly from IBM Passport
Advantage, and a previous version of Installation Manager is not
already installed on your system.

Tip: Add the LaunchPadlLocale language_code to the setup task to change the
display to your user locale or to another language.

Note: If the language is not currently supported for the user interface, you
might see the English version. For details on supported languages and the
language codes for all of the WebSphere Portal user interfaces, see
[languages” on page 3924

After you complete all necessary steps from the launchpad, verify that your
installation was successful.

Solaris: Running the installation program

Use the IBM Installation Manager program to install the software. IBM Installation
Manager provides multiple user interfaces. Select the one that you are more
comfortable with. You can use the graphical user interface or the console to create
a response file for automated installations.

[“Solaris: Installing with the graphical user interface”|
Use the IBM Installation Manager to install IBM WebSphere Portal, IBM
WebSphere Application Server, and the Apache Derby database.

[“Solaris: Installing with the console” on page 286

Use the IBM Installation Manager to install IBM WebSphere Portal with an
existing IBM WebSphere Application Server.

[“Solaris: Creating a response file” on page 28|

After IBM Installation Manager is installed, you can use it to record a response
file that is based on your environment. Record a response file on the same
operating system you plan for the installation. If you have multiple operating
systems, you must record a response file for each operating system. Use a
response file to automate your installation on multiple servers.

[“Solaris: Installing with the response file” on page 290|
Use either a sample response file or a response file that you created to install
WebSphere Application Server and WebSphere Portal. You can create a response
file with the graphical or console mode interface.

Related tasks:

[“Solaris: Preparing your operating system” on page 280
Prepare the operating system to ensure a successful installation.

Solaris: Installing with the graphical user interface:

Use the IBM Installation Manager to install IBM WebSphere Portal, IBM
WebSphere Application Server, and the Apache Derby database.

About this task

The installation program verifies the operating system and its prerequisites,
available disk space, and any required software prerequisites before installation.
You cannot install two instances of the server at the same time, even if you are
installing to different directories. You must install each server completely before
you install the next one.
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Procedure

1.

10.
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Start all servers and applications that require a port number to avoid port
conflicts when you install WebSphere Portal. If you are installing multiple
copies of IBM WebSphere Portal on your server, start the existing
Configuration Wizard servers.

If necessary, start the Installation Manager.

After you install or upgrade the Installation Manager, complete the following
steps to add the repositories where the installation media exists:

a. Open the IBM Installation Manager and go to File > Preferences >
Repositories.

b. Select Add Repositories.

C. Select Browse and go to the Portal-install-eimage/Setup/
repository.config file and then click OK.

d. Ensure that all required repositories are checked. Then, click Test
Connections to ensure that the IBM Installation Manager can successfully
access the directory where the service repositories are stored.

e. Select Apply.
f. Select OK.
On the main IBM Installation Manager panel, select Install.

Optional: If you are installing Portal to an existing copy of WebSphere
Application Server, then select only IBM WebSphere Portal Server on the
Install Packages screen. To complete this installation option, your existing
copy of WebSphere Application Server must meet the following requirements:

* WebSphere Application Server Version 8.5.5.2 or later
* Java Version 7
* No existing Portal profile

Skip the following step, if you choose to install to an existing copy of
WebSphere Application Server.

On Install Packages: Select packages to install, select the following packages,
and then click Next:

* IBM WebSphere Application Server Network Deployment
* IBM WebSphere Portal Server
* IBM WebSphere SDK Java Technology Edition

Note: The IBM WebSphere SDK Java Technology Edition option is
required for a WebSphere Portal installation even though it might be
marked as "Optional" on the Select packages to install screen.

Tip: If you have a WebSphere Portal Enable license, you must select both the
IBM WebSphere Portal Server and IBM WebSphere Portal Enable packages.

On Install Packages: Select the fixes to install screen, select any required fixes.
Then, click Next.

Accept the license agreement and then click Next.

Enter the directory where you want to store shared resources and then click
Next.

Complete the following steps on the Install Packages: Installation Directory
panel:



Remember: The installation directory that you specify must NOT contain any
files or the following characters: ¥ 1 @ # $ %~ &= () +{} | <>?2"=[]; ",
" and spaces.
a. Select the WebSphere Application Server Package Group Name and then
enter the installation directory path.

b. Select the WebSphere Portal Package Group Name and then enter the
installation directory path.

c. Click Next.
11. Select the translations to install and then click Next.

12. Optional: If you chose to install Portal to an existing copy of WebSphere
Application Server, select the available copy of WebSphere Application Server,
and click Next.

Note: Skip this step, if you are not installing Portal to an existing copy of
WebSphere Application Server.

13. On Install Packages: Select the features to install, expand the WebSphere
Application Server and WebSphere Portal packages to modify the features you
want to install and then click Next.

Note: Ensure that Portal Server Profile is selected to create a profile that
contains the Portal application server and the product binary files. Clear this
option if you need a binary only installation for migration or your clustered
environment.

Note: As you select the items, read the Details section for information.
14. On Profile configuration details, enter the user ID and password for the
configuration wizard administrator. Then, click Next.

15. If you selected the Portal Server Profile package, click Enter the
Administrator user ID and password for the Portal Server. Then, select either
the Standard or Advanced configuration mode and then enter the parameter
details for the selected configuration mode.

Note: Select Advanced if you want to specify Uniform Resource Identifier
(URI) information that is specific to your company.

16. Confirm the Summary information and then click Install.
What to do next

After a successful installation, the summary displays. Choose the Portal First Steps
radio button and then click Finish to start the servers and begin configuring
WebSphere Portal with the Configuration Wizard.

Tip: To access First Steps later, you can either select First Steps from the Start
menu or you can run the ./firststeps.sh task from the
PortalServer/installer/wp.firststeps directory. Add the LaunchPadLocale
language_code to the firststeps task to change the display to your user locale or

to another language.

Attention: When you install WebSphere Application Server and WebSphere Portal
together, you might find the following me